## CONTENTS

1 **Introduction** ................. 3
   1.1 System Overview .................... 4
   1.2 Interactive Session with Examples ................. 5
   1.3 Summary of Commands for the Interactive Session Handler ................. 23
   1.4 Running the compiler from command line ................. 24

2 **OMEdit – OpenModelica Connection Editor** ................. 27
   2.1 Starting OMEdit .................... 27
   2.2 MainWindow & Browsers ................. 28
   2.3 Perspectives .................... 33
   2.4 Modeling a Model .................... 37
   2.5 Simulating a Model .................... 39
   2.6 Plotting the Simulation Results ................. 41
   2.7 Re-simulating a Model ................. 42
   2.8 3D Visualization .................... 42
   2.9 Animation of Realtime FMUs ................. 45
   2.10 Interactive Simulation ................. 45
   2.11 How to Create User Defined Shapes – Icons ................. 47
   2.12 Global head section in documentation ................. 48
   2.13 Settings .................... 49
   2.14 __OpenModelica_commandLineOptions Annotation ................. 54
   2.15 __OpenModelica_simulationFlags Annotation ................. 55
   2.16 Debugger .................... 55
   2.17 Editing Modelica Standard Library ................. 55
   2.18 State Machines .................... 56

3 **2D Plotting** ................. 59
   3.1 Example .................... 59
   3.2 Plot Command Interface ................. 61

4 **Solving Modelica Models** ................. 63
   4.1 Integration Methods ................. 63
   4.2 DAE Mode Simulation ................. 64

5 **Debugging** ................. 65
   5.1 The Equation-based Debugger ................. 65
   5.2 The Algorithmic Debugger ................. 67

6 **Generating Graph Representations for Models** ................. 73

7 **FMI and TLM-Based Simulation and Co-simulation of External Models** ................. 75
   7.1 Functional Mock-up Interface - FMI ................. 75
   7.2 Transmission Line Modeling (TLM) Based Co-Simulation ................. 77
   7.3 Composite Model Editing of External Models ................. 77
# OMJulia – OpenModelica Julia Scripting

## 21 Features of OMJulia

### 21.1 Features of OMJulia

### 21.2 Test Commands

### 21.3 Standard get methods

### 21.4 Usage of getMethods

### 21.5 Standard set methods

### 21.6 Usage of setMethods

### 21.7 Advanced Simulation

### 21.8 Linearization

### 21.9 Usage of Linearization methods

### 21.10 Sensitivity Analysis

### 21.11 Usage

## 22 Scripting API

### 22.1 OpenModelica Scripting Commands

### 22.2 Simulation Parameter Sweep

### 22.3 Examples

## 23 OpenModelica Compiler Flags

### 23.1 Options

### 23.2 Debug flags

### 23.3 Flags for Optimization Modules

## 24 Small Overview of Simulation Flags

### 24.1 OpenModelica (C-runtime) Simulation Flags

## 25 Technical Details

### 25.1 The MATv4 Result File Format

## 26 Frequently Asked Questions (FAQ)

### 26.1 OpenModelica General

### 26.2 OMNotebook

### 26.3 OMDev - OpenModelica Development Environment

## 27 Major OpenModelica Releases

### 27.1 Release Notes for OpenModelica 1.14.0

### 27.2 Release Notes for OpenModelica 1.13.0

### 27.3 Release Notes for OpenModelica 1.12.0

### 27.4 Release Notes for OpenModelica 1.11.0

### 27.5 Release Notes for OpenModelica 1.10.0

### 27.6 Release Notes for OpenModelica 1.9.4

### 27.7 Release Notes for OpenModelica 1.9.3

### 27.8 Release Notes for OpenModelica 1.9.2

### 27.9 Release Notes for OpenModelica 1.9.1

### 27.10 Release Notes for OpenModelica 1.9.0

### 27.11 Release Notes for OpenModelica 1.8.1

### 27.12 OpenModelica 1.8.0, November 2011

### 27.13 OpenModelica 1.7.0, April 2011

### 27.14 OpenModelica 1.6.0, November 2010

### 27.15 OpenModelica 1.5.0, July 2010

### 27.16 OpenModelica 1.4.5, January 2009

### 27.17 OpenModelica 1.4.4, Feb 2008

### 27.18 OpenModelica 1.4.3, June 2007

### 27.19 OpenModelica 1.4.2, October 2006

### 27.20 OpenModelica 1.4.1, June 2006

### 27.21 OpenModelica 1.4.0, May 2006

### 27.22 OpenModelica 1.3.1, November 2005

## 28 Contributors to OpenModelica
This document is part of OpenModelica: https://www.openmodelica.org
Contact: OpenModelica@ida.liu.se

Modelica® is a registered trademark of the Modelica Association, https://www.Modelica.org
Mathematica® is a registered trademark of Wolfram Research Inc, http://www.wolfram.com

This users guide provides documentation and examples on how to use the OpenModelica system, both for the Modelica beginners and advanced users.
The OpenModelica system described in this document has both short-term and long-term goals:

- The short-term goal is to develop an efficient interactive computational environment for the Modelica language, as well as a rather complete implementation of the language. It turns out that with support of appropriate tools and libraries, Modelica is very well suited as a computational language for development and execution of both low level and high level numerical algorithms, e.g. for control system design, solving nonlinear equation systems, or to develop optimization algorithms that are applied to complex applications.

- The long-term goal is to have a complete reference implementation of the Modelica language, including simulation of equation based models and additional facilities in the programming environment, as well as convenient facilities for research and experimentation in language design or other research activities. However, our goal is not to reach the level of performance and quality provided by current commercial Modelica environments that can handle large models requiring advanced analysis and optimization by the Modelica compiler.

The long-term research related goals and issues of the OpenModelica open source implementation of a Modelica environment include but are not limited to the following:

- Development of a complete formal specification of Modelica, including both static and dynamic semantics. Such a specification can be used to assist current and future Modelica implementers by providing a semantic reference, as a kind of reference implementation.

- Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural analysis, system identification, etc., as well as modeling problems that require extensions such as partial differential equations, enlarged scope for discrete modeling and simulation, etc.

- Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse, configurability, architectural properties, etc.

- Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by generating code for parallel hardware.

- Improved debugging support for equation based languages such as Modelica, to make them even easier to use.

- Easy-to-use specialized high-level (graphical) user interfaces for certain application domains.

- Visualization and animation techniques for interpretation and presentation of results.

- Application usage and model library development by researchers in various application areas.

The OpenModelica environment provides a test bench for language design ideas that, if successful, can be submitted to the Modelica Association for consideration regarding possible inclusion in the official Modelica standard.

The current version of the OpenModelica environment allows most of the expression, algorithm, and function parts of Modelica to be executed interactively, as well as equation models and Modelica functions to be compiled into efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and a numerical DAE solver.
1.1 System Overview

The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1.1.

The following subsystems are currently integrated in the OpenModelica environment:

- **An interactive session handler**, that parses and interprets commands and Modelica expressions for evaluation, simulation, plotting, etc. The session handler also contains simple history facilities, and completion of file names and certain identifiers in commands.

- **A Modelica compiler subsystem**, translating Modelica to C code, with a symbol table containing definitions of classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from libraries. The compiler also includes a Modelica interpreter for interactive usage and constant expression evaluation. The subsystem also includes facilities for building simulation executables linked with selected numerical ODE or DAE solvers.

- **An execution and run-time module**. This module currently executes compiled binary code from translated expressions and functions, as well as simulation code from equation based models, linked with numerical solvers. In the near future event handling facilities will be included for the discrete and hybrid parts of the Modelica language.

- **Eclipse plugin editor/browser**. The Eclipse plugin called MDT (Modelica Development Tooling) provides file and class hierarchy browsing and text editing capabilities, rather analogous to previously described Emacs editor/browser. Some syntax highlighting facilities are also included. The Eclipse framework has the advantage of making it easier to add future extensions such as refactoring and cross referencing support.

- **OMNotebook DrModelica model editor**. This subsystem provides a lightweight notebook editor, compared to the more advanced Mathematica notebooks available in MathModelica. This basic functionality still allows essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters and sections can be represented and edited, including basic formatting. Cells can contain ordinary text or Modelica models and expressions, which can be evaluated and simulated. However, no mathematical typesetting facilities are yet available in the cells of this notebook editor.

- **Graphical model editor/browser OMEdit**. This is a graphical connection editor, for component based model design by connecting instances of Modelica classes, and browsing Modelica model libraries for reading and picking component models. The graphical model editor also includes a textual editor for editing model class definitions, and a window for interactive Modelica command evaluation.

Figure 1.1: The architecture of the OpenModelica environment. Arrows denote data and control flow. The interactive session handler receives commands and shows results from evaluating commands and expressions that are translated and executed. Several subsystems provide different forms of browsing and textual editing of Modelica code. The debugger currently provides debugging of an extended algorithmic subset of Modelica.
• **Optimization subsystem OMOptim.** This is an optimization subsystem for OpenModelica, currently for design optimization choosing an optimal set of design parameters for a model. The current version has a graphical user interface, provides genetic optimization algorithms and Pareto front optimization, works integrated with the simulators and automatically accesses variables and design parameters from the Modelica model.

• **Dynamic Optimization subsystem.** This is dynamic optimization using collocation methods, for Modelica models extended with optimization specifications with goal functions and additional constraints. This subsystem is integrated with in the OpenModelica compiler.

• **Modelica equation model debugger.** The equation model debugger shows the location of an error in the model equation source code. It keeps track of the symbolic transformations done by the compiler on the way from equations to low-level generated C code, and also explains which transformations have been done.

• **Modelica algorithmic code debugger.** The algorithmic code Modelica debugger provides debugging for an extended algorithmic subset of Modelica, excluding equation-based models and some other features, but including some meta-programming and model transformation extensions to Modelica. This is a conventional full-feature debugger, using Eclipse for displaying the source code during stepping, setting breakpoints, etc. Various back-trace and inspection commands are available. The debugger also includes a data-view browser for browsing hierarchical data such as tree- or list structures in extended Modelica.

### 1.2 Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment, called OMSHELL – the OpenModelica Shell). Most of these examples are also available in the OMNotebook with DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

```python
>>> getInstallationDirectoryPath() + "~/share/doc/omc/testmodels/
"~/OPENMODELICAHOME/share/doc/omc/testmodels/
```

The following commands were run using OpenModelica version:

```python
>>> getVersion()
"OMCompiler v1.13.2"
```

#### 1.2.1 Starting the Interactive Session

The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica Shell which responds with an interaction window:

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in the variable x. The value of the expression is returned.

```python
>>> x := 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}
```

#### 1.2.2 Using the Interactive Mode

When running OMC in interactive mode (for instance using OMSHELL) one can make load classes and execute commands. Here we give a few example sessions.

**Example Session 1**

To get help on using OMSHELL and OpenModelica, type "help()" and press enter.
Example Session 2

To get help on using OMShell and OpenModelica, type "help()" and press enter.

```plaintext
model C
  Integer a;
  Real b;
equation
  der(a) = b;
  der(b) = 12.0;
end C;
```

```plaintext
>>> instantiateModel(C)
```

```
Error:
[<interactive>:5:3-5:13:writable] Error: Argument 'a' to der has illegal type Integer, must be a subtype of Real.
Error: Error occurred while flattening model C
```

1.2.3 Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly giving the command:

```plaintext
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/bubblesort.mo")
true
```

The function bubblesort is called below to sort the vector x in descending order. The sorted result is returned together with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared type of the function result. The input Integer vector was automatically converted to a Real vector according to the Modelica type coercion rules. The function is automatically compiled when called if this has not been done before.

```plaintext
>>> bubblesort(x)
(12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0)
```

Another call:

```plaintext
>>> bubblesort({4,6,2,5,8})
(8.0,6.0,5.0,4.0,2.0)
```
1.2.4 Trying the system and cd Commands

It is also possible to give operating system commands via the system utility function. A command is provided as a string argument. The example below shows the system utility applied to the UNIX command cat, which here outputs the contents of the file bubblesort.mo to the output stream when running omc from the command-line.

```python
>>> system("cat "+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/bubblesort.mo" > bubblesort.mo")
0

function bubblesort
  input Real[:,:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;
```

Note: The output emitted into stdout by system commands is put into log-files when running the CORBA-based clients, not into the visible GUI windows. Thus the text emitted by the above cat command would not be returned, which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

```python
>>> readFile("bubblesort.mo")
function bubblesort
  input Real[:,:] x;
  output Real[size(x,1)] y;
protected
  Real t;
algorithm
  y := x;
  for i in 1:size(x,1) loop
    for j in 1:size(x,1) loop
      if y[i] > y[j] then
        t := y[i];
        y[i] := y[j];
        y[j] := t;
      end if;
    end for;
  end for;
end bubblesort;
```

The system command only returns a success code (0 = success).

```python
>>> system("dir")
0
>>> system("Non-existing command")
127
```

Another built-in command is cd, the change current directory command. The resulting current directory is returned as a string.

1.2. Interactive Session with Examples 7
1.2.5 Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also can be done through the File->Load Modelica Library menu item:

```python
>>> loadModel(Modelica)
true
```

We also load a file containing the dcmotor model:

```python
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo"
true
```

It is simulated:

```python
>>> simulate(dcmotor, startTime=0.0, stopTime=10.0)
```

We list the source code of the model:

```python
>>> list(dcmotor)
model dcmotor
    import Modelica.Electrical.Analog.Basic;
    Basic.Resistor resistor1(R = 10);
    Basic.Inductor inductor1(L = 0.2, i.fixed = true);
    Basic.Ground ground1;
    Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w. fixed = true);
    Basic.EMF emf1(k = 1.0);
    Modelica.Blocks.Sources.Step step1;
    Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltage1;
equation
    connect(step1.y, signalVoltage1.v);

(continues on next page)
We test code instantiation of the model to flat code:

```modelica
>>> instantiateModel(dcmotor)

class dcmotor

Real resistor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between the two pins (= p.v - n.v)");
Real resistor1.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n");
Real resistor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin");
Real resistor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin");
Real resistor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin");
Real resistor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin");

parameter Boolean resistor1.useHeatPort = false "=true, if heatPort is enabled";
parameter Real resistor1.T(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistor1.T_ref "Fixed device temperature if useHeatPort = false";
Real resistor1.LossPower(quantity = "Power", unit = "W") "Loss power leaving component via heatPort";
Real resistor1.T_heatPort(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistor1.T_heatPort "Temperature of heatPort";

parameter Real resistor1.R(quantity = "Resistance", unit = "Ohm", start = 1.0) = 10.0 "Resistance at temperature T_ref";
parameter Real resistor1.T_ref(quantity = "ThermodynamicTemperature", unit = "K", displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15 "Reference temperature";
parameter Real resistor1.alpha(quantity = "LinearTemperatureCoefficient", unit = "1/K") = 0.0 "Temperature coefficient of resistance (R_actual = R*(1 + alpha*(T_heatPort - T_ref))";
Real resistor1.R_actual(quantity = "Resistance", unit = "Ohm") "Actual resistance = R*(1 + alpha*(T_heatPort - T_ref))");

Real inductor1.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between the two pins (= p.v - n.v)");
Real inductor1.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed = true) "Current flowing from pin p to pin n");
Real inductor1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin");
Real inductor1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin");
Real inductor1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin");
Real inductor1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin");

parameter Real inductor1.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.2 "Inductance";
Real ground1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin");
```

(continues on next page)
Real ground1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin";
Real load.flange_a.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
Real load.flange_a.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";
Real load.flange_b.phi(quantity = "Angle", unit = "rad", displayUnit = "deg") "Absolute rotation angle of flange";
Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange";

parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0, start = 1.0) = 1.0 "Moment of inertia";

parameter enumeration (never, avoid, default, prefer, always) load.stateSelect = StateSelect.default "Priority to use phi and w as states";
Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed = true, stateSelect = StateSelect.default) "Absolute rotation angle of component (= \text{der}(\phi))";
Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true, stateSelect = StateSelect.default) "Absolute angular velocity of component (= \text{der}(\phi))";

Real step1.y "Connector of Real output signal";
parameter Real step1.offset = 0.0 "Offset of output signal y";
parameter Real step1.startTime(quantity = "Time", unit = "s") = 0.0 "Output y = 0.0 for time < startTime";
parameter Real step1.height = 1.0 "Height of step";
Real signalVoltage1.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin p";
Real signalVoltage1.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin p";
Real signalVoltage1.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin n";
Real signalVoltage1.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from pin p to pin n";
equation
assert(1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref) >= 1e-15, "Temperature outside scope of model");
resistor1.R_actual = resistor1.R * (1.0 + resistor1.alpha * (resistor1.T_heatPort - resistor1.T_ref));
resistor1.v = resistor1.R_actual * resistor1.i;
resistor1.LossPower = resistor1.v * resistor1.i;
resistor1.v = resistor1.p.v - resistor1.n.v;
0.0 = resistor1.p.i + resistor1.n.i;
resistor1.i = resistor1.p.i;
resistor1.T_heatPort = resistor1.T;
inductor1.L * der(inductor1.i) = inductor1.v;
inductor1.v = inductor1.p.v - inductor1.n.v;
0.0 = inductor1.p.i + inductor1.n.i;
inductor1.i = inductor1.p.i;
ground1.p.v = 0.0;
load.phi = load.flange_a.phi;
load.phi = load.flange_b.phi;
load.w = der(load.phi);
load.a = der(load.w);
load.J = load.a - load.flange_a.tau + load.flange_b.tau;
emf1.internalSupport.flange.tau = emf1.internalSupport.tau;
emf1.internalSupport.flange.phi = emf1.internalSupport.phi;
emf1.fixed.flange.phi = emf1.fixed.phi0;
emf1.v = emf1.p.v - emf1.n.v;
0.0 = emf1.p.i + emf1.n.i;
emf1.i = emf1.p.i;
emf1.phi = emf1.flange.phi - emf1.internalSupport.phi;
emf1.w = der(emf1.phi);
emf1.k = emf1.w - emf1.v;
emf1.tau = (-emf1.k) * emf1.i;
emf1.tauElectrical = -emf1.tau;
emf1.tau = emf1.flange.tau;
step1.y = step1.offset + (if time < step1.startTime then 0.0 else step1.height);
signalVoltage1.v = signalVoltage1.p.v - signalVoltage1.n.v;
0.0 = signalVoltage1.p.i + signalVoltage1.n.i;
signalVoltage1.i = signalVoltage1.p.i;
resistor1.p.i + signalVoltage1.p.i = 0.0;
resistor1.n.i + inductor1.p.i = 0.0;
inductor1.n.i + emf1.p.i = 0.0;
ground1.p.i + emf1.n.i + signalVoltage1.n.i = 0.0;
load.flange_a.tau + emf1.flange.tau = 0.0;
load.flange_b.tau = 0.0;
emf1.fixed.flange.tau + emf1.internalSupport.flange.tau = 0.0;
emf1.fixed.flange.phi = emf1.internalSupport.flange.phi;

(continues on next page)
signalVoltage1.v = step1.y;
resistor1.p.v = signalVoltage1.p.v;
inductor1.p.v = resistor1.n.v;
emf1.p.v = inductor1.n.v;
emf1.flange.phi = load.flange_a.phi;
emf1.n.v = ground1.p.v;
emf1.n.v = signalVoltage1.n.v;
end dcmotor;

We plot part of the simulated result:

![Graph showing the rotation and rotational velocity of the DC motor.]

Figure 1.2: Rotation and rotational velocity of the DC motor

### 1.2.6 The `val()` function

The `val(variableName, time)` scription function can be used to retrieve the interpolated value of a simulation result variable at a certain point in the simulation time, see usage in the BouncingBall simulation below.

### 1.2.7 BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica keywords have been bold-faced by hand for better readability):

```plaintext
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")
true
```

```plaintext
>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
```

(continues on next page)
Instead of just giving a simulate and plot command, we perform a runScript command on a .mos (Modelica script) file sim_BouncingBall.mos that contains these commands:

```
>>> writeFile("sim_BouncingBall.mos", "
  loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo");
  simulate(BouncingBall, stopTime=3.0);
  /* plot({h,flying}); */
"
true
>>> runScript("sim_BouncingBall.mos")
"true
record SimulationResult
  resultFile = "DOCHOME/BouncingBall_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500,
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options = -'",
  outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = "",
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully."
  timeFrontend = 0.007887075,
  timeBackend = 0.006926996,
  timeSimCode = 0.06511556,
  timeTemplates = 0.032357001,
  timeCompile = 0.621676529,
  timeSimulation = 0.015852334,
  timeTotal = 0.749975854
end SimulationResult;
"
```

model Switch
  Real v;
  Real i;
  Real i1;
  Real itot;
  Boolean open;
  equation
  itot = i + i1;
  if open then
    v = 0;
  else
    i = 0;
  end if;
  1 - i1 = 0;
  1 - v - i = 0;
  open = time >= 0.5;
end Switch;
>>> simulate(Switch, startTime=0, stopTime=1)

record SimulationResult
  resultFile = "DOCHOME»/Switch_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500,
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'Switch', options = '',
  outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '',
  messages = "LOG_SUCCESS | info | The initialization finished
  successfully without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully.
"
  timeFrontend = 0.004301694,
  timeBackend = 0.007259827,
  timeSimCode = 0.070050446,
  timeTemplates = 0.036488747,
  timeCompile = 0.605947076,
  timeSimulation = 0.011456527,
  timeTotal = 0.735625938
end SimulationResult;

Retrieve the value of itot at time=0 using the val(variableName, time) function:

>>> val(itot,0)
1.0

Plot itot and open:

Figure 1.3: Plot when the switch opens

We note that the variable open switches from false (0) to true (1), causing itot to increase from 1.0 to 2.0.

1.2.8 Clear All Models

Now, first clear all loaded libraries and models:

>>> clear()
true

List the loaded models – nothing left:
1.2.9 VanDerPol Model and Parametric Plot

We load another model, the VanDerPol model (or via the menu File->Load Model):

```python
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.mo")
true
```

It is simulated:

```python
>>> simulate(VanDerPol, stopTime=80)
record SimulationResult
  resultFile = "DOCHOME\VanDerPol_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500,
                     tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'VanDerPol', options = '',
                     outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '',
                     messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
                     LOG_SUCCESS | info | The simulation finished successfully.
                     ",
  timeFrontend = 0.004107814,
  timeBackend = 0.002433842,
  timeSimCode = 0.05077582200000001,
  timeTemplates = 0.027455075,
  timeCompile = 0.617836336,
  timeSimulation = 0.017370271,
  timeTotal = 0.720088726
end SimulationResult;
```

It is plotted:

```python
>>> plotParametric("x","y")
```

![Figure 1.4: VanDerPol plotParametric(x,y)](image)

Perform code instantiation to flat form of the VanDerPol model:

1.2. Interactive Session with Examples 15
1.2.10 Using Japanese or Chinese Characters

Japanese, Chinese, and other kinds of UniCode characters can be used within quoted (single quote) identifiers, see for example the variable name to the right in the plot below:

1.2.11 Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation at each line into OMSHELL requires copy-paste as one operation from another document):

A nested loop summing reals and integers:
By putting two (or more) variables or assignment statements separated by semicolon(s), ending with a variable, one can observe more than one variable value:

```plaintext
>>> h; g
1997.45
1479.09
```

A for-loop with vector traversal and concatenation of string elements:

```plaintext
>>> i:="";
>>> lst := {"Here ", "are ", "some ", "strings.");
>>> s := "";
>>> for i in lst loop
    s := s + i;
end for;
>>> s
"Here are some strings."
```

Normal while-loop with concatenation of 10 "abc " strings:

```plaintext
>>> s:="";
>>> i:=1;
>>> while i<=10 loop
    s:="abc "+s;
    i:=i+1;
end while;
>>> s
"abc abc abc abc abc abc abc abc abc abc 
```

A simple if-statement. By putting the variable last, after the semicolon, its value is returned after evaluation:

```plaintext
>>> if 5>2 then a := 77; end if; a
77
```

An if-then-else statement with elseif:

```plaintext
>>> if false then
    a := 5;
elseif a > 50 then
    b:= "test"; a:= 100;
else
    a:=34;
end if;
```

Take a look at the variables a and b:

```plaintext
>>> a;b
100
"test"
```

### 1.2.12 Variables, Functions, and Types of Variables

Assign a vector to a variable:

```plaintext
>>> a:=1:5
(1,2,3,4,5)
```
Type in a function:

```modelica
function mySqr
    input Real x;
    output Real y;
algorithm
    y:=x*x;
end mySqr;
```

Call the function:

```modelica
>>> b:=mySqr(2)
4.0
```

Look at the value of variable a:

```modelica
>>> a
{1,2,3,4,5}
```

Look at the type of a:

```modelica
>>> typeOf(a)
"Integer[5]"
```

Retrieve the type of b:

```modelica
>>> typeOf(b)
"Real"
```

What is the type of mySqr? Cannot currently be handled.

```modelica
>>> typeOf(mySqr)
```

List the available variables:

```modelica
>>> listVariables()
{b,a,s,lst,i,h,g,k,currentSimulationResult}
```

Clear again:

```modelica
>>> clear()
true
```

1.2.13 Getting Information about Error Cause

Call the function getErrorString() in order to get more information about the error cause after a simulation failure:

```modelica
>>> getErrorString()
```

1.2.14 Alternative Simulation Output Formats

There are several output format possibilities, with mat being the default. plt and mat are the only formats that allow you to use the val() or plot() functions after a simulation. Compared to the speed of plt, mat is roughly 5 times for small files, and scales better for larger files due to being a binary format. The csv format is roughly twice as fast as plt on data-heavy simulations. The plt format allocates all output data in RAM during simulation, which means that simulations may fail due applications only being able to address 4GB of memory on 32-bit platforms. Empty does no output at all and should be by far the fastest. The csv and plt formats are suitable when using an
external scripts or tools like gnuplot to generate plots or process data. The mat format can be post-processed in MATLAB or Octave.

```plaintext
>>> simulate(..., outputFormat="mat")
>>> simulate(..., outputFormat="csv")
>>> simulate(..., outputFormat="plt")
>>> simulate(..., outputFormat="empty")
```

It is also possible to specify which variables should be present in the result-file. This is done by using POSIX Extended Regular Expressions. The given expression must match the full variable name (^ and $ symbols are automatically added to the given regular expression).

// Default, match everything
```plaintext
>>> simulate(..., variableFilter=".*")
```

// match indices of variable myVar that only contain the numbers using combinations of the letters 1 through 3
```plaintext
>>> simulate(..., variableFilter="myVar\\d{1-3}\")
```

// match x or y or z
```plaintext
>>> simulate(..., variableFilter="x|y|z")
```

1.2.15 Using External Functions

See Chapter Interoperability – C and Python for more information about calling functions in other programming languages.

1.2.16 Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a new OpenModelica feature that automatically partitions the system of equations and schedules the parts for execution on different cores using shared-memory OpenMP based execution. The speedup obtained is dependent on the model structure, whether the system of equations can be partitioned well. This version in the current OpenModelica release is an experimental version without load balancing. The following command, not yet available from the OpenModelica GUI, will run a parallel simulation on a model:

```plaintext
>>> omc -d=openmp model.mo
```

1.2.17 Loading Specific Library Version

There exist many different versions of Modelica libraries which are not compatible. It is possible to keep multiple versions of the same library stored in the directory given by calling getModelicaPath(). By calling loadModel(Modelica, "3.2"), OpenModelica will search for a directory called "Modelica 3.2" or a file called "Modelica 3.2.mo". It is possible to give several library versions to search for, giving preference for a pre-release version of a library if it is installed. If the searched version is "default", the priority is: no version name (Modelica), main release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1) and unordered versions (Modelica Special Release).

The loadModel command will also look at the uses annotation of the top-level class after it has been loaded. Given the following package, Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST automatically.
package Modelica
  annotation(uses(Complex(version="1.0"),
                  ModelicaServices(version="1.1")));
end Modelica;

>>> clear()
true

Packages will also be loaded if a model has a uses-annotation:

class M
end M;

Note:
Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation.
Notification: Automatically loaded package Complex 3.2.1 due to uses annotation.
Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation.

Packages will also be loaded by looking at the first identifier in the path:

class Modelica.Electrical.Analog.Basic.Ground "Ground node"
  Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
  Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin"

Note:
Notification: Automatically loaded package Complex 3.2.2 due to uses annotation.
Notification: Automatically loaded package ModelicaServices 3.2.2 due to uses annotation.
Notification: Automatically loaded package Modelica default due to uses annotation.

1.2.18 Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application programming interface) is described which returns information about models and/or allows manipulation of models. Calls to these functions can be done interactively as below, but more typically by program clients to the OpenModelica Compiler (OMC) server. Current examples of such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the OMEdit graphic model editor, etc. This API is untyped for performance reasons, i.e., no type checking and minimal error checking is done on the calls. The results of a call is returned as a text string in Modelica syntax form, which the client has to parse. An example parser in C++ is available in the OMNotebook source code, whereas another example parser in Java is available in the MDT Eclipse plugin.
Below we show a few calls on the previously simulated BouncingBall model. The full documentation on this API is available in the system documentation. First we load and list the model again to show its structure:

```oml
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo");
>>> list(BouncingBall)
model BouncingBall
  parameter Real e = 0.7 "coefficient of restitution";
  parameter Real g = 9.81 "gravity acceleration";
  Real h(fixed = true, start = 1) "height of ball";
  Real v(fixed = true) "velocity of ball";
  Boolean flying(fixed = true, start = true) "true, if ball is flying";
  Boolean impact;
  Real v_new(fixed = true);
  Integer foo;

  equation
    impact = h <= 0.0;
    foo = if impact then 1 else 2;
    der(v) = if flying then -g else 0;
    der(h) = v;
    when {h <= 0.0 and v <= 0.0, impact} then
      v_new = if edge(impact) then -e * pre(v) else 0;
      flying = v_new > 0;
      reinit(v, v_new);
  end when;
end BouncingBall;
```

Different kinds of calls with returned results:

```oml
>>> getClassRestriction(BouncingBall) "model"
>>> getClassInformation(BouncingBall) ("model","",false,false,false,"/var/lib/hudson/slave/workspace/OpenModelica_SPHINX/OpenModelica/build/share/doc/omc/testmodels/BouncingBall.mo",false,1,1,23,17,{},false,false,""")
>>> isFunction(BouncingBall) false
>>> existClass(BouncingBall) true
>>> getConnectionCount(BouncingBall) 0
>>> getInheritanceCount(BouncingBall) 0
>>> getComponentModifierValue(BouncingBall,e) "0.7"
>>> getComponentModifierNames(BouncingBall,"e") ()
>>> getClassRestriction(BouncingBall) "model"
>>> getVersion() // Version of the currently running OMC
"OMCompiler v1.13.2"
```
1.2.19 Quit OpenModelica

Leave and quit OpenModelica:

```python
>>> quit()
```

1.2.20 Dump XML Representation

The command `dumpXMLDAE` dumps an XML representation of a model, according to several optional parameters.

```python
dumpXMLDAE(modelname[,asInSimulationCode=<Boolean>] [,filePrefix=<String>] [,storeInTemp=<Boolean>] [,addMathMLCode =<Boolean>])
```

This command dumps the mathematical representation of a model using an XML representation, with optional parameters. In particular, `asInSimulationCode` defines where to stop in the translation process (before dumping the model), the other options are relative to the file storage: `filePrefix` for specifying a different name and `storeInTemp` to use the temporary directory. The optional parameter `addMathMLCode` gives the possibility to don’t print the MathML code within the xml file, to make it more readable. Usage is trivial, just: `addMathMLCode=true/false` (default value is false).

1.2.21 Dump Matlab Representation

The command `exportDAEtoMatlab` dumps an XML representation of a model, according to several optional parameters.

```python
exportDAEtoMatlab(modelname);
```

This command dumps the mathematical representation of a model using a Matlab representation. Example:

```python
>>> loadFile(getInstallationDirectoryPath() + "share/doc/omc/testmodels/BouncingBall.mo")
true
>>> exportDAEtoMatlab(BouncingBall)
"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"
```

```plaintext
% Incidence Matrix
% number of rows: 6
IM={{3,6},{1,{'if', 'true','==' {3},{},}},{{'if', 'true','==' {4},{},}},5,{2,{'if
→' , 'edge(impact)' {3},{5},}},{4,2}};
VL = {'foo','v_new','impact','flying','v','h'};

EqStr = {'impact = h <= 0.0;','foo = if impact then 1 else 2;','der(v) = if flying
→ then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_
→ new = if edge(impact) then (-e) * pre(v) else 0.0; end when;','when {h <= 0.0
→ and v <= 0.0, impact} then flying = v_new > 0.0; end when;'};

OldEqStr={'class BouncingBall',' parameter Real e = 0.7 "coefficient of
→ restitution";' parameter Real g = 9.81 "gravity acceleration";' Real
→ h(start = 1.0, fixed = true) "height of ball";' Real v(fixed = true) "velocity of ball";' Boolean flying(start = true, fixed = true) "true, if
→ ball is flying";' Boolean impact;' Real v_new(fixed = true);', Integer
→ foo;' 'equation' , impact = h <= 0.0;';' foo = if impact then 1 else 2;';' der(v) = if flying then -g else 0.0;';' der(h) = v;';' when {h <= 0.0 and v <=
→ 0.0, impact} then',' v_new = if edge(impact) then (-e) * pre(v) else 0.0;';' 
→ flying = v_new > 0.0;';' reinit(v, v_new);', end when;' 'end BouncingBall;
→ ';'};
```
1.3 Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in the interactive session handler.

simulate(modelname) Translate a model named modelname and simulate it.

simulate(modelname[,startTime=<Real>][,stopTime=<Real>][,numberOfIntervals =<Integer>][,outputInterval=<Real>][,method=<String>][,tolerance=<Real>][,fixedStepSize=<Real>][,outputFormat=<String>]) Translate and simulate a model, with optional start time, stop time, and optional number of simulation intervals or steps for which the simulation results will be computed. More intervals will give higher time resolution, but occupy more space and take longer to compute. The default number of intervals is 500. It is possible to choose solving method, default is “dassl”, “euler” and “rungekutta” are also available. Output format “mat” is default. “plt” and “mat” (MATLAB) are the only ones that work with the val() command, “csv” (comma separated values) and “empty” (no output) are also available (see section Alternative Simulation Output Formats).

plot(vars) Plot the variables given as a vector or a scalar, e.g. plot([x1,x2]) or plot(x1).

plotParametric(var1, var2) Plot var2 relative to var1 from the most recently simulated model, e.g. plotParametric(x,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.

clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model, according to several optional parameters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname) Performs code instantiation of a model/class and return a string containing the flat class definition.

list() Return a string containing all loaded class definitions.

list(modelname) Return a string containing the class definition of the named class.

listVariables() Return a vector of the names of the currently defined variables.

loadModel(classname) Load model or package of name classname from the path indicated by the environment variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string argument str.

readFile(str) Load file given as string str and return a string containing the file content.

runScript(str) Execute script file with file name given as string argument str.

system(str) Execute str as a system(shell) command in the operating system; return integer success value. Output into stdout from a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of seconds (elapsed time) the evaluation took.

typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name modelname in the file given by the string argument str.

val(variable,timePoint) Return the (interpolated) value of the variable at time timePoint.

help() Print this helptext (returned as a string).
quit() Leave and quit the OpenModelica environment

### 1.4 Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows cmd.exe.

**Example Session 1 – obtaining information about command line parameters**

```bash
C:\dev> C:\OpenModelica1.9.2 \bin\omc -h
OpenModelica Compiler 1.9.2
Copyright © 2015 Open Source Modelica Consortium (OSMC)
Distributed under OMSC-PL and GPL, see https://www.openmodelica.org/
Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]
...
```

**Example Session 2 - create an TestModel.mo file and run omc on it**

```bash
C:\dev> echo model TestModel parameter Real x = 1; end TestModel; > TestModel.mo
C:\dev> C:\OpenModelica1.9.2 \bin\omc TestModel.mo
class TestModel
  parameter Real x = 1.0;
end TestModel;
C:\dev>
```

**Example Session 3 - create an script.mos file and run omc on it**

Create a file script.mos using your editor containing these commands:

```bash
// start script.mos
loadModel(Modelica); getErrorString();
// end script.mos
C:\dev> notepad script.mos
C:\dev> C:\OpenModelica1.9.2 \bin\omc script.mos
true
```
In order to obtain more information from the compiler one can use the command line options – `showErrorMessages -d=failtrace` when running the compiler:

C:\dev> C:\OpenModelica1.9.2\bin\omc --showErrorMessages -d=failtrace script.mos
OMEDIT – OPENMODELICA CONNECTION EDITOR

OMEdit – OpenModelica Connection Editor is the new Graphical User Interface for graphical model editing in OpenModelica. It is implemented in C++ using the Qt graphical user interface library and supports the Modelica Standard Library that is included in the latest OpenModelica installation. This chapter gives a brief introduction to OMEdit and also demonstrates how to create a DCMotor model using the editor.

OMEdit provides several user friendly features for creating, browsing, editing, and simulating models:

- **Modeling** – Easy model creation for Modelica models.
- **Pre-defined models** – Browsing the Modelica Standard library to access the provided models.
- **User defined models** – Users can create their own models for immediate usage and later reuse.
- **Component interfaces** – Smart connection editing for drawing and editing connections between model interfaces.
- **Simulation** – Subsystem for running simulations and specifying simulation parameters start and stop time, etc.
- **Plotting** – Interface to plot variables from simulated models.

## 2.1 Starting OMEdit

A splash screen similar to the one shown in Figure 2.1 will appear indicating that it is starting OMEdit. The executable is found in different places depending on the platform (see below).

### 2.1.1 Microsoft Windows

OMEdit can be launched using the executable placed in OpenModelicaInstallationDirectory/bin/OMEdit/OMEdit.exe. Alternately, choose OpenModelica > OpenModelica Connection Editor from the start menu in Windows.

### 2.1.2 Linux

Start OMEdit by either selecting the corresponding menu application item or typing “OMEdit” at the shell or command prompt.

### 2.1.3 Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.
2.2 MainWindow & Browsers

The MainWindow contains several dockable browsers,

- Libraries Browser
- Documentation Browser
- Variables Browser
- Messages Browser

Figure 2.2 shows the MainWindow and browsers.

The default location of the browsers are shown in Figure 2.2. All browsers except for Message Browser can be docked into left or right column. The Messages Browser can be docked into top or bottom areas. If you want OMEdit to remember the new docked position of the browsers then you must enable Preserve User’s GUI Customizations option, see section General.

2.2.1 Filter Classes

To filter a class click Edit > Filter Classes or press keyboard shortcut Ctrl+Shift+F. The loaded Modelica classes can be filtered by typing any part of the class name.

2.2.2 Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser. Shows the list of loaded Modelica classes. Each item of the Libraries Browser has right click menu for easy manipulation and usage of the class. The
Figure 2.2: OMEdit MainWindow and Browsers.
classes are shown in a tree structure with name and icon. The protected classes are not shown by default. If you want to see the protected classes then you must enable the Show Protected Classes option, see section General.

![OMEdit - OpenModelica Connection Editor](image)

Figure 2.3: Libraries Browser.

### 2.2.3 Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the navigation buttons for moving forward and backward. It also contains a WYSIWYG editor which allows writing class documentation in HTML format. To see documentation of any class, right click the Modelica class in Libraries Browser and choose View Documentation.

### 2.2.4 Variables Browser

The class variables are structured in the form of the tree and are displayed in the Variables Browser. Each variable has a checkbox. Ticking the checkbox will plot the variable values. There is a find box on the top for filtering the variable in the tree. The filtering can be done using Regular Expression, Wildcard and Fixed String. The complete Variables Browser can be collapsed and expanded using the Collapse All and Expand All buttons.

The browser allows manipulation of changeable parameters for Re-simulating a Model. It also displays the unit and description of the variable.

### 2.2.5 Messages Browser

Shows the list of errors. Following kinds of error can occur,

- Syntax
Modelica

Modelica Standard Library - Version 3.2.2

Information

Package Modelica® is a standardized and free package that is developed together with the Modelica® language from the Modelica Association, see https://www.Modelica.org. It is also called Modelica Standard Library. It provides model components in many domains that are based on standardized interface definitions. Some typical examples are shown in the next figure:

For an introduction, have especially a look at:

- Overview provides an overview of the Modelica Standard Library inside the User's Guide.
- Release Notes summarizes the changes of new versions of the package.
- Contact lets the contributors of the Modelica Standard Library.
- The Examples packages in the various libraries, demonstrate how to use the components of the corresponding sublibrary.

This version of the Modelica Standard Library consists of

- 1600 models and blocks, and
- 1350 functions

that are directly usable (= number of public, non-partial classes). It is fully compliant to Modelica Specification Version 3.2 Revision 2 and it has been tested with Modelica tools from different vendors.

Figure 2.4: Documentation Browser.
Figure 2.5: Variables Browser.
2.3 Perspectives

The perspective tabs are located at the bottom right of the MainWindow:

- Welcome Perspective
- Modeling Perspective
- Plotting Perspective
- Debugging Perspective

2.3.1 Welcome Perspective

Figure 2.6: OMEdit Welcome Perspective.
The Welcome Perspective shows the list of recent files and the list of latest news from https://www.openmodelica.org/. See Figure 2.6. The orientation of recent files and latest news can be horizontal or vertical. User is allowed to show/hide the latest news. See section General.

2.3.2 Modeling Perspective

The Modeling Perspective provides the interface where user can create and design their models. See Figure 2.7.

![Figure 2.7: OMEdit Modeling Perspective.](image)

The Modeling Perspective interface can be viewed in two different modes, the tabbed view and subwindow view, see section General.

2.3.3 Plotting Perspective

The Plotting Perspective shows the simulation results of the models. Plotting Perspective will automatically become active when the simulation of the model is finished successfully. It will also become active when user opens any of the OpenModelica’s supported result file. Similar to Modeling Perspective this perspective can also be viewed in two different modes, the tabbed view and subwindow view, see section General.

2.3.4 Debugging Perspective

The application automatically switches to Debugging Perspective when user simulates the class with algorithmic debugger. The perspective shows the list of stack frames, breakpoints and variables.
Figure 2.8: OMEdit Plotting Perspective.
Figure 2.9: OMEdit Debugging Perspective.
2.4 Modeling a Model

2.4.1 Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward. Choose any of the following methods,

- Select File > New Modelica Class from the menu.
- Click on New Modelica Class toolbar button.
- Click on the Create New Modelica Class button available at the left bottom of Welcome Perspective.
- Press Ctrl+N.

2.4.2 Opening a Modelica File

Choose any of the following methods to open a Modelica file,

- Select File > Open Model/Library File(s) from the menu.
- Click on Open Model/Library File(s) toolbar button.
- Click on the Open Model/Library File(s) button available at the right bottom of Welcome Perspective.
- Press Ctrl+O.

(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)

2.4.3 Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu. It is also possible to convert files to UTF-8.

2.4.4 Model Widget

For each Modelica class one Model Widget is created. It has a statusbar and a view area. The statusbar contains buttons for navigation between the views and labels for information. The view area is used to display the icon, diagram and text layers of Modelica class. See Figure 2.10.

2.4.5 Adding Component Models

Drag the models from the Libraries Browser and drop them on either Diagram or Icon View of Model Widget.

2.4.6 Making Connections

In order to connect one component model to another the user first needs to enable the connect mode ( ) from the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor. To start the connection press left button and move while keeping the button pressed. Now release the left button. Move towards the end connector and click when cursor changes to cross cursor.
Figure 2.10: Model Widget showing the Diagram View.
2.5 Simulating a Model

The simulation options for each model are stored inside the OMEdit data structure. They have the following sequence,

- Each model has its own simulation options.
- If the model is opened for the first time then the simulation options are set to default.
- experiment and __OpenModelica_simulationFlags annotations are applied if the model contains them.
- After that all the changes done via Simulation Setup window are preserved for the whole session. If you want to use the same settings in the future sessions then you should store them inside experiment and __OpenModelica_simulationFlags.

The OMEdit Simulation Setup can be launched by,

- Selecting Simulation > Simulation Setup from the menu. (requires a model to be active in ModelWidget)
- Clicking on the Simulation Setup toolbar button. (requires a model to be active in ModelWidget)
- Right clicking the model from the Libraries Browser and choosing Simulation Setup.

2.5.1 General Tab

- Simulation Interval
  - Start Time – the simulation start time.
  - Stop Time – the simulation stop time.
- Number of Intervals – the simulation number of intervals.
- Interval – the length of one interval (i.e., stepsize)
- Interactive Simulation
  - Simulate with steps (makes the interactive simulation synchronous; plots nicer curves at the expense of performance)
- Simulation server port

Integration

- Method – the simulation solver. See section Integration Methods for solver details.
- Tolerance – the simulation tolerance.
- Jacobian - the jacobain method to use.
- DASSL/IDA Options
- Root Finding - Activates the internal root finding procedure of dassl.
- Restart After Event - Activates the restart of dassl after an event is performed.
- Initial Step Size
- Maximum Step Size
- Maximum Integration Order
- C/C++ Compiler Flags (Optional) – the optional C/C++ compiler flags.
- Number of Processors – the number of processors used to build the simulation.
- Build Only – only builds the class.
- Launch Transformational Debugger – launches the transformational debugger.
- Launch Algorithmic Debugger – launches the algorithmic debugger.
2.5.2 Output Tab

- **Output Format** – the simulation result file output format.
- **Single Precision** - Output results in single precision (only for mat output format).
- **File Name Prefix (Optional)** – the name is used as a prefix for the output files.
- **Result File (Optional)** - the simulation result file name.
- **Variable Filter (Optional)**
  - **Protected Variables** – adds the protected variables in result file.
  - **Equidistant Time Grid** – output the internal steps given by dassl instead of interpolating results into an equidistant time grid as given by stepSize or numberOfIntervals
  - **Store Variables at Events** – adds the variables at time events.
  - **Show Generated File** – displays the generated files in a dialog box.

2.5.3 Simulation Flags Tab

- **Model Setup File (Optional)** – specifies a new setup XML file to the generated simulation code.
- **Initialization Method (Optional)** – specifies the initialization method.
- **Equation System Initialization File (Optional)** – specifies an external file for the initialization of the model.
- **Equation System Initialization Time (Optional)** – specifies a time for the initialization of the model.
- **Clock (Optional)** – the type of clock to use.
- **Linear Solver (Optional)** – specifies the linear solver method.
- **Non Linear Solver (Optional)** – specifies the nonlinear solver.
- **Linearization Time (Optional)** – specifies a time where the linearization of the model should be performed.
- **Output Variables (Optional)** – outputs the variables a, b and c at the end of the simulation to the standard output.
- **Profiling** – creates a profiling HTML file.
- **CPU Time** – dumps the cpu-time into the result file.
- **Enable All Warnings** – outputs all warnings.
- **Logging (Optional)**
  - **stdout** - standard output stream. This stream is always active, can be disabled with -lv=-stdout
  - **assert** - This stream is always active, can be disabled with -lv=-assert
  - **LOG_DASSL** - additional information about dassl solver.
  - **LOG_DASSL_STATES** - outputs the states at every dassl call.
  - **LOG_DEBUG** - additional debug information.
  - **LOG_DSS** - outputs information about dynamic state selection.
  - **LOG_DSS_JAC** - outputs jacobian of the dynamic state selection.
  - **LOG_DT** - additional information about dynamic tearing.
  - **LOG_DT_CONS** - additional information about dynamic tearing (local and global constraints).
  - **LOG_EVENTS** - additional information during event iteration.
• LOG_EVENTS_V - verbose logging of event system.
• LOG_INIT - additional information during initialization.
• LOG_IPOPT - information from Ipopt.
• LOG_IPOPT_FULL - more information from Ipopt.
• LOG_IPOPT_JAC - check jacobian matrix with Ipopt.
• LOG_IPOPT_HESSE - check hessian matrix with Ipopt.
• LOG_IPOPT_ERROR - print max error in the optimization.
• LOG_JAC - outputs the jacobian matrix used by dassl.
• LOG_LS - logging for linear systems.
• LOG_LS_V - verbose logging of linear systems.
• LOG-NLS - logging for nonlinear systems.
• LOG-NLS_V - verbose logging of nonlinear systems.
• LOG-NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.
• LOG-NLS_JAC - outputs the jacobian of nonlinear systems.
• LOG-NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.
• LOG-NLS_RES - outputs every evaluation of the residual function.
• LOG-NLS_EXTRAPOLATE - outputs debug information about extrapolate process.
• LOG_RES_INIT - outputs residuals of the initialization.
• LOG_RT - additional information regarding real-time processes.
• LOG_SIMULATION - additional information about simulation process.
• LOG_SOLVER - additional information about solver process.
• LOG_SOLVER_V - verbose information about the integration process.
• LOG_SOLVER_CONTEXT - context information during the solver process.
• LOG_SOTI - final solution of the initialization.
• LOG_STATS - additional statistics about timer/events/solver.
• LOG_STATS_V - additional statistics for LOG_STATS.
• LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUCCESS.
• LOG_UTIL.
• LOG_ZEROCROSSINGS - additional information about the zerocrossings.
• Additional Simulation Flags (Optional) – specify any other simulation flag.

2.5.4 Archived Simulations Tab

Shows the list of simulations already finished or running. Double clicking on any of them opens the simulation output window.

2.6 Plotting the Simulation Results

Successful simulation of model produces the result file which contains the instance variables that are candidate for plotting. Variables Browser will show the list of such instance variables. Each variable has a checkbox, checking it will plot the variable. See Figure 2.8.
2.6.1 Types of Plotting

The plotting type depends on the active Plot Window. By default the plotting type is Time Plot.

**Time Plot**

Plots the variable over the simulation time. You can have multiple Time Plot windows by clicking on New Plot Window toolbar button ( ![new_plot](image_url)).

**Plot Parametric**

Draws a two-dimensional parametric diagram, between variables x and y, with y as a function of x. You can have multiple Plot Parametric windows by clicking on the New Plot Parametric toolbar button ( ![new_plot_parametric](image_url)).

**Array Plot**

Plots an array variable so that the array elements’ indexes are on the x-axis and corresponding elements’ values are on the y-axis. The time is controlled by the slider above the variable tree. When an array is present in the model, it has a principal array node in the variable tree. To plot this array as an Array Plot, match the principal node. The principal node may be expanded into particular array elements. To plot a single element in the Time Plot, match the element. A new Array Plot window is opened using the New Array Plot Window toolbar button ( ![new_array_plot](image_url)).

**Array Parametric Plot**

Plots the first array elements’ values on the x-axis versus the second array elements’ values on the y-axis. The time is controlled by the slider above the variable tree. To create a new Array Parametric Plot, press the New Array Parametric Plot Window toolbar button ( ![new_array_plot_parametric](image_url)), then match the principle array node in the variable tree view to be plotted on the x-axis and match the principle array node to be plotted on the y-axis.

2.7 Re-simulating a Model

The Variables Browser allows manipulation of changeable parameters for re-simulation. After changing the parameter values user can click on the re-simulate toolbar button ( ![re_simulate](image_url)), or right click the model in Variables Browser and choose re-simulate from the menu.

2.8 3D Visualization

Since OpenModelica 1.11, OMEdit has built-in 3D visualization, which replaces third-party libraries (such as Modelica3D) for 3D visualization.

2.8.1 Running a Visualization

The 3d visualization is based on OpenSceneGraph. In order to run the visualization simply right click the class in Libraries Browser and choose “Simulate with Animation” as shown in Figure 2.11.

One can also run the visualization via Simulation > Simulate with Animation from the menu.

When simulating a model in animation mode, the flag +d=visxml is set. Hence, the compiler will generate a scene description file _visual.xml which stores all information on the multibody shapes. This scene description
references all variables which are needed for the animation of the multibody system. When simulating with 
+\textit{d=visxml}, the compiler will always generate results for these variables.

### 2.8.2 Viewing a Visualization

After the successful simulation of the model, the visualization window will show up automatically as shown in Figure 2.12.

The animation starts with pushing the \textit{play} button. The animation is played until \textit{stopTime} or until the \textit{pause} button is pushed. By pushing the \textit{previous} button, the animation jumps to the initial point of time. Points of time can be selected by moving the \textit{time slider} or by inserting a simulation time in the \textit{Time-box}. The speed factor of animation in relation to realtime can be set in the \textit{Speed-dialog}. Other animations can be opened by using the \textit{open file} button and selecting a result file with a corresponding scene description file.

The 3D camera view can be manipulated as follows:

<table>
<thead>
<tr>
<th>Operation</th>
<th>Key</th>
<th>Mouse Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Closer/Further</td>
<td>none</td>
<td>Wheel</td>
</tr>
<tr>
<td>Move Closer/Further</td>
<td>Right Mouse Hold</td>
<td>Up/Down</td>
</tr>
<tr>
<td>Move Up/Down/Left/Right</td>
<td>Middle Mouse Hold</td>
<td>Move Mouse</td>
</tr>
<tr>
<td>Move Up/Down/Left/Right</td>
<td>Left and Right Mouse Hold</td>
<td>Move Mouse</td>
</tr>
<tr>
<td>Rotate</td>
<td>Left Mouse Hold</td>
<td>Move Mouse</td>
</tr>
<tr>
<td>Shape context menu</td>
<td>Right Mouse + Shift</td>
<td></td>
</tr>
</tbody>
</table>

Predefined views (Isometric, Side, Front, Top) can be selected and the scene can be tilted by 90° either clock or anticlockwise with the rotation buttons.
2.8.3 Additional Visualization Features

The shapes that are displayed in the viewer can be selected with shift + right click. If a shape is selected, a context menu pops up that offers additional visualization features.

The following features can be selected:
### 2.9 Animation of Realtime FMUs

Instead of a result file, OMEdit can load Functional Mock-up Units to retrieve the data for the animation of multibody systems. Just like opening a mat-file from the animation-plotting view, one can open an FMU-file. Necessarily, the FMU has to be generated with the `+d=visxml` flag activated, so that a scene description file is generated in the same directory as the FMU. Currently, only FMU 1.0 and FMU 2.0 model exchange are supported. When choosing an FMU, the simulation settings window pops up to choose solver and step size. Afterwards, the model initializes and can be simulated by pressing the play button.

#### 2.9.1 Interactive Realtime Animation of FMUs

FMUs can be simulated with realtime user interaction. A possible solution is to equip the model with an interaction model from the Modelica_DeviceDrivers library (https://github.com/modelica/Modelica_DeviceDrivers). The realtime synchronization is done by OMEdit so no additional time synchronization model is necessary.

### 2.10 Interactive Simulation

**Warning:** Interactive simulation is an experimental feature.

Interactive simulation is enabled by selecting interactive simulation in the General tab of the simulation settings. There are two main modes of execution: asynchronous and synchronous (simulate with steps). The difference is that in synchronous (step mode), OMEdit sends a command to the simulation for each step that the simulation...
should take. The asynchronous mode simply tells the simulation to run and samples variables values in real-time; if the simulation runs very fast, fewer values will be sampled.

When running in asynchronous mode, it is possible to simulate the model in real-time (with a scaling factor just like simulation flag `-rt`, but with the ability to change the scaling factor during the interactive simulation). In the synchronous mode, the speed of the simulation does not directly correspond to real-time.

### 2.11 How to Create User Defined Shapes – Icons

Users can create shapes of their own by using the shape creation tools available in OMEdit.

- **Line Tool** – Draws a line. A line is created with a minimum of two points. In order to create a line, the user first selects the line tool from the toolbar and then click on the Icon/Diagram View; this will start creating a line. If a user clicks again on the Icon/Diagram View a new line point is created. In order to finish the line creation, user has to double click on the Icon/Diagram View.

- **Polygon Tool** – Draws a polygon. A polygon is created in a similar fashion as a line is created. The only difference between a line and a polygon is that, if a polygon contains two points it will look like a line and if a polygon contains more than two points it will become a closed polygon shape.

- **Rectangle Tool** – Draws a rectangle. The rectangle only contains two points where first point indicates the starting point and the second point indicates the ending the point. In order to create rectangle, the user has to select the rectangle tool from the toolbar and then click on the Icon/Diagram View, this click will become the first point of rectangle. In order to finish the rectangle creation, the user has to click again on the Icon/Diagram View where he/she wants to finish the rectangle. The second click will become the second point of rectangle.

- **Ellipse Tool** – Draws an ellipse. The ellipse is created in a similar way as a rectangle is created.

- **Text Tool** – Draws a text label.

- **Bitmap Tool** – Draws a bitmap container.

The shape tools are located in the toolbar. See Figure 2.13.

![Figure 2.13: User defined shapes.](image)

The user can select any of the shape tools and start drawing on the Icon/Diagram View. The shapes created on the Diagram View of Model Widget are part of the diagram and the shapes created on the Icon View will become the icon representation of the model.

For example, if a user creates a model with name testModel and add a rectangle using the rectangle tool and a polygon using the polygon tool, in the Icon View of the model. The model’s Modelica Text will appear as follows:
model testModel
  annotation (Icon(graphics = {Rectangle(rotation = 0, lineColor = {0,0,255},
  fillColor = {0,0,255}, pattern = LinePattern.Solid, fillPattern = FillPattern.
  None, lineThickness = 0.25, extent = {{ -64.5,88},{63, -22.5}}),Polygon(points =
  {{ -47.5, -29.5},{52.5, -29.5},{4.5, -86},{ -47.5, -29.5}}, rotation = 0,
  lineColor = {0,0,255}, fillColor = {0,0,255}, pattern = LinePattern.Solid,␣
  fillPattern = FillPattern.None, lineThickness = 0.25)}));
end testModel;

In the above code snippet of testModel, the rectangle and a polygon are added to the icon annotation of the model. Similarly, any user defined shape drawn on a Diagram View of the model will be added to the diagram annotation of the model.

### 2.12 Global head section in documentation

If you want to use same styles or same JavaScript for the classes contained inside a package then you can define __OpenModelica_infoHeader annotation inside the Documentation annotation of a package. For example,

```modelica
package P
model M
  annotation (Documentation(info="<html>
    <a href="javascript:HelloWorld()">Click here</a>
  </html>"));
end M;
annotation (Documentation(__OpenModelica_infoHeader="
  <script type="text/javascript">
    function HelloWorld()
    { alert("Hello World!");
    }
  </script>"));
end P;
```

In the above example model M does not need to define the javascript function HelloWorld. It is only defined once at the package level using the __OpenModelica_infoHeader and then all classes contained in the package can use it.

In addition styles and JavaScript can be added from file locations using Modelica URIs. Example:

```modelica
package P
model M
  annotation (Documentation(info="<html>
    <a href="javascript:HelloWorld()">Click here</a>
  </html>"));
end M;
annotation (Documentation(__OpenModelica_infoHeader="
  <script type="text/javascript">
    src="modelica://P/Resources/hello.js"
  }
  </script>"));
end P;
```

Where the file Resources/hello.js then contains:

```javascript
function HelloWorld() {
    alert("Hello World!");
}
```

48 Chapter 2. OMEdit – OpenModelica Connection Editor
2.13 Settings

OMEEdit allows users to save several settings which will be remembered across different sessions of OMEdit. The Options Dialog can be used for reading and writing the settings.

2.13.1 General

- General
  - Language – Sets the application language.
  - Working Directory – Sets the application working directory. All files are generated in this directory.
  - Toolbar Icon Size – Sets the size for toolbar icons.
  - Preserve User’s GUI Customizations – If true then OMEdit will remember its windows and toolbars positions and sizes.
  - Terminal Command – Sets the terminal command. When user clicks on Tools > Open Terminal then this command is executed.
  - Terminal Command Arguments – Sets the terminal command arguments.
  - Hide Variables Browser – Hides the variable browser when switching away from plotting perspective.
  - Activate Access Annotations – Activates the access annotations for the non-encrypted libraries. Access annotations are always active for encrypted libraries.

- Libraries Browser
  - Library Icon Size – Sets the size for library icons.
  - Show Protected Classes – If enabled then Libraries Browser will also list the protected classes.

- Modeling View Mode
  - Tabbed View/SubWindow View – Sets the view mode for modeling.

- Default View
  - Icon View/DiagramView/Modelica Text View/Documentation View – If no preferredView annotation is defined then this setting is used to show the respective view when user double clicks on the class in the Libraries Browser.

- Enable Auto Save
  - Auto save interval – Sets the auto save interval value. The minimum possible interval value is 60 seconds.
  - Enable Auto Save for single classes – Enables the auto save for one class saved in one file.
  - Enable Auto Save for one file packages – Enables the auto save for packages saved in one file.

- Welcome Page
  - Horizontal View/Vertical View – Sets the view mode for welcome page.
  - Show Latest News – if true then displays the latest news.

2.13.2 Libraries

- System Libraries – The list of system libraries that should be loaded every time OMEdit starts.
- Force loading of Modelica Standard Library – If true then Modelica and ModelicaReference will always load even if user has removed them from the list of system libraries.
- Load OpenModelica library on startup – If true then OpenModelica package will be loaded when OMEdit is started.
• **User Libraries** – The list of user libraries/files that should be loaded every time OMEdit starts.

### 2.13.3 Text Editor

- **Format**
  - **Line Ending** - Sets the file line ending.
  - **Byte Order Mark (BOM)** - Sets the file BOM.
- **Tabs and Indentation**
  - **Tab Policy** – Sets the tab policy to either spaces or tabs only.
  - **Tab Size** – Sets the tab size.
  - **Indent Size** – Sets the indent size.
- **Syntax Highlight and Text Wrapping**
  - **Enable Syntax Highlighting** – Enable/Disable the syntax highlighting.
  - **Enable Code Folding** - Enable/Disable the code folding. When code folding is enabled multi-line annotations are collapsed into a compact icon (a rectangle containing "...")). A marker containing a "+" sign becomes available at the left-side of the involved line, allowing the code to be expanded/re-collapsed at will.
  - **Match Parentheses within Comments and Quotes** – Enable/Disable the matching of parentheses within comments and quotes.
  - **Enable Line Wrapping** – Enable/Disable the line wrapping.
- **Autocomplete**
  - **Enable Autocomplete** – Enable/Disable the autocomplete.
- **Font**
  - **Font Family** – Shows the names list of available fonts. Sets the font for the editor.
  - **Font Size** – Sets the font size for the editor.

### 2.13.4 Modelica Editor

- **Preserve Text Indentation** – If true then uses `diffModelicaFileListings` API call otherwise uses the OMC pretty-printing.
- **Colors**
  - **Items** – List of categories used of syntax highlighting the code.
  - **Item Color** – Sets the color for the selected item.
  - **Preview** – Shows the demo of the syntax highlighting.

### 2.13.5 MetaModelica Editor

- **Colors**
  - **Items** – List of categories used of syntax highlighting the code.
  - **Item Color** – Sets the color for the selected item.
  - **Preview** – Shows the demo of the syntax highlighting.
2.13.6 CompositeModel Editor

- Colors
  - Items – List of categories used of syntax highlighting the code.
  - Item Color – Sets the color for the selected item.
  - Preview – Shows the demo of the syntax highlighting.

2.13.7 C/C++ Editor

- Colors
  - Items – List of categories used of syntax highlighting the code.
  - Item Color – Sets the color for the selected item.
  - Preview – Shows the demo of the syntax highlighting.

2.13.8 Graphical Views

- Extent
  - Left – Defines the left extent point for the view.
  - Bottom – Defines the bottom extent point for the view.
  - Right – Defines the right extent point for the view.
  - Top – Defines the top extent point for the view.
- Grid
  - Horizontal – Defines the horizontal size of the view grid.
  - Vertical – Defines the vertical size of the view grid.
- Component
  - Scale factor – Defines the initial scale factor for the component dragged on the view.
  - Preserve aspect ratio – If true then the component’s aspect ratio is preserved while scaling.

2.13.9 Simulation

- Simulation
  - Matching Algorithm – sets the matching algorithm for simulation.
  - Index Reduction Method – sets the index reduction method for simulation.
  - Target Language – sets the target language in which the code is generated.
  - Target Compiler – sets the target compiler for compiling the generated code.
  - OMC Command Line Options – sets the OMC command line options for the simulation.
  - Ignore __OpenModelica_commandLineOptions annotation – if true then ignores the __OpenModelica_commandLineOptions annotation while running the simulation.
  - Ignore __OpenModelica_simulationFlags annotation – if true then ignores the __OpenModelica_simulationFlags annotation while running the simulation.
  - Save class before simulation – if true then always saves the class before running the simulation.
  - Switch to plotting perspective after simulation – if true then GUI always switches to plotting perspective after the simulation.
• Close completed simulation output windows before simulation – if true then the completed simulation output windows are closed before starting a new simulation.
• Delete intermediate compilation files – if true then the files generated during the compilation are deleted automatically.
• Delete entire simulation directory of the model when OMEdit is closed – if true then the entire simulation directory is deleted on quit.
• Output
  • Structured – Shows the simulation output in the form of tree structure.
  • Formatted Text – Shows the simulation output in the form of formatted text.

2.13.10 Messages

• General
  • Output Size - Specifies the maximum number of rows the Messages Browser may have. If there are more rows then the rows are removed from the beginning.
  • Reset messages number before simulation – Resets the messages counter before starting the simulation.
• Font and Colors
  • Font Family – Sets the font for the messages.
  • Font Size – Sets the font size for the messages.
  • Notification Color – Sets the text color for notification messages.
  • Warning Color – Sets the text color for warning messages.
  • Error Color – Sets the text color for error messages.

2.13.11 Notifications

• Notifications
  • Always quit without prompt – If true then OMEdit will quit without prompting the user.
  • Show item dropped on itself message – If true then a message will pop-up when a class is dragged and dropped on itself.
  • Show model is defined as partial and component will be added as replaceable message – If true then a message will pop-up when a partial class is added to another class.
  • Show component is declared as inner message – If true then a message will pop-up when an inner component is added to another class.
  • Show save model for bitmap insertion message – If true then a message will pop-up when user tries to insert a bitmap from a local directory to an unsaved class.
  • Always ask for the dragged component name – If true then a message will pop-up when user drag & drop the component on the graphical view.
  • Always ask for what to do with the text editor error – If true then a message will always pop-up when there is an error in the text editor.

2.13.12 Line Style

• Line Style
  • Color – Sets the line color.
• *Pattern* – Sets the line pattern.
• *Thickness* – Sets the line thickness.
• *Start Arrow* – Sets the line start arrow.
• *End Arrow* – Sets the line end arrow.
• *Arrow Size* – Sets the start and end arrow size.
• *Smooth* – If true then the line is drawn as a Bezier curve.

### 2.13.13 Fill Style

• Fill Style
  • *Color* – Sets the fill color.
  • *Pattern* – Sets the fill pattern.

### 2.13.14 Plotting

• General
  • *Auto Scale* – sets whether to auto scale the plots or not.
  • Plotting View Mode
    • *Tabbed View/SubWindow View* – Sets the view mode for plotting.
  • Curve Style
    • *Pattern* – Sets the curve pattern.
    • *Thickness* – Sets the curve thickness.

Variable filter
  • *Filter Interval* - Delay in filtering the variables. Set the value to 0 if you don’t want any delay.

### 2.13.15 Figaro

• Figaro
  • *Figaro Library* – the Figaro library file path.
  • *Tree generation options* – the Figaro tree generation options file path.
  • *Figaro Processor* – the Figaro processor location.

### 2.13.16 Debugger

• Algorithmic Debugger
  • *GDB Path* – the gnu debugger path
  • *GDB Command Timeout* – timeout for gdb commands.
  • *GDB Output Limit* – limits the GDB output to N characters.
  • *Display C frames* – if true then shows the C stack frames.
  • *Display unknown frames* – if true then shows the unknown stack frames. Unknown stack frames means frames whose file path is unknown.
  • *Clear old output on a new run* – if true then clears the output window on new run.
• *Clear old log on new run* – if true then clears the log window on new run.

• Transformational Debugger

• *Always show Transformational Debugger after compilation* – if true then always open the Transformational Debugger window after model compilation.

• *Generate operations in the info xml* – if true then adds the operations information in the info xml file.

### 2.13.17 FMI

• Export
  
  • *Version*
    
    • *1.0* – Sets the FMI export version to 1.0
    
    • *2.0* – Sets the FMI export version to 2.0
  
  • *Type*
    
    • *Model Exchange* – Sets the FMI export type to Model Exchange.
    
    • *Co-Simulation* – Sets the FMI export type to Co-Simulation.
    
    • *Model Exchange and Co-Simulation* – Sets the FMI export type to Model Exchange and Co-Simulation.
  
  • *FMU Name* – Sets a prefix for generated FMU file.

• Import
  
  • *Delete FMU directory and generated model when OMEdit is closed* – If true then the temporary FMU directory that is created for importing the FMU will be deleted.

### 2.13.18 OMTLMSimulator

• General
  
  • *Path* - path to OMTLMSimulator bin directory.
  
  • *Manager Process* - path to OMTLMSimulator manager process.
  
  • *Monitor Process* - path to OMTLMSimulator monitor process.

### 2.13.19 OMSimulator

• General
  
  • *Working Directory* - working directory for OMSimulator files.
  
  • *Logging Level* - OMSimulator logging level.

### 2.14 __OpenModelica_commandLineOptions Annotation

OpenModelica specific annotation to define the command line options needed to simulate the model. For example if you always want to simulate the model with a specific matching algorithm and index reduction method instead of the default ones then you can write the following code,
The annotation is a space separated list of options where each option is either just a command line flag or a flag with a value.

In OMEEdit right click inside the icon/diagram view of the model and choose Properties. Then OMC Command Line Options and in the text field write `--matchingAlgorithm=BFSB --indexReductionMethod=dynamicStateSelection`.

If you want to ignore this annotation then use `setCommandLineOptions("-ignoreCommandLineOptionsAnnotation=true")`. In OMEEdit Tools > Options > Simulation check Ignore __OpenModelica_commandLineOptions annotation.

### 2.15 __OpenModelica_simulationFlags Annotation

OpenModelica specific annotation to define the simulation options needed to simulate the model. For example if you always want to simulate the model with a specific solver instead of the default DASSL and would also like to see the cpu time then you can write the following code,

```model Test
  annotation(__OpenModelica_simulationFlags(s = "heun", cpu = "()"));
end Test;
```

The annotation is a comma separated list of options where each option is a simulation flag with a value. For flags that doesn’t have any value use `()` (See the above code example).

In OMEEdit open the Simulation Setup and set the Simulation Flags then in the bottom check Save __OpenModelica_simulationFlags annotation inside model and click on OK.

If you want to ignore this annotation then use `setCommandLineOptions("-ignoreSimulationFlagsAnnotation=true")`. In OMEEdit Tools > Options > Simulation check Ignore __OpenModelica_simulationFlags annotation.

### 2.16 Debugger

For debugging capability, see Debugging.

### 2.17 Editing Modelica Standard Library

By default OMEEdit loads the Modelica Standard Library (MSL) as a system library. System libraries are read-only. If you want to edit MSL you need to load it as user library instead of system library. We don’t recommend editing MSL but if you really need to and understand the consequences then follow these steps,

- Go to Tools > Options > Libraries.
- Remove Modelica & ModelicaReference from list of system libraries.
- Uncheck force loading of Modelica Standard Library.
- Add $OPENMODELICAHOME/lib/omlibrary/Modelica X.X/package.mo under user libraries.
- Restart OMEEdit.
2.18 State Machines

2.18.1 Creating a New Modelica State Class

Follow the same steps as defined in Creating a New Modelica Class. Additionally make sure you check the State checkbox.

![OMEdit - Create New Modelica Class](image)

Figure 2.14: Creating a new Modelica state.

2.18.2 Making Transitions

In order to make a transition from one state to another the user first needs to enable the transition mode (_transition) from the toolbar.

Move the mouse over the state. The mouse cursor will change from arrow cursor to cross cursor. To start the transition press left button and move while keeping the button pressed. Now release the left button. Move towards the end state and click when cursor changes to cross cursor.

A Create Transition dialog box will appear which allows you to set the transition attributes. Cancelling the dialog will cancel the transition.

Double click the transition or right click and choose Edit Transition to modify the transition attributes.

2.18.3 State Machine Simulation

Support for Modelica state machines was added in the Modelica Language Specification v3.3. A subtle problem can occur if Modelica v3.2 libraries are loaded, e.g., the Modelica Standard Library v3.2.2, because in this case OMC automatically switches into Modelica v3.2 compatibility mode. Trying to simulate a state machine in Modelica v3.2 compatibility mode results in an error. It is possible to use the OMC flag --std=latest in order to ensure (at least) Modelica v3.3 support. In OMEdit this can be achieved by setting that flag in the Tools > Options > Simulation dialog.
Figure 2.15: Ensure (at least) Modelica v3.3 support.
CHAPTER THREE

2D PLOTTING

This chapter covers the 2D plotting available in OpenModelica via OMNotebook, OMSHELL and command line script. The plotting is based on OMPlot application.

3.1 Example

```oml
class HelloWorld
  Real x(start = 1, fixed = true);
  parameter Real a = 1;
end HelloWorld;
```

equation
  der(x) = -a * x;
end HelloWorld;

To create a simple time plot the above model HelloWorld is simulated. To reduce the amount of simulation data in this example the number of intervals is limited with the argument `numberOfIntervals=5`. The simulation is started with the command below.

```python
>>> simulate(HelloWorld, outputFormat="csv", startTime=0, stopTime=4, numberOfIntervals=5)
```

When the simulation is finished the file `HelloWorld_res.csv` contains the simulation data:

```
Listing 3.1: HelloWorld_res.csv
"time","x","der(x)"
0.0,1.0,-1.0
0.8,0.449328902712475,-0.449328902712475
1.6,0.2018973974273906,-0.2018973974273906
2.4,0.09071896372718975,-0.09071896372718975
3.2,0.04076293845066793,-0.04076293845066793
```

(continues on next page)
Diagrams are now created with the new OMPlot program by using the following plot command:

![Figure 3.1: Simple 2D plot of the HelloWorld example.](image1)

By re-simulating and saving results at many more points, for example using the default 500 intervals, a much smoother plot can be obtained. Note that the default solver method dassl has more internal points than the output points in the initial plot. The results are identical, except the detailed plot has a smoother curve.

![Figure 3.2: Simple 2D plot of the HelloWorld example with a larger number of output points.](image2)
### 3.2 Plot Command Interface

Plot command have a number of optional arguments to further customize the the resulting diagram.

```plaintext
>>> list(OpenModelica.Scripting.plot, interfaceOnly=true)
"function plot
  input VariableNames vars \"The variables you want to plot\"
  input Boolean externalWindow = false \"Opens the plot in a new plot window\"
  input String fileName = "\"<default>\" \"The filename containing the variables.
  \"<default> will read the last simulation result\"
  input String title = \"\" \"This text will be used as the diagram title.\"
  input String grid = \"detailed\" \"Sets the grid for the plot i.e simpler,
  \ndetailed, none.\"
  input Boolean logX = false \"Determines whether or not the horizontal axis is
  \nlogarithmically scaled.\"
  input Boolean logY = false \"Determines whether or not the vertical axis is
  \nlogarithmically scaled.\"
  input String xLabel = \"time\" \"This text will be used as the horizontal label
  \nin the diagram.\"
  input String yLabel = \"\" \"This text will be used as the vertical label in the
  \ndiagram.\"
  input Real xRange[2] = {0.0, 0.0} \"Determines the horizontal interval that is
  \nvisible in the diagram. (0,0) will select a suitable range.\"
  input Real yRange[2] = {0.0, 0.0} \"Determines the vertical interval that is
  \nvisible in the diagram. (0,0) will select a suitable range.\"
  input Real curveWidth = 1.0 \"Sets the width of the curve.\"
  input Integer curveStyle = 1 \"Sets the style of the curve. SolidLine=1,
  \nDashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.\"
  input String legendPosition = \"top\" \"Sets the POSITION of the legend i.e left,
  \nright, top, bottom, none.\"
  input String footer = \"\" \"This text will be used as the diagram footer.\"
  input Boolean autoScale = true \"Use auto scale while plotting.\"
  input Boolean forceOMPlot = false \"if true launches OMPlot and doesn't call
  \ncallback function even if it is defined.\"
  output Boolean success \"Returns true on success\"
end plot;"
```
4.1 Integration Methods

By default OpenModelica transforms a Modelica model into an ODE representation to perform a simulation by using numerical integration methods. This section contains additional information about the different integration methods in OpenModelica. They can be selected by the method parameter of the `simulate` command or the `-s` `simflag`.

The different methods are also called solver and can be distinguished by their characteristic:

- explicit vs. implicit
- order
- step size control
- multi step

A good introduction on this topic may be found in [CK06] and a more mathematical approach can be found in [HNorsettW93].

4.1.1 DASSL

DASSL is the default solver in OpenModelica, because of a several reasons. It is an implicit, higher order, multi-step solver with a step-size control and with these properties it is quite stable for a wide range of models. Furthermore it has a mature source code, which was originally developed in the eighties an initial description may be found in [Pet82].

This solver is based on backward differentiation formula (BDF), which is a family of implicit methods for numerical integration. The used implementation is called DASPK2.0 (see\(^2\)) and it is translated automatically to C by f2c (see\(^3\)).

The following simulation flags can be used to adjust the behavior of the solver for specific simulation problems: `jacobian`, `noRootFinding`, `noRestart`, `initialStepSize`, `maxStepSize`, `maxIntegrationOrder`, `noEquidistantTimeGrid`.

4.1.2 IDA

The IDA solver is part of a software family called sundials: SUite of Nonlinear and DIfferential/ALgebraic equation Solvers [HBG+05]. The implementation is based on DASPK with an extended linear solver interface, which includes an interface to the high performance sparse linear solver KLU [DN10].

The simulation flags of DASSL are also valid for the IDA solver and furthermore it has the following IDA specific flags: `idaLS`, `idaMaxNonLinIters`, `idaMaxConvFails`, `idaNonLinConvCoef`, `idaMaxErrorTestFails`.

---

\(^2\) DASPK Webpage
\(^3\) Cdashr source
4.1.3 Basic Explicit Solvers

The basic explicit solvers are performing with a fixed step-size and differ only in the integration order. The step-size is based on the numberOfIntervals, the startTime and stopTime parameters in the simulate command:

\[
\text{stepSize} \approx \frac{\text{stopTime} - \text{startTime}}{\text{numberOfIntervals}}
\]

- euler - order 1
- heun - order 2
- rungekutta - order 4

4.1.4 Basic Implicit Solvers

The basic implicit solvers are all based on the non-linear solver KINSOL from the SUNDIALS suite. The underlining linear solver can be modified with the simflag -impRKLS. The step-size is determined as for the basic explicit solvers.

- impeuler - order 1
- trapezoid - order 2
- imprungekutta - Based on Radau IIA and Lobatto IIIA defined by its Butcher tableau where the order can be adjusted by -impRKorder.

4.1.5 Experimental Solvers

The following solvers are marked as experimental, mostly because they are till now not tested very well.

- rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step-size control, order 4-5
- irksco - Own developed Runge-Kutta solver - implicit, step-size control, order 1-2
- symSolver - Symbolic inline solver (requires –symSolver) - fixed step-size, order 1
- symSolverSsc - Symbolic implicit inline Euler with step-size control (requires –symSolver) - step-size control, order 1-2
- qss - A QSS solver

4.2 DAE Mode Simulation

Beside the default ODE simulation, OpenModelica is able to simulate models in DAE mode. The DAE mode is enabled by the flag –daeMode. In general the whole equation system of a model is passed to the DAE integrator, including all algebraic loops. This reduces the amount of work that needs to be done in the post optimization phase of the OpenModelica backend. Thus models with large algebraic loops might compile faster in DAE mode.

Once a model is compiled in DAE mode the simulation can be only performed with SUNDIALS/IDA integrator and with enabled -daeMode simulation flag. Both are enabled automatically by default, when a simulation run is started.

4.2.1 References
There are two main ways to debug Modelica code, the transformations browser, which shows the transformations OpenModelica performs on the equations. There is also a debugger for debugging of algorithm sections and functions.

5.1 The Equation-based Debugger

This section gives a short description how to get started using the equation-based debugger in OMEdit.

5.1.1 Enable Tracing Symbolic Transformations

This enables tracing symbolic transformations of equations. It is optional but strongly recommended in order to fully use the debugger. The compilation time overhead from having this tracing on is less than 1%, however, in addition to that, some time is needed for the system to write the xml file containing the transformation tracing information.

Enable -d=infoXmlOperations in Tools->Options->Simulation (see section Simulation) OR alternatively click on the checkbox Generate operations in the info xml in Tools->Options->Debugger (see section Debugger) which performs the same thing.

This adds all the transformations performed by OpenModelica on the equations and variables stored in the model_info.xml file. This is necessary for the debugger to be able to show the whole path from the source equation(s) to the position of the bug.

5.1.2 Load a Model to Debug

Load an interesting model. We will use the package Debugging.mo since it contains suitable, broken models to demonstrate common errors.

5.1.3 Simulate and Start the Debugger

Select and simulate the model as usual. For example, if using the Debugging package, select the model Debugging.Chattering.ChatteringEvents1. If there is an error, you will get a clickable link that starts the debugger. If the user interface is unresponsive or the running simulation uses too much processing power, click cancel simulation first.

5.1.4 Use the Transformation Debugger for Browsing

Use the transformation debugger. It opens on the equation where the error was found. You can browse through the dependencies (variables that are defined by the equation, or the equation is dependent on), and similar for variables. The equations and variables form a bipartite graph that you can walk.
Figure 5.1: Simulating the model.
If the `-d=infoXmlOperations` was used or you clicked the “generate operations” button, the operations performed on the equations and variables can be viewed. In the example package, there are not a lot of operations because the models are small.

Try some larger models, e.g. in the MultiBody library or some other library, to see more operations with several transformation steps between different versions of the relevant equation(s). If you do not trigger any errors in a model, you can still open the debugger, using File->Open Transformations File (model_info.json).

Figure 5.2: Transformations Browser.

### 5.2 The Algorithmic Debugger

This section gives a short description how to get started using the algorithmic debugger in OMEdit. See section Simulation for further details of debugger options/settings. The Algorithmic Debugger window can be launched from Tools->Windows->Algorithmic Debugger.

#### 5.2.1 Adding Breakpoints

There are two ways to add the breakpoints,

- **Click directly on the line number in Text View, a red circle is created indicating a breakpoint as shown in Figure 5.3.**
- **Open the Algorithmic Debugger window and add a breakpoint using the right click menu of Breakpoints Browser window.**
Figure 5.3: Adding breakpoint in Text View.
5.2.2 Start the Algorithmic Debugger

You should add breakpoints before starting the debugger because sometimes the simulation finishes quickly and you won’t get any chance to add the breakpoints.

There are four ways to start the debugger,

- **Open the Simulation Setup and click on Launch Algorithmic Debugger** before pressing Simulate.
- **Right click the model in Libraries Browser and select Simulate with** Algorithmic Debugger.
- **Open the Algorithmic Debugger window and from menu select** Debug-> Debug Configurations.
- **Open the Algorithmic Debugger window and from menu select** Debug-> Attach to Running Process.

5.2.3 Debug Configurations

If you already have a simulation executable with debugging symbols outside of OMEdit then you can use the Debug->Debug Configurations option to load it.

The debugger also supports MetaModelica data structures so one can debug omc executable. Select omc executable as program and write the name of the mos script file in Arguments.
5.2.4 Attach to Running Process

If you already have a running simulation executable with debugging symbols outside of OMEdit then you can use the Debug->Attach to Running Process option to attach the debugger with it. Figure 5.5 shows the Attach to Running Process dialog. The dialog shows the list of processes running on the machine. The user selects the program that he/she wish to debug. OMEdit debugger attaches to the process.

![Attach to Running Process](image)

Figure 5.5: Attach to Running Process.

5.2.5 Using the Algorithmic Debugger Window

Figure 5.6 shows the Algorithmic Debugger window. The window contains the following browsers,

- **Stack Frames Browser** – shows the list of frames. It contains the program context buttons like resume, interrupt, exit, step over, step in, step return. It also contains a threads drop down which allows switching between different threads.

- **BreakPoints Browser** – shows the list of breakpoints. Allows adding/editing/removing breakpoints.

- **Locals Browser** – Shows the list of local variables with values. Select the variable and the value will be shown in the bottom right window. This is just for convenience because some variables might have long values.

- **Debugger CLI** – shows the commands sent to gdb and their responses. This is for advanced users who want to have more control of the debugger. It allows sending commands to gdb.
• *Output Browser* – shows the output of the debugged executable.

Figure 5.6: Algorithmic Debugger.
The system of equations after symbolic transformation is represented by a graph. OpenModelica can generate graph representations which can be displayed in the graph tool yed (http://www.yworks.com/products/yed). The graph generation is activated with the debug flag

+graphml

Two different graphml- files are generated in the working directory. TaskGraph_model.graphml, showing the strongly-connected components of the model and BipartiteGraph_CompleteDAE_model.graphml showing all variables and equations. When loading the graphs with yEd, all nodes are in one place. Please use the various layout algorithms to get a better overview.

Figure 6.1: A task-graph representation of a model in yEd
Figure 6.2: A biparite graph representation of a model in yEd
FMI AND TLM-BASED SIMULATION AND CO-SIMULATION OF EXTERNAL MODELS

7.1 Functional Mock-up Interface - FMI

The new standard for model exchange and co-simulation with Functional Mockup Interface (FMI) allows export of pre-compiled models, i.e., C-code or binary code, from a tool for import in another tool, and vice versa. The FMI standard is Modelica independent. Import and export works both between different Modelica tools, or between certain non-Modelica tools. OpenModelica supports FMI 1.0 & 2.0.

- Model Exchange
- Co-Simulation (under development)

7.1.1 FMI Export

To export the FMU use the OpenModelica command `translateModelFMU(ModelName)` from command line interface, OMShell, OMNotebook or MDT. The export FMU command is also integrated with OMEdit. Select FMI > Export FMU the FMU package is generated in the current directory of omc. You can use the `cd()` command to see the current location. You can set which version of FMI to export through OMEdit settings, see section FMI.

To export the bouncing ball example to an FMU, use the following commands:

```plaintext
>>> loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
←BouncingBall.mo")
true
>>> translateModelFMU(BouncingBall)
""DOCHOME"/BouncingBall.fmu"
>>> system("unzip -l BouncingBall.fmu | egrep -v 'sources|files' | tail -n+3 | 
←grep -o '[A-Za-z_0-9/]+' > BB.log")
0
```

After the command execution is complete you will see that a file BouncingBall.fmu has been created. Its contents varies depending on the current platform. On the machine generating this documentation, the contents in Listing 7.1 are generated (along with the C source code).

Listing 7.1: BouncingBall FMU contents

```plaintext
binaries/
binaries/linux64/
binaries/linux64/BouncingBall_FMU.libs
binaries/linux64/BouncingBall.so
modelDescription.xml
```

A log file for FMU creation is also generated named ModelName_FMU.log. If there are some errors while creating FMU they will be shown in the command line window and logged in this log file as well.

By default an FMU that can be used for both Model Exchange and Co-Simulation is generated. We only support FMI 2.0 for Co-Simulation FMUs.
Currently the Co-Simulation FMU supports only the forward Euler solver with root finding which does an Euler step of communicationStepSize in fmi2DoStep. Events are checked for before and after the call to fmi2GetDerivatives.

7.1.2 FMI Import

To import the FMU package use the OpenModelica command importFMU,

```plaintext
>>> list(OpenModelica.Scripting.importFMU, interfaceOnly=true)
function importFMU
  input String filename "the fmu file name";
  input String workdir = "<default>" "The output directory for imported FMU files.
  → <default> will put the files to current working directory.";
  input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;
  → loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
  input Boolean fullPath = false "When true the full output path is returned, otherwise only the file name.";
  input Boolean debugLogging = false "When true the FMU's debug output is printed."
  →
  input Boolean generateInputConnectors = true "When true creates the input
  → connector pins."
  input Boolean generateOutputConnectors = true "When true creates the output
  → connector pins."
  output String generatedFileName "Returns the full path of the generated file.";
end importFMU;
```

The command could be used from command line interface, OMShell, OMNotebook or MDT. The importFMU command is also integrated with OMEdit. Select FMI > Import FMU the FMU package is extracted in the directory specified by workdir, since the workdir parameter is optional so if its not specified then the current directory of omc is used. You can use the cd() command to see the current location.

The implementation supports FMI for Model Exchange 1.0 & 2.0 and FMI for Co-Simulation 1.0 stand-alone. The support for FMI Co-Simulation is still under development.

The FMI Import is currently a prototype. The prototype has been tested in OpenModelica with several examples. It has also been tested with example FMUs from FMUSDK and Dymola. A more fullfleged version for FMI Import will be released in the near future.

When importing the model into OMEdit, roughly the following commands will be executed:

```plaintext
>>> imported_fmu_mo_file:=importFMU("BouncingBall.fmu")
"BouncingBall_me_FMU.mo"
>>> loadFile(imported_fmu_mo_file)
true
```

The imported FMU can then be simulated like any normal model:

```plaintext
>>> simulate(BouncingBall_me_FMU, stopTime=3.0)
```

The imported FMU can then be simulated like any normal model:
7.2 Transmission Line Modeling (TLM) Based Co-Simulation

This chapter gives a short description how to get started using the TLM-Based co-simulation accessible via OMEdit.

The TLM Based co-simulation provides the following general functionalities:

- Import and add External non-Modelica models such as Matlab/Simulink, Adams, and BEAST models
- Import and add External Modelica models e.g. from tools such as Dymola or Wolfram SystemModeler, etc.
- Specify startup methods and interfaces of the external model
- Build the composite models by connecting the external models
- Set the co-simulation parameters in the composite model
- Simulate the composite models using TLM based co-simulation

7.3 Composite Model Editing of External Models

The graphical composite model editor is an extension and specialization of the OpenModelica connection editor OMEdit. A composite model is composed of several external sub-models including the interconnections between these sub-models. External models are models which need not be in Modelica, they can be FMUs, or models accessed by proxies for co-simulation and connected by TLM-connections. The standard way to store a composite model is in an XML format. The XML schema standard is accessible from tlmModelDescription.xsd. Currently composite models can only be used for TLM based co-simulation of external models.
7.3.1 Loading a Composite Model for Co-Simulation

To load the composite model, select **File > Open Composite Model(s)** from the menu and select composite-model.xml.

OMEdit loads the composite model and show it in the Libraries Browser. Double-clicking the composite model in the Libraries Browser will display the composite model as shown below in Figure 7.2.

![Composite Model with 3D View](image)

Figure 7.2: Composite Model with 3D View.

7.3.2 Co-Simulating the Composite Model

There are two ways to start co-simulation:

- Click **TLM Co-Simulation setup button** (/button) from the toolbar (requires a composite model to be active in ModelWidget)
- Right click the composite model in the Libraries Browser and choose **TLM Co-Simulation setup** from the popup menu (see Figure 7.3)

The TLM Co-Simulation setup appears as shown below in Figure 7.4.

Click **Simulate** from the Co-simulation setup to confirm the co-simulation. Figure 7.5 will appears in which you will be able to see the progress information of the running co-simulation.

The editor also provides the means of reading the log files generated by the simulation manager and monitor. When the simulation ends, click **Open Manager Log File** or **Open Monitor Log File** from the co-simulation progress bar to check the log files.
Figure 7.3: Co-simulating and Fetching Interface Data of a composite model from the Popup Menu.
Figure 7.4: TLM Co-simulation Setup.
Figure 7.5: TLM Co-Simulation Progress.
7.3.3 Plotting the Simulation Results

When the co-simulation of the composite model is completed successfully, simulation results are collected and visualized in the OMEdit plotting perspective as shown in Figure 7.6 and Figure 7.7. The Variables Browser display variables that can be plotted. Each variable has a checkbox, checking it will plot the variable.

![Figure 7.6: TLM Co-Simulation Results Plotting.](image)

7.3.4 Preparing External Models

First step in co-simulation Modeling is to prepare the different external simulation models with TLM interfaces. Each external model belongs to a specific simulation tool, such as MATLAB/Simulink®, BEAST, MSC/ADAMS, Dymola and Wolfram SystemModeler.

When the external models have all been prepared, the next step is to load external models in OMEdit by selecting the File > Load External Model(s) from the menu.

OMEdit loads the external model and show it in the Libraries Browser as shown below in Figure 7.8.

7.3.5 Creating a New Composite Model

We will use the “Double pendulum” composite model which is a multibody system that consists of three sub-models: Two OpenModelica Shaft sub-models (Shaft1 and Shaft2) and one SKF/BEAST bearing sub-model that together build a double pendulum. The SKF/BEAST bearing sub-model is a simplified model with only three balls to speed up the simulation. Shaft1 is connected with a spherical joint to the world coordinate system. The end of Shaft1 is connected via a TLM interface to the outer ring of the BEAST bearing model. The inner ring
Figure 7.7: TLM Co-Simulation Visualization.
Figure 7.8: External Models in OMEdit.
of the bearing model is connected via another TLM interface to Shaft2. Together they build the double pendulum with two shafts, one spherical OpenModelica joint, and one BEAST bearing.

To create a new composite model select File > New Composite Model from the menu.

Your new composite model will appear in the in the Libraries Browser once created. To facilitate the process of textual composite modeling and to provide users with a starting point, the Text View (see Figure 7.9) includes the composite model XML elements and the default simulation parameters.

7.3.6 Adding Submodels

It is possible to build the double pendulum by drag-and-drop of each simulation model component (sub-model) from the Libraries Browser to the Diagram View. To place a component in the Diagram View of the double pendulum model, drag each external sub-model of the double pendulum (i.e. Shaft1, Shaft2, and BEAST bearing sub-model) from the Libraries Browser to the Diagram View.

7.3.7 Fetching Submodels Interface Data

To retrieve list of TLM interface data for sub-models, do any of the following methods:

- Click Fetch Interface Data button ( ) from the toolbar (requires a composite model to be active in ModelWidget)
- Right click the composite model in the Library Browser and choose Fetch Interface Data from the popup menu (see Figure 7.3).
Figure 7.10: Adding sub-models to the double pendulum composite model.
To retrieve list of TLM interface data for a specific sub-model,

- Right click the sub-model inside the composite model and choose **Fetch Interface Data** from the popup menu.

**Figure 7.11** will appear in which you will be able to see the progress information of fetching the interface data.

![Fetching Interface Data Progress](image)

**Figure 7.11: Fetching Interface Data Progress.**

Once the TLM interface data of the sub-models are retrieved, the interface points will appear in the diagram view as shown below in **Figure 7.12**.

### 7.3.8 Connecting Submodels

When the sub-models and interface points have all been placed in the Diagram View, similar to **Figure 7.12**, the next step is to connect the sub-models. Sub-models are connected using the **Connection Line Button** from the toolbar.

To connect two sub-models, select the Connection Line Button and place the mouse cursor over an interface and click the left mouse button, then drag the cursor to the other sub-model interface, and click the left mouse button again. A connection dialog box as shown below in **Figure 7.13** will appear in which you will be able to specify the connection attributes.

Continue to connect all sub-models until the composite model **Diagram View** looks like the one in **Figure 7.14** below.

### 7.3.9 Changing Parameter Values of Submodels

To change a parameter value of a sub-model, do any of the following methods:

- Double-click on the sub-model you want to change its parameter
- Right click on the sub-model and choose **Attributes** from the popup menu

The parameter dialog of that sub-model appears as shown below in **Figure 7.15** in which you will be able to specify the sub-models attributes.
Figure 7.12: Fetching Interface Data.
Figure 7.13: Sub-models Connection Dialog.

Figure 7.14: Connecting sub-models of the Double Pendulum Composite Model.
7.3.10 Changing Parameter Values of Connections

To change a parameter value of a connection, do any of the following methods:

- Double-click on the connection you want to change its parameter
- Right click on the connection and choose Attributes from the popup menu.

The parameter dialog of that connection appears (see Figure 7.13) in which you will be able to specify the connections attributes.

7.3.11 Changing Co-Simulation Parameters

To change the co-simulation parameters, do any of the following methods:

- Click Simulation Parameters button ( ) from the toolbar (requires a composite model to be active in ModelWidget)
- Right click an empty location in the Diagram View of the composite model and choose Simulation Parameters from the popup menu (see Figure 7.16)

The co-simulation parameter dialog of the composite model appears as shown below in Figure 7.17 in which you will be able to specify the simulation parameters.
Figure 7.16: Changing Co-Simulation Parameters from the Popup Menu.

Figure 7.17: Changing Co-Simulation Parameters Dialog.
OMSimulator has its own documentation.
The encryption module allows the library developers to encrypt their libraries for different platforms. Note that you need a special version of OpenModelica with encryption support. Contact us if you want one.

9.1 Encrypting the Library

In order to encrypt the Modelica package call `buildEncryptedPackage(TopLevelPackageName)` from mos script or from OMEdit right click the package in Libraries Browser and select Export Encrypted Package or select Export > Export Encrypted Package from the menu.

All the Modelica files are encrypted and the whole library is zipped into a single file i.e., `PackageName.mol`. Note that you can only encrypt Modelica packages saved in a folder structure. The complete folder structure remains as it is. No encryption is done on the resource files.

9.2 Loading an Encrypted Library

To load the encrypted package call `loadEncryptedPackage(EncryptedPackage.mol)` from the mos script or from OMEdit File > Load Encrypted Package.

9.3 Notes

- There is no license management and obfuscation of the generated code and files. However just a basic encryption and decryption is supported along with full support for protection access annotation as defined in Modelica specification 18.9. This means that anyone who has an OpenModelica version with encryption support can encrypt or decrypt files.
- OpenModelica encryption is based on SEMLA (Safe/ Superior/ Super Encryption of Modelica Libraries and Artifacts) module from Modelon AB.
This chapter covers the OpenModelica electronic notebook subsystem, called OMNotebook, together with the DrModelica tutoring system for teaching Modelica, and DrControl for teaching control together with Modelica. Both are using such notebooks.

10.1 Interactive Notebooks with Literate Programming

Interactive Electronic Notebooks are active documents that may contain technical computations and text, as well as graphics. Hence, these documents are suitable to be used for teaching and experimentation, simulation scripting, model documentation and storage, etc.

10.1.1 Mathematica Notebooks

Literate Programming [Knu84] is a form of programming where programs are integrated with documentation in the same document. Mathematica notebooks [Wol96] is one of the first WYSIWYG (What-You-See-Is-What-You-Get) systems that support Literate Programming. Such notebooks are used, e.g., in the MathModelica modeling and simulation environment, see e.g. Figure 10.1 below and Chapter 19 in [Fri04].

10.1.2 OMNotebook

The OMNotebook software [Axe05][Fernstrom06] is a new open source free software that gives an interactive WYSIWYG realization of Literate Programming, a form of programming where programs are integrated with documentation in the same document.

The OMNotebook facility is actually an interactive WYSIWYG realization of Literate Programming, a form of programming where programs are integrated with documentation in the same document. OMNotebook is a simple open-source software tool for an electronic notebook supporting Modelica.

A more advanced electronic notebook tool, also supporting mathematical typesetting and many other facilities, is provided by Mathematica notebooks in the MathModelica environment, see Figure 10.1.

Traditional documents, e.g. books and reports, essentially always have a hierarchical structure. They are divided into sections, subsections, paragraphs, etc. Both the document itself and its sections usually have headings as labels for easier navigation. This kind of structure is also reflected in electronic notebooks. Every notebook corresponds to one document (one file) and contains a tree structure of cells. A cell can have different kinds of contents, and can even contain other cells. The notebook hierarchy of cells thus reflects the hierarchy of sections and subsections in a traditional document such as a book.

10.2 DrModelica Tutoring System – an Application of OMNotebook

Understanding programs is hard, especially code written by someone else. For educational purposes it is essential to be able to show the source code and to give an explanation of it at the same time.
Moreover, it is important to show the result of the source code’s execution. In modeling and simulation it is also important to have the source code, the documentation about the source code, the execution results of the simulation model, and the documentation of the simulation results in the same document. The reason is that the problem solving process in computational simulation is an iterative process that often requires a modification of the original mathematical model and its software implementation after the interpretation and validation of the computed results corresponding to an initial model.

Most of the environments associated with equation-based modeling languages focus more on providing efficient numerical algorithms rather than giving attention to the aspects that should facilitate the learning and teaching of the language. There is a need for an environment facilitating the learning and understanding of Modelica. These are the reasons for developing the DrModelica teaching material for Modelica and for teaching modeling and simulation.

An earlier version of DrModelica was developed using the MathModelica (now Wolfram SystemModeler) environment. The rest of this chapter is concerned with the OMNotebook version of DrModelica and on the OMNotebook tool itself.

DrModelica has a hierarchical structure represented as notebooks. The front-page notebook is similar to a table of contents that holds all other notebooks together by providing links to them. This particular notebook is the first page the user will see (Figure 10.2).

In each chapter of DrModelica the user is presented a short summary of the corresponding chapter of the Modelica book [Fri04]. The summary introduces some keywords, being hyperlinks that will lead the user to other notebooks describing the keywords in detail.

Now, let us consider that the link “HelloWorld” in DrModelica Section is clicked by the user. The new HelloWorld notebook (see Figure 10.3), to which the user is being linked, is not only a textual description but also contains one or more examples explaining the specific keyword. In this class, HelloWorld, a differential equation is specified.

No information in a notebook is fixed, which implies that the user can add, change, or remove anything in a notebook. Alternatively, the user can create an entirely new notebook in order to write his/her own programs or copy examples from other notebooks. This new notebook can be linked from existing notebooks.

When a class has been successfully evaluated the user can simulate and plot the result, as previously depicted in Figure 10.3 for the simple HelloWorld example model.

After reading a chapter in DrModelica the user can immediately practice the newly acquired information by doing the exercises that concern the specific chapter. Exercises have been written in order to elucidate language constructs step by step based on the pedagogical assumption that a student learns better “using the strategy of learning by doing”. The exercises consist of either theoretical questions or practical programming assignments. All exercises provide answers in order to give the user immediate feedback.

Figure 10.4 shows part of Chapter 9 of the DrModelica teaching material. Here the user can read about language constructs, like algorithm sections, when-statements, and reinit equations, and then practice these constructs by solving the exercises corresponding to the recently studied section.

Exercise 1 from Chapter 9 is shown in Figure 10.5. In this exercise the user has the opportunity to practice different language constructs and then compare the solution to the answer for the exercise. Notice that the answer is not
10.2. DrModelica Tutoring System – an Application of OMNotebook
First Basic Class

1 HelloWorld

The program contains a declaration of a class called HelloWorld with two fields and one equation. The first field is the variable x which is initialized to a start value 2 at the time when the simulation starts. The second field is the variable a, which is a constant that is initialized to 2 at the beginning of the simulation. Such a constant is prefixed by the keyword parameter in order to indicate that it is constant during simulation but is a model parameter that can be changed between simulations.

The Modelica program solves a trivial differential equation \( x' = -a \cdot x \). The variable x is a state variable that can change value over time. The \( x' \) is the time derivative of x.

```modelica
class HelloWorld
  Real x(start = 1, fixed=true);
  parameter Real a = 1;
  equation
dez(x) = -a \cdot x;
end HelloWorld;
```

2 Simulation of HelloWorld

```modelica
simulate( HelloWorld, startTime=0, stopTime=3 )
```

The results are plotted as shown.

Figure 10.3: The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica.
Algorithms and Functions

Algorithms

In Modelica, algorithmic statements can only occur within Algorithm Sections (p. 285), starting with the keyword algorithm. Simple Assignment Statements (p. 287) is the most common kind of statements in algorithm sections. There is a special form of assignment statement that is only used when the right hand side contains a call to a Function with Multiple Results (p. 287).

The for-Statement (also called for-loop) is a convenient way of expressing iteration (p. 288). When using the for-loop for iteration we must be able to express the range of values over which the iteration variable should iterate in a closed form as an iteration expression. For cases where this is not feasible there is also a While-loop iteration construct in Modelica (p. 290). For conditional expressions the if-Statement (p. 292) is used. When Statements (p. 293) are used to express actions at event instants and are closely related to when-equations. The ReInit (p. 296) statement can be used in when-statements to define new values for continuous-time state variables of a model at an event.

The Assert (p. 298) statement provides a convenient means for specifying checks on model validity within a model. The most common usage of Terminate (p. 298) is to give more appropriate stopping criteria for terminating a simulation than a fixed point in time.

Exercises

- Exercise 1
- Exercise 2
- Exercise 3
- Exercise 4
- Exercise 5

Functions

The body of a Modelica function is a kind of algorithm section that contains procedural algorithmic code to be executed when the function is Called (p. 300). Since a function is a restricted and enhanced kind of class it is possible to inherit an existing function.

Figure 10.4: DrModelica Chapter on Algorithms and Functions in the main page of the OMNotebook version of DrModelica.
Exercise 1

Using Algorithm Sections

Write a function `sum`, which calculates the sum of numbers in an array of arbitrary size.

Write a function `average`, which calculates the average of numbers in an array of arbitrary size. `Average` should use make a function call to `Sum`.

Write a class `LargestAverage`, that has two arrays and calculates the average of each of them. Then it compares the averages and sets a variable to true if the first array is larger than the second and otherwise false.

Answer

Figure 10.5: Exercise 1 in Chapter 9 of DrModelica.
10.3 DrControl Tutorial for Teaching Control Theory

DrControl is an interactive OMNotebook document aimed at teaching control theory. It is included in the OpenModelica distribution and appears under the directory:

```plaintext
>>> getInstallationDirectoryPath() + "./share/omnotebook/drcontrol"
"<OPENMODELICAHOME>/share/omnotebook/drcontrol"
```

The front-page of DrControl resembles a linked table of content that can be used as a navigation center. The content list contains topics like:

- Getting started
- The control problem in ordinary life
- Feedback loop
- Mathematical modeling
- Transfer function
- Stability
- Example of controlling a DC-motor
- Feedforward compensation
- State-space form
- State observation
- Closed loop control system.
- Reconstructed system
- Linear quadratic optimization
- Linearization

Each entry in this list leads to a new notebook page where either the theory is explained with Modelica examples or an exercise with a solution is provided to illustrate the background theory. Below we show a few sections of DrControl.

10.3.1 Feedback Loop

One of the basic concepts of control theory is using feedback loops either for neutralizing the disturbances from the surroundings or a desire for a smoother output.

In Figure 10.7, control of a simple car model is illustrated where the car velocity on a road is controlled, first with an open loop control, and then compared to a closed loop system with a feedback loop. The car has a mass $m$, velocity $y$, and aerodynamic coefficient $\alpha$. The $\theta$ is the road slope, which in this case can be regarded as noise.

Let's look at the Modelica model for the open loop controlled car:

$$m \dot{y} = u - \alpha y - mg \times \sin(\theta)$$

```plaintext
model noFeedback
    import SI = Modelica.SIunits;
    SI.Velocity y; // output signal without noise, theta = 0 -> v(t) = 0
    SI.Velocity yNoise; // output signal with noise, theta <> 0 -> v(t) <> 0
    ~theta = 0 -> v(t) = 0
    ~theta <> 0 -> v(t) <> 0

(continues on next page)
Figure 10.6: The answer section to Exercise 1 in Chapter 9 of DrModelica.
Feedback

One important method in designing control systems is a feedback loop. It can be used to eliminate the influence of noise or to decrease the output error.

![Feedback Diagram]

1 Example

Assume that we want to control the speed of a car on the road. The car has a mass \( m \), velocity \( v \), and aerodynamic coefficient \( \alpha \). The \( \theta \) is the road slope, which in this case can be regarded as noise.

\[
my = u - ay - mg \sin(\theta)
\]

If we want a reference speed of 20 m/s for a car with \( m=1500 \text{ kg} \), \( a=250 \text{ Ns/m} \), \( \theta=0 \text{ rad} \), how high should the amplification factor \( b \) be in the regulator?

Try with \( u = 250 * r \).

![Car Diagram]

1.1 Open Loop

```modelica
loadModel(Modelica)
true

model noFeedback
    import SI = Modelica.SIunits;
    SI.Velocity \( y \);
    SI.Velocity \( u \); // output signal without noise, theta = \( \theta \rightarrow v(t) = \theta \\
    SI.Velocity \( u \) // output signal with noise
```

Figure 10.7: Feedback loop.
parameter SI.Mass m = 1500;
parameter Real alpha = 200;
parameter SI.Angle theta = 5*3.141592/180;
parameter SI.Acceleration g = 9.82;
SI.Force u;
SI.Velocity r=20;
equation
m*der(y)=u-alpha*y; // signal without noise
m*der(yNoise)=u-alpha*yNoise-m*g*sin(theta); // with noise
u = 250*r;
end noFeedback;

By applying a road slope angle different from zero the car velocity is influenced which can be regarded as noise in this model. The output signal in Figure 10.8 is stable but an overshoot can be observed compared to the reference signal. Naturally the overshoot is not desired and the student will in the next exercise learn how to get rid of this undesired behavior of the system.

```plaintext
>>> loadModel(Modelica)
true
>>> simulate(noFeedback, stopTime=100)
record SimulationResult
  resultFile = "<DOCHOME>/noFeedback_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 100.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'noFeedback', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
",
  timeFrontend = 0.264135375,
  timeBackend = 0.006172201,
  timeSimCode = 0.063800334,
  timeTemplates = 0.033768851,
  timeCompile = 0.609952122,
  timeSimulation = 0.018244499,
  timeTotal = 0.9962558
end SimulationResult;
```

Warning:
Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").

The closed car model with a proportional regulator is shown below:

\[ u = K \times (r - y) \]

```plaintext
model withFeedback
  import SI = Modelica.SIunits;
  SI.Velocity y; // output signal with feedback
  SI.Velocity yNoise; // output signal with feedback
  link and without noise, theta = 0 \rightarrow v(t) = 0
  link and noise, theta <> 0 \rightarrow v(t) <> 0
  parameter SI.Mass m = 1500;
  parameter Real alpha = 250;
  parameter SI.Angle theta = 5*3.141592/180;
  parameter SI.Acceleration g = 9.82;
```
By using the information about the current level of the output signal and re-tune the regulator the output quantity can be controlled towards the reference signal smoothly and without an overshoot, as shown in Figure 10.9.

In the above simple example the flat modeling approach was adopted since it was the fastest one to quickly obtain a working model. However, one could use the object oriented approach and encapsulate the car and regulator models in separate classes with the Modelica connector mechanism in between.

```modelica
SI.Force u;
SI.Force uNoise;
SI.Velocity r=20;
equation
m*der(y)=u-alpha*y;
m*der(yNoise)=uNoise-alpha*yNoise-m*g*sin(theta);
u = 5000*(r-y);
uNoise = 5000*(r-yNoise);
end withFeedback;
```

```modelica
>>> loadModel(Modelica)
true
>>> simulate(withFeedback, stopTime=10)
record SimulationResult
  resultFile = "«DOCHOME»/withFeedback_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'withFeedback', options = "",
  outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '"
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully.
  "",
  timeFrontend = 0.3873690099999999,
  timeBackend = 0.00158821,
  timeSimCode = 0.050962706,
  timeTemplates = 0.028195222,
  timeCompile = 0.635962444,
  timeSimulation = 0.013934708,
  timeTotal = 1.121038145
end SimulationResult;
```
Warning:
Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").

![Figure 10.9: Closed loop control example.](image)

### 10.3.2 Mathematical Modeling with Characteristic Equations

In most systems the relation between the inputs and outputs can be described by a linear differential equation. Tearing apart the solution of the differential equation into homogenous and particular parts is an important technique taught to the students in engineering courses, also illustrated in Figure 10.10.

\[
\frac{\partial^n y}{\partial t^n} + a_1 \frac{\partial^{n-1} y}{\partial t^{n-1}} + \ldots + a_n y = b_0 \frac{\partial^m u}{\partial t^m} + \ldots + b_{m-1} \frac{\partial u}{\partial t} + b_m u
\]

Now let us examine a second order system:

\[
\ddot{y} + a_1 \dot{y} + a_2 y = 1
\]

```model NegRoots
Real y;
Real der_y;
parameter Real a1 = 3;
parameter Real a2 = 2;
equation
    der_y = deriv(y);
    deriv(der_y) + a1*der_y + a2*y = 1;
end NegRoots;
```

Choosing different values for \(a_1\) and \(a_2\) leads to different behavior as shown in Figure 10.11 and Figure 10.12. In the first example the values of \(a_1\) and \(a_2\) are chosen in such way that the characteristic equation has negative real roots and thereby a stable output response, see Figure 10.11.
Mathematical Modeling

In most systems the relation between the inputs and outputs can be approximated by a linear differential equation.

\[ \frac{d^n}{dt^n} y(t) + a_1 \frac{d^{n-1}}{dt^{n-1}} y(t) + \cdots + a_n y(t) = b_0 \frac{d^m}{dt^m} u(t) + \cdots + b_{m-1} \frac{d}{dt} u(t) + b_m u(t) \]

where the coefficients \( a_i \) and \( b_i \) are constants. The above differential equation has a homogeneous and a particular solution:

\[ y = y_h + y_p \]

The homogeneous solution where \( u \) is set to zero has the form:

\[ y_h = C_1 e^{\lambda_1 t} + \cdots + C_n e^{\lambda_n t} \]

where

\[ \lambda^n + a_1 \lambda^{n-1} + \cdots + a_{n-1} \lambda + a_n = 0 \]

1 Example

Consider the following model.

\[ \frac{d^2}{dt^2} y(t) + a_1 \frac{d}{dt} y(t) + a_2 y(t) = 1 \]

Examine the behavior of the system for different values of \( a_1 \) and \( a_2 \).

1.1 Characteristic Equation with Negative Real Roots, \( \lambda = -1, -2 \)

```model negRoots
Real y;
Real der_y;
parameter Real a1 = 3;
parameter Real a2 = 2;
equation
  der_y = der(y);
  der(der_y) + a1*der_y + a2*y = 1;
end negRoots;

{negRoots}
simulate(negRoots.stopTime=10)
```

Figure 10.10: Mathematical modeling with characteristic equation.
>>> simulate(NegRoots, stopTime=10)

record SimulationResult
  resultFile = "${DOCHOME}/NegRoots_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'NegRoots', options = '",
  outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '"
  messages = "LOG_SUCCESS | info | The initialization finished
  successfully without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully.
  ",
  timeFrontend = 0.372690795,
  timeBackend = 0.002394941,
  timeSimCode = 0.060649448,
  timeTemplates = 0.168385773,
  timeCompile = 0.57772209,
  timeSimulation = 0.017070522,
  timeTotal = 1.199095967
end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").

Figure 10.11: Characteristic equation with real negative roots.

The importance of the sign of the roots in the characteristic equation is illustrated in Figure 10.11 and Figure 10.12, e.g., a stable system with negative real roots and an unstable system with positive imaginary roots resulting in oscillations.

model ImgPosRoots
  Real y;
  Real der_y;
  parameter Real a1 = -2;
  parameter Real a2 = 10;
  equation
    der_y = derivative(y);
(continues on next page)
der(der_y) + a1*der_y + a2*y = 1;
end ImgPosRoots;

>>> simulate(ImgPosRoots, stopTime=10)
record SimulationResult
  resultFile = "«DOCHOME»/ImgPosRoots_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
    tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'ImgPosRoots', options = ' kị",
    outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '***",
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method."
  LOG_SUCCESS | info | The simulation finished successfully.
  timeFrontend = 0.215956436,
  timeBackend = 0.002446835,
  timeSimCode = 0.05109598999999998,
  timeTemplates = 0.02853908,
  timeCompile = 0.6104581840000001,
  timeSimulation = 0.015496896,
  timeTotal = 0.924136094
end SimulationResult;

Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization").

Figure 10.12: Characteristic equation with imaginary roots with positive real part.

The theory and application of Kalman filters is also explained in the interactive course material.

In reality noise is present in almost every physical system under study and therefore the concept of noise is also introduced in the course material, which is purely Modelica based.
1 Example

Consider a tank system with the following transfer function

\[ G(s) = \frac{1}{s + \frac{1}{T}} \]

What is the weight function? Can you plot the step response of the tank?

1.1 Tank Transfer Function

```modelica
loadModel(Modelica.Blocks)

model Tank
    Modelica.Blocks.Continuous.TransferFunction G(b=[1/A],
a=[1,1/T], y_start(fixed=true)=1/A);
    Modelica.Blocks.Continuous.TransferFunction GStep(b=[1/A], a=[1,1/T]);
    parameter Real T = 10;
    parameter Real A = 8;
    Real u = if (time > 0 or time<0) then 0 else Modelica.Constants.inf;
    Real uStep = if (time > 0 or time<0) then 1 else 0;
    equation
        G.u = if time > 0 then 0 else 1e10;
        GStep.u = uStep;
    end Tank;
end Tank;
```

simulate(Tank,startTime=-1e-10,numberOfIntervals=500,stopTime=10);
plot({G.y,GStep.y})

Figure 10.13: Step and pulse (weight function) response.
1 Kalman Filter

Often we don’t have access to the internal states of a system and can only measure the outputs of the system and have to reconstruct the state of the system based on these measurements. This is normally done with an observer. The idea with an observer is that we feedback the difference of the measured output with the estimated output. If the estimation is correct then the difference should be zero.

Another difficulty is that the measured quantities often contain disturbance, i.e. noise.

\[
\begin{align*}
\dot{x} &= A\dot{x} + Bu + e \\
\dot{y} &= C\dot{x} + v
\end{align*}
\]

Here are \( e \) denoting a disturbance in the input signal and \( v \) is a measurement error. The quality of the estimate can be evaluated by the difference

\[ K(y(t) - C\hat{x}(t) - Du(t)) \]

By using this quantity as feedback we obtain the observer

\[ \dot{x} = A\hat{x}(t) + Bu(t) + K(y(t) - C\hat{x}(t) - Du(t)) \]

Now form the error as

\[ \hat{x} = x - \hat{x} \]

The differential error is

Figure 10.14: Theory background about Kalman filter.

Figure 10.15: Comparison of a noisy system with feedback link in DrControl.
10.4 OpenModelica Notebook Commands

OMNotebook currently supports the commands and concepts that are described in this section.

10.4.1 Cells

Everything inside an OMNotebook document is made out of cells. A cell basically contains a chunk of data. That data can be text, images, or other cells. OMNotebook has four types of cells: headercell, textcell, inputcell, and groupcell. Cells are ordered in a tree structure, where one cell can be a parent to one or more additional cells. A tree view is available close to the right border in the notebook window to display the relation between the cells.

- **Textcell** – This cell type is used to display ordinary text and images. Each textcell has a style that specifies how text is displayed. The cell’s style can be changed in the menu Format->Styles, example of different styles are: Text, Title, and Subtitle. The Textcell type also has support for following links to other notebook documents.

- **Inputcell** – This cell type has support for syntax highlighting and evaluation. It is intended to be used for writing program code, e.g. Modelica code. Evaluation is done by pressing the key combination Shift+Return or Shift+Enter. All the text in the cell is sent to OMC (OpenModelica Compiler/interpreter), where the text is evaluated and the result is displayed below the inputcell. By double-clicking on the cell marker in the tree view, the inputcell can be collapsed causing the result to be hidden.

- **Latexcell** – This cell type has support for evaluation of latex scripts. It is intended to be mainly used for writing mathematical equations and formulas for advanced documentation in OMNotebook. Each Latexcell supports a maximum of one page document output. To evaluate this cell, latex must be installed in your system. The users can copy and paste the latex scripts and start the evaluation. Evaluation is done by pressing the key combination Shift+Return or Shift+Enter or the green color eval button present in the toolbar. The script in the cell is sent to latex compiler, where it is evaluated and the output is displayed hiding the latex source. By double-clicking on the cell marker in the tree view, the latex source is displayed for further modification.

- **Groupcell** – This cell type is used to group together other cell. A groupcell can be opened or closed. When a groupcell is opened all the cells inside the groupcell are visible, but when the groupcell is closed only the first cell inside the groupcell is visible. The state of the groupcell is changed by the user double-clicking on the cell marker in the tree view. When the groupcell is closed the marker is changed and the marker has an arrow at the bottom.

10.4.2 Cursors

An OMNotebook document contains cells which in turn contain text. Thus, two kinds of cursors are needed for positioning, text cursor and cell cursor:

- **Textcursor** – A cursor between characters in a cell, appearing as a small vertical line. Position the cursor by clicking on the text or using the arrow buttons.

- **Cellcursor** – This cursor shows which cell currently has the input focus. It consists of two parts. The main cellcursor is basically just a thin black horizontal line below the cell with input focus. The cellcursor is positioned by clicking on a cell, clicking between cells, or using the menu item Cell->Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination Ctrl+Up or Ctrl+Down. The dynamic cellcursor is a short blinking horizontal line. To make this visible, you must click once more on the main cellcursor (the long horizontal line). NOTE: In order to paste cells at the cellcursor, the dynamic cellcursor must be made active by clicking on the main cellcursor (the horizontal line).

10.4.3 Selection of Text or Cells

To perform operations on text or cells we often need to select a range of characters or cells.
• **Select characters** – There are several ways of selecting characters, e.g. double-clicking on a word, clicking and dragging the mouse, or click followed by a shift-click at an adjacent position selects the text between the previous click and the position of the most recent shift-click.

• **Select cells** – *Cells can be selected by clicking on them.* **Holding** down Ctrl and clicking on the cell markers in the tree view allows several cells to be selected, one at a time. Several cells can be selected at once in the tree view by holding down the Shift key. **Holding** down Shift selects all cells between last selected cell and the cell clicked on. This only works if both cells belong to the same groupcell.

### 10.4.4 File Menu

The following file related operations are available in the file menu:

• **Create a new notebook** – A new notebook can be created using the menu File->New or the key combination Ctrl+N. A new document window will then open, with a new document inside.

• **Open a notebook** – To open a notebook use File->Open in the menu or the key combination Ctrl+O. Only files of the type .onb or .nb can be opened. If a file does not follow the OMNotebook format or the FullForm Mathematica Notebook format, a message box is displayed telling the user what is wrong. Mathematica Notebooks must be converted to fullform before they can be opened in OMNotebook.

• **Save a notebook** – To save a notebook use the menu item File->Save or File->Save As. If the notebook has not been saved before the save as dialog is shown and a filename can be selected. OMNotebook can only save in xml format and the saved file is not compatible with Mathematica. Key combination for save is Ctrl+S and for save as Ctrl+Shift+S. The saved file by default obtains the file extension .onb.

• **Print** – Printing a document to a printer is done by pressing the key combination Ctrl+P or using the menu item File->Print. A normal print dialog is displayed where the usually properties can be changed.

• **Import old document** – Old documents, saved with the old version of OMNotebook where a different file format was used, can be opened using the menu item File->Import->Old OMNotebook file. Old documents have the extension .xml.

• **Export text** – The text inside a document can be exported to a text document. The text is exported to this document without almost any structure saved. The only structure that is saved is the cell structure. Each paragraph in the text document will contain text from one cell. To use the export function, use menu item File->Export->Pure Text.

• **Close a notebook window** – A notebook window can be closed using the menu item File->Close or the key combination Ctrl+F4. Any unsaved changes in the document are lost when the notebook window is closed.

• **Quitting OMNotebook** – To quit OMNotebook, use menu item File->Quit or the key combination Ctrl+Q. This closes all notebook windows; users will have the option of closing OMC also. OMC will not automatically shutdown because other programs may still use it. Evaluating the command quit() has the same result as exiting OMNotebook.

### 10.4.5 Edit Menu

• **Editing cell text** – Cells have a set of basic editing functions. The key combination for these are: Undo (Ctrl+Z), Redo (Ctrl+Y), Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions can also be accessed from the edit menu: Undo (Edit->Undo), Redo (Edit->Redo), Cut (Edit->Cut), Copy (Edit->Copy) and Paste (Edit->Paste). Selection of text is done in the usual way by double-clicking, triple-clicking (select a paragraph), dragging the mouse, or using (Ctrl+A) to select all text within the cell.

• **Cut cell** – *Cells can be cut from a document with the menu item* Edit->Cut or the key combination Ctrl+X. The cut function will always cut cells if cells have been selected in the tree view, otherwise the cut function cuts text.
• **Copy cell** – Cells can be copied from a document with the menu item Edit->Copy or the key combination Ctrl+C. The copy function will always copy cells if cells have been selected in the tree view, otherwise the copy function copy text.

• **Paste cell** – To paste copied or cut cells the cell cursor must be selected in the location where the cells should be pasted. This is done by clicking on the cell cursor. Pasting cells is done from the menu Edit->Paste or the key combination Ctrl+V. If the cell cursor is selected the paste function will always paste cells. OMNotebook share the same application-wide clipboard. Therefore cells that have been copied from one document can be pasted into another document. Only pointers to the copied or cut cells are added to the clipboard, thus the cell that should be pasted must still exist. Consequently a cell can not be pasted from a document that has been closed.

• **Find** – Find text string in the current notebook, with the options match full word, match cell, search within closed cells. Short command Ctrl+F.

• **Replace** – Find and replace text string in the current notebook, with the options match full word, match cell, search+replace within closed cells. Short command Ctrl+H.

• **View expression** – Text in a cell is stored internally as a subset of HTML code and the menu item Edit->View Expression let the user switch between viewing the text or the internal HTML representation. Changes made to the HTML code will affect how the text is displayed.

### 10.4.6 Cell Menu

• **Add textcell** – A new textcell is added with the menu item Cell->Add Cell (previous cell style) or the key combination Alt+Enter. The new textcell gets the same style as the previous selected cell had.

• **Add inputcell** – A new inputcell is added with the menu item Cell->Add Inputcell or the key combination Ctrl+Shift+I.

• **Add latexcell** – A new latexcell is added with the menu item Cell->Add Latexcell or the key combination Ctrl+Shift+E.

• **Add groupcell** – A new groupcell is inserted with the menu item Cell->Groupcell or the key combination Ctrl+Shift+G. The selected cell will then become the first cell inside the groupcell.

• **Ungroup groupcell** – A groupcell can be ungrouped by selecting it in the tree view and using the menu item Cell->Ungroup Groupcell or by using the key combination Ctrl+Shift+U. Only one groupcell at a time can be ungrouped.

• **Split cell** – Spliting a cell is done with the menu item Cell->Split cell or the key combination Ctrl+Shift+P. The cell is split at the position of the text cursor.

• **Delete cell** – The menu item Cell->Delete Cell will delete all cells that have been selected in the tree view. If no cell is selected this action will delete the cell that have been selected by the cellcursor. This action can also be called with the key combination Ctrl+Shift+D or the key Del (only works when cells have been selected in the tree view).

• **Cellcursor** – This cell type is a special type that shows which cell that currently has the focus. The cell is basically just a thin black line. The cellcursor is moved by clicking on a cell or using the menu item Cell->Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination Ctrl+Up or Ctrl+Down.

### 10.4.7 Format Menu

• **Textcell** – This cell type is used to display ordinary text and images. Each textcell has a style that specifies how text is displayed. The cells style can be changed in the menu Format->Styles, examples of different styles are: Text, Title, and Subtitle. The Textcell type also have support for following links to other notebook documents.

• **Text manipulation** – There are a number of different text manipulations that can be done to change the appearance of the text. These manipulations include operations like: changing font, changing color
and make text bold, but also operations like: changing the alignment of the text and the margin inside the cell. All text manipulations inside a cell can be done on single letters, words or the entire text. Text settings are found in the Format menu. The following text manipulations are available in OMNotebook:

- Font family
- Font face (Plain, Bold, Italic, Underline)
- Font size
- Font stretch
- Font color
- Text horizontal alignment
- Text vertical alignment
- Margin (outside the border)
- Padding (inside the border)

10.4.8 Insert Menu

- Insert image – Images are added to a document with the menu item Insert->Image or the key combination Ctrl+Shift+M. After an image has been selected a dialog appears, where the size of the image can be chosen. The images actual size is the default value of the image. OMNotebook stretches the image accordingly to the selected size. All images are saved in the same file as the rest of the document.

- Insert link – A document can contain links to other OMNotebook file or Mathematica notebook and to add a new link a piece of text must first be selected. The selected text make up the part of the link that the user can click on. Inserting a link is done from the menu Insert->Link or with the key combination Ctrl+Shift+L. A dialog window, much like the one used to open documents, allows the user to choose the file that the link refers to. All links are saved in the document with a relative file path so documents that belong together easily can be moved from one place to another without the links failing.

10.4.9 Window Menu

- Change window – Each opened document has its own document window. To switch between those use the Window menu. The window menu lists all titles of the open documents, in the same order as they were opened. To switch to another document, simple click on the title of that document.

10.4.10 Help Menu

- About OMNotebook – Accessing the about message box for OMNotebook is done from the menu Help->About OMNotebook.

- About Qt – To access the message box for Qt, use the menu Help->About Qt.

- Help Text – Opening the help text (document OMNotebookHelp.onb) for OMNotebook can be done in the same way as any OMNotebook document is opened or with the menu Help->Help Text. The menu item can also be triggered with the key F1.

10.4.11 Additional Features

- Links – By clicking on a link, OMNotebook will open the document that is referred to in the link.
• **Update link** – All links are stored with relative file path. Therefore OMNotebook has functions that automatically updating links if a document is resaved in another folder. Every time a document is saved, OMNotebook checks if the document is saved in the same folder as last time. If the folder has changed, the links are updated.

• **Evaluate whole Notebook** – All the cells present in the Notebook can be evaluated in one step by pressing the red color evalall button in the toolbar. The cells are evaluated in the same order as they are in the Notebook. However the latexcells cannot be evaluated by this feature.

• **Evaluate several cells** – Several inputcells can be evaluated at the same time by selecting them in the treeview and then pressing the key combination Shift+Enter or Shift+Return. The cells are evaluated in the same order as they have been selected. If a groupcell is selected all inputcells in that groupcell are evaluated, in the order they are located in the groupcell.

• **Moving and Reordering cells in a Notebook** – It is possible to shift cells to a new position and change the hierarchical order of the document. This can be done by clicking the cell and press the Up and Down arrow button in the tool bar to move either Up or Down. The cells are moved one cell above or below. It is also possible to move a cell directly to a new position with one single click by pressing the red color bidirectional UpDown arrow button in the toolbar. To do this the user has to place the cell cursor to a position where the selected cells must be moved. After selecting the cell cursor position, select the cells you want to shift and press the bidirectional UpDown arrow button. The cells are shifted in the same order as they are selected. This is especially very useful when shifting a group cell.

• **Command completion** – Inputcells have command completion support, which checks if the user is typing a command (or any keyword defined in the file commands.xml) and finish the command. If the user types the first two or three letters in a command, the command completion function fills in the rest. To use command completion, press the key combination Ctrl+Space or Shift+Tab. The first command that matches the letters written will then appear. Holding down Shift and pressing Tab (alternative holding down Ctrl and pressing Space) again will display the second command that matches. Repeated request to use command completion will loop through all commands that match the letters written. When a command is displayed by the command completion functionality any field inside the command that should be edited by the user is automatically selected. Some commands can have several of these fields and by pressing the key combination Ctrl+Tab, the next field will be selected inside the command. 

  > Active Command completion: Ctrl+Space / Shift+Tab > Next command: Ctrl+Space / Shift+Tab > Next field in command: Ctrl+Tab’

• **Generated plot** – When plotting a simulation result, OMC uses the program Ptplot to create a plot. From Ptplot OMNotebook gets an image of the plot and automatically adds that image to the output part of an inputcell. Like all other images in a document, the plot is saved in the document file when the document is saved.

• **Stylesheet** – OMNotebook follows the style settings defined in stylesheet.xml and the correct style is applied to a cell when the cell is created.

• **Automatic Chapter Numbering** – OMNotebook automatically numbers different chapter, subchapter, section and other styles. The user can specify which styles should have chapter numbers and which level the style should have. This is done in the stylesheet.xml file. Every style can have a <chapter-Level> tag that specifies the chapter level. Level 0 or no tag at all, means that the style should not have any chapter numbering.

• **Scrollarea** – Scrolling through a document can be done by using the mouse wheel. A document can also be scrolled by moving the cell cursor up or down.

• **Syntax highlighter** – The syntax highlighter runs in a separated thread which speeds up the loading of large document that contains many Modelica code cells. The syntax highlighter only highlights when letters are added, not when they are removed. The color settings for the different types of keywords are stored in the file modelicacolors.xml. Besides defining the text color and background color of keywords, whether or not the keywords should be bold or/and italic can be defined.

• **Change indicator** – A star (*) will appear behind the filename in the title of notebook window if the document has been changed and needs saving. When the user closes a document that has some unsaved change, OMNotebook asks the user if he/she wants to save the document before closing. If the
document never has been saved before, the save-as dialog appears so that a filename can be choosen for the new document.

- **Update menus** – All menus are constantly updated so that only menu items that are linked to actions that can be performed on the currently selected cell is enabled. All other menu items will be disabled. When a textcell is selected the Format menu is updated so that it indicates the text settings for the text, in the current cursor position.

10.5 References

Todo: Add these into extrarefs.bib and cite them somewhere


The following facilities for model-based optimization are provided with OpenModelica:

- **Built-in Dynamic Optimization with OpenModelica and IpOpt** using dynamic optimization is the recommended way of performing dynamic optimization with OpenModelica.
- **Dynamic Optimization with OpenModelica and CasADi**. Use this if you want to employ the CasADi tool for dynamic optimization.
- **Classical Parameter Sweep Optimization using OMOptim**. Use this if you have a static optimization problem.

### 11.1 Built-in Dynamic Optimization with OpenModelica and IpOpt

*Note: this is a very short preliminary description which soon will be considerably improved.*

OpenModelica provides built-in dynamic optimization of models by using the powerful symbolic machinery of the OpenModelica compiler for more efficient and automatic solution of dynamic optimization problems.

The built-in dynamic optimization allows users to define optimal control problems (OCP) using the Modelica language for the model and the optimization language extension called Optimica (currently partially supported) for the optimization part of the problem. This is used to solve the underlying dynamic optimization model formulation using collocation methods, using a single execution instead of multiple simulations as in the parameter-sweep optimization described in section **Parameter Sweep Optimization using OMOptim**.

For more detailed information regarding background and methods, see [BOR+12][RBB+14]

### 11.2 Compiling the Modelica code

Before starting the optimization the model should be symbolically instantiated by the compiler in order to get a single flat system of equations. The model variables should also be scalarized. The compiler frontend performs this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are applied. Then the complete flattened model can be used for initialization, simulation and last but not least for model-based dynamic optimization.

The OpenModelica command optimize(ModelName) from OMShell, OMNotebook or MDT runs immediately the optimization. The generated result file can be read in and visualized with OMEdit or within OMNotebook.

### 11.3 An Example

In this section, a simple optimal control problem will be solved. When formulating the optimization problems, models are expressed in the Modelica language and optimization specifications. The optimization language specification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It includes several constructs including a new specialized class optimization, a constraint section, startTime, finalTime etc. See the optimal control problem for batch reactor model below.
Create a new file named `BatchReactor.mo` and save it in your working directory. Notice that this model contains both the dynamic system to be optimized and the optimization specification.

Once we have formulated the underlying optimal control problems, we can run the optimization by using OMShell, OMNotebook, MDT, OMEdit using command line terminals similar to the options described below:

```plaintext
>>> setCommandLineOptions("-g=Optimica");

Listing 11.1: BatchReactor.mo

```

```plaintext
model BatchReactor
  Real x1(start = 1, fixed=true, min=0, max=1);
  Real x2(start = 0, fixed=true, min=0, max=1);
  input Real u(min=0, max=5);
equation
  der(x1) = -(u+u^2/2)*x1;
  der(x2) = u*x1;
end BatchReactor

optimization nmpcBatchReactor(objective=-x2)
  extends BatchReactor;
end nmpcBatchReactor

>>> optimize(nmpcBatchReactor, numberOfIntervals=16, stopTime=1, tolerance=1e-8)

record SimulationResult
  resultFile = "DOCHOME/nmpcBatchReactor_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 16,",
  tolerance = 1e-08, method = 'optimization', fileNamePrefix = 'nmpcBatchReactor',",
  options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '',
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.

Optimizer Variables

| State[0]:x1(start = 1, nominal = 1, min = 0, max = 1, init = 1) |
| State[1]:x2(start = 0, nominal = 1, min = 0, max = 1, init = 0) |
| Input[2]:u(start = 0, nominal = 5, min = 0, max = 5) |

number of nonlinear constraints: 0

This program contains Ipopt, a library for large-scale nonlinear optimization.
Ipopt is released as open source code under the Eclipse Public License (EPL).
For more information visit http://projects.coin-or.org/Ipopt

LOG_SUCCESS | info | The simulation finished successfully.
```

The control and state trajectories of the optimization results:

The control and state trajectories of the optimization results:
Figure 11.1: Optimization results for Batch Reactor model – input variables.

Figure 11.2: Optimization results for Batch Reactor model – state variables.
11.4 Different Options for the Optimizer IPOPT

Table 11.1: New meanings of the usual simulation options for Ipopt.

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>numberOfIntervals</td>
<td>collocation intervals</td>
</tr>
<tr>
<td>startTime, stopTime</td>
<td>time horizon</td>
</tr>
<tr>
<td>tolerance = 1e-8</td>
<td>e.g. 1e-8</td>
</tr>
<tr>
<td>simflags</td>
<td>all run/debug options</td>
</tr>
</tbody>
</table>

Table 11.2: New simulation options for Ipopt.

<table>
<thead>
<tr>
<th>Option</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>-lv</td>
<td>LOG_IPOPT</td>
</tr>
<tr>
<td>-ipopt_hesse</td>
<td>CONST,BFGS,NUM</td>
</tr>
<tr>
<td>-ipopt_max_iter</td>
<td>number e.g. 10</td>
</tr>
<tr>
<td>externalInput.csv</td>
<td>input guess</td>
</tr>
</tbody>
</table>

11.5 Dynamic Optimization with OpenModelica and CasADi

OpenModelica coupling with CasADi supports dynamic optimization of models by OpenModelica exporting the optimization problem to CasADi which performs the optimization. In order to convey the dynamic system model information between Modelica and CasADi, we use an XML-based model exchange format for differential-algebraic equations (DAE). OpenModelica supports export of models written in Modelica and the Optimization language extension using this XML format, while CasADi supports import of models represented in this format. This allows users to define optimal control problems (OCP) using Modelica and Optimization language specifications, and solve the underlying model formulation using a range of optimization methods, including direct collocation and direct multiple shooting.

11.5.1 Compiling the Modelica code

Before exporting a model to XML, the model should be symbolically instantiated by the compiler in order to get a single flat system of equations. The model variables should also be scalarized. The compiler frontend performs this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are applied. Then the complete flattened model is exported to XML code. The exported XML document can then be imported to CasADi for model-based dynamic optimization.

The OpenModelica command translateModelXML(ModelName) from OMShell, OMNotebook or MDT exports the XML. The export XML command is also integrated with OMEdit. Select XML > Export XML the XML document is generated in the current directory of omc. You can use the cd() command to see the current location. After the command execution is complete you will see that a file ModelName.xml has been exported.

Assuming that the model is defined in the modelName.mo, the model can also be exported to an XML code using the following steps from the terminal window:

- Go to the path where your model file found
- Run command omc -g=Optimica -simCodeTarget=XML Model.mo

11.5.2 An example

In this section, a simple optimal control problem will be solved. When formulating the optimization problems, models are expressed in the Modelica language and optimization specifications. The optimization language specification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It
includes several constructs including a new specialized class optimization, a constraint section, startTime, final-Time etc. See the optimal control problem for batch reactor model below.

Create a new file named `BatchReactor.mo` and save it in your working directory. Notice that this model contains both the dynamic system to be optimized and the optimization specification.

```model BatchReactor
  Real x1(start = 1, fixed = true, min = 0, max = 1);
  Real x2(start = 0, fixed = true, min = 0, max = 1);
  input Real u(min = 0, max = 5);

  equation
    der(x1) = -(u + u ^ 2 / 2) * x1;
    der(x2) = u * x1;
end BatchReactor;
```

One we have formulated the underlying optimal control problems, we can export the XML by using OMSHELL, OMNotebook, MDT, OMEdit or command line terminals which are described in Section XML Import to CasADi via OpenModelica Python Script.

To export XML, we set the simulation target to XML:

```bash
>>> translateModelXML(BatchReactor)
"<DOCHOME>/BatchReactor.xml"
```

This will generate an XML file named `BatchReactor.xml` (Listing 11.2) that contains a symbolic representation of the optimal control problem and can be inspected in a standard XML editor.

Listing 11.2: BatchReactor.xml

```xml
<?xml version="1.0" encoding="UTF-8"?>
<OpenModelicaModelDescription
 xmlns:exp="https://svn.jmodelica.org/trunk/XML/daeExpressions.xsd"
 xmlns:equ="https://svn.jmodelica.org/trunk/XML/daeEquations.xsd"
 xmlns:fun="https://svn.jmodelica.org/trunk/XML/daeFunctions.xsd"
 xmlns:opt="https://svn.jmodelica.org/trunk/XML/daeOptimization.xsd"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"
 fmiVersion="1.0"
 modelName="BatchReactor"
 modelIdentifier="BatchReactor"
 guid="{8c4e810f-3df3-4a00-8276-176fa3c9f9e0}"
 generationDateAndTime="2019-01-31T15:20:00"
 variableNamingConvention="structured"
 numberOfContinuousStates="2"
 numberOfEventIndicators="0"
>

<VendorAnnotations>
  <Tool name="OpenModelica Compiler OMCompiler v1.13.2"> </Tool>
</VendorAnnotations>

<ModelVariables>
  <ScalarVariable name="x1" valueReference="0" variability="continuous"
  causality="internal" alias="noAlias">
    <Real start="1.0" fixed="true" min="0.0" max="1.0" />
  </ScalarVariable>
</ModelVariables>
```
<ScalarVariable name="x2" valueReference="1" variability="continuous" causality="internal" alias="noAlias">
  <Real start="0.0" fixed="true" min="0.0" max="1.0" />
  <QualifiedName>
    <exp:QualifiedNamePart name="x2"/>
  </QualifiedName>
  <isLinearTimedVariables>
    <TimePoint index="0" isLinear="true"/>
  </isLinearTimedVariables>
  <VariableCategory>state</VariableCategory>
</ScalarVariable>

<ScalarVariable name="der(x1)" valueReference="2" variability="continuous" causality="internal" alias="noAlias">
  <Real />
  <QualifiedName>
    <exp:QualifiedNamePart name="x1"/>
  </QualifiedName>
  <isLinearTimedVariables>
    <TimePoint index="0" isLinear="true"/>
  </isLinearTimedVariables>
  <VariableCategory>derivative</VariableCategory>
</ScalarVariable>

<ScalarVariable name="der(x2)" valueReference="3" variability="continuous" causality="internal" alias="noAlias">
  <Real />
  <QualifiedName>
    <exp:QualifiedNamePart name="x2"/>
  </QualifiedName>
  <isLinearTimedVariables>
    <TimePoint index="0" isLinear="true"/>
  </isLinearTimedVariables>
  <VariableCategory>derivative</VariableCategory>
</ScalarVariable>

<ScalarVariable name="u" valueReference="4" variability="continuous" causality="input" alias="noAlias">
  <Real min="0.0" max="5.0" />
  <QualifiedName>
    <exp:QualifiedNamePart name="u"/>
  </QualifiedName>
  <isLinearTimedVariables>
    <TimePoint index="0" isLinear="true"/>
  </isLinearTimedVariables>
  <VariableCategory>algebraic</VariableCategory>
</ScalarVariable>

</ModelVariables>

<equ:BindingEquations>
</equ:BindingEquations>

<equ:DynamicEquations>
<equ:Equation>
  <exp:Sub>
    <exp:Der>
      <exp:Identifier>
        <exp:QualifiedNamePart name="x2"/>
      </exp:Identifier>
    </exp:Der>
    <exp:Mul>
      <exp:Identifier>
        <exp:QualifiedNamePart name="x2"/>
      </exp:Identifier>
    </exp:Mul>
  </exp:Sub>
</equ:Equation>
</equ:DynamicEquations>
\begin{verbatim}
<exp:Identifier>
  <exp:QualifiedNamePart name="u"/>
</exp:Identifier>
<exp:Identifier>
  <exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
<exp:Mul>
  <exp:Sub>
    <exp:Der>
      <exp:Identifier>
        <exp:QualifiedNamePart name="x1"/>
      </exp:Identifier>
      <exp:Mul>
        <exp:Sub>
          <exp:Mul>
            <exp:RealLiteral>-0.5</exp:RealLiteral>
            <exp:Pow>
              <exp:Identifier>
                <exp:QualifiedNamePart name="u"/>
              </exp:Identifier>
              <exp:RealLiteral>2.0</exp:RealLiteral>
            </exp:Pow>
          </exp:Mul>
          <exp:Identifier>
            <exp:QualifiedNamePart name="u"/>
          </exp:Identifier>
        </exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
      </exp:Sub>
      <exp:Sub>
        <exp:Mul>
          <exp:RealLiteral>-0.5</exp:RealLiteral>
          <exp:Pow>
            <exp:Identifier>
              <exp:QualifiedNamePart name="u"/>
            </exp:Identifier>
            <exp:RealLiteral>2.0</exp:RealLiteral>
          </exp:Pow>
        </exp:Mul>
        <exp:Identifier>
          <exp:QualifiedNamePart name="u"/>
        </exp:Identifier>
      </exp:Sub>
    </exp:Der>
    <exp:Sub>
      <exp:Mul>
        <exp:Sub>
          <exp:Mul>
            <exp:RealLiteral>1.0</exp:RealLiteral>
            <exp:RealLiteral>1.0</exp:RealLiteral>
          </exp:Sub>
          <exp:Identifier>
            <exp:QualifiedNamePart name="x1"/>
          </exp:Identifier>
        </exp:Mul>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x1"/>
        </exp:Identifier>
      </exp:Sub>
    </exp:Sub>
  </exp:Der>
  <exp:Sub>
    <exp:Mul>
      <exp:Sub>
        <exp:Mul>
          <exp:RealLiteral>0.0</exp:RealLiteral>
          <exp:RealLiteral>0.0</exp:RealLiteral>
        </exp:Sub>
        <exp:Identifier>
          <exp:QualifiedNamePart name="x2"/>
        </exp:Identifier>
      </exp:Mul>
      <exp:Identifier>
        <exp:QualifiedNamePart name="x2"/>
      </exp:Identifier>
    </exp:Sub>
  </exp:Sub>
</equ:Equation>
<equ:InitialEquations>
<equ:Equation>
  <exp:Sub>
    <exp:Identifier>
      <exp:QualifiedNamePart name="x1"/>
    </exp:Identifier>
    <exp:RealLiteral>1.0</exp:RealLiteral>
  </exp:Sub>
</equ:Equation>
<equ:Equation>
  <exp:Sub>
    <exp:Identifier>
      <exp:QualifiedNamePart name="x2"/>
    </exp:Identifier>
    <exp:RealLiteral>0.0</exp:RealLiteral>
  </exp:Sub>
</equ:Equation>
<equ:InitialEquations>
<equ:Equation>
  <exp:Sub>
    <exp:Identifier>
      <exp:QualifiedNamePart name="x1"/>
    </exp:Identifier>
    <exp:RealLiteral>1.0</exp:RealLiteral>
  </exp:Sub>
</equ:Equation>
<equ:Equation>
  <exp:Sub>
    <exp:Identifier>
      <exp:QualifiedNamePart name="x2"/>
    </exp:Identifier>
    <exp:RealLiteral>0.0</exp:RealLiteral>
  </exp:Sub>
</equ:Equation>
<equ:InitialEquations>
</equ:InitialEquations>
</equ:DynamicEquations>
\end{verbatim}
11.5.3 XML Import to CasADi via OpenModelica Python Script

The symbolic optimal control problem representation (or just model description) contained in BatchReactor.xml can be imported into CasADi in the form of the SymbolicOCP class via OpenModelica python script.

The SymbolicOCP class contains symbolic representation of the optimal control problem designed to be general and allow manipulation. For a more detailed description of this class and its functionalities, we refer to the API documentation of CasADi.

The following step compiles the model to an XML format, imports to CasADi and solves an optimization problem in windows PowerShell:
1. Create a new file named BatchReactor.mo and save it in your working directory.  
   E.g. C:\OpenModelica\1.9.2\share\casadi\testmodel

1. Perform compilation and generate the XML file  
   a. Go to your working directory  
   E.g. cd C:\OpenModelica\1.9.2\share\casadi\testmodel  
   a. Go to omc path from working directory and run the following command  
   E.g. ..\..\..\..\bin\omc +s -g=Optimica –simCodeTarget=XML BatchReactor.mo

3. Run defaultStart.py python script from OpenModelica optimization directory  
   E.g. Python.exe ..\share\casadi\scripts defaultStart.py BatchReactor.xml

The control and state trajectories of the optimization results are shown below:

11.6 Parameter Sweep Optimization using OMOptim

OMOptim is a tool for parameter sweep design optimization of Modelica models. By optimization, one should understand a procedure which minimizes/maximizes one or more objective functions by adjusting one or more parameters. This is done by the optimization algorithm performing a parameter sweep, i.e., systematically adjusting values of selected parameters and running a number of simulations for different parameter combinations to find a parameter setting that gives an optimal value of the goal function.

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow optimizing all sorts of models with following functionalities:

- One or several objectives optimized simultaneously
- One or several parameters (integer or real variables)

However, the user must be aware of the large number of simulations an optimization might require.

11.6.1 Preparing the Model

Before launching OMOptim, one must prepare the model in order to optimize it.

**Parameters**

An optimization parameter is picked up from all model variables. The choice of parameters can be done using the OMOptim interface.

For all intended parameters, please note that:
• **The corresponding variable is constant during all simulations.** The OMOptim optimization in version 0.9 only concerns static parameters’ optimization *i.e.* values found for these parameters will be constant during all simulation time.

• **The corresponding variable should play an input role in the model** *i.e.* its modification influences model simulation results.

**Constraints**

If some constraints should be respected during optimization, they must be defined in the Modelica model itself. For instance, if mechanical stress must be less than 5 N.m\(^{-2}\), one should write in the model:

```modelica
assert(mechanicalStress < 5, "Mechanical stress too high");
```

If during simulation, the variable `mechanicalStress` exceeds 5 N.m\(^{-2}\), the simulation will stop and be considered as a failure.

**Objectives**

As parameters, objectives are picked up from model variables. Objectives’ values are considered by the optimizer at the *final time*.

**11.6.2 Set problem in OMOptim**

**Launch OMOptim**

OMOptim can be launched using the executable placed in OpenModelicaInstallationDirectory/bin/OMOptim/OMOptim.exe. Alternately, choose OpenModelica > OMOptim from the start menu.

**Create a new project**

To create a new project, click on menu File -> New project.

Then set a name to the project and save it in a dedicated folder. The created file created has a .min extension. It will contain information regarding model, problems, and results loaded.

**Load models**

First, you need to load the model(s) you want to optimize. To do so, click on Add .mo button on main window or select menu Model -> Load Mo file...

When selecting a model, the file will be loaded in OpenModelica which runs in the background.

While OpenModelica is loading the model, you could have a frozen interface. This is due to multi-threading limitation but the delay should be short (few seconds).

You can load as many models as you want.

If an error occurs (indicated in log window), this might be because:

• Dependencies have not been loaded before (e.g. modelica library)

• Model use syntax incompatible with OpenModelica.

**Dependencies**

OMOptim should detect dependencies and load corresponding files. However, if some errors occur, please load by yourself dependencies. You can also load Modelica library using Model->Load Modelica library.

When the model correctly loaded, you should see a window similar to Figure 11.3.
Figure 11.3: OMOptim window after having loaded model.
Create a new optimization problem

Problem->Add Problem->Optimization

A dialog should appear. Select the model you want to optimize. Only Model can be selected (no Package, Component, Block. . .).

A new form will be displayed. This form has two tabs. One is called Variables, the other is called Optimization.

[Image: Figure 11.4: Forms for defining a new optimization problem.]

**List of Variables is Empty**

If variables are not displayed, right click on model name in model hierarchy, and select *Read variables*.

**Select Optimized Variables**

To set optimization, we first have to define the variables the optimizer will consider as free *i.e.* those that it should find best values of. To do this, select in the left list, the variables concerned. Then, add them to *Optimized variables* by clicking on corresponding button (➕).

For each variable, you must set minimum and maximum values it can take. This can be done in the *Optimized variables* table.

**Select objectives**

Objectives correspond to the final values of chosen variables. To select these last, select in left list variables concerned and click button of *Optimization objectives* table.

For each objective, you must:

- **Set minimum and maximum values it can take.** If a configuration does not respect these values, this configuration won’t be considered. You also can set minimum and maximum equals to “-“ : it will then
• Define whether objective should be minimized or maximized.

This can be done in the *Optimized variables* table.

**Select and configure algorithm**

After having selected variables and objectives, you should now select and configure optimization algorithm. To do this, click on *Optimization* tab.

Here, you can select optimization algorithm you want to use. In version 0.9, OMOptim offers three different genetic algorithms. Let’s for example choose SPEA2Adapt which is an auto-adaptive genetic algorithm.

By clicking on *parameters*... button, a dialog is opened allowing defining parameters. These are:

- **Population size**: this is the number of configurations kept after a generation. If it is set to 50, your final result can’t contain more than 50 different points.

- **Off spring rate**: this is the number of children per adult obtained after combination process. If it is set to 3, each generation will contain 150 individual (considering population size is 50).

- **Max generations**: this number defines the number of generations after which optimization should stop.

  In our case, each generation corresponds to 150 simulations. Note that you can still stop optimization while it is running by clicking on *stop* button (which will appear once optimization is launched). Therefore, you can set a really high number and still stop optimization when you want without losing results obtained until there.

- **Save frequency**: during optimization, best configurations can be regularly saved. It allows to analyze evolution of best configurations but also to restart an optimization from previously obtained results. A Save Frequency parameter set to 3 means that after three generations, a file is automatically created containing best configurations. These files are named iteration1.sav, iteration2.sav and are store in Temp directory, and moved to SolvedProblems directory when optimization is finished.

- **ReinitStdDev**: this is a specific parameter of EAAdapt1. It defines whether standard deviation of variables should be reinitialized. It is used only if you start optimization from previously obtained configurations (using *Use start file* option). Setting it to yes (1) will, in most of cases, lead to a spread research of optimized configurations, forgetting parameters’ variations’ reduction obtained in previous optimization.

**Use start file**

As indicated before, it is possible to pursue an optimization finished or stopped. To do this, you must enable *Use start file* option and select file from which optimization should be started. This file is an *iteration_*sav file created.
in previous optimization. It is stored in corresponding SolvedProblems folder (iteration10.sav corresponds to the tenth generation of previous optimization).

*Note that this functionality can only work with same variables and objectives*. However, minimum, maximum of variables and objectives can be changed before pursuing an optimization.

**Launch**

You can now launch Optimization by clicking Launch button.

**Stopping Optimization**

Optimization will be stopped when the generation counter will reach the generation number defined in parameters. However, you can still stop the optimization while it is running without loosing obtained results. To do this, click on Stop button. Note that this will not immediately stop optimization: it will first finish the current generation.

This stop function is especially useful when optimum points do not vary any more between generations. This can be easily observed since at each generation, the optimum objectives values and corresponding parameters are displayed in log window.

11.6.3 Results

The result tab appear when the optimization is finished. It consists of two parts: a table where variables are displayed and a plot region.

**Obtaining all Variable Values**

During optimization, the values of optimized variables and objectives are memorized. The others are not. To get these last, you must recomputed corresponding points. To achieve this, select one or several points in point’s list region and click on recompute.

For each point, it will simulate model setting input parameters to point corresponding values. All values of this point (including those which are not optimization parameters neither objectives).

11.6.4 Window Regions in OMOptim GUI
Figure 11.6: Window regions in OMOptim GUI.
This section describes the use of OpenModelica to compute parameter sensitivities using forward sensitivity analysis together with the Sundials/IDA solver.

Note: this is a very short preliminary description which soon will be considerably improved, since this a rather new feature and will continuous improved.

Note: OpenModelica version 1.10 or newer is required.

12.1 Background

Parameter sensitivity analysis aims at analyzing the behavior of the corresponding model states w.r.t. model parameters.

Formally, consider a Modelica model as a DAE system:

\[ F(x, \dot{x}, y, p, t) = 0 \]
\[ x(t_0) = x_0(p) \]

where \( x(t) \in \mathbb{R}^n \) represent state variables, \( \dot{x}(t) \in \mathbb{R}^n \) represent state derivatives, \( y(t) \in \mathbb{R}^k \) represent algebraic variables, \( p \in \mathbb{R}^m \) model parameters.

For parameter sensitivity analysis the derivatives

\[
\frac{\partial x}{\partial p}
\]

are required which quantify, according to their mathematical definition, the impact of parameters \( p \) on states \( x \). In the Sundials/IDA implementation the derivatives are used to evolve the solution over the time by:

\[
\dot{s}_i = \frac{\partial x}{\partial p_i}
\]

12.2 An Example

This section demonstrates the usage of the sensitivities analysis in OpenModelica on an example. This module is enabled by the following OpenModelica compiler flag:

```plaintext
>>> setCommandLineOptions("--calculateSensitivities");
```

Listing 12.1: LotkaVolterra.mo

```plaintext
model LotkaVolterra
  Real x(start=5, fixed=true), y(start=3, fixed=true);
  parameter Real mu1=5, mu2=2;
  parameter Real lambda1=3, lambda2=1;
  equation
```

(continues on next page)
0 = x*(mu1-lambda1*y) - \texttt{der}(x);
0 = -y* (mu2 -lambda2*x) - \texttt{der}(y);
end LotkaVolterra;

Also for the simulation it is needed to set IDA as solver integration method and add a further simulation flag -idaSensitivity to calculate the parameter sensitivities during the normal simulation.

```plaintext
>>> simulate(LotkaVolterra, method="ida", simflags="-idaSensitivity")
record SimulationResult
   resultFile = "DOCHOME/LotkaVolterra_res.mat",
   simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500,
   tolerance = 1e-06, method = 'ida', fileNamePrefix = 'LotkaVolterra', options = '
   ', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '
   -idaSensitivity'",
   messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
   LOG_SUCCESS | info | The simulation finished successfully.
   ",
   timeFrontend = 0.007413207000000001,
   timeBackend = 0.003239124,
   timeSimCode = 0.060786478,
   timeTemplates = 0.033537237,
   timeCompile = 0.6260837429999999,
   timeSimulation = 0.017478854,
   timeTotal = 0.7486624049999999
end SimulationResult;
```

Now all calculated sensitivities are stored into the results mat file under the $Sensitivities block, where all currently every top-level parameter of the Real type is used to calculate the sensitivities w.r.t. every state.

![Figure 12.1: Results of the sensitivities calculated by IDA solver.](image)
Figure 12.2: Results of the LotkaVolterra equations.
PDEModelica1 is nonstandardised experimental Modelica language extension for 1-dimensional partial differential extensions (PDE).

It is enabled using compiler flag --grammar=PDEModelica. Compiler flags may be set e.g. in OMEdit (Tools->Options->Simulation->OMC Flags) or in the OpenModelica script using command

```plaintext
>>> setCommandLineOptions("--grammar=PDEModelica")
true
```

### 13.1 PDEModelica1 language elements

Let us introduce new PDEModelica1 language elements by an advection equation example model:

```plaintext
model Advection "advection equation"
    parameter Real pi = Modelica.Constants.pi;
    parameter DomainLineSegment1D omega(L = 1, N = 100) "domain";
    field Real u(domain = omega) "field";
    initial equation
        u = sin(2*pi*omega.x) "IC";
    equation
        der(u) + pder(u,x) = 0 indomain omega "PDE";
        u = 0 indomain omega.left "BC";
        u = extrapolateField(u) indomain omega.right "extrapolation";
end Advection;
```

The domain `omega` represents the geometrical domain where the PDE holds. The domain is defined using the built-in record `DomainLineSegment1D`. This record contains among others `L` – the length of the domain, `N` – the number of grid points, `x` – the coordinate variable and the regions `left`, `right` and `interior`, representing the left and right boundaries and the interior of the domain.

The field variable `u` is defined using a new keyword `field`. The `domain` is a mandatory attribute to specify the domain of the field.

The `indomain` operator specifies where the equation containing the field variable holds. It is utilised in the initial conditions (IC) of the fields, in the PDE and in the boundary conditions (BC). The syntax is

```plaintext
anEquation indomain aDomain.aRegion;
```

If the region is omitted, `interior` is the default (e.g. the PDE in the example above).

The IC of the field variable `u` is written using an expression containing the coordinate variable `omega.x`.

The PDE contains a partial space derivative written using the `pder` operator. Also the second derivative is allowed (not in this example), the syntax is e.g. `pder(u,x,x)`. It is not necessary to specify the domain of coordinate in `pder` (to write e.g. `pder(u,omega.x)`, even though `x` is a member of `omega`.)
13.2 Limitations

BCs may be written only in terms of variables that are spatially differentiated currently.

All fields that are spatially differentiated must have either BC or extrapolation at each boundary. This extrapolation should be done automatically by the compiler, but this has not been implemented yet. The current workaround is the usage of the `extrapolateField()` operator directly in the model.

If-equations are not supported yet, if-expressions must be used instead.

13.3 Viewing results

During translation field variables are replaced with arrays. These arrays may be plotted using `Array Plot` or even better using `Array Parametric Plot` (to plot x-coordinate versus a field).
14.1 Introduction

The Modelica Development Tooling (MDT) Eclipse Plugin as part of OMDev – The OpenModelica Development Environment integrates the OpenModelica compiler with Eclipse. MDT, together with the OpenModelica compiler, provides an environment for working with Modelica and MetaModelica development projects. This plugin is primarily intended for tool developers rather than application Modelica modelers.

The following features are available:

- Browsing support for Modelica projects, packages, and classes
- Wizards for creating Modelica projects, packages, and classes
- Syntax color highlighting
- Syntax checking
- Browsing of the Modelica Standard Library or other libraries
- Code completion for class names and function argument lists
- Goto definition for classes, types, and functions
- Displaying type information when hovering the mouse over an identifier.

14.2 Installation

The installation of MDT is accomplished by following the below installation instructions. These instructions assume that you have successfully downloaded and installed Eclipse (http://www.eclipse.org).

The latest installation instructions are available through the OpenModelica Trac.

1. Start Eclipse
2. Select Help->Software Updates->Find and Install... from the menu
3. Select ‘Search for new features to install’ and click ‘Next’
4. Select ‘New Remote Site...’
5. Enter ‘MDT’ as name and http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT as URL and click ‘OK’
6. Make sure ‘MDT’ is selected and click ‘Finish’
7. In the updates dialog select the ‘MDT’ feature and click ‘Next’
8. Read through the license agreement, select ‘I accept...’ and click ‘Next’
9. Click ‘Finish’ to install MDT
14.3 Getting Started

14.3.1 Configuring the OpenModelica Compiler

MDT needs to be able to locate the binary of the compiler. It uses the environment variable OPENMODELICA-HOME to do so.

If you have problems using MDT, make sure that OPENMODELICAHOME is pointing to the folder where the OpenModelica Compiler is installed. In other words, OPENMODELICAHOME must point to the folder that contains the Open Modelica Compiler (OMC) binary. On the Windows platform it’s called omc.exe and on Unix platforms it’s called omc.

14.3.2 Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the Modelica perspective. To switch to the Modelica perspective, choose the Window menu item, pick Open Perspective followed by Other... Select the Modelica option from the dialog presented and click OK.

14.3.3 Selecting a Workspace Folder

Eclipse stores your projects in a folder called a workspace. You need to choose a workspace folder for this session, see Figure 14.1.

14.3.4 Creating one or more Modelica Projects

To start a new project, use the New Modelica Project Wizard. It is accessible through File->New-> Modelica Project or by right-clicking in the Modelica Projects view and selecting New->Modelica Project.

You need to disable automatic build for the project(s) (Figure 14.3).

Repeat the procedure for all the projects you need, e.g. for the exercises described in the MetaModelica users guide: 01_experiment, 02a_exp1, 02b_exp2, 03_assignment, 04a_assigntwotype, etc.

NOTE: Leave open only the projects you are working on! Close all the others!

14.3.5 Building and Running a Project

After having created a project, you eventually need to build the project (Figure 14.4).

The build options are the same as the make targets: you can build, build from scratch (clean), or run simulations depending on how the project is setup. See Figure 14.5 for an example of how omc can be compiled (make omc builds OMC).

14.3.6 Switching to Another Perspective

If you need, you can (temporarily) switch to another perspective, e.g. to the Java perspective for working with an OpenModelica Java client as in Figure 14.7.

14.3.7 Creating a Package

To create a new package inside a Modelica project, select File->New->Modelica Package. Enter the desired name of the package and a description of what it contains. Note: for the exercises we already have existing packages.
Figure 14.1: Eclipse Setup – Switching Workspace.
Create a Modelica project

Create a Modelica project in the workspace.

Project name: demo

Figure 14.2: Eclipse Setup – creating a Modelica project in the workspace.
Figure 14.3: Eclipse Setup – disable automatic build for the projects.

Figure 14.4: Eclipse MDT – Building a project.
Please input a value

omc

Figure 14.5: Eclipse – building a project.

Figure 14.6: Eclipse – building a project, resulting log.
14.3.8 Creating a Class

To create a new Modelica class, select where in the hierarchy that you want to add your new class and select File->New->Modelica Class. When creating a Modelica class you can add different restrictions on what the class can contain. These can for example be model, connector, block, record, or function. When you have selected your desired class type, you can select modifiers that add code blocks to the generated code. ‘Include initial code block’ will for example add the line ‘initial equation’ to the class.

14.3.9 Syntax Checking

Whenever a build command is given to the MDT environment, modified and saved Modelica (.mo) files are checked for syntactical errors. Any errors that are found are added to the Problems view and also marked in the source code editor. Errors are marked in the editor as a red circle with a white cross, a squiggly red line under the problematic construct, and as a red marker in the right-hand side of the editor. If you want to reach the problem, you can either click the item in the Problems view or select the red box in the right-hand side of the editor.

14.3.10 Automatic Indentation Support

MDT currently has support for automatic indentation. When typing the Return (Enter) key, the next line is indented correctly. You can also correct indentation of the current line or a range selection using CTRL+I or “Correct Indentation” action on the toolbar or in the Edit menu.

14.3.11 Code Completion

MDT supports Code Completion in two variants. The first variant, code completion when typing a dot after a class (package) name, shows alternatives in a menu. Besides the alternatives, Modelica documentation from comments is shown if is available. This makes the selection easier.
Figure 14.8: Creating a new Modelica package.
Figure 14.9: Creating a new Modelica class.
Figure 14.10: Syntax checking.

Figure 14.11: Code completion when typing a dot.
The second variant is useful when typing a call to a function. It shows the function signature (formal parameter names and types) in a popup when typing the parenthesis after the function name, here the signature `Real sin(SI.Angle u)` of the `sin` function:

![Figure 14.12: Code completion at a function call when typing left parenthesis.](image)

### 14.3.12 Code Assistance on Identifiers when Hovering

When hovering with the mouse over an identifier a popup with information about the identifier is displayed. If the text is too long, the user can press F2 to focus the popup dialog and scroll up and down to examine all the text. As one can see the information in the popup dialog is syntax-highlighted.

![Figure 14.13: Displaying information for identifiers on hovering.](image)

### 14.3.13 Go to Definition Support

Besides hovering information the user can press CTRL+click to go to the definition of the identifier. When pressing CTRL the identifier will be presented as a link and when pressing mouse click the editor will go to the definition of the identifier.

14.3. Getting Started  153
14.3.14 Code Assistance on Writing Records

When writing records, the same functionality as for function calls is used. This is useful especially in MetaModelica when writing cases in match constructs.

Figure 14.14: Code assistance when writing cases with records in MetaModelica.

14.3.15 Using the MDT Console for Plotting
Figure 14.15: Activate the MDT Console.
Figure 14.16: Simulation from MDT Console.
The algorithmic code debugger, used for the algorithmic subset of the Modelica language as well as the Meta-
Modelica language is described in Section The Eclipse-based Debugger for Algorithmic Modelica. Using this
debugger replaces debugging of algorithmic code by primitive means such as print statements or asserts which
is complex, time-consuming and error- prone. The usual debugging functionality found in debuggers for proce-
dural or traditional object-oriented languages is supported, such as setting and removing breakpoints, stepping,
inspecting variables, etc. The debugger is integrated with Eclipse.

15.1 The Eclipse-based Debugger for Algorithmic Modelica

The debugging framework for the algorithmic subset of Modelica and MetaModelica is based on the Eclipse
environment and is implemented as a set of plugins which are available from Modelica Development Tooling
(MDT) environment. Some of the debugger functionality is presented below. In the right part a variable value is
explored. In the top-left part the stack trace is presented. In the middle-left part the execution point is presented.

The debugger provides the following general functionalities:

- Adding/Removing breakpoints.
- Step Over – moves to the next line, skipping the function calls.
- Step In – takes the user into the function call.
- Step Return – complete the execution of the function and takes the user back to the point from where
  the function is called.
- Suspend – interrupts the running program.

15.1.1 Starting the Modelica Debugging Perspective

To be able to run in debug mode, one has to go through the following steps:

- create a mos file
- setting the debug configuration
- setting breakpoints
- running the debug configuration

All these steps are presented below using images.

Create mos file

In order to debug Modelica code we need to load the Modelica files into the OpenModelica Compiler. For this we
can write a small script file like this:
function HelloWorld
    input Real r;
    output Real o;
algorithm
    o := 2 * r;
end HelloWorld;

>>> setCommandLineOptions({"-d=rml,noevalfunc","-g=MetaModelica"})
(true,true)
>>> setCFlags(getCFlags() + " -g")
true
>>> HelloWorld(120.0)

So lets say that we want to debug HelloWorld.mo. For that we must load it into the compiler using the script file. Put all the Modelica files there in the script file to be loaded. We should also initiate the debugger by calling the starting function, in the above code HelloWorld(120.0);

Setting the debug configuration

While the Modelica perspective is activated the user should click on the bug icon on the toolbar and select Debug in order to access the dialog for building debug configurations.

To create the debug configuration, right click on the classification Modelica Development Tooling (MDT) GDB and select New as in figure below. Then give a name to the configuration, select the debugging executable to be executed and give it command line parameters. There are several tabs in which the user can select additional debug configuration settings like the environment in which the executable should be run.

Note that we require Gnu Debugger (GDB) for debugging session. We must specify the GDB location, also we
must pass our script file as an argument to OMC.

**Setting/Deleting Breakpoints**

The Eclipse interface allows to add/remove breakpoints. At the moment only line number based breakpoints are supported. Other alternative to set the breakpoints is; function breakpoints.

**Starting the debugging session and enabling the debug perspective**

**15.1.2 The Debugging Perspective**

The debug view primarily consists of two main views:

- Stack Frames View
- Variables View

The stack frame view, shown in the figure below, shows a list of frames that indicates how the flow had moved from one function to another or from one file to another. This allows backtracing of the code. It is very much possible to select the previous frame in the stack and inspect the values of the variables in that frame. However, it is not possible to select any of the previous frame and start debugging from there. Each frame is shown as `<function_name at file_name:line_number>`.

The Variables view shows the list of variables at a certain point in the program, containing four columns:

- Name – the variable name.
- Declared Type – the Modelica type of the variable.
- Value – the variable value.
- Actual Type – the mapped C type.
Figure 15.3: Creating the Debug Configuration.

Figure 15.4: Setting/deleting breakpoints.
Click and select the debug configuration. The debugging will start.

Figure 15.5: Starting the debugging session.

Figure 15.6: Eclipse will ask if the user wants to switch to the debugging perspective.
By preserving the stack frames and variables it is possible to keep track of the variables values. If the value of any variable is changed while stepping then that variable will be highlighted yellow (the standard Eclipse way of showing the change).

Figure 15.7: The debugging perspective.
Figure 15.8: Switching between perspectives.
A common problem when simulating models in an equation-based language like Modelica is that the model may contain non-linear equation systems. These are solved in each time-step by extrapolating an initial guess and running a non-linear system solver. If the simulation takes too long to simulate, it is useful to run the performance analysis tool. The tool has around 5–25% overhead, which is very low compared to instruction-level profilers (30x-100x overhead). Due to being based on a single simulation run, the report may contain spikes in the charts.

When running a simulation for performance analysis, execution times of user-defined functions as well as linear, non-linear and mixed equation systems are recorded.

To start a simulation in this mode, just use the measureTime flag of the simulate command.

```plaintext
>>> simulate(modelname, measureTime = true)
```

The generated report is in HTML format (with images in the SVG format), stored in a file modelname_prof.html, but the XML database and measured times that generated the report and graphs are also available if you want to customize the report for comparison with other tools.

Below we use the performance profiler on the simple model A:

```plaintext
model ProfilingTest
  function f
    input Real r;
    output Real o = sin(r);
  end f;
  String s = "abc";
  Real x = f(x) "This is x";
  Real y(start=1);
  Real z1 = cos(z2);
  Real z2 = sin(z1);
  equation
    der(y) = time;
  end ProfilingTest;
```

We simulate as usual, but set measureTime=true to activate the profiling:

```plaintext
>>> setCommandLineOptions("--profiling=blocks+html")
true
>>> simulate(ProfilingTest)
record SimulationResult
  resultFile = "<DOCHOME>/ProfilingTest_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500, \--tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'ProfilingTest', options = \--', outputFormat = 'mat', variableFilter = '.\*', cflags = '', simflags = ''",
  messages = "LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully.
  Warning: empty y range [1:1], adjusting to [0.99:1.01]
  Warning: empty y range [1:1], adjusting to [0.99:1.01]
  Warning: empty y range [1:1], adjusting to [0.99:1.01]
```

(continues on next page)
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]

stdout | info | Time measurements are stored in ProfilingTest_prof.html (human-readable) and ProfilingTest_prof.xml (for XSL transforms or more details)

  timeFrontend = 0.007357623000000001,
timeBackend = 0.011624354,
timeSimCode = 0.055174785,
timeTemplates = 0.02912883,
timeCompile = 0.596328042,
timeSimulation = 0.104146704,
timeTotal = 0.803866608

end SimulationResult;

"Warning: The initial conditions are not fully specified. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization")."

Warning: There are iteration variables with default zero start attribute. For more information set -d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-d=initialization")."

16.1 Profiling information for ProfilingTest

16.1.1 Information

All times are measured using a real-time wall clock. This means context switching produces bad worst-case execution times (max times) for blocks. If you want better results, use a CPU-time clock or run the command using real-time priviliges (avoiding context switches).

Note that for blocks where the individual execution time is close to the accuracy of the real-time clock, the maximum measured time may deviate a lot from the average.

For more details, see ProfilingTest_prof.xml.

16.1.2 Settings

<table>
<thead>
<tr>
<th>Name</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Integration method</td>
<td>dassl</td>
</tr>
<tr>
<td>Output format</td>
<td>mat</td>
</tr>
<tr>
<td>Output name</td>
<td>ProfilingTest_res.mat</td>
</tr>
<tr>
<td>Output size</td>
<td>24.0 kB</td>
</tr>
<tr>
<td>Profiling data</td>
<td>ProfilingTest_prof.data</td>
</tr>
<tr>
<td>Profiling size</td>
<td>0 B</td>
</tr>
</tbody>
</table>
16.1.3 Summary

<table>
<thead>
<tr>
<th>Task</th>
<th>Time</th>
<th>Fraction</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pre-Initialization</td>
<td>0.000306</td>
<td>2.42%</td>
</tr>
<tr>
<td>Initialization</td>
<td>0.000337</td>
<td>2.67%</td>
</tr>
<tr>
<td>Event-handling</td>
<td>0.000066</td>
<td>0.52%</td>
</tr>
<tr>
<td>Creating output file</td>
<td>0.001234</td>
<td>9.78%</td>
</tr>
<tr>
<td>Linearization</td>
<td>NaN%</td>
<td>NaN%</td>
</tr>
<tr>
<td>Time steps</td>
<td>0.008377</td>
<td>66.37%</td>
</tr>
<tr>
<td>Overhead</td>
<td>0.000911</td>
<td>7.22%</td>
</tr>
<tr>
<td>Unknown</td>
<td>NaN%</td>
<td>NaN%</td>
</tr>
<tr>
<td>Total simulation time</td>
<td>0.012621</td>
<td>100.00%</td>
</tr>
</tbody>
</table>

16.1.4 Global Steps

<table>
<thead>
<tr>
<th>Steps</th>
<th>Total Time</th>
<th>Fraction</th>
<th>Average Time</th>
<th>Max Time</th>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>499</td>
<td>0.008377</td>
<td>66.37%</td>
<td>0.0000167878</td>
<td>0.000162981</td>
<td>8.71x</td>
</tr>
</tbody>
</table>

16.1.5 Measured Function Calls

<table>
<thead>
<tr>
<th>Name</th>
<th>Calls</th>
<th>Time</th>
<th>Fraction</th>
<th>Max Time</th>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>ProfilingTest.f</td>
<td>506</td>
<td>0.000060764</td>
<td>0.48%</td>
<td>0.000014943</td>
<td>123.43x</td>
</tr>
</tbody>
</table>

16.1.6 Measured Blocks

<table>
<thead>
<tr>
<th>Name</th>
<th>Calls</th>
<th>Time</th>
<th>Fraction</th>
<th>Max Time</th>
<th>Deviation</th>
</tr>
</thead>
<tbody>
<tr>
<td>' &lt;#eq0&gt;'</td>
<td>7</td>
<td>0.000175878</td>
<td>1.39%</td>
<td>0.000180078</td>
<td>6.17x</td>
</tr>
<tr>
<td>' &lt;#eq12&gt;'</td>
<td>2</td>
<td>0.000008104</td>
<td>0.06%</td>
<td>0.000008804</td>
<td>1.17x</td>
</tr>
<tr>
<td>' &lt;#eq20&gt;'</td>
<td>504</td>
<td>0.001538499</td>
<td>12.19%</td>
<td>0.000064738</td>
<td>20.21x</td>
</tr>
<tr>
<td>' &lt;#eq22&gt;'</td>
<td>504</td>
<td>0.002588585</td>
<td>20.51%</td>
<td>0.000060182</td>
<td>10.72x</td>
</tr>
</tbody>
</table>
Equations

<table>
<thead>
<tr>
<th>Name</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>'eq0 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq1 &lt;&gt;'__</td>
<td>y</td>
</tr>
<tr>
<td>'eq2 &lt;&gt;'__</td>
<td>s</td>
</tr>
<tr>
<td>'eq3 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq4 &lt;&gt;'__</td>
<td>z²</td>
</tr>
<tr>
<td>'eq5 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq6 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq7 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq8 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq9 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq10 &lt;&gt;'__</td>
<td>z₁</td>
</tr>
<tr>
<td>'eq11 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq12 &lt;&gt;'__</td>
<td>x</td>
</tr>
<tr>
<td>'eq13 &lt;&gt;'__</td>
<td>der(y)</td>
</tr>
<tr>
<td>'eq14 &lt;&gt;'__</td>
<td>z²</td>
</tr>
<tr>
<td>'eq15 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq16 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq17 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq18 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq19 &lt;&gt;'__</td>
<td>'&lt;#var0&gt;'__</td>
</tr>
<tr>
<td>'eq20 &lt;&gt;'__</td>
<td>z₁</td>
</tr>
<tr>
<td>'eq21 &lt;&gt;'__</td>
<td></td>
</tr>
<tr>
<td>'eq22 &lt;&gt;'__</td>
<td>x</td>
</tr>
<tr>
<td>'eq23 &lt;&gt;'__</td>
<td></td>
</tr>
</tbody>
</table>

Variables

<table>
<thead>
<tr>
<th>Name</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>y</td>
<td></td>
</tr>
<tr>
<td>der(y)</td>
<td></td>
</tr>
<tr>
<td>x</td>
<td>This is x</td>
</tr>
<tr>
<td>z₁</td>
<td></td>
</tr>
<tr>
<td>z₂</td>
<td></td>
</tr>
<tr>
<td>s</td>
<td></td>
</tr>
</tbody>
</table>

This report was generated by OpenModelica on 2019-01-31 15:20:04.
16.2 Genenerated JSON for the Example

Listing 16.1: ProfilingTest_prof.json

```json
{
  "name": "ProfilingTest",
  "prefix": "ProfilingTest",
  "date": "2019-01-31 15:20:04",
  "method": "dassl",
  "outputFormat": "mat",
  "outputFilename": "ProfilingTest_res.mat",
  "outputFilesize": 124581,
  "overheadTime": 0.000911274,
  "preinitTime": 0.000306161,
  "initTime": 0.000336692,
  "eventTime": 6.5523e-05,
  "outputTime": 0.00036692,
  "jacobianTime": 3.6938e-05,
  "totalTime": 0.0126215,
  "totalStepsTime": 1.4966e-05,
  "totalTimeProfileBlocks": 0.00431107,
  "numStep": 499,
  "maxTime": 0.000162981,
  "functions": [
    {
      "name": "ProfilingTest.f",
      "ncall": 506,
      "time": 0.000060764,
      "maxTime": 0.000014943
    }
  ],
  "profileBlocks": [
    {
      "id": 0,
      "ncall": 7,
      "time": 0.000175878,
      "maxTime": 0.000180078
    },
    {
      "id": 12,
      "ncall": 12,
      "time": 0.00008104,
      "maxTime": 0.00008804
    },
    {
      "id": 20,
      "ncall": 504,
      "time": 0.001538499,
      "maxTime": 0.000064738
    },
    {
      "id": 22,
      "ncall": 504,
      "time": 0.002588585,
      "maxTime": 0.000060182
    }
  ]
}
```

16.3 Using the Profiler from OMEdit

When running a simulation from OMEdit, it is possible to enable profiling information, which can be combined with the transformations browser.

When profiling the DoublePendulum example from MSL, the following output in Figure 16.2 is a typical result. This information clearly shows which system takes longest to simulate (a linear system, where most of the time overhead probably comes from initializing LAPACK over and over).
Figure 16.1: Setting up the profiler from OMEdit.

Figure 16.2: Profiling results of the Modelica standard library DoublePendulum example, sorted by execution time.
OpenModelica can simulate in a web browser on a client computer by model code being compiled to efficient Javascript code.

For more information, see https://github.com/tshort/openmodelica-javascript

Below used on the MSL MultiBody RobotR3.fullRobot example model.
Below is information and examples about the OpenModelica external C interfaces, as well as examples of Python interoperability.

### 18.1 Calling External C functions

The following is a small example (ExternalLibraries.mo) to show the use of external C functions:

```model ExternalLibraries
  function ExternalFunc1
    input Real x;
    output Real y;
    external y=ExternalFunc1_ext(x) annotation(Library="ExternalFunc1.o", 
    LibraryDirectory="modelica://ExternalLibraries");
  end ExternalFunc1;

  function ExternalFunc2
    input Real x;
    output Real y;
    external "C" annotation(Library="ExternalFunc2", LibraryDirectory="modelica:// 
    ExternalLibraries");
  end ExternalFunc2;

  Real x(start=1.0, fixed=true), y(start=2.0, fixed=true);
  equation
    der(x)=-ExternalFunc1(x);
    der(y)=-ExternalFunc2(y);
  end ExternalLibraries;
```

These C (.c) files and header files (.h) are needed (note that the headers are not needed since OpenModelica will generate the correct definition if it is not present; using the headers it is possible to write C-code directly in the Modelica source code or declare non-standard calling conventions):

**Listing 18.1: ExternalFunc1.c**

```c
double ExternalFunc1_ext(double x)
{
    double res;
    res = x+2.0*x*x;
    return res;
}
```
18.2 Calling external Python Code from a Modelica model

The following calls external Python code through a very simplistic external function (no data is retrieved from the Python code). By making it a dynamically linked library, you might get the code to work without changing the linker settings.

```modelica
function pyRunString
  input String s;
  external "C" annotation(Include="
#include <Python.h>
"
void pyRunString(const char *str)
(
  Py_SetProgramName("pyRunString"); /* optional but recommended */
  Py_Initialize();
)```

(continues on next page)
Figure 18.1: Plot generated by OpenModelica+gnuplot

```plaintext
PyRun_SimpleString(str);
Py_Finalize();
}
end pyRunString;

model CallExternalPython
algorithm
pyRunString("print 'Python says: simulation time',"+String(time)+" ");
end CallExternalPython;

>>> system("python-config --cflags > pycflags")
0
>>> system("python-config --ldflags > pyldflags")
0
>>> pycflags := stringReplace(readFile("pycflags"),"\n","\n\n");
>>> pyldflags := stringReplace(readFile("pyldflags"),"\n","\n\n");
>>> setCFlags(getCFlags()+pycflags)
true
>>> setLinkerFlags(getLinkerFlags()+pyldflags)
true
>>> simulate(CallExternalPython, stopTime=2)

record SimulationResult
  resultFile = "\DOCHOME\CallExternalPython_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 2.0, numberOfIntervals = 500,
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'CallExternalPython'",
  options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''",
  messages = "Python says: simulation time 0
Python says: simulation time 0
LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
Python says: simulation time 2
LOG_SUCCESS | info | The simulation finished successfully."
```

(continues on next page)
timeFrontend = 0.002970208,
    timeBackend = 0.00714052,
    timeSimCode = 0.049270818,
    timeTemplates = 0.027039193,
    timeCompile = 0.702536821,
    timeSimulation = 0.045927223,
    timeTotal = 0.834982382
end SimulationResult;

18.3 Calling OpenModelica from Python Code

This section describes a simple-minded approach to calling Python code from OpenModelica. For a description
of Python scripting with OpenModelica, see OMPython – OpenModelica Python Interface.

The interaction with Python can be performed in four different ways whereas one is illustrated below. Assume that
we have the following Modelica code:

Listing 18.4: CalledbyPython.mo

model CalledbyPython
    Real x(start=1.0), y(start=2.0);
    parameter Real b = 2.0;
    equation
        der(x) = -b*y;
        der(y) = x;
end CalledbyPython;

In the following Python (.py) files the above Modelica model is simulated via the OpenModelica scripting inter-
face:

Listing 18.5: PythonCaller.py

#!/usr/bin/python
import sys,
    os
global newb = 0.5
evalfile('CreateMosFile.py')
    os.popen(r"omc CalledbyPython.mos").read()
evalfile('RetrResult.py')

Listing 18.6: CreateMosFile.py

#!/usr/bin/python
mos_file = open('CalledbyPython.mos','w', 1)
mos_file.write('loadFile("CalledbyPython.mo");
    setComponentModifierValue(CalledbyPython,b,$Code("+str(newb)+")
); std
    simulate(CalledbyPython,stopTime=10);
mos_file.close()

Listing 18.7: RetrResult.py

#!/usr/bin/python
def zeros(n): #
    vec = [0.0]
    for i in range(int(n)-1): vec = vec + [0.0]
    return vec
res_file = open("CalledbyPython_res.plt","r",1)
line = res_file.readline()
size = int(res_file.readline().split('=')[1])
time = zeros(size)
y = zeros(size)

while line != ['DataSet: time\n']:
    line = res_file.readline().split(',')[0:1]
    for j in range(int(size)):
        time[j] = float(res_file.readline().split(',')[0])

while line != ['DataSet: y\n']:
    line = res_file.readline().split(',')[0:1]
    for j in range(int(size)):
        y[j] = float(res_file.readline().split(',')[1])

res_file.close()

A second option of simulating the above Modelica model is to use the command buildModel instead of the simulate command and setting the parameter value in the initial parameter file, CalledbyPython_init.txt instead of using the command setComponentModifierValue. Then the file CalledbyPython.exe is just executed.

The third option is to use the Corba interface for invoking the compiler and then just use the scripting interface to send commands to the compiler via this interface.

The fourth variant is to use external function calls to directly communicate with the executing simulation process.
This chapter describes the OpenModelica Python integration facilities.

- **OMPython** – the OpenModelica Python scripting interface, see *OMPython – OpenModelica Python Interface*.
- **EnhancedOMPython** - Enhanced OMPython scripting interface, see *Enhanced OMPython Features*.
- **PySimulator** – a Python package that provides simulation and post processing/analysis tools integrated with OpenModelica, see *PySimulator*.

### 19.1 OMPython – OpenModelica Python Interface

OMPython – OpenModelica Python API is a free, open source, highly portable Python based interactive session handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica modeling, compilation and simulation environment based on the latest OpenModelica library standard available. OMPython is architectured to combine both the solving strategy and model building. So domain experts (people writing the models) and computational engineers (people writing the solver code) can work on one unified tool that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm development and research. OMPython is not a standalone package, it depends upon the OpenModelica installation.

OMPython is implemented in Python and depends either on the OmniORB and OmniORBpy - high performance CORBA ORBs for Python or ZeroMQ - high performance asynchronous messaging library and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMPython follow the instructions at [https://github.com/OpenModelica/OMPython](https://github.com/OpenModelica/OMPython)

### 19.1.1 Features of OMPython

OMPython provides user friendly features like:

- Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation, simulation, plotting, etc.
- Interface to the latest OpenModelica API calls.
- Optimized parser results that give control over every element of the output.
- Helper functions to allow manipulation on Nested dictionaries.
- Easy access to the library and testing of OpenModelica commands.

### 19.1.2 Test Commands

OMPython provides two classes for communicating with OpenModelica i.e., OMCSession and OMCSessionZMQ. Both classes have the same interface, the only difference is that OMCSession uses omniORB and OMCSessionZMQ uses ZeroMQ. All the examples listed down uses OMCSessionZMQ but if you want to test OMCSession simply replace OMCSessionZMQ with OMCSession. We recommend to use OMCSessionZMQ.
To test the command outputs, simply create an OMCSessionZMQ object by importing from the OMPython library within Python interpreter. The module allows you to interactively send commands to the OMC server and display their output.

To get started, create an OMCSessionZMQ object:

```python
>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()
```

```python
>>> omc.sendExpression("getVersion()")
OMCompiler v1.13.2
>>> omc.sendExpression("cd()")
«DOCHOME»
>>> omc.sendExpression("loadModel(Modelica)")
True
>>> omc.sendExpression("loadFile(getInstallationDirectoryPath() + "/share/doc/omc/˓→testmodels/BouncingBall.mo")")
True
>>> omc.sendExpression("instantiateModel(BouncingBall)")

```

```plaintext
class BouncingBall
    parameter Real e = 0.7 "coefficient of restitution";
    parameter Real g = 9.81 "gravity acceleration";
    Real h(start = 1.0, fixed = true) "height of ball";
    Real v(fixed = true) "velocity of ball";
    Boolean flying(start = true, fixed = true) "true, if ball is flying";
    Boolean impact;
    Real v_new(fixed = true);
    Integer foo;

    equation
        impact = h <= 0.0;
        foo = if impact then 1 else 2;
        der(v) = if flying then -g else 0.0;
        der(h) = v;
        when (h <= 0.0 and v <= 0.0, impact) then
            v_new = if edge(impact) then (-e) * pre(v) else 0.0;
            flying = v_new > 0.0;
            reinit(v, v_new);
        end when;
    end BouncingBall;
```

We get the name and other properties of a class:

```python
>>> omc.sendExpression("getClassNames()")
('BouncingBall', 'ModelicaServices', 'Complex', 'Modelica')
>>> omc.sendExpression("isPartial(BouncingBall)")
False
>>> omc.sendExpression("isPackage(BouncingBall)")
False
>>> omc.sendExpression("isModel(BouncingBall)")
True
>>> omc.sendExpression("checkModel(BouncingBall)")
Check of BouncingBall completed successfully.
Class BouncingBall has 6 equation(s) and 6 variable(s).
1 of these are trivial equation(s).
>>> omc.sendExpression("getClassRestriction(BouncingBall)")
model
>>> omc.sendExpression("getClassInformation(BouncingBall)")
('model', '', False, False, False, "/var/lib/hudson/slave/workspace/OpenModelica_˓→SPHINX/OpenModelica/build/share/doc/omc/testmodels/BouncingBall.mo", False, 1, 1, ˓→23, 17, (), False, False, ",", ",", False, ")")
>>> omc.sendExpression("getConnectionCount(BouncingBall)")
0
```

(continues on next page)
The common combination of a simulation followed by getting a value and doing a plot:

```python
>>> omc.sendExpression("simulate(BouncingBall, stopTime=3.0)")
{'timeSimulation': 0.025066411, 'timeTemplates': 0.042099246, 'timeTotal': 1.384174268, 'timeFrontend': 0.23058554, 'messages': 'LOG_SUCCESS | info | The initialization finished successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
', 'simulationOptions': 'startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500, tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = ''

>>> omc.sendExpression("val(h, 2.0)")
0.04239430772884106
```

Import As Library

To use the module from within another python program, simply import OMCSessionZMQ from within the using program.

For example:

```python
# test.py
from OMPython import OMCSessionZMQ
omc = OMCSessionZMQ()
cmds = [
    'loadFile(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/BouncingBall.mo")',
    "simulate(BouncingBall)",
    "plot(h)"
]
for cmd in cmds:
    answer = omc.sendExpression(cmd)
    print("\n{}: \n{}\n".format(cmd, answer))
```
19.1.3 Implementation

Client Implementation

The OpenModelica Python API Interface – OMPython, attempts to mimic the OMShell’s style of operations. OMPython is designed to,

- Initialize the CORBA/ZeroMQ communication.
- Send commands to the OMC server via the CORBA/ZeroMQ interface.
- Receive the string results.
- Use the Parser module to format the results.
- Return or display the results.

19.2 Enhanced OMPython Features

Some more improvements are added to OMPython functionality for querying more information about the models and simulate them. A list of new user friendly API functionality allows user to extract information about models using python objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

```python
>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ()
>>> model_path=omc.sendExpression("getInstallationDirectoryPath()") + "/share/doc/omc/testmodels/"
>>> from OMPython import ModelicaSystem
>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall")
```

The object constructor requires a minimum of 2 input arguments which are strings, and may need a third string input argument.

- The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo". If the Modelica file is not in the current directory of Python, then the file path must also be included.
- The second input argument must be a string with the name of the Modelica model including the namespace if the model is wrapped within a Modelica package.
- The third input argument is used to specify the list of dependent libraries or dependent Modelica files e.g.,

```python
>>> mod=ModelicaSystem(model_path + "BouncingBall.mo","BouncingBall",["Modelica"])"
```

- By default ModelicaSystem uses OMCSessionZMQ but if you want to use OMCSession then pass the argument `useCorba=True` to the constructor.

19.2.1 Standard get methods

- `getQuantities()`
- `getContinuous()`
- `getInputs()`
- `getOutputs()`
- `getParameters()`
- `getSimulationOptions()`
getSolutions()

Two calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg: getParameters()).

- getXXX() without input argument, returns a dictionary with names as keys and values as values.
- getXXX(S), where S is a sequence of strings of names, returns a tuple of values for the specified names.

19.2.2 Usage of getMethods

```python
>>> mod.getQuantities() // method-1, list of all variables from xml file
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': 1.0, 'alias': 'noAlias', 'Changeable': 'true', 'Description': None},
 {'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': 0.9, 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getQuantities("height") // method-2, to query information about single quantity
[{'aliasvariable': None, 'Name': 'height', 'Variability': 'continuous', 'Value': 1.0, 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getQuantities(['c','radius']) // method-3, to query information about list of quantity
[{'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'Value': 0.9, 'alias': 'noAlias', 'Changeable': 'true', 'Description': None},
 {'aliasvariable': None, 'Name': 'radius', 'Variability': 'parameter', 'Value': 0.1, 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getContinuous() // method-1, list of continuous variable
{'velocity': -1.825929609047952, 'der(velocity)': -9.8100000000000005, 'der(height)': -1.825929609047952, 'height': 0.65907039052943617}

>>> mod.getContinuous("velocity","height") // method-2, get specific variable value information
(-1.825929609047952, 0.65907039052943617)

>>> mod.getInputs() ()

>>> mod.getOutputs() ()

>>> mod.getParameters() // method-1
{'c': 0.9, 'radius': 0.1}

>>> mod.getParameters("c","radius") // method-2
(0.9, 0.1)

>>> mod.getSimulationOptions() // method-1
{'stepSize': 0.002, 'stopTime': 1.0, 'tolerance': 1e-06, 'startTime': 0.0, 'solver': 'dassl'}

>>> mod.getSimulationOptions("stepSize","tolerance") // method-2
(0.002, 1e-06)
```
>>> mod.getSolutions() // method-1 returns list of simulation variables for which results are available
['time', 'height', 'velocity', 'der(height)', 'der(velocity)', 'c', 'radius']

>>> mod.getSolutions("time","height") // method-2, return list of numpy arrays

19.2.3 Standard set methods

- setInputs()
- setParameters()
- setSimulationOptions()

Two calling possibilities are accepted using setXXXs(), where "XXX" can be any of above functions.

- setXXX(K) with K being a sequence of keyword assignments (e.g.) (name = value).
- setXXX(**D) with D being a dictionary with quantity names as keywords and values, being expanded by ** into the form of K.

19.2.4 Usage of setMethods

>>> mod.setInputs(cAi=1,Ti=2)

>>> mod.setParameters(radius=14,c=0.5) // method-1 setting parameter value

>>> mod.setParameters(**{"radius":14,"c":0.5}) // method-2 setting parameter value

>>> mod.setSimulationOptions(stopTime=2.0,tolerance=1e-08)

19.2.5 Simulation

An example of how to get parameter names and change the value of parameters using set methods and finally simulate the "BouncingBall.mo" model is given below.

>>> mod.getParameters()
{'c': 0.9, 'radius': 0.1}

>>> mod.setParameters(radius=14,c=0.5) //setting parameter value using first option

To check whether new values are updated to model, we can again query the getParameters().

>>> mod.getParameters()
{'c': 0.5, 'radius': 14}

And then finally we can simulate the model using.

>>> mod.simulate()
19.2.6 Linearization

The following methods are proposed for linearization.

- `linearize()`
- `getLinearizationOptions()`
- `setLinearizationOptions()`
- `getLinearInputs()`
- `getLinearOutputs()`
- `getLinearStates()`

19.2.7 Usage of Linearization methods

```python
>>> mod.getLinearizationOptions()  # method-1
{'simflags': ' ', 'stepSize': 0.002, 'stopTime': 1.0, 'startTime': 0.0, 'numberOfIntervals': 500.0, 'tolerance': 1e-08}

>>> mod.getLinearizationOptions("startTime","stopTime")  # method-2
(0.0, 1.0)

>>> mod.setLinearizationOptions(stopTime=2.0,tolerance=1e-06)

>>> mod.linearize()  # returns a tuple of 2D numpy arrays (matrices) A, B, C and D.

>>> mod.getLinearInputs()  # returns a list of strings of names of inputs used when forming matrices.

>>> mod.getLinearOutputs()  # returns a list of strings of names of outputs used when forming matrices.

>>> mod.getLinearStates()  # returns a list of strings of names of states used when forming matrices.
```

19.3 PySimulator

PySimulator provides a graphical user interface for performing analyses and simulating different model types (currently Functional Mockup Units and Modelica Models are supported), plotting result variables and applying simulation result analysis tools like Fast Fourier Transform.

Read more about the PySimulator at https://github.com/PySimulator/PySimulator.
OMMATLAB – OPENMODELICA MATLAB INTERFACE

OMMatlab – the OpenModelica Matlab API is a free, open source, highly portable Matlab-based interactive session handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica modeling, compilation and simulation environment based on the latest OpenModelica library standard available. OMMatlab is architectured to combine both the solving strategy and model building. So domain experts (people writing the models) and computational engineers (people writing the solver code) can work on one unified tool that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm development and research. OMMatlab is not a standalone package, it depends upon the OpenModelica installation.

OMMatlab is implemented in Matlab and depends on ZeroMQ - high performance asynchronous messaging library and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

The Development is in progress and will be soon available. At the moment a prototype of OMMatlab is completed where the users will be able to import the OMMatlab package in Matlab and start to interact with omc through API calls.

20.1 Current Prototype

The current version of the OMMatlab package contains the following features:

- Import the OMMatlab package in Matlab
- Connect with the OpenModelica compiler through zmq sockets
- Able to interact with the OpenModelica compiler through the available API
- All the API calls are communicated with the help of the sendExpression method implemented in a Matlab package
- The results are returned as strings

20.2 Test Commands

To get started, create a OMMatlab session object:

```matlab
>>> import OMMatlab.*
>>> omc= OMMatlab()
>>> omc.sendExpression("getVersion()")
'v1.13.0-dev-531-gde26b558a (64-bit)'
>>> omc.sendExpression("loadModel(Modelica)")
'true'
>>> omc.sendExpression("model a Real s; equation s=sin(10*time); end a;")
'{a}'
>>> omc.sendExpression("simulate(a)")
>>> omc.sendExpression("plot(s)")
'true'
```
Currently this is an incomplete Beta release. In the final release the OMMatlab interface is planned to implement the more advanced API calls below where the users will have the ability to perform interactive simulation and analysis similar to the enhanced OMPython features.

### 20.3 List of Planned API support

- `getQuantities()`
- `getContinuous()`
- `getInputs()`
- `getOutputs()`
- `getParameters()`
- `getSimulationOptions()`
- `getSolutions()`
- `setInputs()`
- `setParameters()`
- `setSimulationOptions()`

With the above list of API calls implemented, the users can have more control over the result types, returned using Matlab data structures.
OMJulia – the OpenModelica Julia API is a free, open source, highly portable Julia based interactive session handler for Julia scripting of OpenModelica API functionality. It provides the modeler with components for creating a complete Julia-Modelica modeling, compilation and simulation environment based on the latest OpenModelica implementation and Modelica library standard available. OMJulia is architected to combine both the solving strategy and model building. Thus, domain experts (people writing the models) and computational engineers (people writing the solver code) can work on one unified tool that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm development and research. OMJulia is not a standalone package, it depends upon the OpenModelica installation.

OMJulia is implemented in Julia and depends on ZeroMQ - high performance asynchronous messaging library and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMJulia follow the instructions at https://github.com/OpenModelica/OMJulia.jl

### 21.1 Features of OMJulia

The OMJulia package contains the following features:

- Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation, simulation, plotting, etc.
- Connect with the OpenModelica compiler through zmq sockets
- Able to interact with the OpenModelica compiler through the available API
- Easy access to the Modelica Standard library.
- All the API calls are communicated with the help of the sendExpression method implemented in a Julia module
- The results are returned as strings

### 21.2 Test Commands

To get started, create an OMJulia session object:

```plaintext
>>> using OMJulia
>>> omc = OMJulia.OMCSession()
>>> omc.sendExpression("loadModel(Modelica)")
"True"
>>> omc.sendExpression("model a Real s; equation s=sin(10*time); end a;")
"[a]"
>>> omc.sendExpression("simulate(a)")
>>> omc.sendExpression("plot(s)")
"true"
```
21.2.1 Advanced OMJulia Features

OMJulia package has advanced functionality for querying more information about the models and simulate them. A list of new user friendly API functionality allows user to extract information about models using julia objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

```julia
>>> using OMJulia
>>> mod = OMJulia.OMCSession()
>>> mod.ModelicaSystem("BouncingBall.mo","BouncingBall")
```

The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which is optional.

- The first input argument must be a string with the file name of the Modelica code, with Modelica file extension ".mo". If the Modelica file is not in the current directory, then the file path must also be included.
- The second input argument must be a string with the name of the Modelica model including the namespace if the model is wrapped within a Modelica package.
- The third input argument (optional) is used to specify the list of dependent libraries. The argument can be passed as a string or array of strings e.g.,

```julia
>>> mod.ModelicaSystem("BouncingBall.mo","BouncingBall",["Modelica", "SystemDynamics"])
```

21.3 Standard get methods

- `getQuantities()`
- `showQuantities()`
- `getContinuous()`
- `getInputs()`
OpenModelica User’s Guide, Release v1.13.2

• getOutputs()
• getParameters()
• getSimulationOptions()
• getSolutions()
Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)
getParameters().
• getXXX() without input argument, returns a dictionary with names as keys and values as values.
• getXXX(S), where S is a string of names.
• getXXX(["S1","S2"]) where S1 and S1 are array of string elements

21.4 Usage of getMethods
>>> mod.getQuantities() // method-1, list of all variables from xml file
[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
˓→"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}, {
˓→"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
˓→"alias": "noAlias", "Changeable": "true", "Description": None}]
>>> mod.getQuantities("height") // method-2, to query information about single
˓→quantity
[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
˓→"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}]
>>> mod.getQuantities(["c","radius"]) // method-3, to query information about list
˓→of quantity
[{"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
˓→"alias": "noAlias", "Changeable": "true", "Description": None}, {"aliasvariable
˓→": None, "Name": "radius", "Variability": "parameter", "Value": "0.1", "alias":
˓→"noAlias", "Changeable": "true", "Description": None}]
>>> mod.getContinuous() // method-1, list of continuous variable
{"velocity": "-1.825929609047952", "der(velocity)": "-9.8100000000000005",
˓→"der(height)": "-1.825929609047952", "height": "0.65907039052943617"}
>>> mod.getContinuous(["velocity","height"]) // method-2, get specific variable
˓→value information
["-1.825929609047952", "0.65907039052943617"]
>>> mod.getInputs()
{}
>>>
{}

mod.getOutputs()

>>> mod.getParameters() // method-1
{"c": "0.9", "radius": "0.1"}
>>> mod.getParameters(["c","radius"]) // method-2
["0.9", "0.1"]
>>> mod.getSimulationOptions() // method-1
{"stepSize": "0.002", "stopTime": "1.0", "tolerance": "1e-06", "startTime": "0.0",
˓→"solver": "dassl"}

21.4. Usage of getMethods

191


21.5 Standard set methods

- setInputs()
- setParameters()
- setSimulationOptions()

Two setting possibilities are accepted using setXXXs(), where "XXX" can be any of above functions.

- setXXX(S) where S is a string of names
- setXXX([S1,S2]) where S1 and S2 are array of string elements

21.6 Usage of setMethods

- mod.setInputs("cAi=1") // method-1
- mod.setInputs(["cAi=1","Ti=2"]) // method-2
- mod.setParameters("radius=14") // method-1
- mod.setParameters(["radius=14","c=0.5"]) // method-2 setting parameter value using array of string
- mod.setSimulationOptions(["stopTime=2.0","tolerance=1e-08"])
Similarly we can also use setInputs() to set a value for the inputs during various time interval can also be done using the following.

```python
>>> mod.setInputs("cAi=1")
```

And then finally we can simulate the model using.

```python
>>> mod.simulate()
```

## 21.8 Linearization

The following methods are available for linearization of a modelica model

- `linearize()`
- `getLinearizationOptions()`
- `setLinearizationOptions()`
- `getLinearInputs()`
- `getLinearOutputs()`
- `getLinearStates()`

### 21.9 Usage of Linearization methods

```python
>>> mod.getLinearizationOptions()  # method-1
{"stepSize": "0.002", "stopTime": "1.0", "startTime": "0.0", "numberOfIntervals": "500.0", "tolerance": "1e-08"}

>>> mod.getLinearizationOptions(["startTime","stopTime"])  # method-2
["0.0", "1.0"]

>>> mod.setLinearizationOptions(["stopTime=2.0","tolerance=1e-06"])

>>> mod.linearize()  # returns a list 2D arrays (matrices) A, B, C and D.

>>> mod.getLinearInputs()  # returns a list of strings of names of inputs used when forming matrices.

>>> mod.getLinearOutputs()  # returns a list of strings of names of outputs used when forming matrices.

>>> mod.getLinearStates()  # returns a list of strings of names of states used when forming matrices.
```

## 21.10 Sensitivity Analysis

A Method for computing numeric sensitivity of modelica model is available.

- \((res1,res2) = \text{sensitivity}(arg1,\text{arg2}\text{,arg3})\)

The constructor requires a minimum of 3 input arguments.

- `arg1`: Array of strings of Modelica Parameter names
• arg2: Array of strings of Modelica Variable names
• arg3: Array of float Excitations of parameters; defaults to scalar 1e-2

The results contains the following:

• res1: Vector of Sensitivity names.
• res2: Array of sensitivities: vector of elements per parameter, each element containing time series per variable.

### 21.11 Usage

```python
>>> (Sns, San) = mod.sensitivity(“UA”, “EdR”, “T”, “cA”, [1e-2, 1e-4])
```

With the above list of API calls implemented, the users can have more control over the result types, returned as Julia data structures.
The following are short summaries of OpenModelica scripting commands. These commands are useful for loading and saving classes, reading and storing data, plotting of results, and various other tasks.

The arguments passed to a scripting function should follow syntactic and typing rules for Modelica and for the scripting function in question. In the following tables we briefly indicate the types or character of the formal parameters to the functions by the following notation:

- String typed argument, e.g. "hello", "myfile.mo".
- **TypeName** – class, package or function name, e.g. **MyClass**, Modelica.Math.
- **VariableName** – variable name, e.g. v1, v2, vars1[2].x, etc.
- Integer or Real typed argument, e.g. 35, 3.14, xintvariable.
- options – optional parameters with named formal parameter passing.

### 22.1 OpenModelica Scripting Commands

The following are brief descriptions of the scripting commands available in the OpenModelica environment. All commands are shown in alphabetical order:

#### 22.1.1 relocateFunctions

```plaintext
function relocateFunctions
  input String fileName;
  input String names[:, 2];
  output Boolean success;
end relocateFunctions;
```

#### 22.1.2 GC_expand_hp

```plaintext
function GC_expand_hp
  input Integer size;
  output Boolean success;
end GC_expand_hp;
```

#### 22.1.3 GC_gcollect_and_unmap

#### 22.1.4 GC_get_prof_stats
function GC_get_prof_stats
    output GC_PROFSTATS gcStats;
end GC_get_prof_stats;

22.1.5 GC_set_max_heap_size

function GC_set_max_heap_size
    input Integer size;
    output Boolean success;
end GC_set_max_heap_size;

22.1.6 addClassAnnotation

function addClassAnnotation
    input TypeName class_; 
    input ExpressionOrModification annotate;
    output Boolean bool;
end addClassAnnotation;

22.1.7 addInitialState

function addInitialState
    input TypeName cl;
    input String state;
    input ExpressionOrModification annotate;
    output Boolean bool;
end addInitialState;

22.1.8 addTransition

function addTransition
    input TypeName cl;
    input String from;
    input String to;
    input String condition;
    input Boolean immediate = true;
    input Boolean reset = true;
    input Boolean synchronize = false;
    input Integer priority = 1;
    input ExpressionOrModification annotate;
    output Boolean bool;
end addTransition;

22.1.9 alarm

impure function alarm
    input Integer seconds;
    output Integer previousSeconds;
end alarm;
22.1.10 **appendEnvironmentVar**

Appends a variable to the environment variables list.

```plaintext
function appendEnvironmentVar
  input String var;
  input String value;
  output String result "returns "error" if the variable could not be appended";
end appendEnvironmentVar;
```

22.1.11 **basename**

```plaintext
function basename
  input String path;
  output String basename;
end basename;
```

22.1.12 **buildEncryptedPackage**

```plaintext
function buildEncryptedPackage
  input TypeName className "the class that should encrypted";
  output Boolean success;
  output String commandOutput "Output of the packagetool executable";
end buildEncryptedPackage;
```

22.1.13 **buildLabel**

builds Lable.

```plaintext
function buildLabel
  input TypeName className "the class that should be built";
  input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Integer numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "dassl" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "" "fileNamePrefix. <default> = ""
  input String options = "" "options. <default> = ""
  input String outputFormat = "mat" "Format for the result file. <default> = "mat"
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = .*
  input String cflags = "" "cflags. <default> = ""
  input String simflags = "" "simflags. <default> = ""
  output String[2] buildModelResults;
end buildLabel;
```

22.1.14 **buildModel**
builds a modelica model by generating c code and build it.
It does not run the code!
The only required argument is the className, while all others have some default-
→values.
simulate(className, [startTime], [stopTime], [numberOfIntervals], [tolerance],
→[method], [fileNamePrefix], [options], [outputFormat], [variableFilter],
→[cflags], [simflags])
Example command:
simulate(A);

function buildModel
input TypeName className "the class that should be built";
input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
input String method = "<default>" "integration method used for simulation. <default> = dassl";
input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
input String options = "<default>" "options. <default> = \"\"";
input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".*\"";
input String cflags = "<default>" "cflags. <default> = \"\"";
input String simflags = "<default>" "simflags. <default> = \"\"";
output String[2] buildModelResults;
end buildModel;

22.1.15 buildModelFMU

translates a modelica model into a Functional Mockup Unit.
The only required argument is the className, while all others have some default-
→values.
Example command:
buildModelFMU(className, version="2.0");

function buildModelFMU
input TypeName className "the class that should translated";
input String version = "2.0" "FMU version, 1.0 or 2.0.";
input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation), me_cs (both model exchange and co-simulation)";
input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";
input String platforms[:]={"static"} "The list of platforms to generate code for. \"dynamic\"=current platform, dynamically link the runtime. \"static\"=current platform, statically link everything. Else, use a host triple, e.g. \"x86_64-linux-gnu\" or \"x86_64-w64-mingw32\"";
input Boolean includeResources = false "include Modelica based resources via loadResource or not";
output String generatedFileName "Returns the full path of the generated FMU.";
end buildModelFMU;
22.1.16 buildOpenTURNSInterface

generates wrapper code for OpenTURNS

```modelica
define function buildOpenTURNSInterface
  input TypeName className;
  input String pythonTemplateFile;
  input Boolean showFlatModelica = false;
  output String outPythonScript;
end buildOpenTURNSInterface;
```

22.1.17 cd

change directory to the given path (which may be either relative or absolute) returns the new working directory on success or a message on failure if the given path is the empty string, the function simply returns the current \(\rightarrow\) working directory.

```modelica
define function cd
  input String newWorkingDirectory = "";
  output String workingDirectory;
end cd;
```

22.1.18 checkAllModelsRecursive

Checks all models recursively and returns number of variables and equations.

```modelica
define function checkAllModelsRecursive
  input TypeName className;
  input Boolean checkProtected = false "Checks also protected classes if true";
  output String result;
end checkAllModelsRecursive;
```

22.1.19 checkCodeGraph

Checks if the given taskgraph has the same structure as the graph described in the \(\rightarrow\) codefile.

```modelica
define function checkCodeGraph
  input String graphfile;
  input String codefile;
  output String[] result;
end checkCodeGraph;
```

22.1.20 checkInterfaceOfPackages

```modelica
define function checkInterfaceOfPackages
  input TypeName cl;
  input String dependencyMatrix[; , ];
  output Boolean success;
end checkInterfaceOfPackages;
```
22.1.21 checkModel

Checks a model and returns number of variables and equations.

```plaintext
function checkModel
    input TypeName className;
    output String result;
end checkModel;
```

22.1.22 checkSettings

Display some diagnostics.

```plaintext
function checkSettings
    output CheckSettingsResult result;
end checkSettings;
```

22.1.23 checkTaskGraph

Checks if the given taskgraph has the same structure as the reference taskgraph and if all attributes are set correctly.

```plaintext
function checkTaskGraph
    input String filename;
    input String reffilename;
    output String[:] result;
end checkTaskGraph;
```

22.1.24 classAnnotationExists

Check if annotation exists.

```plaintext
function classAnnotationExists
    input TypeName className;
    input TypeName annotationName;
    output Boolean exists;
end classAnnotationExists;
```

22.1.25 clear

Clears everything: symboltable and variables.

```plaintext
function clear
    output Boolean success;
end clear;
```

22.1.26 clearCommandLineOptions

Resets all command-line flags to their default values.
function clearCommandLineOptions
  output Boolean success;
end clearCommandLineOptions;

22.1.27 clearDebugFlags
Resets all debug flags to their default values.

function clearDebugFlags
  output Boolean success;
end clearDebugFlags;

22.1.28 clearMessages
Clears the error buffer.

function clearMessages
  output Boolean success;
end clearMessages;

22.1.29 clearProgram
Clears loaded.

function clearProgram
  output Boolean success;
end clearProgram;

22.1.30 clearVariables
Clear all user defined variables.

function clearVariables
  output Boolean success;
end clearVariables;

22.1.31 closeSimulationResultFile
Closes the current simulation result file.
Only needed by Windows. Windows cannot handle reading and writing to the same file from different processes.
To allow OMEdit to make successful simulation again on the same file we must close the file after reading the Simulation Result Variables.
Even OMEdit only use this API for Windows.

function closeSimulationResultFile
  output Boolean success;
end closeSimulationResultFile;
22.1.32 codeToString

function codeToString
    input $Code className;
    output String string;
end codeToString;

22.1.33 compareFiles

impure function compareFiles
    input String file1;
    input String file2;
    output Boolean isEqual;
end compareFiles;

22.1.34 compareFilesAndMove

impure function compareFilesAndMove
    input String newFile;
    input String oldFile;
    output Boolean success;
end compareFilesAndMove;

22.1.35 compareSimulationResults

compares simulation results.

function compareSimulationResults
    input String filename;
    input String reffilename;
    input String logfilename;
    input Real relTol = 0.01;
    input Real absTol = 0.0001;
    input String[:] vars = fill("", 0);
    output String[:] result;
end compareSimulationResults;

22.1.36 convertUnits

function convertUnits
    input String s1;
    input String s2;
    output Boolean unitsCompatible;
    output Real scaleFactor;
    output Real offset;
end convertUnits;

22.1.37 copy

copies the source file to the destined directory. Returns true if the file has been copied.
function copy
    input String source;
    input String destination;
    output Boolean success;
end copy;

22.1.38 copyClass

Copies a class within the same level

function copyClass
    input TypeName className "the class that should be copied";
    input String newClassName "the name for new class";
    input TypeName withIn = $Code(TopLevel) "the with in path for new class";
    output Boolean result;
end copyClass;

22.1.39 countMessages

function countMessages
    output Integer numMessages;
    output Integer numErrors;
    output Integer numWarnings;
end countMessages;

22.1.40 deleteFile

Deletes a file with the given name.

function deleteFile
    input String fileName;
    output Boolean success;
end deleteFile;

22.1.41 deleteInitialState

function deleteInitialState
    input TypeName cl;
    input String state;
    output Boolean bool;
end deleteInitialState;

22.1.42 deleteTransition

function deleteTransition
    input TypeName cl;
    input String from;
    input String to;
    input String condition;
    input Boolean immediate;
    input Boolean reset;
end deleteTransition;
22.1.43 deltaSimulationResults

calculates the sum of absolute errors.

```plaintext
function deltaSimulationResults
  input String filename;
  input String reffilename;
  input String method "method to compute then error. choose 1norm, 2norm, maxerr";
  input String[:] vars = fill("", 0);
  output Real result;
end deltaSimulationResults;
```

22.1.44 diffModelicaFileListings

Creates diffs of two strings corresponding to Modelica files

```plaintext
function diffModelicaFileListings
  input String before, after;
  input DiffFormat diffFormat = DiffFormat.color;
  output String result;
end diffModelicaFileListings;
```

22.1.45 diffSimulationResults

compares simulation results.

```plaintext
function diffSimulationResults
  input String actualFile;
  input String expectedFile;
  input String diffPrefix;
  input Real relTol = 1e-3 "y tolerance";
  input Real relTolDiffMinMax = 1e-4 "y tolerance based on the difference between the maximum and minimum of the signal";
  input Real rangeDelta = 0.002 "x tolerance";
  input String[:] vars = fill("", 0);
  input Boolean keepEqualResults = false;
  output Boolean success;
  output String[:] failVars;
end diffSimulationResults;
```

22.1.46 diffSimulationResultsHtml

```plaintext
function diffSimulationResultsHtml
  input String var;
  input String actualFile;
  input String expectedFile;
  input Real relTol = 1e-3 "y tolerance";
```
input Real relTolDiffMinMax = 1e-4 "y tolerance based on the difference between the maximum and minimum of the signal";
input Real rangeDelta = 0.002 "x tolerance";
output String html;
end diffSimulationResultsHtml;

22.1.47 directoryExists

function directoryExists
    input String dirName;
    output Boolean exists;
end directoryExists;

22.1.48 dirname

function dirname
    input String path;
    output String dirName;
end dirname;

22.1.49 dumpXMLDAE

Outputs the DAE system corresponding to a specific model.

function dumpXMLDAE
    input TypeName className;
    input String translationLevel = "flat" "flat, optimiser, backEnd, or stateSpace";
    input Boolean addOriginalIncidenceMatrix = false;
    input Boolean addSolvingInfo = false;
    input Boolean addMathMLCode = false;
    input Boolean dumpResiduals = false;
    input String fileNamePrefix = "<default>" "this is the className in string form by default";
    input String rewriteRulesFile = "" "the file from where the rewriteRules are read, default is empty which means no rewrite rules";
    output Boolean success "if the function succeeded true/false";
    output String xmlFileName "the Xml file";
end dumpXMLDAE;

22.1.50 echo

echo(false) disables Interactive output, echo(true) enables it again.

function echo
    input Boolean setEcho;
    output Boolean newEcho;
end echo;
22.1.51 escapeXML

```modelica
function escapeXML
  input String inStr;
  output String outStr;
end escapeXML;
```

22.1.52 exit

```modelica
function exit
  input Integer status;
end exit;
```

22.1.53 exportToFigaro

```modelica
function exportToFigaro
  input TypeName path;
  input String directory = cd();
  input String database;
  input String mode;
  input String options;
  input String processor;
  output Boolean success;
end exportToFigaro;
```

22.1.54 extendsFrom

```modelica
returns true if the given class extends from the given base class
```

```modelica
function extendsFrom
  input TypeName className;
  input TypeName baseClassName;
  output Boolean res;
end extendsFrom;
```

22.1.55 filterSimulationResults

```modelica
function filterSimulationResults
  input String inFile;
  input String outFile;
  input String[] vars;
  input Integer numberOfIntervals = 0 "0=Do not resample";
  input Boolean removeDescription = false;
  output Boolean success;
end filterSimulationResults;
```

22.1.56 generateCode

```modelica
The input is a function name for which C-code is generated and compiled into a dll/so
```
22.1.57 generateEntryPoint

```plaintext
function generateEntryPoint
  input String fileName;
  input TypeName entryPoint;
  input String url = "https://trac.openmodelica.org/OpenModelica/newticket";
end generateEntryPoint;
```

22.1.58 generateHeader

```plaintext
function generateHeader
  input String fileName;
  output Boolean success;
end generateHeader;
```

22.1.59 generateScriptingAPI

```plaintext
function generateScriptingAPI
  input TypeName cl;
  input String name;
  output Boolean success;
  output String moFile;
  output String qtFile;
  output String qtHeader;
end generateScriptingAPI;
```

22.1.60 generateSeparateCode

```plaintext
function generateSeparateCode
  input TypeName className;
  input Boolean cleanCache = false "If true, the cache is reset between each generated package. This conserves memory at the cost of speed."
  output Boolean success;
end generateSeparateCode;
```

22.1.61 generateSeparateCodeDependencies

```plaintext
function generateSeparateCodeDependencies
  input String stampSuffix = ".c" "Suffix to add to dependencies (often .c.stamp)"
  output String[:] dependencies;
end generateSeparateCodeDependencies;
```

22.1.62 generateSeparateCodeDependenciesMakefile
function generateSeparateCodeDependenciesMakefile
  input String filename "The file to write the makefile to";
  input String directory = "" "The relative path of the generated files";
  input String suffix = ".c" "Often .stamp since we do not update all the files";
  output Boolean success;
end generateSeparateCodeDependenciesMakefile;

22.1.63 generateVerificationScenarios

function generateVerificationScenarios
  input TypeName path;
  output Boolean success;
end generateVerificationScenarios;

22.1.64 getAlgorithmCount

Counts the number of Algorithm sections in a class.

function getAlgorithmCount
  input TypeName class_; 
  output Integer count;
end getAlgorithmCount;

22.1.65 getAlgorithmItemsCount

Counts the number of Algorithm items in a class.

function getAlgorithmItemsCount
  input TypeName class_; 
  output Integer count;
end getAlgorithmItemsCount;

22.1.66 getAnnotationCount

Counts the number of Annotation sections in a class.

function getAnnotationCount
  input TypeName class_; 
  output Integer count;
end getAnnotationCount;

22.1.67 getAnnotationModifierValue

function getAnnotationModifierValue
  input TypeName name;
  input String vendorannotation;
  input String modifiername;
  output String modifiernamevalue;
end getAnnotationModifierValue;
22.1.68 getAnnotationNamedModifiers

```
function getAnnotationNamedModifiers
  input TypeName name;
  input String vendorannotation;
  output String[:] modifiernamelist;
end getAnnotationNamedModifiers;
```

22.1.69 getAnnotationVersion

```
function getAnnotationVersion
  output String annotationVersion;
end getAnnotationVersion;
```

22.1.70 getAstAsCorbaString

```
Print the whole AST on the CORBA format for records, e.g.
record Absyn.PROGRAM
  classes = ...,
  within_ = ...,
  globalBuildTimes = ...
end Absyn.PROGRAM;
```

```
function getAstAsCorbaString
  input String fileName = "<interactive>";
  output String result "returns the string if fileName is interactive; else it returns ok or error depending on if writing the file succeeded";
end getAstAsCorbaString;
```

22.1.71 getAvailableIndexReductionMethods

```
function getAvailableIndexReductionMethods
  output String[:] allChoices;
  output String[:] allComments;
end getAvailableIndexReductionMethods;
```

22.1.72 getAvailableLibraries

```
function getAvailableLibraries
  output String[:] libraries;
end getAvailableLibraries;
```

22.1.73 getAvailableMatchingAlgorithms

```
function getAvailableMatchingAlgorithms
  output String[:] allChoices;
  output String[:] allComments;
end getAvailableMatchingAlgorithms;
```
22.1.74 getAvailableTearingMethods

```oml
function getAvailableTearingMethods
    output String[: ] allChoices;
    output String[: ] allComments;
end getAvailableTearingMethods;
```

22.1.75 getBooleanClassAnnotation

Check if annotation exists and returns its value

```oml
function getBooleanClassAnnotation
    input TypeName className;
    input TypeName annotationName;
    output Boolean value;
end getBooleanClassAnnotation;
```

22.1.76 getBuiltinType

```oml
function getBuiltinType
    input TypeName cl;
    output String name;
end getBuiltinType;
```

22.1.77 getCFlags

CFLAGS

```oml
function getCFlags
    output String outString;
end getCFlags;
```

22.1.78 getCXXCompiler

CXX

```oml
function getCXXCompiler
    output String compiler;
end getCXXCompiler;
```

22.1.79 getClassComment

Returns the class comment.

```oml
function getClassComment
    input TypeName cl;
    output String comment;
end getClassComment;
```
22.1.80 getClassInformation

```plaintext
function getClassInformation
  input TypeName cl;
  output String restriction, comment;
  output Boolean partialPrefix, finalPrefix, encapsulatedPrefix;
  output String fileName;
  output Boolean fileReadOnly;
  output Integer lineNumberStart, columnNumberStart, lineNumberEnd, columnNumberEnd;
  output String dimensions[];
  output Boolean isProtectedClass;
  output Boolean isDocumentationClass;
  output String version;
  output String preferredView;
  output Boolean state;
  output String access;
end getClassInformation;
```

22.1.81 getClassNames

```
function getClassNames
  input TypeName class_ = $Code(AllLoadedClasses);
  input Boolean recursive = false;
  input Boolean qualified = false;
  input Boolean sort = false;
  input Boolean builtin = false "List also builtin classes if true";
  input Boolean showProtected = false "List also protected classes if true";
  input Boolean includeConstants = false "List also constants in the class if true";
  output TypeName classNames[];
end getClassNames;
```

22.1.82 getClassRestriction

```
function getClassRestriction
  input TypeName cl;
  output String restriction;
end getClassRestriction;
```

22.1.83 getClassesInModelicaPath

```
MathCore-specific or not? Who knows!
```

```
function getClassesInModelicaPath
  output String classesInModelicaPath;
end getClassesInModelicaPath;
```

22.1.84 getCommandLineOptions
Returns all command line options who have non-default values as a list of strings. The format of the strings is '--flag=value --flag2=value2'.

```plaintext
function getCommandLineOptions
  output String[: ] flags;
end getCommandLineOptions;
```

### 22.1.85 getCompileCommand

```plaintext
function getCompileCommand
  output String compileCommand;
end getCompileCommand;
```

### 22.1.86 getCompiler

```plaintext
CC
function getCompiler
  output String compiler;
end getCompiler;
```

### 22.1.87 getComponentModifierNames

```plaintext
function getComponentModifierNames
  input TypeName class_; 
  input String componentName; 
  output String[: ] modifiers; 
end getComponentModifierNames;
```

### 22.1.88 getComponentModifierValue

```plaintext
function getComponentModifierValue
  input TypeName class_; 
  input TypeName modifier; 
  output String value; 
end getComponentModifierValue;
```

### 22.1.89 getComponentModifierValues

```plaintext
function getComponentModifierValues
  input TypeName class_; 
  input TypeName modifier; 
  output String value; 
end getComponentModifierValues;
```

### 22.1.90 getComponentsTest
function getComponentsTest
  input TypeName name;
  output Component[:] components;
record Component
  String className;
  // when building record the constructor. Records are allowed to contain only
  // components of basic types, arrays of basic types or other records.
  String name;
  String comment;
  Boolean isProtected;
  Boolean isFinal;
  Boolean isFlow;
  Boolean isStream;
  Boolean isReplaceable;
  String variability "'constant', 'parameter', 'discrete', ''";
  String innerOuter "'inner', 'outer', ''";
  String inputOutput "'input', 'output', ''";
  String dimensions[:];
end Component;
end getComponentsTest;

22.1.91 getConfigFlagValidOptions

Returns the list of valid options for a string config flag, and the description
strings for these options if available

function getConfigFlagValidOptions
  input String flag;
  output String validOptions[:];
  output String mainDescription;
  output String descriptions[:];
end getConfigFlagValidOptions;

22.1.92 getConnectionCount

Counts the number of connect equation in a class.

function getConnectionCount
  input TypeName className;
  output Integer count;
end getConnectionCount;

22.1.93 getDefaultOpenCLDevice

Returns the id for the default OpenCL device to be used.

function getDefaultOpenCLDevice
  output Integer defdevid;
end getDefaultOpenCLDevice;
22.1.94 getDerivedClassModifierNames

Returns the derived **class modifier** names.
Example command:

```plaintext
type Resistance = Real(final quantity="Resistance", final unit="Ohm");
getDerivedClassModifierNames(Resistance) => {"quantity","unit"}
```

```plaintext
function getDerivedClassModifierNames
  input TypeName className;
  output String[:] modifierNames;
end getDerivedClassModifierNames;
```

22.1.95 getDerivedClassModifierValue

Returns the derived **class modifier** value.
Example command:

```plaintext
type Resistance = Real(final quantity="Resistance", final unit="Ohm");
getDerivedClassModifierValue(Resistance, unit); => " = "Ohm"
getDerivedClassModifierValue(Resistance, quantity); => " = "Resistance"
```

```plaintext
function getDerivedClassModifierValue
  input TypeName className;
  input TypeName modifierName;
  output String modifierValue;
end getDerivedClassModifierValue;
```

22.1.96 getDerivedUnits

```plaintext
function getDerivedUnits
  input String baseUnit;
  output String[:] derivedUnits;
end getDerivedUnits;
```

22.1.97 getDocumentationAnnotation

Returns the documentaiton **annotation** defined in the **class**.

```plaintext
function getDocumentationAnnotation
  input TypeName cl;
  output String out[3] "(info,revision,infoHeader) TODO: Should be changed to have 2 outputs instead of an array of 2 Strings...";
end getDocumentationAnnotation;
```

22.1.98 getEnvironmentVar

Returns the value of the environment variable.

```plaintext
function getEnvironmentVar
  input String var;
  output String value "returns empty string on failure";
end getEnvironmentVar;
```
### 22.1.99 getEquationCount
Counts the number of Equation sections in a class.

```plaintext
function getEquationCount
  input TypeName class_; 
  output Integer count; 
end getEquationCount; 
```

### 22.1.100 getEquationItemsCount
Counts the number of Equation items in a class.

```plaintext
function getEquationItemsCount
  input TypeName class_; 
  output Integer count; 
end getEquationItemsCount; 
```

### 22.1.101 getErrorString

```plaintext
impure function getErrorString
  input Boolean warningsAsErrors = false; 
  output String errorString; 
end getErrorString; 
```

### 22.1.102 getImportCount
Counts the number of Import sections in a class.

```plaintext
function getImportCount
  input TypeName class_; 
  output Integer count; 
end getImportCount; 
```

### 22.1.103 getIndexReductionMethod

```plaintext
function getIndexReductionMethod
  output String selected; 
end getIndexReductionMethod; 
```

### 22.1.104 getInheritedClasses

```plaintext
function getInheritedClasses
  input TypeName name; 
  output TypeName inheritedClasses[:]; 
end getInheritedClasses; 
```
22.1.105 getInitialAlgorithmCount

Counts the number of Initial Algorithm sections in a class.

```modelica
definition getInitialAlgorithmCount
  input TypeName class_
  output Integer count
end getInitialAlgorithmCount;
```

22.1.106 getInitialAlgorithmItemsCount

Counts the number of Initial Algorithm items in a class.

```modelica
definition getInitialAlgorithmItemsCount
  input TypeName class_
  output Integer count
end getInitialAlgorithmItemsCount;
```

22.1.107 getInitialEquationCount

Counts the number of Initial Equation sections in a class.

```modelica
definition getInitialEquationCount
  input TypeName class_
  output Integer count
end getInitialEquationCount;
```

22.1.108 getInitialEquationItemsCount

Counts the number of Initial Equation items in a class.

```modelica
definition getInitialEquationItemsCount
  input TypeName class_
  output Integer count
end getInitialEquationItemsCount;
```

22.1.109 getInitialStates

```modelica
definition getInitialStates
  input TypeName cl
  output String[:, :] initialStates
end getInitialStates;
```

22.1.110 getInstallationDirectoryPath

This returns OPENMODELICA_HOME if it is set; on some platforms the default path is returned if it is not set.

```modelica
definition getInstallationDirectoryPath
  output String installationDirectoryPath
end getInstallationDirectoryPath;
```
### 22.1.111 getInstantiatedParametersAndValues

```plaintext
function getInstantiatedParametersAndValues
  input TypeName cls;
  output String[:] values;
end getInstantiatedParametersAndValues;
```

### 22.1.112 getLanguageStandard

Returns the current Modelica Language Standard in use.

```plaintext
function getLanguageStandard
  output String outVersion;
end getLanguageStandard;
```

### 22.1.113 getLinker

```plaintext
function getLinker
  output String linker;
end getLinker;
```

### 22.1.114 getLinkerFlags

```plaintext
function getLinkerFlags
  output String linkerFlags;
end getLinkerFlags;
```

### 22.1.115 getLoadedLibraries

```plaintext
function getLoadedLibraries
  output String[:, 2] libraries;
end getLoadedLibraries;
```

### 22.1.116 getMatchingAlgorithm

```plaintext
function getMatchingAlgorithm
  output String selected;
end getMatchingAlgorithm;
```

### 22.1.117 getMemorySize

```plaintext
function getMemorySize
  output Real memory(unit = "MiB");
end getMemorySize;
```
22.1.118 getMessagesString

see getErrorString()

```plaintext
function getMessagesString
  output String messagesString;
end getMessagesString;
```

22.1.119 getModelicaPath

Get the Modelica Library Path.

```plaintext
function getModelicaPath
  output String modelicaPath;
end getModelicaPath;
```

22.1.120 getNoSimplify

Returns true if noSimplify flag is set.

```plaintext
function getNoSimplify
  output Boolean noSimplify;
end getNoSimplify;
```

22.1.121 getNthAlgorithm

Returns the Nth Algorithm section.

```plaintext
function getNthAlgorithm
  input TypeName class_; input Integer index;
  output String result;
end getNthAlgorithm;
```

22.1.122 getNthAlgorithmItem

Returns the Nth Algorithm Item.

```plaintext
function getNthAlgorithmItem
  input TypeName class_; input Integer index;
  output String result;
end getNthAlgorithmItem;
```

22.1.123 getNthAnnotationString

Returns the Nth Annotation section as string.
function getNthAnnotationString
  input TypeName class_;  
  input Integer index;  
  output String result;  
end getNthAnnotationString;

22.1.124 getNthConnection

Returns the Nth connection.
Example command:
getNthConnection(A) => {"from", "to", "comment"}

function getNthConnection
  input TypeName className;  
  input Integer index;  
  output String[: ] result;  
end getNthConnection;

22.1.125 getNthEquation

Returns the Nth Equation section.

function getNthEquation
  input TypeName class_;  
  input Integer index;  
  output String result;  
end getNthEquation;

22.1.126 getNthEquationItem

Returns the Nth Equation Item.

function getNthEquationItem
  input TypeName class_;  
  input Integer index;  
  output String result;  
end getNthEquationItem;

22.1.127 getNthImport

Returns the Nth Import as string.

function getNthImport
  input TypeName class_;  
  input Integer index;  
  output String out[3] "{{"Path\",\"Id\",\"Kind\"}}";  
end getNthImport;
22.1.128 getNthInitialAlgorithm

Returns the Nth Initial Algorithm section.

function getNthInitialAlgorithm
   input TypeName class_;  
   input Integer index;  
   output String result;  
end getNthInitialAlgorithm;

22.1.129 getNthInitialAlgorithmItem

Returns the Nth Initial Algorithm Item.

function getNthInitialAlgorithmItem
   input TypeName class_;  
   input Integer index;  
   output String result;  
end getNthInitialAlgorithmItem;

22.1.130 getNthInitialEquation

Returns the Nth Initial Equation section.

function getNthInitialEquation
   input TypeName class_;  
   input Integer index;  
   output String result;  
end getNthInitialEquation;

22.1.131 getNthInitialEquationItem

Returns the Nth Initial Equation Item.

function getNthInitialEquationItem
   input TypeName class_;  
   input Integer index;  
   output String result;  
end getNthInitialEquationItem;

22.1.132 getOrderConnections

Returns true if orderConnections flag is set.

function getOrderConnections
   output Boolean orderConnections;  
end getOrderConnections;
### 22.1.133 getPackages

Returns the list of packages defined in the class.

```plaintext
function getPackages
  input TypeName class_ = $Code(AllLoadedClasses);
  output TypeName classNames[;];
end getPackages;
```

### 22.1.134 getParameterNames

```plaintext
function getParameterNames
  input TypeName class_;
  output String[:] parameters;
end getParameterNames;
```

### 22.1.135 getParameterValue

```plaintext
function getParameterValue
  input TypeName class_;  
  input String parameterName;
  output String parameterValue;
end getParameterValue;
```

### 22.1.136 getSettings

```plaintext
function getSettings
  output String settings;
end getSettings;
```

### 22.1.137 getShowAnnotations

```plaintext
function getShowAnnotations
  output Boolean show;
end getShowAnnotations;
```

### 22.1.138 getSimulationOptions

```plaintext
function getSimulationOptions
  input TypeName name;
  input Real defaultStartTime = 0.0;
  input Real defaultStopTime = 1.0;
  input Real defaultTolerance = 1e-6;
  input Integer defaultNumberOfIntervals = 500 "May be overridden by defining defaultInterval instead";
  input Real defaultInterval = 0.0 "If = 0.0, then numberOfIntervals is used to calculate the step size";
  output Real startTime;
  output Real stopTime;
  output Real tolerance;
  output Integer numberOfIntervals;
end getSimulationOptions;
```

(continues on next page)
output Real interval;
end getSimulationOptions;

22.1.139 getSourceFile

Returns the filename of the class.

function getSourceFile
  input TypeName class_;  
  output String filename "empty on failure";
end getSourceFile;

22.1.140 getTearingMethod

function getTearingMethod
  output String selected;
end getTearingMethod;

22.1.141 getTempDirectoryPath

Returns the current user temporary directory location.

function getTempDirectoryPath
  output String tempDirectoryPath;
end getTempDirectoryPath;

22.1.142 getTimeStamp

function getTimeStamp
  input TypeName cl;  
  output Real timeStamp;
  output String time StampAsString;
end getTimeStamp;

22.1.143 getTransitions

function getTransitions
  input TypeName cl;  
  output String[:, :] transitions;
end getTransitions;

22.1.144 getUsedClassNames

Returns the list of class names used in the total program defined by the class.

function getUsedClassNames
  input TypeName className;
  output TypeName classNames[:];
end getUsedClassNames;
22.1.145 getUses

```plaintext
function getUses
  input TypeName pack;
  output String[:, :] uses;
end getUses;
```

22.1.146 getVectorizationLimit

```plaintext
function getVectorizationLimit
  output Integer vectorizationLimit;
end getVectorizationLimit;
```

22.1.147 getVersion

Returns the version of the Modelica compiler.

```plaintext
function getVersion
  input TypeName cl = $Code(OpenModelica);
  output String version;
end getVersion;
```

22.1.148 help

display the OpenModelica help text.

```plaintext
function help
  input String topic = "topics";
  output String helpText;
end help;
```

22.1.149 iconv

The iconv() function converts one multibyte characters from one character set to another. See man (3) iconv for more information.

```plaintext
function iconv
  input String string;
  input String from;
  input String to = "UTF-8";
  output String result;
end iconv;
```

22.1.150 importFMU

Imports the Functional Mockup Unit
Example command: importFMU("A.fmu");
function importFMU
    input String filename "the fmu file name";
    input String workdir = "<default>" "The output directory for imported FMU files. <default> will put the files to current working directory.";
    input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
    input Boolean fullPath = false "When true the full output path is returned; otherwise only the file name.";
    input Boolean debugLogging = false "When true the FMU's debug output is printed.
    output String generatedFileName "Returns the full path of the generated file.";
end importFMU;

22.1.151 importFMUModelDescription
Imports modelDescription.xml
Example command:
importFMUModelDescription("A.xml");

function importFMUModelDescription
    input String filename "the fmu file name";
    input String workdir = "<default>" "The output directory for imported FMU files. <default> will put the files to current working directory.";
    input Integer loglevel = 3 "loglevel_nothing=0;loglevel_fatal=1;loglevel_error=2;loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";
    input Boolean fullPath = false "When true the full output path is returned; otherwise only the file name.";
    input Boolean debugLogging = false "When true the FMU's debug output is printed.
    output String generatedFileName "Returns the full path of the generated file.";
end importFMUModelDescription;

22.1.152 inferBindings

function inferBindings
    input TypeName path;
    output Boolean success;
end inferBindings;

22.1.153 instantiateModel
Instantiates the class and returns the flat Modelica code.

function instantiateModel
    input TypeName className;
    output String result;
end instantiateModel;
22.1.154 isBlock

```modelica
function isBlock
  input TypeName cl;
  output Boolean b;
end isBlock;
```

22.1.155 isClass

```modelica
function isClass
  input TypeName cl;
  output Boolean b;
end isClass;
```

22.1.156 isConnector

```modelica
function isConnector
  input TypeName cl;
  output Boolean b;
end isConnector;
```

22.1.157 isEnumeration

```modelica
function isEnumeration
  input TypeName cl;
  output Boolean b;
end isEnumeration;
```

22.1.158 isExperiment

```modelica
function isExperiment
  input TypeName name;
  output Boolean res;
end isExperiment;
```

22.1.159 isFunction

```modelica
function isFunction
  input TypeName cl;
  output Boolean b;
end isFunction;
```

22.1.160 isModel

```modelica
function isModel
  input TypeName cl;
  output Boolean b;
end isModel;
```
22.1.161 isOperator

```modelica
function isOperator
    input TypeName cl;
    output Boolean b;
end isOperator;
```

22.1.162 isOperatorFunction

```modelica
function isOperatorFunction
    input TypeName cl;
    output Boolean b;
end isOperatorFunction;
```

22.1.163 isOperatorRecord

```modelica
function isOperatorRecord
    input TypeName cl;
    output Boolean b;
end isOperatorRecord;
```

22.1.164 isOptimization

```modelica
function isOptimization
    input TypeName cl;
    output Boolean b;
end isOptimization;
```

22.1.165 isPackage

```modelica
function isPackage
    input TypeName cl;
    output Boolean b;
end isPackage;
```

22.1.166 isPartial

```modelica
function isPartial
    input TypeName cl;
    output Boolean b;
end isPartial;
```

22.1.167 isProtectedClass

```modelica
function isProtectedClass
    input TypeName cl;
    input String c2;
    output Boolean b;
end isProtectedClass;
```
22.1.168 isRecord

```plaintext
function isRecord
  input TypeName cl;
  output Boolean b;
end isRecord;
```

22.1.169 isShortDefinition

returns true if the definition is a short class definition

```plaintext
function isShortDefinition
  input TypeName class_; 
  output Boolean isShortCls;
end isShortDefinition;
```

22.1.170 isType

```plaintext
function isType
  input TypeName cl;
  output Boolean b;
end isType;
```

22.1.171 linearize

creates a model with symbolic linearization matrixes

```plaintext
function linearize
  input TypeName className "the class that should be simulated";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real stepSize = 0.002 "step size that is used for the result file. <default> = 0.002";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "<default>" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = "mat"";
  input Boolean storeInTemp = false "storeInTemp. <default> = false";
  input Boolean noClean = false "noClean. <default> = false";
  input String options = "<default>" "options. <default> = "";
  input String outputFormat = "mat" "Format for the result file. <default> = "mat"
  "";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = "*.";
  input String cflags = "<default>" "cflags. <default> = "";
  input String simflags = "<default>" "simflags. <default> = ""
end linearize;
```
22.1.172 list

Lists the contents of the given class, or all loaded classes.

```plaintext
function list
    input TypeName class_ = $Code(AllLoadedClasses);
    input Boolean interfaceOnly = false;
    input Boolean shortOnly = false "only short class definitions";
    input ExportKind exportKind = ExportKind.Absyn;
    output String contents;
end list;
```

22.1.173 listFile

Lists the contents of the file given by the class.

```plaintext
function listFile
    input TypeName class_;  
    output String contents;
end listFile;
```

22.1.174 listVariables

Lists the names of the active variables in the scripting environment.

```plaintext
function listVariables
    output TypeName variables[::];
end listVariables;
```

22.1.175 loadEncryptedPackage

```plaintext
function loadEncryptedPackage
    input String fileName;
    input String workdir = "<default>" "The output directory for imported encrypted files. <default> will put the files to current working directory.";
    output Boolean success;
end loadEncryptedPackage;
```

22.1.176 loadFile

Load file (*.mo) and merge it with the loaded AST.

```plaintext
function loadFile
    input String fileName;
    input String encoding = "UTF-8";
    input Boolean uses = true;
    output Boolean success;
end loadFile;
```
22.1.177 loadFileInteractive

function loadFileInteractive
  input String filename;
  input String encoding = "UTF-8";
  output TypeName names[:];
end loadFileInteractive;

22.1.178 loadFileInteractiveQualified

function loadFileInteractiveQualified
  input String filename;
  input String encoding = "UTF-8";
  output TypeName names[:];
end loadFileInteractiveQualified;

22.1.179 loadFiles

load files (*.mo) and merges them with the loaded AST.

function loadFiles
  input String[:] fileNames;
  input String encoding = "UTF-8";
  input Integer numThreads = OpenModelica.Scripting.numProcessors();
  output Boolean success;
end loadFiles;

22.1.180 loadModel

Loads the Modelica Standard Library.

function loadModel
  input TypeName className;
  input String[:] priorityVersion = {"default"};
  input Boolean notify = false "Give a notification of the libraries and versions that were loaded";
  input String languageStandard = "" "Override the set language standard. Parse with the given setting, but do not change it permanently.";
  input Boolean requireExactVersion = false "If the version is required to be exact, if there is a uses Modelica(version="3.2"), Modelica 3.2.1 will not match it."
  output Boolean success;
end loadModel;

22.1.181 loadModelica3D

function loadModelica3D
  input String version = "3.2.1";
  output Boolean status;
end loadModelica3D;
22.1.182 loadString

Parses the data and merges the resulting AST with the loaded AST. If a filename is given, it is used to provide error messages as if the string was read in binary format from a file with the same name. The file is converted to UTF-8 from the given character set. When merge is true the classes cNew in the file will be merged with the already loaded classes cOld in the following way:
1. get all the inner class definitions from cOld that were loaded from a different file than itself
2. append all elements from step 1 to class cNew public list

NOTE: Encoding is deprecated as *ALL* strings are now UTF-8 encoded.

```plaintext
function loadString
  input String data;
  input String filename = "<interactive>";
  input String encoding = "UTF-8";
  input Boolean merge = false "if merge is true the parsed AST is merged with the existing AST, default to false which means that is replaced, not merged";
  output Boolean success;
end loadString;
```

22.1.183 mkdir

create directory of given path (which may be either relative or absolute) returns true if directory was created or already exists.

```plaintext
function mkdir
  input String newDirectory;
  output Boolean success;
end mkdir;
```

22.1.184 moveClass

Moves a class up or down depending on the given offset, where a positive offset moves the class down and a negative offset up. The offset is truncated if the resulting index is outside the class list. It retains the visibility of the class by adding public/protected sections when needed, and merges sections of the same type if the class is moved from a section it was alone in. Returns true if the move was successful, otherwise false.

```plaintext
function moveClass
  input TypeName className "the class that should be moved";
  input Integer offset "Offset in the class list.";
  output Boolean result;
end moveClass;
```

22.1.185 moveClassToBottom

Moves a class to the bottom of its enclosing class. Returns true if the move was successful, otherwise false.

```plaintext
function moveClassToBottom
end moveClassToBottom;
```
function moveClassToBottom
    input TypeName className;
    output Boolean result;
end moveClassToBottom;

22.1.186 moveClassToTop

Moves a class to the top of its enclosing class. Returns true if the move was successful, otherwise false.

function moveClassToTop
    input TypeName className;
    output Boolean result;
end moveClassToTop;

22.1.187 ngspicetoModelica

Converts ngspice netlist to Modelica code. Modelica file is created in the same directory as netlist file.

function ngspicetoModelica
    input String netlistfileName;
    output Boolean success = false;
end ngspicetoModelica;

22.1.188 numProcessors

function numProcessors
    output Integer result;
end numProcessors;

22.1.189 optimize

optimize a modelica/optimica model by generating c code, build it and run the optimization executable.
The only required argument is the className, while all others have some default values.
simulate(className, [startTime], [stopTime], [numberOfIntervals], [stepSize],
         [tolerance], [fileNamePrefix], [options], [outputFormat], [variableFilter],
         [cflags], [simflags])
Example command:
simulate(A);

function optimize
    input TypeName className "the class that should simulated";
    input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
    input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
    input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
    input Real stepSize = 0.002 "step size that is used for the result file. <default> = 0.002";
(continues on next page)
input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = l-6";
input String method = DAE.SCONST("optimization") "optimize a modelica/optimica model."
input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"
input Boolean storeInTemp = false "storeInTemp. <default> = false"
input Boolean noClean = false "noClean. <default> = false"
input String options = "<default>" "options. <default> = \"
input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"
input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = \".\"
input String cflags = "<default>" "cflags. <default> = \"
input String simflags = "<default>" "simflags. <default> = \"
output String optimizationResults;
end optimize;

22.1.190 parseFile

function parseFile
input String filename;
input String encoding = "UTF-8";
output TypeName names[:];
end parseFile;

22.1.191 parseString

function parseString
input String data;
input String filename = "<interactive>";
output TypeName names[:];
end parseString;

22.1.192 plot

Launches a plot window using OMPlot.

function plot
input VariableNames vars "The variables you want to plot";
input Boolean externalWindow = false "Opens the plot in a new plot window";
input String fileName = "<default>" "The filename containing the variables. \<default> will read the last simulation result";
input String title = "\" "This text will be used as the display title.";
input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none.";
input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled.";
input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled.";
input String xLabel = "time" "This text will be used as the horizontal label in the diagram.";
input String yLabel = "\" "This text will be used as the vertical label in the diagram.";
input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram. (0,0) will select a suitable range.";

(continues on next page)
input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram. (0,0) will select a suitable range."
input Real curveWidth = 1.0 "Sets the width of the curve."
input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7."
input String legendPosition = "top" "Sets the POSITION of the legend i.e left, right, top, bottom, none."
input String footer = "" "This text will be used as the diagram footer."
input Boolean autoScale = true "Use auto scale while plotting."
input Boolean forceOMPlot = false "If true launches OMPlot and doesn't call callback function even if it is defined."
output Boolean success "Returns true on success"
end plot;

22.1.193 plotAll

Works in the same way as plot(), but does not accept any variable names as input. Instead, all variables are part of the plot window. Example command sequences:
simulate(A);plotAll();
simulate(A);plotAll(externalWindow=true);
simulate(A,fileNamePrefix="B");simulate(C);plotAll(x,fileName="B.mat");

function plotAll
input Boolean externalWindow = false "Opens the plot in a new plot window";
input String fileName = "<default>" "The filename containing the variables. <default> will read the last simulation result";
input String title = "" "This text will be used as the diagram title."
input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none."
input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled."
input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled."
input String xLabel = "time" "This text will be used as the horizontal label in the diagram."
input String yLabel = "" "This text will be used as the vertical label in the diagram."
input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram. (0,0) will select a suitable range."
input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram. (0,0) will select a suitable range."
input Real curveWidth = 1.0 "Sets the width of the curve. SolidLine=1, DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7."
input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, right, top, bottom, none."
input String footer = "" "This text will be used as the diagram footer."
input Boolean autoScale = true "Use auto scale while plotting."
input Boolean forceOMPlot = false "If true launches OMPlot and doesn't call callback function even if it is defined."
output Boolean success "Returns true on success";
end plotAll;
### 22.1.194 plotParametric

Launches a plotParametric window using OMPlot. Returns `true` on success.

Example command sequences:
```modelica
simulate(A); plotParametric(x, y);
simulate(A); plotParametric(x, y, externalWindow=true);
```

```modelica
function plotParametric
    input VariableName xVariable;
    input VariableName yVariable;
    input Boolean externalWindow = false "Opens the plot in a new plot window";
    input String fileName = "<default>" "The filename containing the variables.  
                                -><default> will read the last simulation result";
    input String title = "" "This text will be used as the diagram title.";
    input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed, none.";
    input Boolean logX = false "Determines whether or not the horizontal axis is logarithmically scaled.";
    input Boolean logY = false "Determines whether or not the vertical axis is logarithmically scaled.";
    input String xLabel = "time" "This text will be used as the horizontal label in the diagram.";
    input String yLabel = "" "This text will be used as the vertical label in the diagram.";
    input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is visible in the diagram.  
                                 ->(0,0) will select a suitable range.";
    input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is visible in the diagram.  
                                 ->(0,0) will select a suitable range.";
    input Real curveWidth = 1.0 "Sets the width of the curve.";
    input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, 
                                 DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";
    input String legendPosition = "top" "Sets the POSITION of the legend i.e left, right, top, bottom, none.";
    input String footer = "" "This text will be used as the diagram footer.";
    input Boolean autoScale = true "Use auto scale while plotting.";
    input Boolean forceOMPlot = false "If true launches OMPlot and doesn't call callback function even if it is defined.";
    output Boolean success "Returns true on success";
end plotParametric;
```

### 22.1.195 readFile

The contents of the given file are returned. Note that if the function fails, the error message is returned as a string instead of multiple output or similar.

```modelica
impure function readFile
    input String fileName;
    output String contents;
end readFile;
```

### 22.1.196 readFileNoNumeric

Returns the contents of the file, with anything resembling a (real) number stripped out, and at the end adding:

```
Filter count from number domain: n.
```

(continues on next page)
This should probably be changed to multiple outputs; the filtered string and an integer.

Does anyone use this API call?

```plaintext
function readFileNoNumeric
   input String fileName;
   output String contents;
end readFileNoNumeric;
```

22.1.197 readSimulationResult

Reads a result file, returning a matrix corresponding to the variables and size given.

```plaintext
function readSimulationResult
   input String filename;
   input VariableNames variables;
   input Integer size = 0 "0=read any size... If the size is not the same as the result-file, this function fails";
   output Real result[:, :];
end readSimulationResult;
```

22.1.198 readSimulationResultSize

The number of intervals that are present in the output file.

```plaintext
function readSimulationResultSize
   input String fileName;
   output Integer sz;
end readSimulationResultSize;
```

22.1.199 readSimulationResultVars

Returns the variables in the simulation file; you can use val() and plot() commands using these names.

```plaintext
function readSimulationResultVars
   input String fileName;
   input Boolean readParameters = true;
   input Boolean openmodelicaStyle = false;
   output String[:] vars;
end readSimulationResultVars;
```

22.1.200 realpath

Get full path name of file or directory name

```plaintext
function realpath
   input String name "Absolute or relative file or directory name";
   output String fullName "Full path of 'name";
end realpath;
```
22.1.201 reduceTerms

reduce terms.

```
function reduceTerms
    input TypeName className "the class that should be built";
    input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";
    input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
    input Integer numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
    input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
    input String method = "dassl" "integration method used for simulation. <default> = dassl";
    input String fileNamePrefix = "" "fileNamePrefix. <default> = "";
    input String options = "" "options. <default> = "";
    input String outputFormat = "mat" "Format for the result file. <default> = "mat";
    input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = ".*";
    input String cflags = "" "cflags. <default> = "";
    input String simflags = "" "simflags. <default> = "";
    input String labelstoCancel = "";
    output String[2] buildModelResults;
end reduceTerms;
```

22.1.202 regex

Sets the error buffer and returns -1 if the regex does not compile. The returned result is the same as POSIX regex(): The first value is the complete matched string The rest are the substrings that you wanted. For example:

```
regex(lorem, "\([A-Za-z]*\) \([A-Za-z]*\) ",maxMatches=3) => {" ipsum dolor ","ipsum","dolor")
```

This means if you have n groups, you want maxMatches=n+1

```
function regex
    input String str;
    input String re;
    input Integer maxMatches = 1 "The maximum number of matches that will be returned";
    input Boolean extended = true "Use POSIX extended or regular syntax";
    input Boolean caseInsensitive = false;
    output Integer numMatches "-1 is an error, 0 means no match, else returns a number 1..maxMatches";
    output String matchedSubstrings[maxMatches] "unmatched strings are returned as empty";
end regex;
```

22.1.203 regexBool

Returns true if the string matches the regular expression.

```
function regexBool
    input String str;
    input String re;
```
input Boolean extended = true "Use POSIX extended or regular syntax";
input Boolean caseInsensitive = false;
output Boolean matches;
end regexBool;

22.1.204 regularFileExists

function regularFileExists
  input String fileName;
  output Boolean exists;
end regularFileExists;

22.1.205 reloadClass

reloads the file associated with the given (loaded class)

function reloadClass
  input TypeName name;
  input String encoding = "UTF-8";
  output Boolean success;
end reloadClass;

22.1.206 remove

removes a file or directory of given path (which may be either relative or absolute).

function remove
  input String path;
  output Boolean success "Returns true on success."
end remove;

22.1.207 removeComponentModifiers

function removeComponentModifiers
  input TypeName class_;
  input String componentName;
  input Boolean keepRedeclares = false;
  output Boolean success;
end removeComponentModifiers;

22.1.208 removeExtendsModifiers

function removeExtendsModifiers
  input TypeName className;
  input TypeName baseClassName;
  input Boolean keepRedeclares = false;
  output Boolean success;
end removeExtendsModifiers;
22.1.209 reopenStandardStream

```plaintext
function reopenStandardStream
  input StandardStream _stream;
  input String filename;
  output Boolean success;
end reopenStandardStream;
```

22.1.210 rewriteBlockCall

```plaintext
Function for property modeling, transforms block calls into instantiations for a loaded model

function rewriteBlockCall
  input TypeName className;
  input TypeName inDefs;
  output Boolean success;
end rewriteBlockCall;
```

22.1.211 runOpenTURNSPythonScript

```plaintext
runs OpenTURNS with the given python script returning the log file

function runOpenTURNSPythonScript
  input String pythonScriptFile;
  output String logOutputFile;
end runOpenTURNSPythonScript;
```

22.1.212 runScript

```plaintext
Runs the mos-script specified by the filename.

impure function runScript
  input String fileName "*.mos";
  output String result;
end runScript;
```

22.1.213 runScriptParallel

```plaintext
function runScriptParallel
  input String scripts[:];
  input Integer numThreads = numProcessors();
  input Boolean useThreads = false;
  output Boolean results[:];
end runScriptParallel;
```

22.1.214 save
22.1.215 **saveAll**

Save the entire loaded AST to file.

```oml
function saveAll
    input String fileName;
    output Boolean success;
end saveAll;
```

22.1.216 **saveModel**

```oml
function saveModel
    input String fileName;
    input TypeName className;
    output Boolean success;
end saveModel;
```

22.1.217 **saveTotalModel**

```oml
function saveTotalModel
    input String fileName;
    input TypeName className;
    input Boolean stripAnnotations = false;
    input Boolean stripComments = false;
    output Boolean success;
end saveTotalModel;
```

22.1.218 **saveTotalSCode**

22.1.219 **searchClassNames**

Searches for the class name in all the loaded classes.

Example command:

```oml
searchClassNames("ground");
searchClassNames("ground", true);
```

```oml
function searchClassNames
    input String searchText;
    input Boolean findInText = false;
    output TypeName classNames[:];
end searchClassNames;
```

22.1.220 **setAnnotationVersion**

Sets the annotation version.
function setAnnotationVersion
  input String annotationVersion;
  output Boolean success;
end setAnnotationVersion;

22.1.221 setCFlags

CFLAGS

function setCFlags
  input String inString;
  output Boolean success;
end setCFlags;

22.1.222 setCXXCompiler

CXX

function setCXXCompiler
  input String compiler;
  output Boolean success;
end setCXXCompiler;

22.1.223 setCheapMatchingAlgorithm

example input: 3

function setCheapMatchingAlgorithm
  input Integer matchingAlgorithm;
  output Boolean success;
end setCheapMatchingAlgorithm;

22.1.224 setClassComment

Sets the class comment.

function setClassComment
  input TypeName class_;  
  input String filename;
  output Boolean success;
end setClassComment;

22.1.225 setCommandLineOptions

The input is a regular command-line flag given to OMC, e.g. -d=failtrace or -g=MetaModelica
function setCommandLineOptions
    input String option;
    output Boolean success;
end setCommandLineOptions;

22.1.226 setCompileCommand

function setCompileCommand
    input String compileCommand;
    output Boolean success;
end setCompileCommand;

22.1.227 setCompiler

CC

function setCompiler
    input String compiler;
    output Boolean success;
end setCompiler;

22.1.228 setCompilerFlags

function setCompilerFlags
    input String compilerFlags;
    output Boolean success;
end setCompilerFlags;

22.1.229 setCompilerPath

function setCompilerPath
    input String compilerPath;
    output Boolean success;
end setCompilerPath;

22.1.230 setDebugFlags

example input: failtrace,-noevalfunc

function setDebugFlags
    input String debugFlags;
    output Boolean success;
end setDebugFlags;

22.1.231 setDefaultOpenCLDevice

Sets the default OpenCL device to be used.
function setDefaultOpenCLDevice
   input Integer defdevId;
   output Boolean success;
end setDefaultOpenCLDevice;

22.1.232 setDocumentationAnnotation

function setDocumentationAnnotation
   input TypeName class_;
   input String info = "";
   input String revisions = "";
   output Boolean bool;
end setDocumentationAnnotation;

22.1.233 setEnvironmentVar

function setEnvironmentVar
   input String var;
   input String value;
   output Boolean success;
end setEnvironmentVar;

22.1.234 setIndexReductionMethod

example input: dynamicStateSelection

function setIndexReductionMethod
   input String method;
   output Boolean success;
end setIndexReductionMethod;

22.1.235 setInitXmlStartValue

function setInitXmlStartValue
   input String fileName;
   input String variableName;
   input String startValue;
   input String outputFile;
   output Boolean success = false;
end setInitXmlStartValue;

22.1.236 setInstallationDirectoryPath

Sets the OPENMODELICAHOME environment variable. Use this method instead of `setEnvironmentVar`.

function setInstallationDirectoryPath
   input String installationDirectoryPath;
   output Boolean success;
end setInstallationDirectoryPath;
22.1.237 setLanguageStandard

Sets the Modelica Language Standard.

```plaintext
function setLanguageStandard
  input String inVersion;
  output Boolean success;
end setLanguageStandard;
```

22.1.238 setLinker

```plaintext
function setLinker
  input String linker;
  output Boolean success;
end setLinker;
```

22.1.239 setLinkerFlags

```plaintext
function setLinkerFlags
  input String linkerFlags;
  output Boolean success;
end setLinkerFlags;
```

22.1.240 setMatchingAlgorithm

```plaintext
example input: omc

function setMatchingAlgorithm
  input String matchingAlgorithm;
  output Boolean success;
end setMatchingAlgorithm;
```

22.1.241 setModelicaPath

The Modelica Library Path - MODELICAPATH in the language specification; --OPENMODELICALIBRARY in OpenModelica.

```plaintext
function setModelicaPath
  input String modelicaPath;
  output Boolean success;
end setModelicaPath;
```

22.1.242 setNoSimplify

Sets the noSimplify flag.

```plaintext
function setNoSimplify
  input Boolean noSimplify;
  output Boolean success;
end setNoSimplify;
```
22.1.243 setOrderConnections

Sets the orderConnection flag.

```modelica
function setOrderConnections
  input Boolean orderConnections;
  output Boolean success;
end setOrderConnections;
```

22.1.244 setPlotCommand

```modelica
function setPlotCommand
  input String plotCommand;
  output Boolean success;
end setPlotCommand;
```

22.1.245 setPostOptModules

```modelica
function setPostOptModules
  input String modules;
  output Boolean success;
end setPostOptModules;
```

22.1.246 setPreOptModules

```modelica
function setPreOptModules
  input String modules;
  output Boolean success;
end setPreOptModules;
```

22.1.247 setShowAnnotations

```modelica
function setShowAnnotations
  input Boolean show;
  output Boolean success;
end setShowAnnotations;
```

22.1.248 setSourceFile

```modelica
function setSourceFile
  input TypeName class_;
  input String filename;
  output Boolean success;
end setSourceFile;
```
22.1.249 setTearingMethod

```omc
example input: omcTearing

function setTearingMethod
  input String tearingMethod;
  output Boolean success;
end setTearingMethod;
```

22.1.250 setTempDirectoryPath

```omc
function setTempDirectoryPath
  input String tempDirectoryPath;
  output Boolean success;
end setTempDirectoryPath;
```

22.1.251 setVectorizationLimit

```omc
function setVectorizationLimit
  input Integer vectorizationLimit;
  output Boolean success;
end setVectorizationLimit;
```

22.1.252 simulate

```omc
simulates a modelica model by generating c code, build it and run the simulation.

The only required argument is the className, while all others have some default values.

simulate(className, [startTime], [stopTime], [numberOfIntervals], [tolerance],
  [method], [fileNamePrefix], [options], [outputFormat], [variableFilter],
  [cflags], [simflags])

Example command:
simulate(A);

function simulate
  input TypeName className "the class that should simulated";
  input Real startTime = "<default>" "the start time of the simulation. <default> = 0.0";
  input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";
  input Real numberOfIntervals = 500 "number of intervals in the result file. <default> = 500";
  input Real tolerance = 1e-6 "tolerance used by the integration method. <default> = 1e-6";
  input String method = "<default>" "integration method used for simulation. <default> = dassl";
  input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = "\""";
  input String options = "<default>" "options. <default> = \"\"";
  input String outputFormat = "mat" "Format for the result file. <default> = \"mat\"";
  input String variableFilter = ".*" "Filter for variables that should store in result file. <default> = ".*";
  input String cflags = "<default>" "cflags. <default> = \"\"";
  input String simflags = "<default>" "simflags. <default> = \"\"";
  output SimulationResult simulationResults;
```

(continues on next page)
22.1.253 solveLinearSystem

Solve $A \cdot X = B$, using dgesv or lp_solve (if any variable in X is integer)

Returns for solver dgesv: info>0: Singular for element i. info<0: Bad input.
For solver lp_solve: ???

```modelica
function solveLinearSystem
    input Real[size(B, 1), size(B, 1)] A;
    input Real[: ] B;
    input LinearSystemSolver solver = LinearSystemSolver.dgesv;
    input Integer[: ] isInt = {-1} "list of indices that are integers";
    output Real[size(B, 1)] X;
    output Integer info;
end solveLinearSystem;
```

22.1.254 sortStrings

```modelica
function sortStrings
    input String arr[: ];
    output String sorted[: ];
end sortStrings;
```

22.1.255 stat

```modelica
impure function stat
    input String fileName;
    output Boolean success;
    output Real fileSize;
    output Real mtime;
end stat;
```

22.1.256 stringReplace

```modelica
function stringReplace
    input String str;
    input String source;
    input String target;
    output String res;
end stringReplace;
```
22.1.257 stringSplit
Splits the string at the places given by the character

```modelica
function stringSplit
  input String string;
  input String token "single character only";
  output String[:] strings;
end stringSplit;
```

22.1.258 stringTypeName

```modelica
function stringTypeName
  input String str;
  output TypeName cl;
end stringTypeName;
```

22.1.259 stringVariableName

```modelica
function stringVariableName
  input String str;
  output VariableName cl;
end stringVariableName;
```

22.1.260 strtok
Splits the strings at the places given by the token, for example:
```
strtok("abcbdef","b") => {"a","c","def"}
strtok("abcbdef","cd") => {"ab","ef"}
```

```modelica
function strtok
  input String string;
  input String token;
  output String[:] strings;
end strtok;
```

22.1.261 system
Similar to system(3). Executes the given command in the system shell.

```modelica
impure function system
  input String callStr "String to call: sh -c $callStr";
  input String outputFile = "" "The output is redirected to this file (unless already done by callStr)";
  output Integer retval "Return value of the system call; usually 0 on success";
end system;
```

22.1.262 system_parallel
Similar to system(3). Executes the given commands in the system shell, in parallel if omc was compiled using OpenMP.
impure function system_parallel
    input String callStr[:]= "String to call: sh -c $callStr";
    input Integer numThreads = numProcessors();
    output Integer retval[:]= "Return value of the system call; usually 0 on success";
end system_parallel;

22.1.263 testsuiteFriendlyName

function testsuiteFriendlyName
    input String path;
    output String fixed;
end testsuiteFriendlyName;

22.1.264 threadWorkFailed

22.1.265 translateGraphics

function translateGraphics
    input TypeName className;
    output String result;
end translateGraphics;

22.1.266 translateModelFMU

translates a modelica model into a Functional Mockup Unit.
The only required argument is the className, while all others have some default values.
Example command:
translateModelFMU(className, version="2.0");

function translateModelFMU
    input TypeName className="the class that should translated";
    input String version = "2.0" "FMU version, 1.0 or 2.0.";
    input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation), me_cs (both model exchange and co-simulation)";
    input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = className";
    input Boolean includeResources = false "include Modelica based resources via loadResource or not";
    output String generatedFileName "Returns the full path of the generated FMU.";
end translateModelFMU;

22.1.267 typeNameString

function typeNameString
    input TypeName cl;
    output String out;
end typeNameString;
22.1.268  typeNameStrings

```modelica
function typeNameStrings
  input TypeName cl;
  output String out[:];
end typeNameStrings;
```

22.1.269  typeOf

```modelica
function typeOf
  input VariableName variableName;
  output String result;
end typeOf;
```

22.1.270  updateInitialState

```modelica
function updateInitialState
  input TypeName cl;
  input String state;
  input ExpressionOrModification annotate;
  output Boolean bool;
end updateInitialState;
```

22.1.271  updateTransition

```modelica
function updateTransition
  input TypeName cl;
  input String from;
  input String to;
  input String oldCondition;
  input Boolean oldImmediate;
  input Boolean oldReset;
  input Boolean oldSynchronize;
  input Integer oldPriority;
  input String newCondition;
  input Boolean newImmediate;
  input Boolean newReset;
  input Boolean newSynchronize;
  input Integer newPriority;
  input ExpressionOrModification annotate;
  output Boolean bool;
end updateTransition;
```

22.1.272  uriToFilename

```modelica
function uriToFilename
  input String uri;
  output String filename = "";
end uriToFilename;
```
22.1.273 val

Return the value of a variable at a given time in the simulation results

```modelica
function val
  input VariableName var;
  input Real timePoint = 0.0;
  input String fileName = "<default>" "The contents of the currentSimulationResult_variable";
  output Real valAtTime;
end val;
```

22.1.274 verifyCompiler

```modelica
function verifyCompiler
  output Boolean compilerWorks;
end verifyCompiler;
```

22.1.275 writeFile

Write the data to file. Returns true on success.

```modelica
impure function writeFile
  input String fileName;
  input String data;
  input Boolean append = false;
  output Boolean success;
end writeFile;
```

22.2 Simulation Parameter Sweep

Following example shows how to update the parameters and re-run the simulation without compiling the model.

```modelica
loadFile("BouncingBall.mo");
getErrorString();
// build the model once
buildModel(BouncingBall);
getErrorString();
for i in 1:3 loop
  // We update the parameter e start value from 0.7 to "0.7 + i".
  value := 0.7 + i;
  // call the generated simulation code to produce a result file BouncingBall%i_res.mat.
  system("./BouncingBall -override=e="+String(value)+" -r=BouncingBall "+
         _res.mat
  
  system("./BouncingBall -override=e="+String(value)+" -r=BouncingBall "+
         _res.mat");
  getErrorString();
end for;
```

We used the BouncingBall.mo in the example above. The above example produces three result files each containing different start value for e i.e., 1.7, 2.7, 3.7.
22.3 Examples

The following is an interactive session with the OpenModelica environment including some of the abovemen-
tioned commands and examples. First we start the system, and use the command line interface from OMShell,
OMNotebook, or command window of some of the other tools.

We type in a very small model:

```modelica
model Test "Testing OpenModelica Scripts"
  Real x, y;
equation
  x = 5.0+time; y = 6.0;
end Test;
```

We give the command to flatten a model:

```modelica
>>> instantiateModel(Test)
class Test "Testing OpenModelica Scripts"
  Real x;
  Real y;
  equation
    x = 5.0 + time;
    y = 6.0;
end Test;
```

A range expression is typed in:

```modelica
>>> a:=1:10
{1,2,3,4,5,6,7,8,9,10}
```

It is multiplied by 2:

```modelica
>>> a*2
{2,4,6,8,10,12,14,16,18,20}
```

The variables are cleared:

```modelica
>>> clearVariables()
true
```

We print the loaded class test from its internal representation:

```modelica
>>> list(Test)
model Test "Testing OpenModelica Scripts"
  Real x, y;
  equation
    x = 5.0 + time;
    y = 6.0;
end Test;
```

We get the name and other properties of a class:

```modelica
>>> getClassNames()
(Test,ProfilingTest)
>>> getClassComment(Test) "Testing OpenModelica Scripts"
>>> isPartial(Test) false
>>> isPackage(Test) false
>>> isModel(Test) true
```
The common combination of a simulation followed by getting a value and doing a plot:

```python
>>> simulate(Test, stopTime=3.0)

The common combination of a simulation followed by getting a value and doing a plot:

```python
>>> simulate(Test, stopTime=3.0)
record SimulationResult
  resultFile = "«DOCHOME»/Test_res.mat",
  simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500,",
  tolerance = 1e-06, method = 'dassl', fileNamePrefix = 'Test', options = '',
  outputFormat = 'mat', variableFilter = '.*', cflags = '', simflags = '',
  messages = "LOG_SUCCESS | info | The initialization finished.
  successfull without homotopy method.
  LOG_SUCCESS | info | The simulation finished successfully.
  stdout | info | Time measurements are stored in Test_prof.html",
  (human-readable) and Test_prof.xml (for XSL transforms or more details)
",
  timeFrontend = 0.004629069,
  timeBackend = 0.004679843,
  timeSimCode = 0.05255037000000001,
  timeTemplates = 0.028273708,
  timeCompile = 0.530051523,
  timeSimulation = 0.037270063,
  timeTotal = 0.657562713
end SimulationResult;

Figure 22.1: Plot generated by OpenModelica+gnuplot

22.3.1 Interactive Function Calls, Reading, and Writing

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in
the variable x. The type and the value of the expression is returned.

```
The function bubblesort is called to sort this vector in descending order. The sorted result is returned together with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared type of the function result. The input Integer vector was automatically converted to a Real vector according to the Modelica type coercion rules.

Now we want to try another small application, a simplex algorithm for optimization. First read in a small matrix containing coefficients that define a simplex problem to be solved:

```plaintext
>>> a := {
    {-1,-1,-1, 0, 0, 0, 0, 0, 0},
    {-1, 1, 0, 1, 0, 0, 0, 0, 5},
    { 1, 4, 0, 0, 1, 0, 0, 0, 45},
    { 2, 1, 0, 0, 1, 0, 0, 0, 27},
    { 3, 4, 0, 0, 0, 1, 0, 0, 24},
    { 0, 0, 1, 0, 0, 0, 1, 0, 4}
}  

function pivot1
    input Real b[:, :];
    input Integer p;
    input Integer q;
    output Real a[size(b, 1), size(b, 2)];
protected
    Integer M;
    Integer N;
algorithm
```

(continues on next page)
a := b;
N := size(a,1)-1;
M := size(a,2)-1;
for j in 1:N loop
  for k in 1:M loop
    if j<>p and k<>q then
      a[j,k] := a[j,k]-0.3*j;
    end if;
  end for;
end for;
a[p,q] := 0.05;
end pivot1;

function misc_simplex1
  input Real matr[:,:];
  output Real x[size(matr,2)-1];
  output Real z;
  output Integer q;
  output Integer p;
protected
  Real a[size(matr,1),size(matr,2)];
  Integer M;
  Integer N;
algorithm
  N := size(a,1)-1;
  M := size(a,2)-1;
  a := matr;
p:=0;q:=0;
a := pivot1(a,p+1,q+1);
  while not (q==(M) or p==(N)) loop
    q := 0;
    while not (q == (M) or a[0+1,q+1]>1) loop
      q:=q+1;
    end while;
    p := 0;
    while not (p == (N) or a[p+1,q+1]>0.1) loop
      p:=p+1;
    end while;
    if (q < M) and (p < N) and (p>0) and (q>0) then
      a := pivot1(a,p,q);
    end if;
    if(p<=0) and (q<=0) then
      a := pivot1(a,p+1,q+1);
    end if;
    if(p<=0) and (q>0) then
      a := pivot1(a,p+1,q);
    end if;
    if(p>0) and (q<=0) then
      a := pivot1(a,p,q+1);
    end if;
  end while;
  z := a[1,M];
x := {a[i,1] for i in 1:size(x,1)};
for i in 1:10 loop
  for j in 1:M loop
    x[j] := x[j]+x[j]*0.01;
  end for;
end for;
end misc_simplex1;

 Then call the simplex algorithm implemented as the Modelica function simplex1. This function returns four results, which are represented as a tuple of four return values:
>>> misc_simplex1(a)
({0.05523110627056022, -1.104622125411205, -1.104622125411205, 0.0, 0.0, 0.0, 0.0, 0.0, 0.0}, 0.0, 8, 1)
Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]

- Libraries: Fully qualified names of libraries to load before processing Model or Script. The libraries should
  be separated by spaces: Lib1 Lib2 ... LibN.

### 23.1 Options

- **-d, –debug**
  Sets debug flags. Use –help=debug to see available flags.
  String list (default empty).

- **-h, –help**
  Displays the help text. Use –help=topics for more information.
  String (default empty).

- **–v, –version**
  Print the version and exit.
  Boolean (default false).

- **–target**
  Sets the target compiler to use.
  String (default gcc). Valid options:
  - gcc
  - msvc
  - msvc10
  - msvc12
  - msvc13
  - msvc15
  - vxworks69
  - debugrt

- **-g, –grammar**
  Sets the grammar and semantics to accept.
  String (default Modelica). Valid options:
  - Modelica
  - MetaModelica
• ParModelica
• Optimica
• PDEModelica

--annotationVersion
Sets the annotation version that should be used.
String (default 3.x). Valid options:
  • 1.x
  • 2.x
  • 3.x

--std
Sets the language standard that should be used.
String (default latest). Valid options:
  • 1.x
  • 2.x
  • 3.1
  • 3.2
  • 3.3
  • latest

--showErrorMessages
Show error messages immediately when they happen.
Boolean (default false).

--showAnnotations
Show annotations in the flattened code.
Boolean (default false).

--noSimplify
Do not simplify expressions if set.
Boolean (default false).

--preOptModules
Sets the pre optimization modules to use in the back end. See --help=optmodules for more info.
String list (default normalInlineFunction,evaluateParameters,simplifyIfEquations,expandDerOperator,removeEqualFunctionCalls,checkDependentInitialization,heapCheck,inlineExp2,inlineRhs,inlineArrayEqn,removeSimpleEquations,comSubExp,resolveLoops,evalFunc,encapsulateWhenConditions).
Valid options:
  • clockPartitioning (Does the clock partitioning.)
  • collapseArrayExpressions (Simplifies \{x[1],x[2],x[3]\} \rightarrow x for arrays of whole variable references (simplifies code generation).)
  • comSubExp (Introduces alias assignments for variables which are assigned to simple terms i.e. a = b/c; d = b/c; \rightarrow a=d)
  • dumpDAE (dumps the DAE representation of the current transformation state)
  • dumpDAEXML (dumps the DAE as xml representation of the current transformation state)
  • encapsulateWhenConditions (This module replaces each when condition with a boolean variable.)
  • evalFunc (evaluates functions partially)
• evaluateParameters (Evaluates parameters with annotation(Evaluate=true). Use ‘-evaluateFinalParameters=true’ or ‘–evaluateProtectedParameters=true’ to specify additional parameters to be evaluated. Use ‘–replaceEvaluatedParameters=true’ if the evaluated parameters should be replaced in the DAE. To evaluate all parameters in the Frontend use -d=evaluateAllParameters.)

• expandDerOperator (Expands der(expr) using Derive.differentiteExpTime.)

• findStateOrder (Sets derivative information to states.)

• inlineArrayEqn (This module expands all array equations to scalar equations.)

• normalInlineFunction (Perform function inlining for function with annotation Inline=true.)

• inputDerivativesForDynOpt (Allowed derivatives of inputs in dyn. optimization.)

• introduceDerAlias (Adds for every der-call an alias equation e.g. dx = der(x).)

• removeEqualFunctionCalls (Detects equal function calls of the form a=f(b) and c=f(b) and substitutes them to get speed up.)

• removeProtectedParameters (Replace all parameters with protected=true in the system.)

• removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replacing all occurrences of the old variable reference with the new value (constants) or variable reference (alias elimination).)

• removeUnusedParameter (Strips all parameter not present in the equations from the system.)

• removeUnusedVariables (Strips all variables not present in the equations from the system.)

• removeVerySimpleEquations ([Experimental] Like removeSimpleEquations, but less thorough. Note that this always uses the experimental new alias elimination, –removeSimpleEquations=new, which makes it unstable. In particular, MultiBody systems fail to translate correctly. It can be used for simple (but large) systems of equations.)

• replaceEdgeChange (Replace edge(b) = b and not pre(b) and change(b) = v <> pre(v).)

• residualForm (Transforms simple equations x=y to zero-sum equations 0=y-x.)

• resolveLoops (resolves linear equations in loops)

• simplifyAllExpressions (Does simplifications on all expressions.)

• simplifyIfEquations (Tries to simplify if equations by use of information from evaluated parameters.)

• sortEqnsVars (Heuristic sorting for equations and variables.)

• unitChecking (Does advanced unit checking which consists of two parts: 1. calculation of unspecified unit information for variables; 2. consistency check for all equations based on unit information. Please note: This module is still experimental.)

• wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)

–cheapmatchingAlgorithm

Sets the cheap matching algorithm to use. A cheap matching algorithm gives a jump start matching by heuristics. Integer (default 3). Valid options:

• 0 (No cheap matching.)

• 1 (Cheap matching, traverses all equations and match the first free variable.)

• 3 (Random Karp-Sipser: R. M. Karp and M. Sipser. Maximum matching in sparse random graphs.)

–matchingAlgorithm

Sets the matching algorithm to use. See –help=optmodules for more info.

String (default PFPlusExt). Valid options:

• BFSB (Breadth First Search based algorithm.)
• DFSB (Depth First Search based algorithm.)
• MC21A (Depth First Search based algorithm with look ahead feature.)
• PF (Depth First Search based algorithm with look ahead feature.)
• PFPlus (Depth First Search based algorithm with look ahead feature and fair row traversal.)
• HK (Combined BFS and DFS algorithm.)
• HKDW (Combined BFS and DFS algorithm.)
• ABMP (Combined BFS and DFS algorithm.)
• PR (Matching algorithm using push relabel mechanism.)
• DFSBExt (Depth First Search based Algorithm external c implementation.)
• BFSBExt (Breadth First Search based Algorithm external c implementation.)
• MC21AExt (Depth First Search based Algorithm with look ahead feature external c implementation.)
• PFExt (Depth First Search based Algorithm with look ahead feature external c implementation.)
• PFPlusExt (Depth First Search based Algorithm with look ahead feature and fair row traversal external c implementation.)
• HKExt (Combined BFS and DFS algorithm external c implementation.)
• HKDWExt (Combined BFS and DFS algorithm external c implementation.)
• ABMPExt (Combined BFS and DFS algorithm external c implementation.)
• PRExt (Matching algorithm using push relabel mechanism external c implementation.)
• BB (BBs try.)

--indexReductionMethod
Sets the index reduction method to use. See --help=optmodules for more info.
String (default dynamicStateSelection). Valid options:
• none (Skip index reduction)
• uode (Use the underlying ODE without the constraints.)
• dynamicStateSelection (Simple index reduction method, select (dynamic) dummy states based on analysis of the system.)
• dummyDerivatives (Simple index reduction method, select (static) dummy states based on heuristic.)

--postOptModules
Sets the post optimization modules to use in the back end. See --help=optmodules for more info.
String list (default lateInlineFunction,wrapFunctionCalls,inlineArrayEqn,constantLinearSystem,simplifysemiLinear,removeSimpleExpressions,calculateStateSetsJacobians,calculateStrongComponentJacobians,addTimeAsState,calculateStateSetsJacobians,generateAnalyticalJacobian,forceNLSAnalyticJacobian). Valid options:
• addScaledVars_states (added var_norm = var/nominal, where var is state)
• addScaledVars_inputs (added var_norm = var/nominal, where var is input)
• addTimeAsState (Experimental feature: this replaces each occurrence of variable time with a new introduced state $time with equation der($time) = 1.0)
• calculateStateSetsJacobians (Generates analytical jacobian for dynamic state selection sets.)
• calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong components. By default non-linear components with user-defined function calls are skipped. See also debug flags: NLSAnalyticJacobian and forceNLSAnalyticJacobian)
• collapseArrayExpressions (Simplifies \{x[1],x[2],x[3]\} → x for arrays of whole variable references (simplifies code generation).)
• constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e,f are constants) at compile-time.)

• countOperations (Count the mathematical operations of the system.)

• createAliasVarsForOutputStates (Module creates alias variables for output states.)

• cseBinary (Common Sub-expression Elimination)

• dumpComponentsGraphStr (Dumps the assignment graph used to determine strong components to format suitable for Mathematica)

• dumpDAE (dumps the DAE representation of the current transformation state)

• dumpDAEXML (dumps the DAE as xml representation of the current transformation state)

• evaluateParameters (Evaluates parameters with annotation(Evaluate=true). Use ’–evaluateFinalParameters=true’ or ’–evaluateProtectedParameters=true’ to specify additional parameters to be evaluated. Use ’–replaceEvaluatedParameters=true’ if the evaluated parameters should be replaced in the DAE. To evaluate all parameters in the Frontend use -d=evaluateAllParameters.)

• extendDynamicOptimization (Move loops to constraints.)

• generateSymbolicLinearization (Generates symbolic linearization matrices A,B,C,D for linear model: \( \dot{x} = Ax + Bu \))

• generateSymbolicSensitivities (Generates symbolic Sensivities matrix, where \( \text{der}(x) \) is differentiated w.r.t. param.)

• inlineArrayEqn (This module expands all array equations to scalar equations.)

• inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)

• lateInlineFunction (Perform function inlining for function with annotation LateInline=true.)

• partlintornsystem (partitions linear torn systems.)

• recursiveTearing (inline and repeat tearing)

• reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and constraints. This module requires -d=reduceDynOpt.)

• relaxSystem (relaxation from gaussian elemination)

• removeConstants (Remove all constants in the system.)

• removeEqualFunctionCalls (Detects equal function calls of the form a=f(b) and c=f(b) and substitutes them to get speed up.)

• removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replacing all occurrences of the old variable reference with the new value (constants) or variable reference (alias elimination).)

• removeUnusedParameter (Strips all parameter not present in the equations from the system to get speed up for compilation of target code.)

• removeUnusedVariables (Strips all variables not present in the equations from the system to get speed up for compilation of target code.)

• reshufflePost (Reshuffles algebraic loops.)

• simplifyAllExpressions (Does simplifications on all expressions.)

• simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data structure))

• simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires +gDynOpt.)

• simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)
• `simplifyTimeIndepFuncCalls` (Simplifies time independent built in function calls like `pre(param) -> param`, `der(param) -> 0.0`, `change(param) -> false`, `edge(param) -> false`.)

• `simplifysemiLinear` (Simplifies calls to `semiLinear`.)

• `solveLinearSystem` (Solve linear system with newton step)

• `solveSimpleEquations` (Solves simple equations)

• `symSolver` (Rewrites the ode system for implicit Euler method. This module requires `+symSolver`.)

• `symbolicJacobian` (Detects the sparse pattern of the ODE system and calculates also the symbolic Jacobian if flag `--generateSymbolicJacobian` is enabled.)

• `tearingSystem` (For method selection use flag `tearingMethod`.)

• `wrapFunctionCalls` (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)

`--simCodeTarget`

Sets the target language for the code generation.

String (default C). Valid options:

• None
• Adevs
• C
• Cpp
• CSharp
• ExperimentalEmbeddedC
• Java
• JavaScript
• sfmi
• XML
• MidC

`--orderConnections`

Orders connect equations alphabetically if set.

Boolean (default `true`).

`-t, --typeinfo`

Prints out extra type information if set.

Boolean (default `false`).

`-a, --keepArrays`

Sets whether to split arrays or not.

Boolean (default `false`).

`-m, --modelicaOutput`

Enables valid modelica output for flat modelica.

Boolean (default `false`).

`-q, --silent`

Turns on silent mode.

Boolean (default `false`).
-c, –corbaSessionName
Sets the name of the corba session if -d=interactiveCorba or –interactive=corba is used.
String (default empty).
-n, –numProcs
Sets the number of processors to use (0=default=auto).
Integer (default 0).
-l, –latency
Sets the latency for parallel execution.
Integer (default 0).
-b, –bandwidth
Sets the bandwidth for parallel execution.
Integer (default 0).
-i, –instClass
Instantiate the class given by the fully qualified path.
String (default empty).
-v, –vectorizationLimit
Sets the vectorization limit, arrays and matrices larger than this will not be vectorized.
Integer (default 0).
-s, –simulationCg
Turns on simulation code generation.
Boolean (default false).
–evalAnnotationParams
Sets whether to evaluate parameters in annotations or not.
Boolean (default false).
–generateLabeledSimCode
Turns on labeled SimCode generation for reduction algorithms.
Boolean (default false).
–reduceTerms
Turns on reducing terms for reduction algorithms.
Boolean (default false).
–reductionMethod
Sets the reduction method to be used.
String (default deletion). Valid options:
- deletion
- substitution
- linearization
–demoMode
Disable Warning/Error Massages.
Boolean (default false).

23.1. Options
Override the locale from the environment.
String (default empty).

Sets the default OpenCL device to be used for parallel execution.
Integer (default 0).

Maximal traversals to find simple equations in the acausal system.
Integer (default 2).

Redirect the dump to file. If the file ends with .html HTML code is generated.
String (default empty).

Enables (very) experimental code to break algebraic loops using the delay() operator. Probably messes with initialization.
Boolean (default true).

Sets the tearing method to use. Select no tearing or choose tearing method.
String (default cellier). Valid options:
- noTearing (Skip tearing.)
- omcTearing (Tearing method developed by TU Dresden: Frenkel, Schubert.)
- cellier (Tearing based on Celliers method, revised by FH Bielefeld: Täuber, Patrick)

Sets the tearing heuristic to use for Cellier-tearing.
String (default MC3). Valid options:
- MC1 (Original cellier with consideration of impossible assignments and discrete Vars.)
- MC2 (Modified cellier, drop first step.)
- MC11 (Modified MC1, new last step 'count impossible assignments'.)
- MC21 (Modified MC2, new last step 'count impossible assignments'.)
- MC12 (Modified MC1, step 'count impossible assignments' before last step.)
- MC22 (Modified MC2, step 'count impossible assignments' before last step.)
- MC13 (Modified MC1, build sum of impossible assignment and causalizable equations, choose var with biggest sum.)
- MC23 (Modified MC2, build sum of impossible assignment and causalizable equations, choose var with biggest sum.)
- MC231 (Modified MC23, Two rounds, choose better potentials-set.)
- MC3 (Modified cellier, build sum of impossible assignment and causalizable equations for all vars, choose var with biggest sum.)
- MC4 (Modified cellier, use all heuristics, choose var that occurs most in potential sets)
–disableLinearTearing
Disables the tearing of linear systems. That might improve the performance of large linear systems (N>1000) in combination with a sparse solver (e.g. umfpack) at runtime (usage with: -ls umfpack). Deprecated flag: Use –maxSizeLinearTearing=0 instead.
Boolean (default false).

–scalarizeMinMax
Scalarizes the built-in min/max reduction operators if true.
Boolean (default false).

–scalarizeBindings
Always scalarizes bindings if set.
Boolean (default false).

–corbaObjectReferenceFilePath
Sets the path for corba object reference file if -d=interactiveCorba is used.
String (default empty).

–hpcomScheduler
Sets the scheduler for task graph scheduling (list | listr | level | levelfix | ext | metis | mcp | taskdep | tds | bls | rand | none). Default: level.
String (default level).

–hpcomCode
Sets the code-type produced by hpcom (openmp | pthreads | pthreads_spin | tbb | mpi). Default: openmp.
String (default openmp).

–rewriteRulesFile
Activates user given rewrite rules for Absyn expressions. The rules are read from the given file and are of the form rewrite(fromExp, toExp);
String (default empty).

–replaceHomotopy
Replaces homotopy(actual, simplified) with the actual expression or the simplified expression. Good for debugging models which use homotopy. The default is to not replace homotopy.
String (default none). Valid options:
• none (Default, do not replace homotopy.)
• actual (Replace homotopy(actual, simplified) with actual.)
• simplified (Replace homotopy(actual, simplified) with simplified.)

–generateSymbolicJacobian
Generates symbolic Jacobian matrix, where der(x) is differentiated w.r.t. x. This matrix can be used by dassl or ida solver with simulation flag `-jacobian`.
Boolean (default false).

–generateSymbolicLinearization
Generates symbolic linearization matrices A,B,C,D for linear model: \( \dot{x} = Ax + Bu \ y = Cx + Du \)
Boolean (default false).

–intEnumConversion
Allow Integer to enumeration conversion.
Boolean (default false).

--profiling
Sets the profiling level to use. Profiled equations and functions record execution time and count for each time step taken by the integrator.

String (default none). Valid options:
- none (Generate code without profiling)
- blocks (Generate code for profiling function calls as well as linear and non-linear systems of equations)
- blocks+html (Like blocks, but also run xsltproc and gnuplot to generate an html report)
- all (Generate code for profiling of all functions and equations)
- all_perf (Generate code for profiling of all functions and equations with additional performance data using the papi-interface (cpp-runtime))
- all_stat (Generate code for profiling of all functions and equations with additional statistics (cpp-runtime))

--reshuffle
Sets tolerance of reshuffling algorithm: 1: conservative, 2: more tolerant, 3 resolve all

Integer (default 1).

--gDynOpt
Generate dynamic optimization problem based on annotation approach.

Boolean (default false).

--maxSizeSolveLinearSystem
Max size for solveLinearSystem.

Integer (default 0).

--cppFlags
Sets extra flags for compilation with the C++ compiler (e.g. +cppFlags=-O3,-Wall)

String list (default ).

--removeSimpleEquations
Specifies method that removes simple equations.

String (default default). Valid options:
- none (Disables module)
- default (Performs alias elimination and removes constant variables. Default case uses in preOpt phase the fastAcausal and in postOpt phase the causal implementation.)
- causal (Performs alias elimination and removes constant variables. Causal implementation.)
- fastAcausal (Performs alias elimination and removes constant variables. fastImplementation fastAcausal.)
- allAcausal (Performs alias elimination and removes constant variables. Implementation allAcausal.)
- new (New implementation (experimental))

--dynamicTearing
Activates dynamic tearing (TearingSet can be changed automatically during runtime, strict set vs. casual set.)

String (default false). Valid options:
- false (No dynamic tearing.)
- true (Dynamic tearing for linear and nonlinear systems.)
- linear (Dynamic tearing only for linear systems.)
• nonlinear (Dynamic tearing only for nonlinear systems.)

–symSolver
Activates symbolic implicit solver (original system is not changed).
String (default none). Valid options:
  • none
  • impEuler
  • expEuler

–loop2con
Specifies method that transform loops in constraints. hint: using initial guess from file!
String (default none). Valid options:
  • none (Disables module)
  • lin (linear loops -> constraints)
  • noLin (no linear loops -> constraints)
  • all (loops -> constraints)

–forceTearing
Use tearing set even if it is not smaller than the original component.
Boolean (default false).

–simplifyLoops
Simplify algebraic loops.
Integer (default 0). Valid options:
  • 0 (do nothing)
  • 1 (special modification of residual expressions)
  • 2 (special modification of residual expressions with helper variables)

–recursiveTearing
Inline and repeat tearing.
Integer (default 0). Valid options:
  • 0 (do nothing)
  • 1 (linear tearing set of size 1)
  • 2 (linear tearing)

–flowThreshold
Sets the minium threshold for stream flow rates
Real (default 1e-07).

–matrixFormat
Sets the matrix format type in cpp runtime which should be used (dense | sparse ). Default: dense.
String (default dense).

–partlintorn
Sets the limit for partitionin of linear torn systems.
Integer (default 0).

–initOptModules
Sets the initialization optimization modules to use in the back end. See --help=optmodules for more info.

String list (default simplifyComplexFunction,tearingSystem,solveSimpleEquations,calculateStrongComponentJacobians,simplifyAllExpressions,collapseArrayExpressions).

Valid options:

- calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong components. By default non-linear components with user-defined function calls are skipped. See also debug flags: NLSanalyticJacobian and forceNLSanalyticJacobian)
- collapseArrayExpressions (Simplifies \{x[1],x[2],x[3]\} → x for arrays of whole variable references (simplifies code generation).)
- constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e,f are constants) at compile-time.)
- extendDynamicOptimization (Move loops to constraints.)
- generateHomotopyComponents (Finds the parts of the DAE that have to be handled by the homotopy solver and creates a strong component out of it.)
- inlineHomotopy (Experimental: Inlines the homotopy expression to allow symbolic simplifications.)
- inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)
- recursiveTearing (inline and repeat tearing)
- reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and constraints. This module requires -d=reduceDynOpt.)
- replaceHomotopyWithSimplified (Replaces the homotopy expression homotopy(actual, simplified) with the simplified part.)
- simplifyAllExpressions (Does simplifications on all expressions.)
- simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data structure))
- simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires +gDynOpt.)
- simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)
- solveSimpleEquations (Solves simple equations)
- tearingSystem (For method selection use flag tearingMethod.)
- wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls with the newly introduced variables.)

--maxMixedDeterminedIndex
Sets the maximum mixed-determined index that is handled by the initialization.
Integer (default 3).

--useLocalDirection
Keeps the input/output prefix for all variables in the flat model, not only top-level ones.
Boolean (default false).

--defaultOptModulesOrdering
If this is activated, then the specified pre-/post-/init-optimization modules will be rearranged to the recommended ordering.
Boolean (default true).

--preOptModules+
Enables additional pre-optimization modules, e.g. --preOptModules+=module1,module2 would additionally enable module1 and module2. See --help=optmodules for more info.
String list (default empty).

\-preOptModules-

Disables a list of pre-optimization modules, e.g. \-preOptModules=module1,module2\ would disable module1 and module2. See \-help=optmodules\ for more info.

String list (default empty).

\-postOptModules+

Enables additional post-optimization modules, e.g. \-postOptModules+=module1,module2\ would additionally enable module1 and module2. See \-help=optmodules\ for more info.

String list (default empty).

\-postOptModules-

Disables a list of post-optimization modules, e.g. \-postOptModules-=module1,module2\ would disable module1 and module2. See \-help=optmodules\ for more info.

String list (default empty).

\-initOptModules+

Enables additional init-optimization modules, e.g. \-initOptModules+=module1,module2\ would additionally enable module1 and module2. See \-help=optmodules\ for more info.

String list (default empty).

\-initOptModules-

Disables a list of init-optimization modules, e.g. \-initOptModules-=module1,module2\ would disable module1 and module2. See \-help=optmodules\ for more info.

String list (default empty).

\-instCacheSize

Sets the size of the internal hash table used for instantiation caching.

Integer (default 25343).

\-maxSizeLinearTearing

Sets the maximum system size for tearing of linear systems (default 200).

Integer (default 200).

\-maxSizeNonlinearTearing

Sets the maximum system size for tearing of nonlinear systems (default 10000).

Integer (default 10000).

\-noTearingForComponent

Deactivates tearing for the specified components. Use \-d=tearingdump\ to find out the relevant indexes.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})

\-daeMode

Generates code to simulate models in DAE mode. The whole system is passed directly to the DAE solver SUN-DIALS/IDA and no algebraic solver is involved in the simulation process.

Boolean (default false).

\-inlineMethod

Sets the inline method to use. replace : This method inlines by replacing in place all expressions. Might lead to very long expression. append : This method inlines by adding additional variables to the whole system. Might lead to much bigger system.

String (default replace). Valid options:
• replace
• append

\textit{\texttt{--setTearingVars}}

Sets the tearing variables by its strong component indexes. Use \texttt{\textquotesingle -d=tearingdump\textquotesingle} to find out the relevant indexes. Use following format: \texttt{\textquotesingle --setTearingVars=(sci,n,t1,...,tn)*\textquotesingle}, with sci = strong component index, n = number of tearing variables, t1,...tn = tearing variables. E.g.: \texttt{\textquotesingle --setTearingVars=4,2,3,5\textquotesingle} would select variables 3 and 5 in strong component 4.

Unknown default value\texttt{Flags.FlagData.INT_LIST_FLAG(data = \{NIL\})}

\textit{\texttt{--setResidualEqns}}

Sets the residual equations by its strong component indexes. Use \texttt{\textquotesingle -d=tearingdump\textquotesingle} to find out the relevant indexes for the collective equations. Use following format: \texttt{\textquotesingle --setResidualEqns=(sci,n,r1,...,rn)*\textquotesingle}, with sci = strong component index, n = number of residual equations, r1,...rn = residual equations. E.g.: \texttt{\textquotesingle --setResidualEqns=4,2,3,5\textquotesingle} would select equations 3 and 5 in strong component 4. Only works in combination with \texttt{\textquotesingle setTearingVars\textquotesingle}.

Unknown default value\texttt{Flags.FlagData.INT_LIST_FLAG(data = \{NIL\})}

\textit{\texttt{--ignoreCommandLineOptionsAnnotation}}

Ignores the command line options specified as annotation in the class.

Boolean (default false).

\textit{\texttt{--calculateSensitivities}}

Generates sensitivities variables and matrixes.

Boolean (default false).

\textit{\texttt{-r, --alarm}}

Sets the number seconds until omc timeouts and exits. Used by the testing framework to terminate infinite running processes.

Integer (default 0).

\textit{\texttt{--totalTearing}}

Activates total tearing (determination of all possible tearing sets) for the specified components. Use \texttt{\textquotesingle -d=tearingdump\textquotesingle} to find out the relevant indexes.

Unknown default value\texttt{Flags.FlagData.INT_LIST_FLAG(data = \{NIL\})}

\textit{\texttt{--ignoreSimulationFlagsAnnotation}}

Ignores the simulation flags specified as annotation in the class.

Boolean (default false).

\textit{\texttt{--dynamicTearingForInitialization}}

Enable Dynamic Tearing also for the initialization system.

Boolean (default false).

\textit{\texttt{--preferTVarsWithStartValue}}

Prefer tearing variables with start value for initialization.

Boolean (default false).

\textit{\texttt{--equationsPerFile}}

Generate code for at most this many equations per C-file (partially implemented in the compiler).

Integer (default 2000).

\textit{\texttt{--evaluateFinalParameters}}

Evaluates all the final parameters in addition to parameters with annotation(Evaluate=true).
Boolean (default false).

**–evaluateProtectedParameters**
Evaluates all the protected parameters in addition to parameters with annotation(Evaluate=true).
Boolean (default false).

**–replaceEvaluatedParameters**
Replaces all the evaluated parameters in the DAE.
Boolean (default true).

**–condenseArrays**
Sets whether array expressions containing function calls are condensed or not.
Boolean (default true).

**–wfcAdvanced**
wrapFunctionCalls ignores more than default cases, e.g. exp, sin, cos, log. (experimental flag)
Boolean (default false).

**–tearingStrictness**
Sets the strictness of the tearing method regarding the solvability restrictions.
String (default strict). Valid options:

- casual (Loose tearing rules using ExpressionSolve to determine the solvability instead of considering the partial derivative. Allows to solve for everything that is analytically possible. This could lead to singularities during simulation.)
- strict (Robust tearing rules by consideration of the partial derivative. Allows to divide by parameters that are not equal to or close to zero.)
- veryStrict (Very strict tearing rules that do not allow to divide by any parameter. Use this if you aim at overriding parameters after compilation with values equal to or close to zero.)

**–interactive**
Sets the interactive mode for omc.
String (default none). Valid options:

- none (do nothing)
- corba (Starts omc as a server listening on the socket interface.)
- tcp (Starts omc as a server listening on the Corba interface.)
- zmq (Starts omc as a ZeroMQ server listening on the socket interface.)

**-z, –zeroMQFileSuffix**
Sets the file suffix for zeroMQ port file if –interactive=zmq is used.
String (default empty).

**–homotopyApproach**
Sets the homotopy approach.
String (default equidistantGlobal). Valid options:

- equidistantLocal (Local homotopy approach with equidistant lambda steps. The homotopy parameter only effects the local strongly connected component.)
- adaptiveLocal (Local homotopy approach with adaptive lambda steps. The homotopy parameter only effects the local strongly connected component.)
• **equidistantGlobal** (Default, global homotopy approach with equidistant lambda steps. The homotopy parameter effects the entire initialization system.)

• **adaptiveGlobal** (Global homotopy approach with adaptive lambda steps. The homotopy parameter effects the entire initialization system.)

---

**–ignoreReplaceable**
Sets whether to ignore replaceability or not when redeclaring.
Boolean (default false).

---

**–postOptModulesDAE**
Sets the optimization modules for the DAEmode in the back end. See –help=optmodules for more info.
String list (default lateInlineFunction,wrapFunctionCalls,simplifysemiLinear,simplifyComplexFunction,removeConstants,simplifyTimeIndepFuncCalls,simplifyAllExpressions,findZeroCrossings,createDAEmodeBDAE,detectDAEmodeSparsePattern,setEvaluationStage).

---

**–evalLoopLimit**
The loop iteration limit used when evaluating constant function calls.
Integer (default 100000).

---

**–evalRecursionLimit**
The recursion limit used when evaluating constant function calls.
Integer (default 256).

---

**–singleInstanceAglSolver**
Sets to instantiate only one algebraic loop solver all algebraic loops
Boolean (default false).

## 23.2 Debug flags

The debug flag takes a comma-separated list of flags which are used by the compiler for debugging or experimental purposes. Flags prefixed with "-" or "no" will be disabled. The available flags are (+ are enabled by default, - are disabled):

**Cache** *(default: on)*
Turns off the instantiation cache.

**NLSanalyticJacobian** *(default: on)*
Enables analytical jacobian for non-linear strong components without user-defined function calls, for that see forceNLSanalyticJacobian

**acceptTooManyFields** *(default: off)*
Accepts passing records with more fields than expected to a function. This is not allowed, but is used in Fluid.Dissipation. See https://trac.modelica.org/Modelica/ticket/1245 for details.

**addDerAliases** *(default: off)*
Adds for every der-call an alias equation e.g. \( dx = \text{der}(x) \). It’s a work-a-round flag, which helps in some cases to simulate the models e.g. Modelica.Fluid.Examples.HeatExchanger.HeatExchangerSimulation. Deprecated flag: Use –preOptModules+=introduceDerAlias instead.

**addScaledVars** *(default: off)*
Adds an alias equation \( \text{var}_\text{nrom} = \text{var}/\text{nominal} \) where \( \text{var} \) is state Deprecated flag: Use –postOptModules+=addScaledVars_states instead.

**addScaledVarsInput** *(default: off)*
Adds an alias equation \( \text{var}_\text{nrom} = \text{var}/\text{nominal} \) where \( \text{var} \) is input Deprecated flag: Use –postOptModules+=addScaledVars_inputs instead.

**aliasConflicts** *(default: off)*
Dumps alias sets with different start or nominal values.

**backendKeepEnv** *(default: on)*
When enabled, the environment is kept when entering the backend, which enables CevalFunction (function interpretation) to work. This module not essential for the backend to function in most cases, but can improve simulation performance by evaluating functions. The drawback to keeping
the environment graph in memory is that it is huge (~80% of the total memory in use when returning the front-end DAE).

**backendReduceDAE (default: off)** Prints all Reduce DAE debug information.

**backenddaeinfo (default: off)** Enables dumping of back-end information about system (Number of equations before back-end,...).

**bldump (default: off)** Dumps information from index reduction.

**bltMatrixdump (default: off)** Dumps the blt matrix in html file. IE seems to be very good in displaying large matrices.

**buildExternalLibs (default: on)** Use the autotools project in the Resources folder of the library to build missing external libraries.

**ceval (default: off)** Prints extra information from Ceval.

**cgraph (default: off)** Prints out connection graph information.

**cgraphGraphVizFile (default: off)** Generates a graphviz file of the connection graph.

**cgraphGraphVizShow (default: off)** Displays the connection graph with the GraphViz lefty tool.

**checkASUB (default: off)** Prints out a warning if an ASUB is created from a CREF expression.

**checkBackendDAE (default: off)** Do some simple analyses on the datastructure from the frontend to check if it is consistent.

**checkDAECrefType (default: off)** Enables extra type checking for cref expressions.

**checkSimplify (default: off)** Enables checks for expression simplification and prints a notification whenever an undesirable transformation has been performed.

**constjac (default: off)** solves linear systems with constant Jacobian and variable b-Vector symbolically

**countOperations (default: off)** Count operations.

**daedumppraphv (default: off)** Dumps the DAE in graphviz format.

**debugAlgebraicLoopsJacobian (default: off)** Dumps debug output while creating symbolic jacobians for non-linear systems.

**debugAlias (default: off)** Dumps some information about the process of removeSimpleEquations.

**debugDAEmode (default: off)** Dump debug output for the DAEmode.

**debugDifferentiation (default: off)** Dumps debug output for the differentiation process.

**debugDifferentiationVerbose (default: off)** Dumps verbose debug output for the differentiation process.

**disableColoring (default: off)** Disables coloring algorithm while sparsity detection.


**disableDirectionalDerivatives (default: on)** For FMI 2.0 only dependency analysis will be perform.

**disableFMIDependency (default: off)** Disables the dependency analysis and generation for FMI 2.0.

**disableJacsforScc (default: off)** Disables calculation of jacobians to detect if a SCC is linear or non-linear. By disabling all SCC will handled like non-linear.


**disableRecordConstructorOutput (default: off)** Disables output of record constructors in the flat code.


**disableSingleFlowEq (default: off)** Disables the generation of single flow equations.

**disableStartCalc (default: off)** Deactivates the pre-calculation of start values during compile-time.
disableWindowsPathCheckWarning (default: off) Disables warnings on Windows if OPENMODELICA-HOME/MinGW is missing.

dummyselect (default: off) Dumps information from dummy state selection heuristic.
dump (default: off) Dumps the absyn representation of a program.
dumpBackendInline (default: off) Dumps debug output while inline function.
dumpBackendInlineVerbose (default: off) Dumps debug output while inline function.
dumpCSE (default: off) Additional output for CSE module.
dumpCSE_verbose (default: off) Additional output for CSE module.
dumpConstrepl (default: off) Dump the found replacements for constants.
dumpEArepl (default: off) Dump the found replacements for evaluate annotations (evaluate=true) parameters.
dumpEncapsulateConditions (default: off) Dumps the results of the preOptModule encapsulateWhenConditions.

dumpEqInUC (default: off) Dumps all equations handled by the unit checker.
dumpEqUCStruct (default: off) Dumps all the equations handled by the unit checker as tree-structure.
dumpExcludedSymJacExps (default: off) This flags dumps all expression that are excluded from differentiation of a symbolic Jacobian.
dumpFPrepl (default: off) Dump the found replacements for final parameters.
dumpFunctions (default: off) Add functions to backend dumps.
dumpHomotopy (default: off) Dumps the results of the postOptModule optimizeHomotopyCalls.
dumpInlineSolver (default: off) Dumps the inline solver equation system.
dumpLoops (default: off) Dumps loop equation.
dumpPPrepl (default: off) Dump the found replacements for protected parameters.
dumpParamrepl (default: off) Dump the found replacements for remove parameters.
dumpRecursiveTearing (default: off) Dump between steps of recursiveTearing
dumpSCCGraphML (default: off) Dumps graphml files with the strongly connected components.
dumpSimCode (default: off) Dumps the simCode model used for code generation.
dumpSimplifyLoops (default: off) Dump between steps of simplifyLoops
dumpSortEqnsAndVars (default: off) Dumps debug output for the modules sortEqnsAndVars.
dumpSparsePattern (default: off) Dumps sparse pattern with coloring used for simulation.
dumpSparsePatternVerbose (default: off) Dumps in verbose mode sparse pattern with coloring used for simulation.
dumpSynchronous (default: off) Dumps information of the clock partitioning.
dumpTransformedModelica (default: off) Dumps the back-end DAE to a Modelica-like model after all symbolic transformations are applied.
dumpUnits (default: off) Dumps all the calculated units.
dumpdaelow (default: off) Dumps the equation system at the beginning of the back end.
dumpdgesv (default: off) Enables dumping of the information whether DGESV is used to solve linear systems.
dumpEqnInorder (default: off) Enables dumping of the equations in the order they are calculated.
dumpindxdae (default: off) Dumps the equation system after index reduction and optimization.
dumpinitialsystem (default: off) Dumps the initial equation system.
dumprepl (default: off) Dump the found replacements for simple equation removal.
dynload (default: off) Display debug information about dynamic loading of compiled functions.
evalFuncDump (default: off) dumps debug information about the function evaluation
evalOutputOnly (default: off) Generates equations to calculate outputs only.
evalParameterDump (default: off) Dumps information for evaluating parameters.
evalfunc (default: on) Turns on/off symbolic function evaluation.
evaluateAllParameters (default: off) Evaluates all parameters if set.
events (default: on) Turns on/off events handling.
execHash (default: off) Measures the time it takes to hash all simcode variables before code generation.
execstat (default: off) Prints out execution statistics for the compiler.
execstatGCcollect (default: off) When running execstat, also perform an extra full garbage collection.
experimentalReductions (default: off) Turns on custom reduction functions (OpenModelica extension).
failtrace (default: off) Sets whether to print a failtrace or not.
fmuExperimental (default: off) Include an extra function in the FMU fmi2GetSpecificDerivatives.
forceNLAnalyticJacobian (default: off) Forces calculation analytical jacobian also for non-linear strong components with user-defined functions.
frontEndUnitCheck (default: off) Checks the consistency of units in equation.
gcProfiling (default: off) Prints garbage collection stats to standard output.
gen (default: off) Turns on/off dynamic loading of functions that are compiled during translation. Only enable this if external functions are needed to calculate structural parameters or constants.
gendebugsymbol (default: off) Generate code with debugging symbols.
generateCodeCheat (default: off) Used to generate code for the bootstrapped compiler.
graphInst (default: off) Do graph based instantiation.
graphInstGenGraph (default: off) Dumps a graph of the program. Use with -d=graphInst
graphInstRunDep (default: off) Run scode dependency analysis. Use with -d=graphInst
graphInstShowGraph (default: off) Display a graph of the program interactively. Use with -d=graphInst
graphml (default: off) Dumps .graphml files for the bipartite graph after Index Reduction and a task graph for the SCCs. Can be displayed with yEd.
graphviz (default: off) Dumps the absyn representation of a program in graphviz format.
graphvizDump (default: off) Activates additional graphviz dumps (as .dot files). It can be used in addition to one of the following flags: {dumpdaelow|dumpinitialsystems|dumpindxdae}.
hardcodedStartValues (default: off) Embed the start values of variables and parameters into the c++ code and do not read it from xml file.
hpcom (default: off) Enables parallel calculation based on task-graphs.
hpcomDump (default: off) Dumps additional information on the parallel execution with hpcom.
hpcomMemoryOpt (default: off) Optimize the memory structure regarding the selected scheduler
ignoreCycles (default: off) Ignores cycles between constant/parameter components.
implOde (default: off) Activates implicit codegen
infoXmlOperations (default: off) Enables output of the operations in the _info.xml file when translating models.
initialization (default: off) Shows additional information from the initialization process.

inlineFunctions (default: on) Controls if function inlining should be performed.

inlineSolver (default: off) Generates code for inline solver.

instance (default: off) Prints extra failtrace from InstanceHierarchy.

interactive (default: off) Starts omc as a server listening on the socket interface.

interactiveCorba (default: off) Starts omc as a server listening on the Corba interface.

interactiveDump (default: off) Prints out debug information for the interactive server.

iterationVars (default: off) Shows a list of all iteration variables.

listAppendWrongOrder (default: on) Print notifications about bad usage of listAppend.

lookup (default: off) Print extra failtrace from lookup.

mergeAlgSections (default: off) Disables coloring algorithm while sparsity detection.

metaModelicaRecordAllocWords (default: off) Instrument the source code to record memory allocations (requires run-time and generated files compiled with -DOMC_RECORD_ALLOC_WORDS).

multirate (default: off) The solver can switch partitions in the system.

newInst (default: off) Enables experimental new instantiation phase.

nfAPI (default: off) Enables experimental new instantiation use in the OMC API.

nfEvalConstArgFuncs (default: on) Evaluate all functions with constant arguments in the new frontend.

nfExpandFuncArgs (default: off) Expand all function arguments in the new frontend.

nfExpandOperations (default: on) Expand all unary/binary operations to scalar expressions in the new frontend.

nfScalarize (default: on) Run scalarization in NF, default true.

oldFrontEndUnitCheck (default: off) Checks the consistency of units in equation (for the old front-end).


optdaedump (default: off) Dumps information from the optimization modules.

parallelCodegen (default: on) Enables code generation in parallel (disable this if compiling a model causes you to run out of RAM).

paramlowlowdump (default: off) Enables dumping of the parameters in the order they are calculated.

parmodauto (default: off) Experimental: Enable parallelization of independent systems of equations in the translated model.

partitionInitialization (default: on) This flag controls if partitioning is applied to the initialization system.

patternmAllInfo (default: off) Adds notifications of all pattern-matching optimizations that are performed.

patternmDeadCodeElimination (default: on) Performs dead code elimination in match-expressions. For example: equation c = fn(b); then c; => then fn(b);

patternmMoveLastExp (default: on) Optimization that moves the last assignment(s) into the result of a match-expression. For example: equation c = fn(b); then c; => then fn(b);

patternmSkipFilterUnusedBindings (default: off)

pedantic (default: off) Switch into pedantic debug-mode, to get much more feedback.

printStructuralParameters (default: off) Prints the structural parameters identified by the frontend.

pthread (default: off) Experimental: Unused parallelization.


reldx (default: off) Prints out debug information about relations, that are used as zero crossings.
relocatableFunctions (default: off) Generates relocatable code: all functions become function pointers and can be replaced at run-time.

reportSerializedSize (default: off) Reports serialized sizes of various data structures used in the compiler.

reshufflePost (default: off) Reshuffles the systems of equations.

resolveLoopsDump (default: off) Debug Output for ResolveLoops Module.

tml (default: off) Converts Modelica-style arrays to lists.

runtimeStaticLinking (default: off) Use the static simulation runtime libraries (C++ simulation runtime).

scodeDep (default: on) Does scode dependency analysis prior to instantiation. Defaults to true.

semiLinear (default: off) Enables dumping of the optimization information when optimizing calls to semiLinear.

shortOutput (default: off) Enables short output of the simulate() command. Useful for tools like OMNotebook.

showDaeGeneration (default: off) Show the dae variable declarations as they happen.

showExpandableInfo (default: off) Display the element source information in the dumped DAE for easier debugging.

showInstCacheInfo (default: off) Prints information about instantiation cache hits and additions. Defaults to false.

showStartOrigin (default: off) Enables dumping of the DAE startOrigin attribute of the variables.

showStatement (default: off) Shows the statement that is currently being evaluated when evaluating a script.

skipInputOutputSyntacticSugar (default: off) Used when bootstrapping to preserve the input output parsing of the code output by the list command.

stateselection (default: off) Enables dumping of selected states. Extends -d=backendedaieinfo.

static (default: off) Enables extra debug output from the static elaboration.

stripPrefix (default: on) Strips the environment prefix from path/crefs. Defaults to true.

susanDebug (default: off) Makes Susan generate code using try/else to better debug which function broke the expected match semantics.

symjacdump (default: off) Dumps information about symbolic Jacobians. Can be used only with postOptModules: generateSymbolicJacobian, generateSymbolicLinearization.

symjacdumpseqn (default: off) Dump for debug purpose of symbolic Jacobians. (deactivated now).

symjacdumpverbose (default: off) Dumps information in verbose mode about symbolic Jacobians. Can be used only with postOptModules: generateSymbolicJacobian, generateSymbolicLinearization.

symjacwarnings (default: off) Prints warnings regarding symbolic jacobians.

tail (default: off) Prints out a notification if tail recursion optimization has been applied.

tearingdump (default: off) Dumps tearing information.

tearingdumpV (default: off) Dumps verbose tearing information.

totaltearingdump (default: off) Dumps total tearing information.

totaltearingdumpV (default: off) Dumps verbose total tearing information.

tplPerfTimes (default: off) Enables output of template performance data for rendering text to file.

transformsbeforedump (default: off) Applies transformations required for code generation before dumping flat code.

types (default: off) Prints extra failtrace from Types.

uncertainties (default: off) Enables dumping of status when calling modelEquationsUC.

upmod (default: off) Prints information about modification updates.
useMPI (default: off) Add MPI init and finalize to main method (CPPruntime).

vectorize (default: off) Activates vectorization in the backend.

visxml (default: off) Outputs a xml-file that contains information for visualization.

warnMinMax (default: on) Makes a warning assert from min/max variable attributes instead of error.

warnNoNominal (default: off) Prints the iteration variables in the initialization and simulation DAE, which do not have a nominal value.

writeToBuffer (default: off) Enables writing simulation results to buffer.

### 23.3 Flags for Optimization Modules

Flags that determine which symbolic methods are used to produce the causalized equation system.

The `--preOptModules` flag sets the optimization modules which are used before the matching and index reduction in the back end. These modules are specified as a comma-separated list.

The `--matchingAlgorithm` sets the method that is used for the matching algorithm, after the pre optimization modules.

The `--indexReductionMethod` sets the method that is used for the index reduction, after the pre optimization modules.

The `--initOptModules` then sets the optimization modules which are used after the index reduction to optimize the system for initialization, specified as a comma-separated list.

The `--postOptModules` then sets the optimization modules which are used after the index reduction to optimize the system for simulation, specified as a comma-separated list.
This chapter contains a short overview of simulation flags as well as additional details of the numerical integration methods.

24.1 OpenModelica (C-runtime) Simulation Flags

The simulation executable takes the following flags:

- **-abortSlowSimulation**  Aborts if the simulation chatters.
- **-alarm=value or -alarm value**  Aborts after the given number of seconds (default=0 disables the alarm).
- **-clock=value or -clock value**  Selects the type of clock to use. Valid options include:
  - RT (monotonic real-time clock)
  - CYC (cpu cycles measured with RDTSC)
  - CPU (process-based CPU-time)
- **-cpu**  Dumps the cpu-time into the result file using the variable named $cpuTime.
- **-csvOstep=value or -csvOstep value**  Value specifies csv-files for debug values for optimizer step.
- **-daeMode**  Enables daeMode simulation if the model was compiled with the omc flag –daeMode and ida method is used.
- **-deltaXLinearize=value or -deltaXLinearize value**  Value specifies the delta x value for numerical differentiation used by linearization. The default value is sqrt(DBL_EPSILON*2e1).
- **-deltaXSolver=value or -deltaXSolver value**  Value specifies the delta x value for numerical differentiation used by integration method. The default values is sqrt(DBL_EPSILON).
- **-embeddedServer=value or -embeddedServer value**  Enables an embedded server. Valid values:
  - none - default, run without embedded server
  - opc-da - [broken] run with embedded OPC DA server (WIN32 only, uses proprietary OPC SC interface)
  - opc-ua - [experimental] run with embedded OPC UA server (TCP port 4841 for now; will have its own configuration option later)
  - filename - path to a shared object implementing the embedded server interface (requires access to internal OMC data-structures if you want to read or write data)
- **-embeddedServerPort=value or -embeddedServerPort value**  Value specifies the port number used by the embedded server. The default value is 4841.
- **-mat_sync=value or -mat_sync value**  Syncs the mat file header after emitting every N time-points.
- **-emit_protected**  Emits protected variables to the result-file.
- **-f=value or -f value**  Value specifies a new setup XML file to the generated simulation code.
-help=value or -help value  Get detailed information that specifies the command-line flag
   For example, -help=f prints detailed information for command-line flag f.

-homAdaptBend=value or -homAdaptBend value  Maximum trajectory bending to accept the homotopy step.
   Default: 0.5, which means the corrector vector has to be smaller than half of the predictor vector.

-homBacktraceStrategy=value or -homBacktraceStrategy value  Value specifies the backtrace strategy in the
   homotopy corrector step. Valid values:
   • fix - default, go back to the path by fixing one coordinate
   • orthogonal - go back to the path in an orthogonal direction to the tangent vector

-homHEps=value or -homHEps value  Tolerance respecting residuals for the homotopy H-function (default: 1e-5).
   In the last step (lambda=1) newtonFTol is used as tolerance.

-homMaxLambdaSteps=value or -homMaxLambdaSteps value  Maximum lambda steps allowed to run the homotopy path (default: system size * 100).

-homMaxNewtonSteps=value or -homMaxNewtonSteps value  Maximum newton steps in the homotopy corrector step (default: 20).

-homMaxTries=value or -homMaxTries value  Maximum number of tries for one homotopy lambda step (default: 10).

-homNegStartDir  Start to run along the homotopy path in the negative direction.
   If one direction fails, the other direction is always used as fallback option.

-homotopyOnFirstTry  If the model contains the homotopy operator, directly use the homotopy method to solve
   the initialization problem. Without this flag, the solver first tries to solve the initialization problem without
   homotopy and only uses homotopy as fallback option.

-homTauDecFac=value or -homTauDecFac value  Decrease homotopy step size tau by this factor if tau is too
   big in the homotopy corrector step (default: 10.0).

-hom TauDecFacPredictor=value or -homTauDecFacPredictor value  Decrease homotopy step size tau by this
   factor if tau is too big in the homotopy predictor step (default: 2.0).

-homTauIncFac=value or -homTauIncFac value  Increase homotopy step size tau by this factor if tau can be
   increased after the homotopy corrector step (default: 2.0).

-homTauIncThreshold=value or -homTauIncThreshold value  Increase the homotopy step size tau if
   homAdaptBend/bend > homTauIncThreshold (default: 10).

-homTauMax=value or -homTauMax value  Maximum homotopy step size tau for the homotopy process (default:
   10).

-homTauMin=value or -homTauMin value  Minimum homotopy step size tau for the homotopy process (default:
   1e-4).

-homTauStart=value or -homTauStart value  Homotopy step size tau at the beginning of the homotopy process
   (default: 0.2).

-idaMaxErrorTestFails=value or -idaMaxErrorTestFails value  Value specifies the maximum number of error
   test failures in attempting one step. The default value is 7.

-idaMaxNonLinIters=value or -idaMaxNonLinIters value  Value specifies the maximum number of nonlinear
   solver iterations at one step. The default value is 3.

-idaMaxConvFails=value or -idaMaxConvFails value  Value specifies the maximum number of nonlinear solver
   convergence failures at one step. The default value is 10.

-idaNonLinConvCoef=value or -idaNonLinConvCoef value  Value specifies the safety factor in the nonlinear
   convergence test. The default value is 0.33.

-idaLS=value or -idaLS value  Value specifies the linear solver of the ida integration method. Valid values:
• dense (ida internal dense method.)
• klu (ida use sparse direct solver KLU. (default))
• spgmr (ida generalized minimal residual method. Iterative method)
• spbcg (ida Bi-CGStab. Iterative method)
• sptfqmr (ida TFQMR. Iterative method)

-idaScaling Enable scaling of the IDA solver.

-idaSensitivity Enables sensitivity analysis with respect to parameters if the model is compiled with omc flag –calculateSensitivities.

-ignoreHideResult Emits also variables with HideResult=true annotation.

-iif=value or -iif value Value specifies an external file for the initialization of the model.

-iim=value or -iim value Value specifies the initialization method. Following options are available: ‘symbolic’ (default) and ‘none’.
  • none (sets all variables to their start values and skips the initialization process)
  • symbolic (solves the initialization problem symbolically - default)

-iit=value or -iit value Value [Real] specifies a time for the initialization of the model.

-ils=value or -ils value Value specifies the number of steps for homotopy method (required: -iim=symbolic). The value is an Integer with default value 4.

-impRKOrder=value or -impRKOrder value Value specifies the integration order of the implicit Runge-Kutta method. Valid values: 1 to 6. Default order is 5.

-impRKLS=value or -impRKLS value Selects the linear solver of the integration methods impeuler, trapezoid and imprungekuta:
  • iterativ - default, sparse iterativ linear solver with fallback case to dense solver
  • dense - dense linear solver, SUNDIALS default method

-initialStepSize=value or -initialStepSize value Value specifies an initial step size, used by the methods: dassl, ida

-csvInput=value or -csvInput value Value specifies an csv-file with inputs for the simulation/optimization of the model

-exInputFile=value or -exInputFile value Value specifies an external file with inputs for the simulation/optimization of the model.

-stateFile=value or -stateFile value Value specifies an file with states start values for the optimization of the model.

-inputPath=value or -inputPath value Value specifies a path for reading the input files i.e., model_init.xml and model_info.json

-ipopt_hesvalue=value or -ipopt_hes value Value specifies the hessematrix for Ipopt(OMC, BFGS, const).

-ipopt_init=value or -ipopt_init value Value specifies the initial guess for optimization (sim, const).

-ipopt_jac=value or -ipopt_jac value Value specifies the Jacobian for Ipopt(SYM, NUM, NUMDENSE).

-ipopt_max_iter=value or -ipopt_max_iter value Value specifies the max number of iteration for ipopt.

-ipopt_warm_start=value or -ipopt_warm_start value Value specifies lvl for a warm start in ipopt: 1,2,3,...

-jacobian=value or -jacobian value Select the calculation method for Jacobian used by the integration method:
  • coloredNumerical (Colored numerical Jacobian, which is default for dassl and ida. With option -idaLS=klu a sparse matrix is used.)
  • internalNumerical (Dense solver internal numerical Jacobian.)
• coloredSymbolical (Colored symbolical Jacobian. Needs omc compiler flag – generateSymbolicJacobian. With option -idaLS=klu a sparse matrix is used.)
• numerical (Dense numerical Jacobian.)
• symbolical (Dense symbolical Jacobian. Needs omc compiler flag –generateSymbolicJacobian.)

-\texttt{\textit{-l=value or -l value}} Value specifies a time where the linearization of the model should be performed.

-\texttt{\textit{-l\_datarec}} Emit data recovery matrices with model linearization.

-\texttt{\textit{-logFormat=value or -logFormat value}} Value specifies the log format of the executable:
  • text (default)
  • xml
  • xmltcp (required -port flag)

-\texttt{\textit{-ls=value or -ls value}} Value specifies the linear solver method
  • lapack (method using LAPACK LU factorization)
  • lis (method using iterative solver Lis)
  • klu (method using KLU sparse linear solver)
  • umfpack (method using UMFPACK sparse linear solver)
  • totalpivot (method using a total pivoting LU factorization for underdetermination systems)
  • default (default method - LAPACK with total pivoting as fallback)

-\texttt{\textit{-ls\_ipopt=value or -ls\_ipopt value}} Value specifies the linear solver method for Ipopt, default mumps. Note: Use if you build ipopt with other linear solver like ma27

-\texttt{\textit{-lss=value or -lss value}} Value specifies the linear sparse solver method
  • default (the default sparse linear solver (or a dense solver if there is none available) )
  • lis (method using iterative solver Lis)
  • klu (method using klu sparse linear solver)
  • umfpack (method using umfpack sparse linear solver)

-\texttt{\textit{-lssMaxDensity=value or -lssMaxDensity value}} Value specifies the maximum density for using a linear sparse solver. The value is a Double with default value 0.2.

-\texttt{\textit{-lssMinSize=value or -lssMinSize value}} Value specifies the minimum system size for using a linear sparse solver. The value is an Integer with default value 4001.

-\texttt{\textit{-lv=value or -lv value}} Value (a comma-separated String list) specifies which logging levels to enable. Multiple options can be enabled at the same time.
  • stdout (this stream is always active, can be disabled with -lv=-stdout)
  • assert (this stream is always active, can be disabled with -lv=-assert)
  • LOG\_DASSL (additional information about dassl solver)
  • LOG\_DASSL\_STATES (outputs the states at every dassl call)
  • LOG\_DEBUG (additional debug information)
  • LOG\_DSS (outputs information about dynamic state selection)
  • LOG\_DSS\_JAC (outputs jacobian of the dynamic state selection)
  • LOG\_DT (additional information about dynamic tearing)
  • LOG\_DT\_CONS (additional information about dynamic tearing (local and global constraints))
  • LOG\_EVENTS (additional information during event iteration)
  • LOG\_EVENTS\_V (verbose logging of event system)
• LOG_INIT (additional information during initialization)
• LOG_IPOPT (information from Ipopt)
• LOG_IPOPT_FULL (more information from Ipopt)
• LOG_IPOPT_JAC (check jacobian matrix with Ipopt)
• LOG_IPOPT_HESSE (check hessian matrix with Ipopt)
• LOG_IPOPT_ERROR (print max error in the optimization)
• LOG_JAC (outputs the jacobian matrix used by dassl)
• LOG_LS (logging for linear systems)
• LOG_LS_V (verbose logging of linear systems)
• LOG_NLS (logging for nonlinear systems)
• LOG_NLS_V (verbose logging of nonlinear systems)
• LOG_NLS_HOMOTOPY (logging of homotopy solver for nonlinear systems)
• LOG_NLS_JAC (outputs the jacobian of nonlinear systems)
• LOG_NLS_JAC_TEST (tests the analytical jacobian of nonlinear systems)
• LOG_NLS_RES (outputs every evaluation of the residual function)
• LOG_NLS_EXTRAPOLATE (outputs debug information about extrapolate process)
• LOG_RES_INIT (outputs residuals of the initialization)
• LOG_RT (additional information regarding real-time processes)
• LOG_SIMULATION (additional information about simulation process)
• LOG_SOLVER (additional information about solver process)
• LOG_SOLVER_V (verbose information about the integration process)
• LOG_SOLVER_CONTEXT (context information during the solver process)
• LOG_SOTI (final solution of the initialization)
• LOG_STATS (additional statistics about timer/events/solver)
• LOG_STATS_V (additional statistics for LOG_STATS)
• LOG_SUCCESS (this stream is always active, unless deactivated with -lv=-LOG_SUCCESS)
• LOG_UTIL (???)
• LOG_ZEROCROSSINGS (additional information about the zerocrossings)

-\texttt{mbi=value or -mbi value} Value specifies the maximum number of bisection iterations for state event detection or zero for default behavior

-\texttt{mei=value or -mei value} Value specifies the maximum number of event iterations. The value is an Integer with default value 20.

-\texttt{maxIntegrationOrder=value or -maxIntegrationOrder value} Value specifies maximum integration order, used by the methods: dassl, ida.

-\texttt{maxStepSize=value or -maxStepSize value} Value specifies maximum absolute step size, used by the methods: dassl, ida.

-\texttt{measureTimePlotFormat=value or -measureTimePlotFormat value} Value specifies the output format of the measure time functionality:
  • svg
  • jpg
  • ps
- **newtonFtol** = value or -newtonFtol value  Tolerance respecting residuals for updating solution vector in Newton solver. Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the tolerance newtonFtol and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonXTol. The value is a Double with default value 1e-12.

- **newtonMaxStepFactor** = value or -newtonMaxStepFactor value  Maximum newton step factor mnewtstep = maxStepFactor * norm2(xScaling). Used currently only by KINSOL.

- **newtonXTol** = value or -newtonXTol value  Tolerance respecting newton correction (delta_x) for updating solution vector in Newton solver. Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the tolerance newtonFtol and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonXTol. The value is a Double with default value 1e-12.

- **newton** = value or -newton value  Value specifies the damping strategy for the newton solver.
  - damped (Newton with a damping strategy)
  - damped2 (Newton with a damping strategy 2)
  - damped ls (Newton with a damping line search)
  - damped_bt (Newton with a damping backtracking and a minimum search via golden ratio method)
  - pure (Newton without damping strategy)

- **nls** = value or -nls value  Value specifies the nonlinear solver:
  - hybrid (Modification of the Powell hybrid method from minpack - former default solver)
  - kinsol (SUNDIALS/KINSOL includes an interface to the sparse direct solver, KLU. See simulation option -nlsLS for more information.)
  - newton (Newton Raphson - prototype implementation)
  - mixed (Mixed strategy. First the homotopy solver is tried and then as fallback the hybrid solver.)
  - homotopy (Damped Newton solver if failing case fixed-point and Newton homotopies are tried.)

- **nlsInfo**  Outputs detailed information about solving process of non-linear systems into csv files.

- **nlsLS** = value or -nlsLS value  Value specifies the linear solver used by the non-linear solver:
  - default (chooses the nls linear solver based on which nls is being used.)
  - totalpivot (internal total pivot implementation. Solve in some case even under-determined systems.)
  - lapack (use external LAPACK implementation.)
  - klu (use KLU direct sparse solver. Only with KINSOL available.)

- **nlsMaxDensity** = value or -nlsMaxDensity value  Value specifies the maximum density for using a non-linear sparse solver. The value is a Double with default value 0.2.

- **nlsMinSize** = value or -nlsMinSize value  Value specifies the minimum system size for using a non-linear sparse solver. The value is an Integer with default value 10001.

- **noemit**  Do not emit any results to the result file.

- **noEquidistantTimeGrid**  Output the internal steps given by dassl/ida instead of interpolating results into an equidistant time grid as given by stepSize or numberOfIntervals.

- **noEquidistantOutputFrequency** = value or -noEquidistantOutputFrequency value  Integer value n controls the output frequency in noEquidistantTimeGrid mode and outputs every n-th time step

- **noEquidistantOutputTime** = value or -noEquidistantOutputTime value  Real value timeValue controls the output time point in noEquidistantOutputTime mode and outputs every time>=k*timeValue, where k is an integer

- **noEventEmit**  Do not emit event points to the result file.
-noRestart Disables the restart of the integration method after an event is performed, used by the methods: dassl, ida

-noRootFinding Disables the internal root finding procedure of methods: dassl and ida.

-noScaling Disables scaling for the variables and the residuals in the algebraic nonlinear solver KINSOL.

-noSuppressAlg Flag to not suppress algebraic variables in the local error test of the ida solver in daeMode. In general, the use of this option is discouraged when solving DAE systems of index 1, whereas it is generally encouraged for systems of index 2 or more.

-optDebugJac=value or -optDebugJac value Value specifies the number of iterations from the dynamic optimization, which will be debugged, creating .csv and .py files.

-optimizerNP=value or -optimizerNP value Value specifies the number of points in a subinterval. Currently supports numbers 1 and 3.

-optimizerTimeGrid=value or -optimizerTimeGrid value Value specifies external file with time points.

-output=value or -output value Output the variables a, b and c at the end of the simulation to the standard output: time = value, a = value, b = value, c = value

-outputPath=value or -outputPath value Value specifies a path for writing the output files i.e., model_res.mat, model_prof.intdata, model_prof.realdata etc.

-override=value or -override value Override the variables or the simulation settings in the XML setup file For example: var1=start1, var2=start2, par3=start3, startTime=val1, stopTime=val2

-overrideFile=value or -overrideFile value Will override the variables or the simulation settings in the XML setup file with the values from the file. Note that: -overrideFile CANNOT be used with -override. Use when variables for -override are too many. overrideFileName contains lines of the form: var1=start1

-port=value or -port value Value specifies the port for simulation status (default disabled).

-r=value or -r value Value specifies the name of the output result file. The default file-name is based on the model name and output format. For example: Model_res.mat.

-rt=value or -rt value Value specifies the scaling factor for real-time synchronization (0 disables). A value > 1 means the simulation takes a longer time to simulate.

-s=value or -s value Value specifies the integration method. For additional information see the User’s Guide

- euler - Euler - explicit, fixed step size, order 1
- heun - Heun’s method - explicit, fixed step, order 2
- rungekutta - classical Runge-Kutta - explicit, fixed step, order 4
- impeuler - Euler - implicit, fixed step size, order 1
- trapezoid - trapezoidal rule - implicit, fixed step size, order 2
- imprungekutta - Runge-Kutta methods based on Radau and Lobatto IIA - implicit, fixed step size, order 1-6 (selected manually by flag -impRKOrder)
- irksco - own developed Runge-Kutta solver - implicit, step size control, order 1-2
- dassl - default solver - BDF method - implicit, step size control, order 1-5
- ida - SUNDIALS IDA solver - BDF method with sparse linear solver - implicit, step size control, order 1-5
- rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step size control, order 4-5 [experimental]
- symSolver - symbolic inline Solver [compiler flag +symSolver needed] - fixed step size, order 1
- symSolverSsc - symbolic implicit Euler with step size control [compiler flag +symSolver needed] - step size control, order 1
- qss - A QSS solver [experimental]
• optimization - Special solver for dynamic optimization

-single Output results in single precision (mat-format only).

-steps Dumps the number of integration steps into the result file.

-steadyState Aborts the simulation if steady state is reached.

-steadyStateTol=value or -steadyStateTol value This relative tolerance is used to detect steady state:
\[
\max\left(\frac{|d(x_i)/dt|}{\text{nominal}(x_i)}\right) < \text{steadyStateTol}
\]

-keepHessian=value or -keepHessian value Value specifies the number of steps, which keep Hessian matrix constant.

-w Shows all warnings even if a related log-stream is inactive.
This chapter gives an overview of some implementation details that might be interesting when building tools around OpenModelica.

25.1 The MATv4 Result File Format

The default result-file format of OpenModelica is based on MATLAB level 4 MAT-files as described in the MATLAB documentation. This format can be read by tools such as MATLAB, Octave, Scilab, and SciPy. OpenModelica will write the result-files in a particular way that can be read by tools such as DyMat and Dymola (OpenModelica can also read files generated by Dymola since the used format is the same).

The variables stored in the MAT-file are (in the order required by OpenModelica):

- **Aclass**
  - `Aclass(1,:)` is always *Atrajectory*
  - `Aclass(2,:)` is 1.1 in OpenModelica
  - `Aclass(3,:)` is empty
  - `Aclass(4,:)` is either `binTrans` or `binNormal`

    The most important part of the variable is `Aclass(4,:)` since there are two main ways the result-file is stored: transposed or not. For efficiency, the result-file is written time-step by time-step during simulation. But the best way to read the data for a single variable is if the variables are stored variable by variable.

    If `Aclass(4,:)` is `binTrans`, all matrices need to be transposed since the file was not transposed for efficient reading of the file. Note that this affects all matrices, even matrices that do not change during simulation (such as name and description).

- **name** is an n x m character (int8) matrix, where n is the number of variables stored in the result-file (including time). m is the length of the longest variable. OpenModelica stores the trailing part of the name as NIL bytes (0) whereas other tools use spaces for the trailing part.

- **description** is an n x m character (int8) matrix containing the comment-string corresponding to the variable in the name matrix.

- **dataInfo** is an n x 4 integer matrix containing information for each variable (in the same order as the name and description matrices).
  - `dataInfo(i,1)` is 1 or 2, saying if variable i is stored in the data_1 or data_2 matrix. If it is 0, it is the abscissa (time variable).
  - `dataInfo(i,2)` contains the index in the data_1 or data_2 matrix. The index is 1-based and may contain several variables pointing to the same row (alias variables). A negative value means that the variable is a negated alias variable.
  - `dataInfo(i,3)` is 0 to signify linear interpolation. In other tools the value is the number of times differentiable this variable is, which may improve plotting.
• `dataInfo(i,4)` is -1 in OpenModelica to signify that the value is not defined outside the time range. 0 keeps the first/last value when going outside the time range and 1 performs linear interpolation on the first/last two points.

data_1 If it is an n x 1 matrix it contains the values of parameters. If it is an n x 2 matrix, the first and second column signify start and stop-values.

data_2 Each row contains the values of a variable at the sampled times. The corresponding time stamps are stored in `data_2(1,:)`. `data_2(2,1)` is the value of some variable at time `data_2(1,1)`. 
FREQUENTLY ASKED QUESTIONS (FAQ)

Below are some frequently asked questions in three areas, with associated answers.

26.1 OpenModelica General

- **Q:** OpenModelica does not read the MODELICAPATH environment variable, even though this is part of the Modelica Language Specification.

- **A:** Use the OPENMODELICALIBRARY environment variable instead. We have temporarily switched to this variable, in order not to interfere with other Modelica tools which might be installed on the same system. In the future, we might switch to a solution with a settings file, that also allows the user to turn on the MODELICAPATH functionality if desired.

- **Q:** How do I enter multi-line models into OMShell since it evaluates when typing the Enter/Return key?

- **A:** There are basically three methods: 1) load the model from a file using the pull-down menu or the loadModel command. 2) Enter the model/function as one (possibly long) line. 3) Type in the model in another editor, where using multiple lines is no problem, and copy/paste the model into OMShell as one operation, then push Enter. Another option is to use OMNotebook instead to enter and evaluate models.

26.2 OMNotebook

- **Q:** OMNotebook hangs, what to do?

- **A:** It is probably waiting for the omc.exe (compiler) process. (Under windows): Kill the processes omc.exe, g++.exe (C-compiler), as.exe (assembler), if present. If OMNotebook then asks whether to restart OMC, answer yes. If not, kill the process OMNotebook.exe and restart manually.

- **Q:** After a previous session, when starting OMNotebook again, I get a strange message.

- **A:** You probably quit the previous OpenModelica session in the wrong way, which left the process omc.exe running. Kill that process, and try starting OMNotebook again.

- **Q:** I copy and paste a graphic figure from Word or some other application into OMNotebook, but the graphic does not appear. What is wrong?

- **A:** OMNotebook supports the graphic picture formats supported by Qt 4, including the .png, .bmp (bitmap) formats, but not for example the gif format. Try to convert your picture into one of the supported formats, (e.g. in Word, first do paste as bitmap format), and then copy the converted version into a text cell in OMNotebook.

- **Q:** I select a cell, copy it (e.g. Ctrl-C), and try to paste it at another place in the notebook. However, this does not work. Instead some other text that I earlier put on the clipboard is pasted into the nearest text cell.
• **A:** The problem is wrong choice of cursor mode, which can be text insertion or cell insertion. If you click inside a cell, the cursor become vertical, and OMNotebook expects you to paste text inside the cell. To paste a cell, you must be in cell insertion mode, i.e., click between two cells (or after a cell), you will get a vertical line. Place the cursor carefully on that vertical line until you see a small horizontal cursor. Then you should paste the cell.

• **Q:** I am trying to click in cells to place the vertical character cursor, but it does not seem to react.

• **A:** This seems to be a Qt feature. You have probably made a selection (e.g. for copying) in the output section of an evaluation cell. This seems to block cursor position. Click again in the output section to disable the selection. After that it will work normally.

• **Q:** I have copied a text cell and start writing at the beginning of the cell. Strangely enough, the font becomes much smaller than it should be.

• **A:** This seems to be a Qt feature. Keep some of the old text and start writing the new stuff inside the text, i.e., at least one character position to the right. Afterwards, delete the old text at the beginning of the cell.

26.3 OMDev - OpenModelica Development Environment

• **Q:** I get problems compiling and linking some files when using OMDev with the MINGW (Gnu) C compiler under Windows.

• **A:** You probably have some Logitech software installed. There is a known bug/incompatibility in Logitech products. For example, if lvpresrv.exe is running, kill it and/or prevent it to start again at reboot; it does not do anything really useful, not needed for operation of web cameras or mice.
CHAPTER
TWENTYSEVEN

MAJOR OPENMODELICA RELEASES

This Appendix lists the most important OpenModelica releases and a brief description of their contents. Right now versions from 1.3.1 to 1.14.0 are described.

27.1 Release Notes for OpenModelica 1.14.0

27.1.1 OpenModelica Compiler (OMC)

27.1.2 Graphic Editor OMEdit

27.1.3 FMI Support

27.1.4 Other things

27.2 Release Notes for OpenModelica 1.13.0

- OMSimulator 2.0 – the second release of our efficient FMI Simulation tool including a GUI for FMI Composition, co-simulation and model-exchange simulation, and SSP standard support. - Model and library encryption/decryption support. (Only for usage by OSMC member organizations) - Improved OpenModelica DAEMode for efficient solution of large Modelica models. - Julia scripting API to OpenModelica. - Basic Matlab scripting API to OpenModelica. - OMSysIdent - parameter estimation module for linear and non-linear parametric dynamic models. - Interactive simulation and control of simulations with OPC-UA. - PDEModelica1 - experimental support for one-dimensional PDEs in Modelica. - Analytic directional derivatives for FMI export and efficient calculation of multiple Jacobian columns – giving much faster simulation for some models - Enhanced OMEdit – including fast multi-file search. - Improved error messages and stability. - A version of the new fast compiler frontend available for testing, can be enabled by a flag Currently (December 10), simulates about 84% of MSL 3.2.2

Note: the replaceable GUI support has been moved to OpenModelica 1.14.0 and will be available in nightly builds.

27.3 Release Notes for OpenModelica 1.12.0

- A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator, first version for connected FMUs, TLM objects, Simulink models (via wrappers), Adams models (via wrappers), BEAST models (via wrappers), Modelica models
- Graphic configuration editing of composite models consisting of FMUs
• Basic graphical editing support for state machines and transitions
• Faster lookup processing, making some libraries faster to browse and compile
• Additional advanced visualization features for multibody animation
• Increased library coverage including significantly increased verification coverage
• Increased tool interoperability by addition of the ZeroMQ communications protocol
• Further enhanced OMPython including linearization, now also working with Python 3
• Support for RedHat/Fedora binary builds of OpenModelica

27.3.1 OpenModelica Compiler (OMC)

• Faster lookup processing
• Initializing external objects together with parameters
• Handle exceptions in numeric solvers
• Support for higher-index discrete clock partitions
• Improved unit checking
• Improved initialization of start values
• Decreased compilation time of models with large size arrays
• New approach for homotopy-based initialization (still experimental)
• A bunch of fixes: Bugs, regressions, performance issues
• Improved Dynamic Tearing by adding constraints for the casual set
• Improved module wrapFunctionCalls with one-time evaluation of Constant CSE-variables
• Added initOptModule for inlineHomotopy
• Added configuration flag tearingStrictness to influence solvability
• New methods for inline integration for continuous equations in clocked partitions, now covering: ExplicitEuler, ImplicitEuler, SemiImplicitEuler and ImplicitTrapezoid
• Complete implementation of synchronous features in C++ runtime
• Refactored linear solver of C++ runtime
• Improved Modelica_synchronous_cpp coverage
• New common linear solver module, optionally sparse, for the C++ runtime
• Coverage of most of the OpenHydraulics library
• Improved coverage of ThermoSysPro, IdealizedContact and Chemical libraries
• Support of time events for cpp-simulation and enabled time events in cpp-FMUs
• Global homotopy method for initialization
• Scripting API to compute accumulated errors (1-norm, 2-norm, max. error) of 2 time series

27.3.2 Graphic Editor OMEdit

• Additional advanced visualization features for multibody animation (transparency, textures, change colours by dialog)
• An HTML WYSIWYG Editor, e.g. useful for documentation
• Support for choices(checkBox=true) annotation.
• Support for loadSelector & saveSelector attribute of Dialog annotation.
• Panning of icon/diagram view and plot window.
• AutoComplete feature in text editing for keywords, types, common Modelica constructs
• Follow connector transformation from Diagram View to Icon View.
• Further stability improvements
• Improved performance for rendering some icons using the interactive API
• Improved handling of parameters that cannot be evaluated in Icon annotations
• Basic graphic editing support for state machines and transitions (not yet support for showing state internals on diagram layer)
• Interactive state manipulation for FMU-based animations

27.3.3 FMI Support

• A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator, first version (a main deliverable of the OPENCPS project, significant contributions and code donations from SKF)
• Graphic configuration editing of composite models consisting of FMUs
• Co-simulation/simulation of connected FMUs, TLM objects, Simulink models (via wrappers), Adams models (via wrappers), BEAST models (via wrappers), Modelica models.

27.3.4 Other things

• Increased OpenModelica tool interoperability by adding the ZeroMQ communications protocol in addition to the previously available Corba. This also enables Python 3 usage in OMPython on all platforms.
• Textual support through the OpenModelica API and graphical support in OMEdit for generation of single or multiple requirement verification scenarios
• VVDRlib – a small library for connecting requirements and models together, with notions for mediators, scenarios, design alternatives
• Further enhanced OMPython including linearization, now also working with Python 3.
• Jupyter notebooks also supported with OMPython and Python 3
• New enhanced library testing script (libraries.openmodelica.org/branches).
• Addition of mutable reference data types in MetaModelica
• Support for RedHat/Fedora binary builds of OpenModelica
• Support for exporting the system of equations in GraphML (yEd) format for debugging

27.4 Release Notes for OpenModelica 1.11.0

• Dramatically improved compilation speed and performance, in particular for large models.
• 3D animation visualization of regular MSL MultiBody simulations and for real-time FMUs.
• Better support for synchronous and state machine language elements, now supports 90% of the clocked synchronous library.
• Several OMEdit improvements including folding of large annotations.
• 64-bit OM on Windows further stabilized
- An updated OMDev (OpenModelica Development Environment), involving msys2. This was needed for the shift to 64-bit on Windows.
- Integration of Sundials/IDA DAE solver with potentially large increase of simulation performance for large models with sparse structure.
- Improved library coverage.
- Parameter sensitivity analysis added to OMC.

### 27.4.1 OpenModelica Compiler (OMC)

- Real-time synchronization support by using simFlag \(-rt=1.0\) (or some other time scaling factor).
- A prototype implementation of OPC UA using an open source OPC UA implementation. The old OPC implementation was not maintained and relied on a Windows-only proprietary OPC DA+UA package. (At the moment, OPC is experimental and lacks documentation; it only handles reading/writing Real/Boolean input/state variables. It is planned for OMEdit to use OPC UA to re-implement interactive simulations and plotting.)
- Dramatically improved compilation speed and dramatically reduced memory requirements for very large models. In Nov 2015, the largest power generation and transmission system model that OMC could handle had 60000 equations and it took 700 seconds to generate the simulation executable code; it now takes only 45 seconds to do so with OMC 1.11.0, which can also handle a model 10 times bigger (600 000 equations) in less than 15 minutes and with less than 32 GB of RAM. Simulation times are comparable to domain-specific simulation tools. See for example ScalableTestSuite for some of the improvements.
- Improved library coverage
- Better support for synchronous and state machine language elements, now simulates 90% of the clocked synchronous library.
- Enhanced Cpp runtime to support the PowerSystems library.
- Integration of Sundials/IDA solver as an alternative to DASSL.
- A DAEMode solver mode was added, which allows to use the sparse IDA solver to handle the DAEs directly. This can lead to substantially faster simulation on large systems with sparse structure, compared to the traditional approach.
- The direct sparse solvers KLU and SuperLU have been added, with benefits for models with large algebraic loops.
- Multi-parameter sensitivity analysis added to OMC.
- Progress on more efficient inline function mechanism.
- Stabilized 64-bit Windows support.
- Performance improvement of parameter evaluation.
- Enhanced tearing support, with prefer iteration variables and user-defined tearing.
- Support for external object aliases in connectors and equations (a non-standard Modelica extension).
- Code generation directly to file (saves maximum memory used). \#3356
- Code generation in parallel is enabled since \#3356 (controlled by omc flag \(-n\')). This improves performance since generating code directly to file avoid memory allocation.
- Allowing mixed dense and sparse linear solvers in the generated simulation (chosen depending on simflags \(-ls\) (dense solver), \(-lss\) (sparse solver), \(-lssMaxDensity\) and \(-lssMinSize\)).
27.4.2 Graphic Editor OMEdit

- Significantly faster browsing of most libraries.
- Several GUI improvements including folding of multi-line annotations.
- Further improved code formatting preservation during edits.
- Support for all simulation logging flags.
- Select and export variables after simulation.
- Support for Byte Order Mark. Added support enables other tools to correctly read the files written by OMEdit.
- Save files with line endings according to OS (Windows (CRLF), Unix (LF)).
- Added OMEdit support for FMU cross compilation. This makes it possible to launch OMEdit on a remote or virtual Linux machine using a Windows X server and export an FMU with Windows binaries.
- Support of DisplayUnit and unit conversion.
- Fixed automatic save.
- Initial support for DynamicSelect in model diagrams (texts and visible attribute after simulation, no expressions yet).
- An HTML documentation editor (not WYSIWYG; that editor will be available in the subsequent release).
- Improved logging in OMEdit of structured messages and standard output streams for simulations.

27.4.3 FMI Support

- Cross compilation of C++ FMU export. Compared to the C runtime, the C++ cross compilation covers the whole runtime for model exchange.
- Improved Newton solver for C++ FMUs (scaling and step size control).

27.4.4 Other things

- 3D animation visualization of regular MSL MultiBody simulations and for real-time FMUs.
- An updated OMDev (OpenModelica Development Environment), involving msys2. This was needed for the shift to 64-bit on Windows.
- OMWebbook, a web version of OMNotebook online. Also, a script is available to convert an OMNotebook to an OMWebbook.
- A Jupyter notebook Modelica mode, available in OpenModelica.

27.5 Release Notes for OpenModelica 1.10.0

The most important enhancements in the OpenModelica 1.10.0 release:

27.5.1 OpenModelica Compiler (OMC)

New features:

- Real-time synchronization support by using simFlag -rt=1.0 (or some
other time scaling factor). - A prototype implementation of OPC UA using an open source OPC UA implementation. The old OPC implementation was not maintained and relied on a Windows-only proprietary OPC DA+UA package. (At the moment, OPC is experimental and lacks documentation; it only handles reading/writing Real/Boolean input/state variables. It is planned for OMEdit to use OPC UA to re-implement interactive simulations and plotting.)

Performance enhancements:

- Code generation directly to file (saves maximum memory used). #3356 -

Code generation in parallel enabled since #3356 allows this without allocating too much memory (controlled by omc flag `-n`). - Various scalability enhancements, allowing the compiler to handle hundreds of thousands of equations. See for example ScalableTestSuite for some of the improvements. - Better defaults for handling tearing (OMC flags `--maxSizeLinearTearing` and `--maxSizeNonlinearTearing`). - Allowing mixed dense and sparse linear solvers in the generated simulation (chosen depending on simflags `-ls` (dense solver), `-lss` (sparse solver), `-lsMaxDensity` and `-lssMinSize`).

27.5.2 Graphic Editor OMEdit

27.5.3 OpenModelica Notebook (OMNotebook)

27.5.4 Optimization

27.5.5 FMI Support

27.5.6 OpenModelica Development Environment (OMDev)

27.6 Release Notes for OpenModelica 1.9.4

OpenModelica v1.9.4 was released 2016-03-09. These notes cover the v1.9.4 release and its subsequent bug-fix releases (now up to 1.9.7).

27.6.1 OpenModelica Compiler (OMC)

- Improved simulation speed for many models. simulation speed went up for 80% of the models. The compiler frontend became faster for almost all models, average about 40% faster.
- Initial support for synchronous models with clocked equations as defined in the Modelica 3.3 standard
- Support for homotopy operator

27.6.2 Graphic Editor OMEdit

- Undo/Redo support.
- Preserving text formatting, including indentation and whitespace. This is especially important for diff/merge with several collaborating developers possibly using several different Modelica tools.
- Better support for inherited classes.
- Allow simulating models using visual studio compiler.
- Support for saving Modelica package in a folder structure.
- Allow reordering of classes inside a package.
- Highlight matching parentheses in text view.
- When copying the text retain the text highlighting and formatting.
• Support for global head definition in the documentation by using ‘__OpenModelica_infoHeader’ annotation.
• Support for expandable connectors.
• Support for uses annotation.

27.6.3 FMI Support

• Full FMI 2.0 co-simulation support now available
• Upgrade Cpp runtime from C++03 to C++11 standard, minimizing external link dependencies. Exported FMUs don’t depend on additional libraries such as boost anymore
• FMI 2.0 is broken for some models in 1.9.4. Upgrading to 1.9.6 is advised.

27.7 Release Notes for OpenModelica 1.9.3

The most important enhancements in the OpenModelica 1.9.3 release:

• Enhanced collaborative development and testing of OpenModelica by moving to the GIT-hub framework for versioning and parallel development.
• More accessible and up-to-date automatically generated documentation provided in both html and pdf.
• Further improved simulation speed and coverage of several libraries.
• OMEdit graphic connection editor improvements.
• OMNotebook improvements.

27.7.1 OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted to the following:

• Further improved simulation speed and coverage for several libraries.
• Faster generated code for functions involving arrays, factor 2 speedup for many power generation models.
• Better initialization.
• An implicit inline Euler solver available.
• Code generation to enable vectorization of for-loops.
• Improved non-linear, linear and mixed system solving.
• Cross-compilation for the ARMhf architecture.
• A prototype state machine implementation.
• Improved performance and stability of the C++ runtime option.
• More accessible and up-to-date automatically generated documentation provided in both html and .pdf.

27.7.2 Graphic Editor OMEdit

There are several improvements to the OpenModelica graphic connection editor OMEdit:

• Support for uses annotations.
• Support for declaring components as vectors.
• Faster messages browser with clickable error messages.
• Support for managing the stacking order of graphical shapes.
• Several improvements to the plot tool and text editor in OMEdit.

27.7.3 OpenModelica Notebook (OMNotebook)

Several improvements:
• Support for moving cells from one place to another in a notebook.
• A button for evaluation of whole notebooks.
• A new cell type called Latex cells, supporting Latex formatted input that provides mathematical typesetting of formulae when evaluated.

27.7.4 Optimization

Several improvements of the Dynamic Optimization module with collocation, using Ipopt:
• Better performance due to smart treatment of algebraic loops for optimization.
• Improved formulation of optimization problems with an annotation approach which also allows graphical problem formulation.
• Proper handling of constraints at final time.

27.7.5 FMI Support

Further improved FMI 2.0 co-simulation support.

27.7.6 OpenModelica Development Environment (OMDev)

A big change: version handling and parallel development has been improved by moving from SVN to GitHub. This makes it easier for each developer to test his/her fixes and enhancements before committing the code. Automatic mirroring of all code is still performed to the OpenModelica SVN site.

27.8 Release Notes for OpenModelica 1.9.2

The OpenModelica 1.9.2 Beta release is available now, January 31, 2015. Please try it and give feedback! The final release is planned within 1-2 weeks after some more testing. The most important enhancements in the OpenModelica 1.9.2 release:
• The OpenModelica compiler has moved to a new development and release platform: the bootstrapped OpenModelica compiler. This gives advantages in terms of better programmability, maintenance, debugging, modularity and current/future performance increases.
• The OpenModelica graphic connection editor OMEdit has become 3-5 times faster due to faster communication with the OpenModelica compiler linked as a DLL. This was made possible by moving to the bootstrapped compiler.
• Further improved simulation coverage for a number of libraries.
• OMEdit graphic connection editor improvements
27.8.1 OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted to the following:

• The OpenModelica compiler has moved to a new development and release platform: the bootstrapped OpenModelica compiler. This gives advantages in terms of better programmability, maintenance, debugging, modularity and current/future performance increases.

• Further improved simulation coverage for a number of libraries compared to 1.9.1. For example:
  – MSL 3.2.1 100% compilation, 97% simulation (3% increase)
  – MSL Trunk 99% compilation (1% increase), 93% simulation (3% increase)
  – ModelicaTest 3.2.1 99% compilation (2% increase), 95% simulation (6% increase)
  – ThermoSysPro 100% compilation, 80% simulation (17% increase)
  – ThermoPower 97% compilation (5% increase), 85% simulation (5% increase)
  – Buildings 80% compilation (1% increase), 73% simulation (1% increase)

• Further enhanced OMC compiler front-end coverage, scalability, speed and memory.
• Better initialization.
• Improved tearing.
• Improved non-linear, linear and mixed system solving.
• Common subexpression elimination support - drastically increases performance of some models.

27.8.2 Graphic Editor OMEdit

• The OpenModelica graphic connection editor OMEdit has become 3-5 times faster due to faster communication with the OpenModelica compiler linked as a DLL. This was made possible by moving to the bootstrapped compiler.

• Enhanced simulation setup window in OMEdit, which among other things include better support for integration methods and dassl options.

• Support for running multiple simultaneous simulation.

• Improved handling of modifiers.

• Re-simulate with changed options, including history support and re-simulating with previous options possibly edited.

• More user friendly user interface by improved connection line drawing, added snap to grid for icons and conversion of icons from PNG to SVG, and some additional fixes.

27.8.3 Optimization

Some smaller improvements of the Dynamic Optimization module with collocation, using Ipopt.

27.8.4 FMI Support

Further improved for FMI 2.0 model exchange import and export, now compliant according to the FMI compliance tests. FMI 1.0 support has been further improved.
27.9 Release Notes for OpenModelica 1.9.1

The most important enhancements in the OpenModelica 1.9.1 release:

- Improved library support.
- Further enhanced OMC compiler front-end coverage and scalability.
- Significant improved simulation support for libraries using Fluid and Media.
- Dynamic model debugger for equation-based models integrated with OMEdit.
- Dynamic algorithm model debugger with OMEdit; including support for MetaModelica when using the bootstrapped compiler.

New features: Dynamic debugger for equation-based models; Dynamic Optimization with collocation built into OpenModelica, performance analyzer integrated with the equation model debugger.

27.9.1 OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted to the following:

- Further improved OMC model compiler support for a number of libraries including MSL 3.2.1, ModelicaTest 3.2.1, PetriNet, Buildings, PowerSystems, OpenHydraulics, ThermoPower, and ThermoSysPro.
- Further enhanced OMC compiler front-end coverage, scalability, speed and memory.
- Better coverage of Modelica libraries using Fluid and Media.
- Automatic differentiation of algorithms and functions.
- Improved testing facilities and library coverage reporting.
- Improved model compilation speed by compiling model parts in parallel (bootstrapped compiler).
- Support for running model simulations in a web browser.
- New faster initialization that handles over-determined systems, under-determined systems, or both.
- Compiler back-end partly redesigned for improved scalability and better modularity.
- Better tearing support.
- The first run-time Modelica equation-based model debugger, not available in any other Modelica tool, integrated with OMEdit.
- Enhanced performance profiler integrated with the debugger.
- Improved parallelization prototype with several parallelization strategies, task merging and duplication, shorter critical paths, several scheduling strategies.
- Some support for general solving of mixed systems of equations.
- Better error messages.
- Improved bootstrapped OpenModelica compiler.
- Better handling of array subscripts and dimensions.
- Improved support for reduction functions and operators.
- Better support for partial functions.
- Better support for function tail recursion, which reduces memory usage.
- Partial function evaluation in the back-end to improve solving singular systems.
- Better handling of events/zero crossings.
- Support for colored Jacobians.
• New differentiation package that can handle a much larger number of expressions.
• Support for sparse solvers.
• Better handling of asserts.
• Improved array and matrix support.
• Improved overloaded operators support.
• Improved handling of overconstrained connection graphs.
• Better support for the cardinality operator.
• Parallel compilation of generated code for speeding up compilation.
• Split of model files into several for better compilation scalability.
• Default linear tearing.
• Support for impure functions.
• Better compilation flag documentation.
• Better automatic generation of documentation.
• Better support for calling functions via instance.
• New text template based unparsing for DAE, Absyn, SCode, TaskGraphs, etc.
• Better support for external objects (#2724, reject non-constructor functions returning external objects)
• Improved C++ runtime.
• Improved testing facilities.
• New unit checking implementation.
• Support for model rewriting expressions via rewriting rules in an external file.
• Reject more bad code (r19986, consider records with different components type-incompatible)

27.9.2 OpenModelica Connection Editor (OMEdit)

• Convenient editing of model parameter values and re-simulation without recompilation after parameter changes.
• Improved plotting.
• Better handling of flags/units/resources/crashes.
• Run-time Modelica equation-based model debugger that provides both dynamic run-time debugging and debugging of symbolic transformations.
• Run-time Modelica algorithmic code debugger; also MetaModelica debugger with the bootstrapped Open-Modelica compiler.

27.9.3 OMPython

The interface was changed to version 2.0, which uses one object for each OpenModelica instance you want active. It also features a new and improved parser that returns easier to use datatypes like maps and lists.

27.9.4 Optimization

A builtin integrated Dynamic Optimization module with collocation, using Ipopt, is now available.
27.9.5 FMI Support

Support for FMI 2.0 model exchange import and export has been added. FMI 1.0 support has been further improved.

27.10 Release Notes for OpenModelica 1.9.0

This is the summary description of changes to OpenModelica from 1.8.1 to 1.9.0, released 2013-10-09. This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted to the following:

27.10.1 OpenModelica Compiler (OMC)

This release mainly includes bug fixes and improvements of the OpenModelica Compiler (OMC), including, but not restricted to the following:

- A more stable and complete OMC model compiler. The 1.9.0 final version simulates many more models than the previous 1.8.1 version and OpenModelica 1.9.0 beta versions.
- Much better simulation support for MSL 3.2.1, now 270 out of 274 example models compile (98%) and 245 (89%) simulate, compared to 30% simulating in the 1.9.0 beta1 release.
- Much better simulation for the ModelicaTest 3.2.1 library, now 401 out of 428 models build (93%) and 364 simulate (85%), compared to 32% in November 2012.
- Better simulation support for several other libraries, e.g. more than twenty examples simulate from ThermoSysPro, and all but one model from PlanarMechanics simulate.
- Improved tearing algorithm for the compiler backend. Tearing is by default used.
- Much faster matching and dynamic state selection algorithms for the compiler backend.
- New index reduction algorithm implementation.
- New default initialization method that symbolically solves the initialization problem much faster and more accurately. This is the first version that in general initialize hybrid models correctly.
- Better class loading from files. The package.order file is now respected and the file structure is more thoroughly examined (#1764).
- It is now possible to translate the error messages in the omc kernel (#1767).
- FMI Support. FMI co-simulation with OpenModelica as master. Improved FMI Import and export for model exchange. Most of FMI 2.0 is now also supported.

- Checking (when possible) that variables have been assigned to before they are used in algorithmic code (#1776).
- Full version of Python scripting.
- 3D graphics visualization using the Modelica3D library.
- The PySimulator package from DLR for additional analysis is integrated with OpenModelica (see Modelica2012 paper), and included in the OpenModelica distribution (Windows only).
- Prototype support for uncertainty computations, special feature enabled by special flag.
- Parallel algorithmic Modelica support (ParModelica) for efficient portable parallel algorithmic programming based on the OpenCL standard, for CPUs and GPUs.
- Support for optimization of semiLinear according to MSL 3.3 chapter 3.7.2.5 semiLinear (r12657,r12658).
- The compiler is now fully bootstrapped and can compile itself using a modest amount of heap and stack space (less than the RML-based compiler, which is still the default).
• Some old debug-flags were removed. Others were renamed. Debug flags can now be enabled by default.
• Removed old unused simulation flags noClean and storeInTemp (r15927).
• Many stack overflow issues were resolved.
• Dynamic Optimization with OpenModelica. Dynamic optimization with XML export to the CasADi package is now integrated with OpenModelica. Moreover, a native integrated Dynamic Optimization prototype using Ipopt is now in the OpenModelica release, but currently needs a special flag to be turned on since it needs more testing and refinement before being generally made available.

27.10.2 OpenModelica Notebook (OMNotebook)

• A ‘shortOutput’ option has been introduced in the simulate command for less verbose output. The DrModelica interactive document has been updated and the models tested. Almost all models now simulate with OpenModelica.

27.10.3 OpenModelica Eclipse Plug-in (MDT)

• Enhanced debugger for algorithmic Modelica code, supporting both standard Modelica algorithmic code called from simulation models, and MetaModelica code.

27.10.4 OpenModelica Development Environment (OMDev)

• Migration of version handling and configuration management from CodeBeamer to Trac.

27.10.5 Graphic Editor OMEdit

• General GUI: backward and forward navigation support in Documentation view, enhanced parameters window with support for Dialog annotation. Most of the images are converted from raster to vector graphics i.e PNG to SVG.
• Libraries Browser: better loading of libraries, library tree can now show protected classes, show library items class names as middle ellipses if the class name text is larger, more options via the right click menu for quick usage.
• ModelWidget: add the partial class as a replaceable component, look for the default component prefixes and name when adding the component.
• GraphicsView: coordinate system manipulation for icon and diagram layers. Show red box for models that do not exist. Show default graphical annotation for the components that doesn’t have any graphical annotations. Better resizing of the components. Properties dialog for primitive shapes i.e Line, Polygon, Rectangle, Ellipse, Text and Bitmap.
• File Opening: open one or more Modelica files, allow users to select the encoding while opening the file, convert files to UTF-8 encoding, allow users to open the OpenModelica result files.
• Variables Browser: find variables in the variables browser, sorting in the variables browser.
• Plot Window: clear all curves of the plot window, preserve the old selected variable and update its value with the new simulation result.
• Simulation: support for all the simulation flags, read the simulation output as soon as is is obtained, output window for simulations, options to set matching algorithm and index reduction method for simulation. Display all the files generated during the simulation is now supported. Options to set OMC command line flags.
• Options: options for loading libraries via loadModel and loadFile each time GUI starts, save the last open file directory location, options for setting line wrap mode and syntax highlighting.
• Modelica Text Editor: preserving user customizations, new search & replace functionality, support for comment/uncomment.
• Notifications: show custom dialogs to users allowing them to choose whether they want to see this dialog again or not.
• Model Creation: Better support for creating new classes. Easy creation of extends classes or nested classes.
• Messages Widget: Multi line error messages are now supported.
• Crash Detection: The GUI now automatically detects the crash and writes a stack trace file. The user is given an option to send a crash report along with the stack trace file and few other useful files via email.
• Autosave: OMEdit saves the currently edited model regularly, in order to avoid losing edits after GUI or compiler crash. The save interval can be set in the Options menu.

27.10.6 ModelicaML

• Enhanced ModelicaML version with support for value bindings in requirements-driven modeling available for the latest Eclipse and Papyrus versions. GUI specific adaptations. Automated model composition workflows (used for model-based design verification against requirements) are modularized and have improved in terms of performance.

27.11 Release Notes for OpenModelica 1.8.1

The OpenModelica 1.8.1 release has a faster and more stable OMC model compiler. It flattens and simulates more models than the previous 1.8.0 version. Significant flattening speedup of the compiler has been achieved for certain large models. It also contains a New ModelicaML version with support for value bindings in requirements-driven modeling and importing Modelica library models into ModelicaML models. A beta version of the new OpenModelica Python scripting is also included. The release was made on 2012-04-03 (r11645).

27.11.1 OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica Compiler (OMC) and several improvements of the backend, including, but not restricted to:
• A faster and more stable OMC model compiler. The 1.8.1 version flattens and simulates more models than the previous 1.8.0 version.
• Support for operator overloading (except Complex numbers).
• New ModelicaML version with support for value bindings in requirements-driven modeling and importing Modelica library models into ModelicaML models.
• Faster plotting in OMNotebook. The feature sendData has been removed from OpenModelica. As a result, the kernel no longer depends on Qt. The plot3() family of functions have now replaced to plot(), which in turn have been removed. The non-standard visualize() command has been removed in favour of more recent alternatives.
• Store OpenModelica documentation as Modelica Documentation annotations.
• Re-implementation of the simulation runtime using C instead of C++ (this was needed to export FMI source-based packages).
• FMI import/export bug fixes.
• Changed the internal representation of various structures to share more memory. This significantly improved the performance for very large models that use records.
• Faster model flattening, Improved simulation, some graphical API bug fixes.
• More robust and general initialization, but currently time-consuming.
• New initialization flags to omc and options to simulate(), to control whether fast or robust initialization is
  selected, or initialization from an external (.mat) data file.
• New options to API calls list, loadFile, and more.
• Enforce the restriction that input arguments of functions may not be assigned to.
• Improved the scripting environment. cl := $TypeName(Modelica);getClassComment(cl); now works as
  expected. As does looping over lists of typenames and using reduction expressions.
• Beta version of Python scripting.
• Various bugfixes.
• NOTE: interactive simulation is not operational in this release. It will be put back again in the near future,
  first available as a nightly build. It is also available in the previous 1.8.0 release.

27.11.2 OpenModelica Notebook (OMNotebook)

• Faster and more stable plotting.

27.11.3 OpenModelica Shell (OMShell)

• No changes.

27.11.4 OpenModelica Eclipse Plug-in (MDT)

• Small fixes and improvements.

27.11.5 OpenModelica Development Environment (OMDev)

• No changes.

27.11.6 Graphic Editor OMEdit

• Bug fixes.

27.11.7 OMOptim Optimization Subsystem

• Bug fixes.

27.11.8 FMI Support

• Bug fixes.

27.12 OpenModelica 1.8.0, November 2011

The OpenModelica 1.8.0 release contains OMC flattening improvements for the Media library - it now flattens
the whole library and simulates about 20% of its example models. Moreover, about half of the Fluid library models
also flatten. This release also includes two new tool functionalities - the FMI for model exchange import and
export, and a new efficient Eclipse-based debugger for Modelica/MetaModelica algorithmic code.
27.12.1 OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica Compiler (OMC) and several improvements of the backend, including, but not restricted to: A faster and more stable OMC model compiler. The 1.8.0 version flattens and simulates more models than the previous 1.7.0 version.

- Flattening of the whole Media library, and about half of the Fluid library. Simulation of approximately 20% of the Media library example models. - Functional Mockup Interface (FMI) 1.0 for model exchange, export and import, for the Windows platform. - Bug fixes in the OpenModelica graphical model connection editor OM Edit, supporting easy-to-use graphical drag-and-drop modeling and Modelica Language (MSL) 3.1. - Bug fixes in the OMOptim optimization subsystem. - Beta version of compiler support for a new Eclipse-based very efficient algorithmic code debugger for functions in MetaModelica/Modelica, available in the development environment when using the bootstrapped OpenModelica compiler. - Improvements in initialization of simulations. - Improved index reduction with dynamic state selection, which improves simulation. - Better error messages from several parts of the compiler, including a new API call for giving better error messages. - Automatic partitioning of equation systems and multi-core parallel simulation of independent parts based on the shared-memory OpenMP model. This version is a preliminary experimental version without load balancing.

27.12.2 OpenModelica Notebook (OMNotebook)

No changes.

27.12.3 OpenModelica Shell (OMShell)

Small performance improvements.

27.12.4 OpenModelica Eclipse Plug-in (MDT)

Small fixes and improvements. MDT now also includes a beta version of a new Eclipse-based very efficient algorithmic code debugger for functions in MetaModelica/Modelica.

27.12.5 OpenModelica Development Environment (OMDev)

Third party binaries, including Qt libraries and executable Qt clients, are now part of the OMDev package. Also, now uses GCC 4.4.0 instead of the earlier GCC 3.4.5.

27.12.6 Graphic Editor OMEdit

Bug fixes. Access to FMI Import/Export through a pull-down menu. Improved configuration of library loading. A function to go to a specific line number. A button to cancel an on-going simulation. Support for some updated OMC API calls.

27.12.7 New OMOptim Optimization Subsystem

Bug fixes, especially in the Linux version.

27.12.8 FMI Support

The Functional Mockup Interface (FMI) 1.0 for model exchange import and export is supported by this release. The functionality is accessible via API calls as well as via pull-down menu commands in OMEdit.
27.13 OpenModelica 1.7.0, April 2011

The OpenModelica 1.7.0 release contains OMC flattening improvements for the Media library, better and faster event handling and simulation, and fast MetaModelica support in the compiler, enabling it to compiler itself. This release also includes two interesting new tools – the OMOptim optimization subsystem, and a new performance profiler for equation-based Modelica models.

27.13.1 OpenModelica Compiler (OMC)

This release includes bug fixes and performance improvements of the flattening frontend part of the OpenModelica Compiler (OMC) and several improvements of the backend, including, but not restricted to:

- Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1), except Media and Fluid. - Progress in supporting the Media library, some models now flatten. - Much faster simulation of many models through more efficient handling of alias variables, binary output format, and faster event handling. - Faster and more stable simulation through new improved event handling, which is now default.
- Simulation result storage in binary .mat files, and plotting from such files. - Support for Unicode characters in quoted Modelica identifiers, including Japanese and Chinese. - Preliminary MetaModelica 2.0 support. (use setCommandLineOptions({"+g=MetaModelica"}) ). Execution is as fast as MetaModelica 1.0, except for garbage collection. - Preliminary bootstrapped OpenModelica compiler: OMC now compiles itself, and the bootstrapped compiler passes the test suite. A garbage collector is still missing. - Many bug fixes.

27.13.2 OpenModelica Notebook (OMNotebook)

Improved much faster and more stable 2D plotting through the new OMPlot module. Plotting from binary .mat files. Better integration between OMEdit and OMNotebook, copy/paste between them.

27.13.3 OpenModelica Shell (OMShell)

Same as previously, except the improved 2D plotting through OMPlot.

27.13.4 Graphic Editor OMEdit

Several enhancements of OMEdit are included in this release. Support for Icon editing is now available. There is also an improved much faster 2D plotting through the new OMPlot module. Better integration between OMEdit and OMNotebook, with copy/paste between them. Interactive on-line simulation is available in an easy-to-use way.

27.13.5 New OMOptim Optimization Subsystem

A new optimization subsystem called OMOptim has been added to OpenModelica. Currently, parameter optimization using genetic algorithms is supported in this version 0.9. Pareto front optimization is also supported.

27.13.6 New Performance Profiler

A new, low overhead, performance profiler for Modelica models has been developed.
27.14 OpenModelica 1.6.0, November 2010

The OpenModelica 1.6.0 release primarily contains flattening, simulation, and performance improvements regarding Modelica Standard Library 3.1 support, but also has an interesting new tool – the OMEdit graphic connection editor, and a new educational material called DrControl, and an improved ModelicaML UML/Modelica profile with better support for modeling and requirement handling.

27.14.1 OpenModelica Compiler (OMC)

This release includes bug fix and performance improvements of the flattening frontend part of the OpenModelica Compiler (OMC) and some improvements of the backend, including, but not restricted to:

- Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1), except Media and Fluid. - Improved flattening speed of a factor of 5-20 compared to OpenModelica 1.5 for a number of models, especially in the MultiBody library. - Reduced memory consumption by the OpenModelica compiler frontend, for certain large models a reduction of a factor 50. - Reorganized, more modular OpenModelica compiler backend, can now handle approximately 30 000 equations, compared to previously approximately 10 000 equations. - Better error messages from the compiler, especially regarding functions. - Improved simulation coverage of MSL 3.1. Many models that did not simulate before are now simulating. However, there are still many models in certain sublibraries that do not simulate. - Progress in supporting the Media library, but simulation is not yet possible. - Improved support for enumerations, both in the frontend and the backend. - Implementation of stream connectors. - Support for linearization through symbolic Jacobians. - Many bug fixes.

27.14.2 OpenModelica Notebook (OMNotebook)

A new DrControl electronic notebook for teaching control and modeling with Modelica.

27.14.3 OpenModelica Development Environment (OMDev)

Several enhancements. Support for match-expressions in addition to matchcontinue. Support for real if-then-else. Support for if-then without else-branches. Modelica Development Tooling 0.7.7 with small improvements such as more settings, improved error detection in console, etc.

27.14.4 New Graphic Editor OMEdit

A new improved open source graphic model connection editor called OMEdit, supporting 3.1 graphical annotations, which makes it possible to move models back and forth to other tools without problems. The editor has been implemented by students at Linköping University and is based on the C++ Qt library.

27.15 OpenModelica 1.5.0, July 2010

This OpenModelica 1.5 release has major improvements in the OpenModelica compiler frontend and some in the backend. A major improvement of this release is full flattening support for the MultiBody library as well as limited simulation support for MultiBody. Interesting new facilities are the interactive simulation and the integrated UML-Modelica modeling with ModelicaML. Approximately 4 person-years of additional effort have been invested in the compiler compared to the 1.4.5 version, e.g., in order to have a more complete coverage of Modelica 3.0, mainly focusing on improved flattening in the compiler frontend.
27.15.1 OpenModelica Compiler (OMC)

This release includes major improvements of the flattening frontend part of the OpenModelica Compiler (OMC) and some improvements of the backend, including, but not restricted to:

• Improved flattening speed of at least a factor of 10 or more compared to the 1.4.5 release, primarily for larger models with inner-outer, but also speedup for other models, e.g. the robot model flattens in approximately 2 seconds. - Flattening of all MultiBody models, including all elementary models, breaking connection graphs, world object, etc. Moreover, simulation is now possible for at least five MultiBody models: Pendulum, DoublePendulum, InitSpringConstant, World, PointGravityWithPointMasses. - Progress in supporting the Media library, but simulation is not yet possible. - Support for enumerations, both in the frontend and the backend. - Support for expandable connectors. - Support for the inline and late inline annotations in functions. - Complete support for record constructors, also for records containing other records. - Full support for iterates, including nested ones. - Support for inferred iterator and for-loop ranges. - Support for the function derivative annotation. - Prototype of interactive simulation. - Prototype of integrated UML-Modelica modeling and simulation with ModelicaML. - A new bidirectional external Java interface for calling external Java functions, or for calling Modelica functions from Java. - Complete implementation of replaceable model extends. - Fixed problems involving arrays of unknown dimensions. - Limited support for tearing. - Improved error handling at division by zero. - Support for Modelica 3.1 annotations. - Support for all MetaModelica language constructs inside OpenModelica. - OpenModelica works also under 64-bit Linux and Mac 64-bit OSX. - Parallel builds and running test suites in parallel on multi-core platforms. - New OpenModelica text template language for easier implementation of code generators, XML generators, etc. - New OpenModelica code generators to C and C# using the text template language. - Faster simulation result data file output optionally as comma-separated values. - Many bug fixes.

It is now possible to graphically edit models using parts from the Modelica Standard Library 3.1, since the SimForge graphical editor (from Politecnico di Milano) that is used together with OpenModelica has been updated to version 0.9.0 with a important new functionality, including support for Modelica 3.1 and 3.0 annotations. The 1.6 and 2.2.1 Modelica graphical annotation versions are still supported.

27.15.2 OpenModelica Notebook (OMNotebook)

Improvements in platform availability.

• Support for 64-bit Linux. - Support for Windows 7. - Better support for MacOS, including 64-bit OSX.

27.16 OpenModelica 1.4.5, January 2009

This release has several improvements, especially platform availability, less compiler memory usage, and supporting more aspects of Modelica 3.0.

27.16.1 OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC):

• Less memory consumption and better memory management over time. This also includes a better API supporting automatic memory management when calling C functions from within the compiler. - Modelica 3.0 parsing support. - Export of DAE to XML and MATLAB. - Support for several platforms Linux, MacOS, Windows (2000, Xp, Vista). - Support for record and strings as function arguments. - Many bug fixes. - (Not part of OMC): Additional free graphic editor SimForge can be used with OpenModelica.
27.16.2 OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the plotting functionality and platform availability.

- A number of improvements in the plotting functionality: scalable plots, zooming, logarithmic plots, grids, etc. - Programmable plotting accessible through a Modelica API. - Simple 3D visualization. - Support for several platforms Linux, MacOS, Windows (2000, Xp, Vista).

27.17 OpenModelica 1.4.4, Feb 2008

This release is primarily a bug fix release, except for a preliminary version of new plotting functionality available both from the OMNotebook and separately through a Modelica API. This is also the first release under the open source license OSMC-PL (Open Source Modelica Consortium Public License), with support from the recently created Open Source Modelica Consortium. An integrated version handler, bug-, and issue tracker has also been added.

27.17.1 OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC):

- Better support for if-equations, also inside when. - Better support for calling functions in parameter expressions and interactively through dynamic loading of functions. - Less memory consumption during compilation and interactive evaluation. - A number of bug-fixes.

27.17.2 OpenModelica Notebook (OMNotebook)

Test release of improvements, primarily in the plotting functionality and platform availability.

- Preliminary version of improvements in the plotting functionality: scalable plots, zooming, logarithmic plots, grids, etc., currently available in a preliminary version through the plot2 function. - Programmable plotting accessible through a Modelica API.

27.17.3 OpenModelica Eclipse Plug-in (MDT)

This release includes minor bugfixes of MDT and the associated MetaModelica debugger.

27.17.4 OpenModelica Development Environment (OMDev)

Extended test suite with a better structure. Version handling, bug tracking, issue tracking, etc. now available under the integrated Codebeamer.

27.18 OpenModelica 1.4.3, June 2007

This release has a number of significant improvements of the OMC compiler, OMNotebook, the MDT plugin and the OMDev. Increased platform availability now also for Linux and Macintosh, in addition to Windows. OMSH is the same as previously, but now ported to Linux and Mac.
27.18.1 OpenModelica Compiler (OMC)

This release includes a number of improvements of the OpenModelica Compiler (OMC):

- Significantly increased compilation speed, especially with large models and many packages.
- Now available also for Linux and Macintosh platforms.
- Support for when-equations in algorithm sections, including elsewhen.
- Support for inner/outer prefixes of components (but without type error checking).
- Improved solution of nonlinear systems.
- Added ability to compile generated simulation code using Visual Studio compiler.
- Added "smart setting of fixed attribute to false. If initial equations, OMC instead has fixed=true as default for states due to allowing overdetermined initial equation systems.
- Better state select heuristics.
- New function getIncidenceMatrix(ClassName) for dumping the incidence matrix.
- Built-in functions String(), product(), ndims(), implemented.
- Support for terminate() and assert() in equations.
- In emitted flat form: protected variables are now prefixed with protected when printing flat class.
- Some support for tables, using omcTableTimeIni instead of dymTableTimeIni2.
- Better support for empty arrays, and support for matrix operations like a*[1,2;3,4].
- Improved val() function can now evaluate array elements and record fields, e.g. val(x[n]), val(x.y).
- Support for reinit in algorithm sections.
- String support in external functions.
- Double precision floating point precision now also for interpreted expressions.
- Better simulation error messages.
- Support for der(expressions).
- Support for iterator expressions such as {3*i for i in 1..10}.
- More test cases in the test suite.
- A number of bug fixes, including sample and event handling bugs.

27.18.2 OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the platform availability.

- Available on the Linux and Macintosh platforms, in addition to Windows.
- Fixed cell copying bugs, plotting of derivatives now works, etc.

27.18.3 OpenModelica Shell (OMShell)

Now available also on the Macintosh platform.

27.18.4 OpenModelica Eclipse Plug-in (MDT)

This release includes major improvements of MDT and the associated MetaModelica debugger:

- Greatly improved browsing and code completion works both for standard Modelica and for MetaModelica.
- Hovering over identifiers displays type information.
- A new and greatly improved implementation of the debugger for MetaModelica algorithmic code, operational in Eclipse.
- Greatly improved performance - only approx 10% speed reduction even for 100 000 line programs.
- Greatly improved single stepping, step over, data structure browsing, etc.
- Many bug fixes.

27.18.5 OpenModelica Development Environment (OMDev)

Increased compilation speed for MetaModelica. Better if-expression support in MetaModelica.

27.19 OpenModelica 1.4.2, October 2006

This release has improvements and bug fixes of the OMC compiler, OMNotebook, the MDT plugin and the OMDev. OMShell is the same as previously.
27.19.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):

- Improved initialization and index reduction.
- Support for integer arrays is now largely implemented.
- The `val(variable,time)` scripting function for accessing the value of a simulation result variable at a certain point in the simulated time.
- Interactive evaluation of for-loops, while-loops, if-statements, if-expressions, in the interactive scripting mode.
- Improved documentation and examples of calling the Model Query and Manipulation API.
- Many bug fixes.

27.19.2 OpenModelica Notebook (OMNotebook)

Search and replace functions have been added. The DrModelica tutorial (all files) has been updated, obsolete sections removed, and models which are not supported by the current implementation marked clearly. Automatic recognition of the `.onb` suffix (e.g. when double-clicking) in Windows makes it even more convenient to use.

27.19.3 OpenModelica Eclipse Plug-in (MDT)

Two major improvements are added in this release:

- Browsing and code completion works both for standard Modelica and for MetaModelica.
- The debugger for algorithmic code is now available and operational in Eclipse for debugging of MetaModelica programs.

27.20 OpenModelica 1.4.1, June 2006

This release has only improvements and bug fixes of the OMC compiler, the MDT plugin and the OMDev components. The OMShell and OMNotebook are the same.

27.20.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):

- Support for external objects.
- OMC now reports the version number (via command line switches or CORBA API `getVersion()`).
- Implemented caching for faster instantiation of large models.
- Many bug fixes.

27.20.2 OpenModelica Eclipse Plug-in (MDT)

Improvements of the error reporting when building the OMC compiler. The errors are now added to the problems view. The latest MDT release is version 0.6.6 (2006-06-06).

27.20.3 OpenModelica Development Environment (OMDev)

Small fixes in the MetaModelica compiler. MetaModelica Users Guide is now part of the OMDev release. The latest OMDev was release in 2006-06-06.
27.21 OpenModelica 1.4.0, May 2006

This release has a number of improvements described below. The most significant change is probably that OMC has now been translated to an extended subset of Modelica (MetaModelica), and that all development of the compiler is now done in this version.

27.21.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):

- Partial support for mixed system of equations.
- New initialization routine, based on optimization (minimizing residuals of initial equations).
- Symbolic simplification of builtin operators for vectors and matrices.
- Improved code generation in simulation code to support e.g. Modelica functions.
- Support for classes extending basic types, e.g. connectors (support for MSL 2.2 block connectors).
- Support for parametric plotting via the plotParametric command.
- Many bug fixes.

27.21.2 OpenModelica Shell (OMShell)

Essentially the same OMShell as in 1.3.1. One difference is that now all error messages are sent to the command window instead of to a separate log window.

27.21.3 OpenModelica Notebook (OMNotebook)

Many significant improvements and bug fixes. This version supports graphic plots within the cells in the notebook. Improved cell handling and Modelica code syntax highlighting. Command completion of the most common OMC commands is now supported. The notebook has been used in several courses.

27.21.4 OpenModelica Eclipse Plug-in (MDT)

This is the first really useful version of MDT. Full browsing of Modelica code, e.g. the MSL 2.2, is now supported. (MetaModelica browsing is not yet fully supported). Full support for automatic indentation of Modelica code, including the MetaModelica extensions. Many bug fixes. The Eclipse plug-in is now in use for OpenModelica development at PELAB and MathCore Engineering AB since approximately one month.

27.21.5 OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica development.

- A separate web page for OMDev (OpenModelica Development Environment).
- A pre-packaged OMDev zip-file with precompiled binaries for development under Windows using the mingw Gnu compiler from the Eclipse MDT plug-in. (Development is also possible using Visual Studio).

27.22 OpenModelica 1.3.1, November 2005

This release has several important highlights.
This is also the *first* release for which the New BSD (Berkeley) open-source license applies to the source code, including the whole compiler and run-time system. This makes it possible to use OpenModelica for both academic and commercial purposes without restrictions.

27.22.1 OpenModelica Compiler (OMC)

This release includes a significantly improved OpenModelica Compiler (OMC):

- Support for hybrid and discrete-event simulation (if-equations, if-expressions, when-equations; not yet if-statements and when-statements).
- Parsing of full Modelica 2.2.
- Improved support for external functions.
- Vectorization of function arguments; each-modifiers, better implementation of replaceable, better handling of structural parameters, better support for vector and array operations, and many other improvements.
- Flattening of the Modelica Block library version 1.5 (except a few models), and simulation of most of these.
- Automatic index reduction (present also in previous release).
- Updated User’s Guide including examples of hybrid simulation and external functions.

27.22.2 OpenModelica Shell (OMShell)

An improved window-based interactive command shell, now including command completion and better editing and font size support.

27.22.3 OpenModelica Notebook (OMNotebook)

A free implementation of an OpenModelica notebook (OMNotebook), for electronic books with course material, including the DrModelica interactive course material. It is possible to simulate and plot from this notebook.

27.22.4 OpenModelica Eclipse Plug-in (MDT)

An early alpha version of the first Eclipse plug-in (called MDT for Modelica Development Tooling) for Modelica Development. This version gives compilation support and partial support for browsing Modelica package hierarchies and classes.

27.22.5 OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica development.

- Bugzilla support for OpenModelica bug tracking, accessible to anybody.
- A system for automatic regression testing of the compiler and simulator, (+ other system parts) usually run at check in time.
- Version handling is done using SVN, which is better than the previously used CVS system. For example, name change of modules is now possible within the version handling system.
CONTRIBUTORS TO OPENMODELICA

This Appendix lists the individuals who have made significant contributions to OpenModelica, in the form of software development, design, documentation, project leadership, tutorial material, promotion, etc. The individuals are listed for each year, from 1998 to the current year: the project leader and main author/editor of this document followed by main contributors followed by contributors in alphabetical order.

28.1 OpenModelica Contributors 2015

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Volker Waurich, TU Dresden, Dresden, Germany.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Anders Andersson, VTI, Linköping, Sweden.
Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Daniel Bouskela, EDF, Paris, France.
Lena Buffoni, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Atiyah Elsheikh, AIT, Vinnea, Austria.
Rüdiger Franke, ABB, Germany
Jens Frenkel, TU Dresden, Dresden, Germany.
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Alf Isakssson, ABB Corporate Research, Västerås, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Henning Kiel, Bocholt, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Leonardo Laguna, Wolfram MathCore AB, Linköping, Sweden.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Oliver Lenord, Siemens PLM, California, USA.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Alachew Mengist, PELAB, Linköping University, Linköping, Sweden.
Abhir Raj Metkar, CDAC, Trivandrum, Kerala, India.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Lars Mikelsons, Bosch Rexroth, Lohr am Main, Germany.
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden.
Kannan Moudgalya, IIT Bombay, Mumbai, India.
Kenneth Nealy, USA.
Hannu Niemistö, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Arunkumar Palanisamy, PELAB, Linköping University, Linköping, Sweden.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Vitalij Ruge, Fachhochschule Bielefeld, Bielefeld, Germany.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Roland Samlaus, Bosch, Stuttgart, Germany.
Vladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Jan Šilar, Charles University, Prague, Czech Republic
Kristian Staväker, PELAB, Linköping University, Linköping, Sweden.
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden.
Bernhard Thiele, PELAB, Linköping University, Linköping, Sweden.
Hubert Thierot, CEP Paristech, Ecole des Mines, Paris, France.
Gustaf Thorslund, PELAB, Linköping University, Linköping, Sweden.
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden.
Marcus Walther, TU Dresden, Dresden, Germany.
28.2 OpenModelica Contributors 2014

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
Jens Frenkel, TU Dresden, Dresden, Germany.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Lena Buffoni, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Filippo Donida, Politecnico di Milano, Milan, Italy.
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Zoheb Hossain, PELAB, Linköping University, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Abhinn Kothari, PELAB, Linköping University, Linköping, Sweden.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Oliver Lenord, Siemens PLM, California, USA.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Henrik Magnusson, Linköping, Sweden.
Abhi Raj Metkar, CDAC, Trivandrum, Kerala, India.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Tuomas Miettinen, VTT, Espoo, Finland.
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden.
Hannu Niemistö, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Arunkumar Palanisamy, PELAB, Linköping University, Linköping, Sweden.
Karl Pettersson, IEI, Linköping University, Linköping, Sweden.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Jhansi Remala, PELAB, Linköping University, Linköping, Sweden.
Reino Ruusu, VTT, Espoo, Finland.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Wladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Alachew Shitahun, PELAB, Linköping University, Linköping, Sweden.
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia
Ingo Staack, IEI, Linköping University, Linköping, Sweden.
Kristian Staväker, PELAB, Linköping University, Linköping, Sweden.
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden.
Hubert Thierot, CEP Paristech, Ecole des Mines, Paris, France.
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden.
Parham Vasaiely, EADS, Hamburg, Germany.
Niklas Worschech, Bosch-Rexroth, Lohr am Main, Germany.
Robert Wotzlau, Goettingen, Germany.
Azam Zia, PELAB, Linköping University, Linköping, Sweden.

28.3 OpenModelica Contributors 2013

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
Jens Frenkel, TU Dresden, Dresden, Germany.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Lena Buffoni, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Filippo Donida, Politecnico di Milano, Milan, Italy.
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Zoheb Hossain, PELAB, Linköping University, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Abhin Mth成交, PELAB, Linköping University, Linköping, Sweden.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Oliver Lenord, Siemens PLM, California, USA.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Henrik Magnusson, Linköping, Sweden.
Abhi Raj Metkar, CDAC, Trivandum, Kerala, India.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Tuomas Miettinen, VTT, Espoo, Finland.
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden.
Hannu Niemisto, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Arunkumar Palanisamy, PELAB, Linköping University, Linköping, Sweden.
Karl Pettersson, IEI, Linköping University, Linköping, Sweden.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Jhansi Remala, PELAB, Linköping University, Linköping, Sweden.
Reino Ruusu, VTT, Espoo, Finland.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Wladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Alachew Shitahun, PELAB, Linköping University, Linköping, Sweden.
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia
Ingo Staack, IEI, Linköping University, Linköping, Sweden.
Kristian Stavåker, PELAB, Linköping University, Linköping, Sweden.
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden.
Hubert Thierot, CEP Paristech, Ecole des Mines, Paris, France.
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden.
Parham Vasaiely, EADS, Hamburg, Germany.
Niklas Worschech, Bosch-Rexroth, Lohr am Main, Germany.
Robert Wotzlaw, Goettingen, Germany.
Azam Zia, PELAB, Linköping University, Linköping, Sweden.

28.4 OpenModelica Contributors 2012

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
Jens Frenkel, TU Dresden, Dresden, Germany.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Mikael Axin, IEI, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Filippo Donida, Politecnico di Milano, Milan, Italy.
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Zoheb Hossain, PELAB, Linköping University, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Abhin Kothari, PELAB, Linköping University, Linköping, Sweden.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Oliver Lenord, Siemens PLM, California, USA.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Henrik Magnusson, Linköping, Sweden.
Abhi Raj Metkar, CDAC, Trivandrum, Kerala, India.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Tuomas Miettinen, VTT, Espoo, Finland.
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden.
Hannu Niemistö, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Arunkumar Palanisamy, PELAB, Linköping University, Linköping, Sweden.
Karl Pettersson, IEI, Linköping University, Linköping, Sweden.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Jhansi Remala, PELAB, Linköping University, Linköping, Sweden.
Reino Ruusu, VTT, Espoo, Finland.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Wladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Alachew Shitahun, PELAB, Linköping University, Linköping, Sweden.
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia.
Ingo Staack, IEI, Linköping University, Linköping, Sweden.
28.5 OpenModelica Contributors 2011

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
Jens Frenkel, TU Dresden, Dresden, Germany.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Mikael Axin, IEI, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Filippo Donida, Politecnico di Milano, Milan, Italy.
Anand Ganeson, PELAB, Linköping University, Linköping, Sweden.
Mahder Gebremedhin, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Zoheb Hossain, PELAB, Linköping University, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden.
Kim Jansson, PELAB, Linköping University, Linköping, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Joel Klinghed, PELAB, Linköping University, Linköping, Sweden.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Abhinn Kothari, PELAB, Linköping University, Linköping, Sweden.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Oliver Lenord, Siemens PLM, California, USA.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Rickard Lindberg, PELAB, Linköping University, Linköping, Sweden
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Henrik Magnusson, Linköping, Sweden.
Abhi Raj Metkar, CDAC, Trivandrum, Kerala, India.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Tuomas Miettinen, VTT, Espoo, Finland.
Afshin Moghadam, PELAB, Linköping University, Linköping, Sweden.
Hannu Niemistö, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Kristoffer Norling, PELAB, Linköping University, Linköping, Sweden.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Karl Pettersson, IEI, Linköping University, Linköping, Sweden.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Reino Ruusu, VTT, Espoo, Finland.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Wladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Klas Sjöholm, PELAB, Linköping University, Linköping, Sweden.
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia.
Ingo Staack, IEI, Linköping University, Linköping, Sweden.
Kristian Staväker, PELAB, Linköping University, Linköping, Sweden.
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden.
Hubert Thierot, CEP Paristech, Ecole des Mines, Paris, France.
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden.
Parham Vasiely, EADS, Hamburg, Germany.
Niklas Worschech, Bosch-Rexroth, Lohr am Main, Germany.
28.6 OpenModelica Contributors 2010

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Per Östlund, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Adeel Asghar, PELAB, Linköping University, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Simon Björklén, PELAB, Linköping University, Linköping, Sweden.
Mikael Blom, PELAB, Linköping University, Linköping, Sweden.
Robert Braun, IEI, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy.
Filippo Donida, Politecnico di Milano, Milan, Italy.
Henrik Eriksson, PELAB, Linköping University, Linköping, Sweden.
Anders Fernström, PELAB, Linköping University, Linköping, Sweden.
Jens Frenkel, TU Dresden, Dresden, Germany.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden.
Kim Jansson, PELAB, Linköping University, Linköping, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany.
Tommi Karhela, VTT, Espoo, Finland.
Joel Klinghed, PELAB, Linköping University, Linköping, Sweden.
Petter Krus, IEI, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland.
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden.
Magnus Leksell, Linköping, Sweden.
Oliver Lenord, Bosch-Rexroth, Lahr am Main, Germany.
Ariel Liebman, Energy Users Association of Australia, Victoria, Australia.
Rickard Lindberg, PELAB, Linköping University, Linköping, Sweden
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Henrik Magnusson, Linköping, Sweden.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Hannu Niemistö, VTT, Espoo, Finland.
Peter Nordin, IEI, Linköping University, Linköping, Sweden.
Kristoffer Norling, PELAB, Linköping University, Linköping, Sweden.
Lennart Ochel, Fachhochschule Bielefeld, Bielefeld, Germany.
Atanas Pavlov, Munich, Germany.
Karl Pettersson, IEI, Linköping University, Linköping, Sweden.
Pavel Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Reino Ruusu, VTT, Espoo, Finland.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Wladimir Schamai, EADS, Hamburg, Germany.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany.
Klas Sjöholm, PELAB, Linköping University, Linköping, Sweden.
Anton Sodja, University of Ljubljana, Ljubljana, Slovenia
Ingo Staack, IEI, Linköping University, Linköping, Sweden.
Kristian Staväker, PELAB, Linköping University, Linköping, Sweden.
Sonia Tariq, PELAB, Linköping University, Linköping, Sweden.
Mohsen Torabzadeh-Tari, PELAB, Linköping University, Linköping, Sweden.
Niklas Worschech, Bosch-Rexroth, Lahr am Main, Germany.
Robert Wotzlaw, Goettingen, Germany.
Björn Zachrisson, MathCore Engineering AB, Linköping, Sweden.

28.7 OpenModelica Contributors 2009

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.
Adrian Pop, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Constantin Belyaev, Bashpromavtomatika Ltd., Ufa, Russia
Simon Björklén, PELAB, Linköping University, Linköping, Sweden.
Mikael Blom, PELAB, Linköping University, Linköping, Sweden.
Willi Braun, Fachhochschule Bielefeld, Bielefeld, Germany.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Stefan Brus, PELAB, Linköping University, Linköping, Sweden.
Francesco Casella, Politecnico di Milano, Milan, Italy
Filippo Donida, Politecnico di Milano, Milan, Italy
Henrik Eriksson, PELAB, Linköping University, Linköping, Sweden.
Anders Fernström, PELAB, Linköping University, Linköping, Sweden.
Jens Frenkel, TU Dresden, Dresden, Germany.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Michael Hanke, NADA, KTH, Stockholm
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Alf Isaksson, ABB Corporate Research, Västerås, Sweden
Kim Jansson, PELAB, Linköping University, Linköping, Sweden.
Daniel Kanth, Bosch-Rexroth, Lohr am Main, Germany
Tommi Karhela, VTT, Espoo, Finland.
Joel Klinghed, PELAB, Linköping University, Linköping, Sweden.
Juha Kortelainen, VTT, Espoo, Finland
Alexey Lebedev, Equa Simulation AB, Stockholm, Sweden
Magnus Leksell, Linköping, Sweden
Oliver Lenord, Bosch-Rexroth, Lohr am Main, Germany
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Henrik Magnusson, Linköping, Sweden
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Hannu Niemistö, VTT, Espoo, Finland
Kristoffer Norling, PELAB, Linköping University, Linköping, Sweden.
Atanas Pavlov, Munich, Germany.
Pavol Privitzer, Institute of Pathological Physiology, Praha, Czech Republic.
Per Sahlin, Equa Simulation AB, Stockholm, Sweden.
Gerhard Schmitz, University of Hamburg, Hamburg, Germany
Klas Sjöholm, PELAB, Linköping University, Linköping, Sweden.
Martin Sjölund, PELAB, Linköping University, Linköping, Sweden.
Kristian Staväker, PELAB, Linköping University, Linköping, Sweden.
28.8 OpenModelica Contributors 2008

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Vasile Baluta, PELAB, Linköping University, Linköping, Sweden.
Mikael Blom, PELAB, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Henrik Eriksson, PELAB, Linköping University, Linköping, Sweden.
Anders Fernström, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Kim Jansson, PELAB, Linköping University, Linköping, Sweden.
Joel Klinghed, PELAB, Linköping University, Linköping, Sweden.
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Kristoffer Norling, PELAB, Linköping University, Linköping, Sweden.
Anders Sandholm, PELAB, Linköping University, Linköping, Sweden.
Klas Sjöholm, PELAB, Linköping University, Linköping, Sweden.
Kristian Ståvåker, PELAB, Linköping University, Linköping, Sweden.
Simon Bjorklén, PELAB, Linköping University, Linköping, Sweden.
Constantin Belyaev, Bashpromavtomatika Ltd., Ufa, Russia
28.9 OpenModelica Contributors 2007

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Adrian Pop, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
David Akhvlediani, PELAB, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Henrik Eriksson, PELAB, Linköping University, Linköping, Sweden.
Anders Fernström, PELAB, Linköping University, Linköping, Sweden.
Pavel Grozman, Equa AB, Stockholm, Sweden.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Ola Leifler, IDA, Linköping University, Linköping, Sweden.
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Eric Meyers, Pratt & Whitney Rocketdyne, Palm City, Florida, USA.
Kristoffer Norling, PELAB, Linköping University, Linköping, Sweden.
Anders Sandholm, PELAB, Linköping University, Linköping, Sweden.
Klas Sjöholm, PELAB, Linköping University, Linköping, Sweden.
William Spinelli, Politecnico di Milano, Milano, Italy
Kristian Stavåker, PELAB, Linköping University, Linköping, Sweden.
Stefan Vorkoetter, MapleSoft, Waterloo, Canada.
Björn Zachrisson, MathCore Engineering AB, Linköping, Sweden.
Constantin Belyaev, Bashpromavtomatika Ltd., Ufa, Russia

28.10 OpenModelica Contributors 2006

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, MathCore Engineering AB, Linköping, Sweden.
Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
28.11 OpenModelica Contributors 2005

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.
Peter Aronsson, PELAB, Linköping University and MathCore Engineering AB, Linköping, Sweden.
Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Ingemar Axelsson, PELAB, Linköping University, Linköping, Sweden.
David Broman, PELAB, Linköping University, Linköping, Sweden.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Kaj Nyström, PELAB, Linköping University, Linköping, Sweden.
Lucian Popescu, MathCore Engineering AB, Linköping, Sweden.
Levon Saldamli, PELAB, Linköping University, Linköping, Sweden.

28.12 OpenModelica Contributors 2004

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, Linköping University, Linköping, Sweden.
Bernhard Bachmann, Fachhochschule Bielefeld, Bielefeld, Germany.
Peter Bunus, PELAB, Linköping University, Linköping, Sweden.
Daniel Hedberg, MathCore Engineering AB, Linköping, Sweden.
Håkan Lundvall, PELAB, Linköping University, Linköping, Sweden.
Emma Lärsson Nilsson, PELAB, Linköping University, Linköping, Sweden.
Kaj Nyström, PELAB, Linköping University, Linköping, Sweden.
Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Lucian Popescu, MathCore Engineering AB, Linköping, Sweden.
Levon Saldamli, PELAB, Linköping University, Linköping, Sweden.

28.13 OpenModelica Contributors 2003

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.
Peter Aronsson, Linköping University, Linköping, Sweden.
Levon Saldamli, PELAB, Linköping University, Linköping, Sweden.

Peter Bunus, PELAB, Linköping University, Linköping, Sweden.
Vadim Engelson, PELAB, Linköping University, Linköping, Sweden.
Daniel Hedberg, Linköping University, Linköping, Sweden.
Eva-Lena Lengquist-Sandelin, PELAB, Linköping University, Linköping, Sweden.
Susanna Monemar, PELAB, Linköping University, Linköping, Sweden.
Adrian Pop, PELAB, Linköping University, Linköping, Sweden.
Erik Svensson, MathCore Engineering AB, Linköping, Sweden.

28.14 OpenModelica Contributors 2002

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Levon Saldamli, PELAB, Linköping University, Linköping, Sweden.

Peter Aronsson, Linköping University, Linköping, Sweden.
Daniel Hedberg, Linköping University, Linköping, Sweden.
Henrik Johansson, PELAB, Linköping University, Linköping, Sweden.
Andreas Karström, PELAB, Linköping University, Linköping, Sweden.
28.15 OpenModelica Contributors 2001

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Levon Saldamli, PELAB, Linköping University, Linköping, Sweden.
Peter Aronsson, Linköping University, Linköping, Sweden.

28.16 OpenModelica Contributors 2000

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

28.17 OpenModelica Contributors 1999

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

Peter Rönquist, PELAB, Linköping University, Linköping, Sweden.

28.18 OpenModelica Contributors 1998

Peter Fritzson, PELAB, Linköping University, Linköping, Sweden.

David Kågedal, PELAB, Linköping University, Linköping, Sweden.
Vadim Engelson, PELAB, Linköping University, Linköping, Sweden.


